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Reporting Overview

Reporting is a collection of data as a result of monitoring the network traffic, which can be used for
further analysis. In NetWitness Platform you can run a report against NetWitness Platform Database
core services to identify the network activities. For example, if you want to identify the Top Source
Countries and Destination Countries, or top Threat and Risk trends that help monitor any changes to the
normal categories or monitor the users and services that may potentially have malicious activities etc.

The reporting typically consist of: Reports and Charts. You can report on the log, packet and endpoint
data collected, and customize the reports and charts to enhance the visual appearance. You can create
real-time reports for historical data. You can create charts and dashlets, that can be added in the real-
time chart dashlets as well.

Reporting Engine

Reporting relies on the Reporting Engine to provide data for the reports, alerts and charts. Hence, you
must configure the Reporting Engine as a service to NetWitness Platform before you can generate the
reports. You must also specify the data source in the Reporting Engine from which the data is extracted.

The data that you can report or alert depends on the configuration of Reporting Engine and the data
sources that you specify as part of the rule definition.

Note: Make sure you have access to the components in the Reporting.

Note: Make sure you have access to the required data sources. Only privileged users with access to
sensitive information have the permission to certain data sources. To manage access control to data
sources, see the "Add a Role and Assign Permissions for Warehouse Analytics" However, for the
existing reports, alerts and charts, if the user role or permissions are modified for the

data sources, then it is not applicable unless you manually update the permissions.

Note: Reporting is accessible based on the role based access, defined for the user.

Report

A report is a combination of rules and other formatting objects such as headers and HTML-formatted
notes that describe and identify data pertaining to a particular area of interest. Reports are defined and
managed in the Build Report page and can be scheduled to run on an adhoc or timely basis. Once a
report is run, results are stored centrally and can be automatically sent over email, SFTP, URL, and NFS
to users, viewed via the NetWitness Platform web interface, downloaded as PDF and CSV files.

A report consists of the following:

ey o e

Report Name Used to identify the report Reportl

- - to schedule them at a later
Note: For Name field, the icon to extend the column size | time.

is not displayed at the end of the column field. You have
to hover the mouse a little to the left side to see the icon
for extending the column.

Reporting Overview 6
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N N

Pre-defined text ficlds Headerl,
used within a report to Comment
make the report more

meaningful to the user.

Text

Rules

The rules (queries) used to  select

create a report.

user.dst

where
ip.src =
10.10.10.1

Note: In the Reporting user interface, the displayed date or time is always according to the user-
selected time zone profile.

Rule

A rule is the basic and essential building block in the Reporting. You must create a rule which can be
used in a Report, Chart or Alert.

A rule represents a unique query that detects and summarizes the requested information within a
collection of network data.

The rule syntax is very similar to that of Standard Query Language (SQL) where you can use the select
clause, where clause, sort and group options and limits for the result set. A rule consists of the following:

ey ot = e

Name

Select

Where

Then
(Rule
Actions)

The name of the rule.

List of meta types that are returned in the result set. The list of
meta types is provided in the Meta Library. Meta Library in the
Rule Builder is continually synchronized with the index
configuration of the NetWitness Platform host to which
NetWitness Platform is connected. The number of meta types
that this property can represent depends on how the rule is to be
sorted. If the Sort by property is 'None' or Custom, a rule can
have more than one select field, for example, for each match,
include the ip.src, ip.dst, size, time in the rule result. If a rule is
set to be sorted, either by session count, session size, or packet
size, then there can only be one field on which to select.

A clause that is the base query for the rule.

A series of functions that manipulate the original result set of a
rule in order to make the output in a report more meaningful or
add additional functionality other than querying and displaying
data.

Windows System
Account Activity

alert='cleartext ftp
password'

lookup and add
(‘'username',"ip.src',10);

Reporting Overview
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T N

Sort By Determines how the data in the result set is sorted. The various  Total
possibilities are:

° Total
o Value

e Column Name

Limit Designates how large a result set can be for the given rule. 20
Users must note that if a result set is sorted by count or size, the
limit represents the top (or bottom) N values to be returned. If
the result set is not sorted, the first N values are returned.

Note: In the User Interface (Ul), the date or time displayed depends on the time zone selected by the
user.

Rule Types

There are different rule types in the Reporting. Rule types designate the source of data for the report
rule. Following are the rule types:

NetWitness Database ~ The NetWitness database extracts the meta from a Reporting Engine
(NetWitness DB) configured to use a Concentrator, Broker and Archiver as the data sources
and provides the meta for rules.

Warehouse Database The Warehouse database, also referred to as the RSA NetWitness

(Warehouse DB) Warehouse, warehouses large volumes of data. The Warehouse is designed
so that you can retrieve large volumes of data easily and efficiently. The
Warehouse also extracts the meta from the Reporting Engine.

Respond Database The Respond database contain alerts and incidents generated from different
(Respond DB) services and you can create a report on those alerts and incidents.

Note: In the User Interface (UI), the date or time displayed depends on the time zone selected by the
user.

List
A list is a variable that refers to a series of comma-separated values (CSV). You can insert a list into a

rule or use it as an argument to a rule action. Lists can act as placeholders for other values, which you
can populate and update as needed.

You can create, manage and view lists that can be used to define rules for Reporting and Alerting.

Lists cannot be empty or have duplicate or blank values.

Reporting Overview 8
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Note: If you are defining a report with a rule which has lookup and add in the Then clause and direct
the report output to a list, the list is not populated with the result.

For example, if you create a rule with ip.src in the Select clause and lookup and add ('ip.dst','ip.src',
10) in the Then clause, the report displays the result, but if you have redirected the output to a list, the
list will be empty

Chart

Chart is a tabular or grid representation of data. It consists of the following:

vy Joren e

Chart Name Identifies the chart. Chartl
Rule Basis Identifies the rule path chosen from the folder hierarchy.

Any NetWitness Platform DB rule in the Reporting Engine system which is not sorted by none can be
used to instantly create a chart. In NetWitness Platform, the chart interval can be adjusted from the chart
definition panel itself. Each time a chart runs, it stores its result data locally in the Reporting Engine, so
that it can be reviewed in either the Dashboard View or Chart View without any performance
considerations.

Note: In the Reporting user interface, the output for the field where Date and Time are displayed is
always according to the user-selected time zone profile.

Note: The Reporting Engine (RE) will automatically check for the available disk space before you
execute a Test Rule, Report, Chart and Alert. If the RE disk space (in percentage) is less than the
minimum disk space threshold (default value is 5), the RE will stop the current execution and an error
message 'Available disk space of Reporting engine home is <5%, please clean up the space to proceed
further' is displayed. Additionally, you may also configure the minimum disk space threshold by using
the following path: RE>Config>General>System Configuration>Mini disk space threshold in %.

Reporting Guidelines

This section lists the RSA recommended guidelines to enhance the execution time of your reporting
entities such as rules, reports, alerts, charts, and lists. The guidelines are provided for the following:

« NWDB Rules
o Timeout Configuration for NWDB Rules
o Lookup and Add rule action

o List value Reports

NWDB Rules

If the reporting entities such as report, alert, or chart contain NWDB rules (in most cases where the
query contains Group By) takes a long time to execute, you may do the following:

9 Reporting Overview
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1. Refine the Where clause:

You may limit the number of sessions scanned by using or refining the Where clause (especially

when you use the Group By option). For example, consider the following rule.

Build Rule

Rule Type

MName

Seszion

MNetwitness Platform DB
Source |p Activigy

Event Count v
ipsrc

Sowurce |P Address

ipsrc exists

ipsrc

Enter a then clauss...

Column Name

Total

=
<

Save Reset

Test Rule

Sort By

" Descending

If you use a Where clause as mentioned above, the number of sessions aggregated is huge. To avoid
this, you can filter only required sessions by specifying the list of [P addresses or creating a List (list

of IP Address) that contains relevant IP addresses.

Note: The NWDB rule where clause is appropriately quoted if the syntax has an invalid quote. For
example, in case of an invalid meta, or missing separator, the status and the error message is
updated appropriately.

Reporting Overview
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Build Rule

Rule Type MetWitness Platform DB

Mame Source P Activity

Summarize Svent Coune -

zelect ip.src

Alias Source IP Address

Where ip.src=%[/User Report/List of IP Address]

Group By ip.src

Then Enter a then clause...

Order By Column Name Sort By
Total Ascending

Session o +

Threshald

Limiz 20 *

E Save Reset Test Rule

2. Using indexed Meta keys in the Where clause:

To understand if the Meta is indexed or not, mouse hover the Meta List present on the right panel. If
the Value Type is INDEX VALUE, then the Meta is indexed. The Value Type is INDEX KEY or
INDEX NONE if the Meta is not indexed.

Below is a snapshot of a Meta key that is indexed.

11 Reporting Overview
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Meta

10.31.204.31 - conc

05
access.point

action

ad.compu
Value Type: INDEX_VALUE

Meta Type: STRING
Description: Action Event

ad.compu

ad.domain.dst
ad.domain.src
ad.username.dst
ad.username.src

alert

3. Configure the Timeout option:

If the query is taking a long time and fails due to timeout issues, you can configure the timeout for the
NWDB rule executions. For more information, see below section "Timeout Configuration for NWDB
Rules".

Schedule the queries to run at different times:

If multiple query aggregates are concurrently executed and timeout occurs, you may schedule the
queries to run at different times without much overlap.

Timeout Configuration for NWDB Rules

Note: It is a good practice to check the statistics of the Reporting Engine and the NWDB data sources
before you make any changes to the configuration. For more information, see the "Monitor Service
Details" topic for Reporting Engine and "Monitor System Statistics" topic in the System Maintenance
Guide.

If NWDB rule execution fails due to timeout, you may get the following errors on the View a Report
page:

Reporting Engine timeout error

“Data source ‘10.31.x.x Concentrator' did not respond within the configured time 30 minutes
for the ‘/sdk/values' request.”

NWDB timeout error

"Error occurred while fetching data from source '10.31.x.x Concentrator'. {Timeout message
from NWDB}”

In such cases, you may do the following:

Reporting Overview 12
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o Reporting Engine timeout

In case of Reporting Engine timeout, you may set the timeout to a longer duration so the long running
queries can be executed. For more information on setting the NWDB Queries Time Out and NWDB
Info Queries Time Out option for the Reporting Engine, see "Step 2. Configure Reporting Engine
Settings" topic in the Reporting Engine Configuration Guide. RSA recommends you set the NWDB
Query Time Out to zero minutes (implies no timeout) and NWDB Info Queries Time Out to 60
minutes.

o NWDB timeout

In case of NWDB timeout, you may need to configure the query.level.timeout and
max.concurrent.queries parameters for the NWDB data source based on the recommendations
in the Core Database Tuning Guide to fine tune the queries.

The following figure is an example of Explorer view where you can set the parameters for NWDB
data source.

RSA RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN @ admin® (@)
Hosts  Services Event Sources Health & Wellness  System  Security
% Change Service | EMSA-Broker | Security

Roles Settings
=14 User Information
Username
Name Username
admin Administrator admin
password Confirm Password
Email Description
Administrator account for this service
User Settings
Auth Type Core Query Timeout
NetWitness Platform v 60 o
Query Prefix Session Threshold
0
Role Membership
Groups.
M Administrators
[] Aggregation
Analysts
Data_Privacy_Officers
Malware_Analysts
Operators
SOC_Managers
Apply Reset

o Schedule Reports at different times

If the NWDB core devices are heavily utilized, you may schedule the reports to run at different times
without overlap.

o Split the Report

13 Reporting Overview
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If you have many rules in a Report, split the report into multiple reports with each report containing
logical set of rules. If you have multiple rules, all rules will begin to execute at the same time based
on available threads, therefore you may group the rules logically into separate reports.

LookupAndAdd Rule Action

If a rule that consists of single or multiple lookup and add rule actions, takes a long time to execute
the report, it is because each of the rule action triggers multiple lookup queries on the NWDB data
source resulting in longer execution time.

To improve the report execution time, you may do the following:

o Refine the Where clause in the following:
o Rule that contains the lookup and add rule action

e lookup and add rule action
o Set Limits

You must set appropriate limits for the rule and rule actions. If the limit is high it will result in many
queries being triggered and hence the report will take a long time to execute.

o Set the boolean aggregate parameter

If you do not want the aggregate value such as sum (meta), count (meta) etc. for the lookup
values, set the boolean aggregate parameter to false in the lookup and add rule action. For more
information, see the "NWDB Rule Syntax" section in Rule Syntax.

lookup and add(string select, string field, int limit, boolean inherit,
string extraWhere, boolean aggregate)

Consider the rule with lookup and add rule action:

Reporting Overview
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Build Rule

Rule Type MetWitness Platform DB

Mame Source IP Activity

Summarize Custom ¥

Select ip.src, count {alias.host)

Alias Source [P Address

Wihere

Group By ip-src

L
Then lookup_and_add (ip.dst, ip.src.25,. false)

Enter a then clause...

Order By Column Mame

Enter the column name..

Session . A
Limit 20 .
Use Lave Reset Test Rule

Sort By

Azcending

The output is displayed:

15
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2018 52 09:00:00 Source IP Activity 2018 52 10:59:59
Source |P Address countialias.host)
1. ip.src BE24
2. ip.src 5438
1. ip.dst
3. ip.Erc 2481
4. ip.src 1158

o Each lookup and add rule action triggers by default two concurrent lookup queries on the data
source. RSA recommends that you retain the default setting, however if you want to increase the
value you may want to ensure the value of Max # of Concurrent LookupAndAdd
Queries parameter in Reporting Engine is less than the Max Concurrent Queries value in the
NWDB data source configuration.

If the NWDB data source is shared across other services, then you may retain a low value for the
Max # of Concurrent LookupAndAdd Queries parameter in Reporting Engine as increasing it
will impact the queries from other services. For more information, see "Reporting Engine General
Tab" topic in Reporting Engine Configuration Guide.

« If you are interested only in unique values and not accurate aggregates, then set the Session
Threshold to a non-zero value for the NWDB rule. For more information, see "Create a Rule Using
NetWitness Data Source" section in Configure a Rule. The higher the value, the longer is the rule
execution. If the value is set to zero it will take a longer time but will provide accurate aggregates.

Consider a rule with lookup and add rule action and Session Threshold set to 10.

Reporting Overview 16
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Build Rule

Rule Type MetWitness Platform DB
Mame Source IP Activity
Summarize Custom =
Select ip-src, countfalias.host)
Alias P Address
MWhere
Group By ip-src
r
Then lookup_and_add{ip.dst, ip.src.25,,.false);

Enzer a then clauss...

Crder By Column Name Sort By

Encer the column name... Azcending

10 -
Limit 20 -+

m Lave Reset Test Rule

The output is displayed:

17 Reporting Overview
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2 02 . 02
Dat Source 2018 33 08:55:00 Source IP Activity 2018 ,; 08:54:59
Broker - Broker ~
IP Address count(alias.host) -
Format
1., 1p.src 1553

Tabular v

1. ip.dst
Time Range
Dast - 2. ip.dst

3. ip.dst
27 Weeks v

4, ip.dst
M Use relative time calculation

5. ip.dst

7. ip.dst

8. Ip.dst

. ip.dst

10. ip.dst

11. ip.dst

12, ip.dst

13, ip.dst

List Value Reports
Use a Refined List:

In case of List value reports (for any data source type), individual reports will be generated for each
value in the list. Therefore, more the number of values in the list the longer the reports will take to
execute. Hence, you must use a refined list to generate such reports.

Access Control for Reporting

Reporting Module provides you the option to set up access control for all the components in the module.
In NetWitness Platform, you can define different roles and specify the access control for each of the role
from the System Security module. You can define the access control to be provided for the Reporting
module for each role. For more information, see "Step 1: Review the Pre-Configured NetWitness
Platform Roles" and "Step 2: (Optional) Add a Role and Assign Permission" topics in the System
Security and User Management Guide.

In the Reports module, you can modify the role permissions or access to the following Reporting objects:

The Following is an example of the hierarchy of the object groups, objects and dependents. This is an
illustration of the Report Groups and Reports hierarchy.

Reporting Overview 18
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. Administrator
Object Group A Reports
i o H Router Config
Changes
Router
Dependent A Configuration rule
i S | | Network Activity
Reports
. Network Traffic
Report
Inbound Network
—  Dependent BA ] Traffic rule
Qutbound Network
—  Dependent BB ] Traffic rule
Inbound Network
—  Dependent BC | Traffic Schedule
Sub Group AA User Activity Reports

Report Groups and Reports Hierarchy
Permission for Object Groups

o You must have the Read & Write permission to set the permissions for the Object Group, Objects, or
Dependents. The dependents with “No Access” permission are grayed out and dependents with
“Read-Only” permission are indicated with an icon.

o When you set the permission for the Object Group, the Objects and Dependents in the Object Group
do not inherit the permission automatically. Y ou must select the "Apply these permissions to sub-
groups and <Objects> in this group" option to achieve this. For example, if you do not want Operators
roles to access reports in Report Group A, then you must set the permission on Group A to No access
for the Operator role and select the "Apply these permissions to sub-groups and Reports in this
group" option.

o When you set the permissions for the Object Group and select the "Apply these permissions to sub-
groups and <Objects> in this group" option, the dependents such as rules or schedules in the objects
do not inherit the permissions automatically. You must use the "Apply Read-only permission to Rules
in the <Object>" option to apply the permission to the rules.

19 Reporting Overview



Reporting User Guide

o When you set the permissions for the Objects, you must ensure that the Objects in hierarchy should
always have a permission that is less than or equal to the one above in the hierarchy for the
permission to be applied. For example, if the reports in a Report Group have Read & Write
permission and you apply a Read-Only or No Access permission at the Report Group level and select
the "Apply these permissions to sub-groups and Reports in this group" option, then the permission on
the rules will remain unchanged.

o The permissions are cascaded from top to down in the hierarchy and not vice-versa. For example, if
you apply a permission to a rule, it does not change the permission of the Report that contains the rule.

Permission for Objects or Dependents
o You must have the Read & Write permission to set the permissions for the Objects or Dependents.

o You can specify the permission for multiple objects at once instead of setting the permission for each
object.

o When you set the permission for the Object, the dependents in the Object do not inherit the permission
automatically. You must select the "Apply Read-only permission to Rules in the <Object>" option to
achieve this.

When you apply the permission to dependents the permission is applied based on the existing permission
for the role. For example, consider an Analyst and a Operator with the following permissions for the
different dependents (Report A object has Rule AA, Rule AB, and Rule AC as dependents).

Object or Dependent | Analyst

Report A Read & Write  No Access
Rule AA Read & Write  No Access
Rule AB Read and Write Read and Write
Rule AC Read-only No Access

When the Analyst applies a Read & Write permission for the Operator role and selects the option "Apply
Read-only permission to Rules in the <Object>", then the permissions will be set for the different
dependents as follows:

Modify the Permissions

o Group Level: Set the permissions at the Object Group level and for all the object and entities in the
Group. For example, if you have 80 reports in the Administrators Reports group and you do not want
anyone except the Administrator to add or modify these reports, you can set the permission for all the
other roles at the group level to Read-Only and select the option to apply it to all the reports and sub-
groups in the report group.

o Multiple Objects:Select multiple objects and specify the access for all the selected objects. For
example, if you have 10 reports in the Network Traffic sub group with sensitive information that you
do not want anyone to access, select the 10 reports and then set the permission for all the roles as "No
Access".

Reporting Overview 20
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o Single Object: Select only the object and specify the permission. For example, select the Network
Traffic Report and specify the Read-Write permission for the Security Analyst role or select the
Login Failure Alert and specify the Read-Write permission for a Security Analyst role.

Object or Operator (Before Permission is | Operator (After Permission is
Dependent
Report A No Access Read & Write

Rule AA No Access Read-only

Rule AB Read and Write Read & Write

Rule AC No Access Read-only

Roles and Permissions for Reporting Module

Although NetWitness Platform has five pre-configured roles, you can add custom roles. For example, in
addition to the pre-configured Analysts role, you can add custom roles
for AnalystsEurope and AnalystsAsia.

Administrators Full system access

Operators Access to configurations but not to data

Analysts Access to data but not to configurations

SOC Managers Same access as Analysts and an additional permission to handle incidents

Malware Analysts Access to malware events only

Depending on the user role, you can set the following access permissions to access the Reporting module
components (Rules, Reports, Charts, Alerts, Lists):

o Create
o Delete

Export

Manage

e View

Note: You must enable all these permissions for a user role to be able to define, delete, manage and
view each of the Reporting modules. Y ou must also have appropriate permissions for the data source
to be listed, while defining the reports, charts, or alerts. For more information, see "Configure Data
sources Permissions" topic in the Reporting Engine Configuration Guide.

For a detailed list of permissions and how to add a role and assign permissions, see "Role Permissions"
and "Step 2. (Optional) Add a Role and Assign Permissions" topics in the System Security and User
Management Guide.
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Configure and Generate a Report

This figure is an overview of the entire process of configuring and generating a report.

Create and Schedule a
Report

Create a Report or
Report Group
— View a Report
Schedule a Report

Configure a Rule

Create or Deploy a Rule
Configure Reporting
Engine -

Create a Parameterized

Create a List or List
Group

Report Using Variables
Investigate a Report

Manage Lists, Rules or
Reports

To configure and generate a report, perform the following tasks:

1. Configure Reporting Engine - You must configure the Reporting Engine before you can configure and
generate a report. You must also specify the data source in the Reporting Engine from which the data
is extracted. For more information on how to configure Reporting Engine, see "Configure Reporting
Engine" topic in the Reporting Configuration Guide.

Configure a Rule

Create and Schedule a Report

View a Report

Investigate a Report

S i

Manage Lists, Rules or Reports
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Configure a Rule

You can create a new rule or deploy an existing rule from the Live Services which can be used in a
report. You can use different conditions to refine the data or information in the data sources such as :

o Select clause

o Where clause

e Group By

e Order By and so on

For example, you can write a rule to view the top 20 web addresses that the users visit daily.

You can create different type of rules using different data sources. Based on your requirements you can
select any of the following options to create a rule:

o Create a Rule Using NetWitness Data Source
o Create a Rule Using Warehouse Data Source

o Create a Rule Using Respond Data Source

You can also use a list in a rule to refine a search result from the data source. Once a rule is created you
can test a rule to see the results returned by the rule.

Create a Rule Group

To create a rule group or rule sub-group, perform the following:
1. Goto MONITOR > Reports.

The Manage tab is displayed.
2. Do one of the following.

o To define a rule group:

a. Inthe Rule Groups Panel, click + .
The new rule group is added to the Rule Groups panel.

b. Enter the name for the rule group and click ENTER.
o To add a rule sub-group:

a. In the Rule Groups panel, select the rule group to which you want to add a sub-group.

b. ClickT.
The new rule sub-group is added to the rule group.

c. Enter the name for the rule sub-group and click ENTER.
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Create a Rule Using NetWitness Data Source
You can create a rule to fetch data or events from a NetWitness data source. The same procedure is
used to define a rule to fetch data or events from an Archiver data source.

The Archiver data source can be added in the Services Config View of the Reporting Engine. For more
information, see "(Optional) Add Archiver as a Data Source to Reporting Engine" topic in the Archiver
Configuration Guide.

Prerequisites

Make sure that you understand how custom meta keys are created using custom feeds. For more
information, see "Create Custom Meta Keys using Custom Feed" topic in the Decoder and Log Decoder
Configuration Guide.

To create a rule to fetch data or events from a NetWitness Data Source, perform the following:
1. Go to MONITOR> Reports.

The Manage tab is displayed.

2. In the Rule toolbar, click + > NetWitnessDB.
The Build Rule view tab is displayed.
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Build Rule

Rule Type Metwitness Platform DB

MName Source and Destination details

Summarize Ewent Count -

Select p.dst

Alias |IF Address

Where pgst=1

e ip.dist

Then Enter a then clause...
4

Order By Column Mame Sort By
Total Azcending

Jezzion 0 -

Threshold . -

Limiz =0 S

Save Re<et Test Rule

3. Inthe Rule Type field, NetWitness DB is selected by default.

4. In the Name field, enter a name that is used to Identify or label the rule in alerts and reports.

The Summarize field determines the type of summarization or aggregation for the rule. Based on the

type of rule to be defined, you must select one of the following:

o To define a Non-Aggregate rule without any grouping, select: None

o To define an Aggregate rule with special aggregation like the collection (sessions/events/packets)

related aggregates, select one of the following:
o Event Count
o Packet Count

o Session Size

25
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10.

11.

o To define an Aggregate rule with meta values and custom aggregates like sum(), count(), and so
on, select: Custom

Choosing 'Custom' in the Summarize field enables you to define aggregate function of your
choice in the Select clause. For example, select ip.src, countdistinct(ip.dst), distinct(ip.dst). The
supported aggregate functions are:

o sum (<meta>)

o count(<meta>)

« countdistinct(<meta>)
o min(<meta>)

o max(<meta>)

o avg(<meta>)

o first(<meta>)

o last(<meta>)

o len(<meta>)

o distinct(<meta>)

For more detailed information about Aggregate and Non-aggregate rule, see "NWDB Rule Syntax
section" in Rule Syntax.

In the Select ficld, enter a meta or select a meta from the list of available meta types provided in the
Meta Library. For more information, see "Meta Panel" in Build Rule View. The meta name to fetch

raw log is raw. raw can only be used in the Select field. It cannot be used in the Where and
Then fields. Multiple aggregate functions are supported for Custom aggregate rule in the Select
field. For example, Select: ip.src, username, service, distinct(country.src), sum(payload).

In the Alias field, enter the alias name for columns used in the Select clause.

In the Where ficld, enter a meta or select a meta from the list of available meta types and use the
operators to construct the Where clause for the base query criteria.
The Group By field is a read-only field which gets populated with meta that are defined in the Select

clause. For a Non-Aggregate function, this field is not visible. A maximum of six meta are supported
in the Group By field.

Note: In earlier versions of NetWitness Platform, only one meta was supported for Custom
aggregate rule in the Group By clause. From now, a maximum of six meta are supported in
the Group By clause.

In the Then field, enter the rule actions that manipulate the original result set of a rule in order to
make the output in a report more concrete or add additional functionality other than querying data and
displaying it, for example, creating a feed from the results. For a complete list of available rule
actions, see "NWDB Rule Syntax" in Rule Syntax.

Note: When a rule is executed for an Archiver data source, it is recommended not to use query
intensive rule actions such as lookup and add() and show whats new().

In the Order By field, perform the following:
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12.

13.

14.

a. Inthe Column Name column, enter the name of the columns by which you want to sort the
results. By default, the value is empty. The value gets populated based on the value selected in
the Summarize field.

o For Summarize 'None', if no Order By is selected, then by default it is ordered by session or
collection time.

o For other Summarize values, the default sorting is based on the first 'group by' meta selected
when no 'order by' is defined. For Event Count, Packet Count, and Session size, the
accepted values are Total and Value.

b. In the Sort by column, select one of the following ways to sort the results:
o Ascending Order
o Descending Order

In the Session Threshold field, enter the optimization setting to stop scanning the matching sessions
for each possible unique value for the selected meta. The threshold is an integer between 0 (default)
and 2147483647.

Note: This is applicable to only NWDB Aggregate rules. If the default value is specified, all the
matching sessions will be scanned and the accurate value will be returned. A higher session
threshold allows accurate counts for a value. However, this causes longer rule execution time. For
example, consider you set the Session Threshold as 1000 for ip.src. If there are 5000 matching
sessions then for a particular ip.src value which is present in more than 1000 sessions, NWDB
stops the scan after 1000 sessions and returns the extrapolated aggregate value. This optimizes the
query execution time. If the value is present in less than 1000 sessions, then the actual value is
returned.

In the Limit field, enter the limit to be put on the query while fetching data from the database. If a
result set is sorted by event count, packet count, or session size, the limit represents the top (or
bottom) N values to be returned. If the result set is not sorted, the first N values are returned.

Click Save.

Note: Unlike parsed meta, raw logs are fetched from decoders. When both raw log and

parsed meta are queried in a single rule, due to different retention periods, parsed meta might be
available and raw logs missing in the same session. So the result will have parsed meta values and
empty raw value for those sessions. For example, for the rule Select ip.src, ip.dst, service,
username, raw, the parsed meta might be populated and the raw meta remains empty for a few
sessions.

Create a Rule Using Warehouse Data Source

You can create a rule to fetch data or events from a Warehouse event source. You can define the rules
in two modes:

o Default Mode

o Expert Mode

Default Mode
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In Default Mode, you can create rules containing simple SQL like HIVE queries that

contain clauses like Select, Where, Group By, and Having. By default, you can create rules to query
sessions or raw logs. For more information on "Simple query syntax and examples", see Warehouse DB
Simple Rules Syntax.

The following figure is an example of the Build Rule view that displays when you select Warehouse
DB for Rule Type without the Expert Mode selected.

Build Rule Meta
Rule Type Warehouze DE MFE_LOT11 L4
Expert Mode  [] bt
Mame EFS by Device o5 -
Select hour{from_unixtime{time]). count{timel{60=E0) I:
From sessions ~
Alias Hour.AverageERE
Where device_type = ‘snort’
-
Group By hour{from_unixtime{time])) »
Having
Order By Column Name Sort By w
Enter the column name_. Ascending
+Z Insert - [ 38 - =
B[] Compliance -
a0
Limit |+ =
B[] Logs

Sawve Reset Test Rule B[] Metwork Activity

Querying Raw Logs

The raw log format is used in the select or where clause to query for raw logs.

Note: The time range that you can specify in your query is a day (24 hours). If you have specified a
time range less than a day in your query, the result set contains data of at least a day (24 hours).

The following figure is an example of the Build Rule view that displays when you select Warehouse
DB for Rule Type and create a rule for querying raw logs.
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Build Rule
Rule Type
Expert Mode
Mame

Select

From

Alizs

Where

Group By
Having

Cirder By

Limit

=

Warehouse DB

‘Windows Failed Logon Events
raw_log

logs W
lMezzage

raw_log LIKE "#5ecurity_525%' OR raw_log LIKE “#%5ecurity_530%" OR raw_log
LIKE "%5ecurity_531%" OR raw_log LIKE “5ecurity_532%' OR raw_|log LIKE
“Security_533%" OR

hour{frem_unixtime{time]}

Column Name Sort By

Enter the column name_.

b

20

Sawve Reset Test Rule

MMeta

MFS_LDT111

4

Lists

= Insert -
B[] Compliance

a

B[] Lo

B[] Network Activity

B[] Per User Report
a0
a0

4

Q
1

Expert Mode

Advanced rules are defined using complex HIVE queries created using the clauses DROP, CREATE,
and so on. Unlike simple rules, we always insert the results into a table. For more information on
"Advanced HIVE query language", see HIVE language manual.

The following figure is an example of the Build Rule view that displays when you select Warehouse
DB for Rule Type with Expert Mode selected.
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: Meta
Build Rule
MFS_LOT11 a
Rule Type ‘Warehouse OB
- ®
Expert Mode ™
05 -
Name Rule in Expert Mode ) |:|
Query DROP Table IF EXISTS sessions21022014: .
CREATE External TABLE = —
ROW FORMAT & .serde avrg AvroserDe’
STORED AS |MP
‘arg.apach
g
z
LOCATION YREA/ rsasacly
TELPROPERT
o -
3
“fields":
[
{"name”:"time", “type”:["leng”. "null”] "default™:"null"}. — %
{"name”:"threat_categery”. "type”:["string”. "null"] "default™"null"}. -
{"name™"jp src”. "type™["string”. "null"] "defsult™:"null"} o #2 |nzert - on
{"name”:"device_clasz". "type™:["string”. "null"] "default™ " null"}
1 @] Compliance -
et mapred.inputdinrecursivestrus: h oD
Alias
B[] Legs
B[] Network Activity
Use Save Reset Test Rule
B[] Per User Report
o
mr] -
4 | [ »

If you want to generate a report for a specific time range, you need to manually define the time range in
the query using the following two variables:

o ${report starttime} - The starting time of the range in seconds.

o ${report _endtime} - The ending time of the range in seconds.

For example, SELECT coll, col2 FROM custom_table WHERE timecol >= ${report_starttime}
AND timecol <= ${report_endtime};

Note: By default, Reporting Engine treats $ { keyword} as a variable. If you want to specify HIVE
variables, you must mention the complete syntax of a variable. For example,
S{hiveconf:hive.exec.scratchdir}.

Prerequisites
Make sure that you understand how custom meta keys are created using custom feeds. For more
information, see "Create Custom Meta Keys using Custom Feed" topic in the Host and Services
Configuration Guide.
To create a rule to fetch data or events from a Warehouse data source, perform the following:
1. Goto MONITOR > Reports.

The Manage tab is displayed.

2. In the Rule toolbar, click
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+ - Warehouse DB.

The Build Rule view is displayed.

3. Inthe Rule Type field, Warehouse DB is selected by default.

If you are defining the rule in Default mode, perform the following:

a. In the Name field, enter a name that is used to Identify or label the rule in alerts and reports.

b. Inthe Select field, enter a meta or select the meta from the drop-down or select a meta from the
list of available meta types provided in the Meta Panel. For more information, see " Meta Panel"
in Build Rule View.

c. Inthe From drop-down menu, select one of the following:

o Session
o Logs

d. Inthe Alias field, enter the alias name for columns used in the Select clause.

e. Inthe Where ficld, enter a meta or select a meta from the list of available meta types provided
in the Meta Panel. The Where clause provides the base query criteria for the rule.

f. In the Group By field, enter the meta selected in the Select clause, so that the result set is
grouped based on the meta.

g. In the Having field, enter the criteria to filter the result set for aggregated queries.

h. Inthe Order By field, perform the following:

1. Inthe Column Name column, enter the name of the columns by which you want to group the
results.

2. In the Sort by column, select one of the following ways to sort the results:
o Ascending Order
o Descending Order

i. Inthe Limit ficld, enter the limit to be put on the query while fetching data from the database. If
a result set is sorted by session count, packet count, or session size, the limit represents the top
(or bottom) N values to be returned. If the result set is not sorted, the first N values are returned.

j. Click Save.

4. If you are defining the rule in Expert mode, select the Expert Mode checkbox and perform the
following:

a. In the Name field, enter a name that is used to Identify or label the rule in alerts and reports.

b. Inthe Query field, enter the Hive query statement to query the data source.

c. Inthe Alias field, enter the alias name for columns used in the Select clause.

d. Click Save.
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Create a Rule Using Respond Data Source

You can create a rule to fetch incidents or alerts from a Respond data source.
Prerequisites
Make sure that you:

Ensure Reporting Engine service is up and running.

Ensure the Incident Management service is up and running. For more information, see "Configure a
Database for the Respond Server Service" topic in the NetWitness Respond Configuration Guide.

(Optional) Ensure the Event Stream Analysis service is up and running. For more information, see
"Step 2. Configure Advanced Settings for an ESA Service" topic in the £S4 Configuration Guide.

(Optional) Ensure the Malware Analysis service is up and running. For more information, see "
(Optional) Configure Auditing on Malware Analysis Host" topic in the Malware Configuration Guide.

Note: You need to configure any one of the services (Event Stream Analysis, Reporting Engine,
Malware Analysis, or Endpoint) based on your requirement and the type of alerts or incidents you want
to generate.

To create a rule to fetch data or events from a Respond Data Source, perform the following:

1.

Go to MONITOR > Reports.

The Manage tab is displayed.

In the Rule toolbar, click + - RESPOND.

The Build Rule view tab is displayed.

In the Rule Type field, Respond is selected by default.

In the Name field, enter a name that is used to Identify or label the rule in alerts and incident reports.

The Summarize field determines the type of summarization or aggregation for the rule. Based on the
type of rule to be defined, you must select one of the following:

o To define a Non-Aggregate rule without any grouping, select None
o To define an Aggregate rule with meta values and custom aggregates select Custom

Choosing 'Custom' in the Summarize field enables you to define aggregate function of your
choice in the Select clause based on the report type you have selected.

For more detailed information about Aggregate and Non-aggregate rule, see Rule Syntax.

In the From field, based on the type of report output to be displayed, you must select one of the
following:

o Alert
o Incident

In the Selectficld, enter a meta or select a meta from the list of available meta types provided in the
Meta Library. For more information, see "Meta Panel" in Build Rule View. It cannot be used in the
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Where field. Only one aggregate function is supported at a time in a query.

For example, the supported metas for alert are:

o alert host summary

o alert.name

o alert.numEvents

« alert.severity

o alert.source

o alert.timestamp

o incidentCreated

o incidentld

o receivedTime

For example, the supported metas for incident are:

o categories

o created

e priority

o riskScore

o sealed

o status

For more detailed information, see "Aggregate and Non-aggregate rule" topic in the Rule Syntax.
8. In the Alias field, enter the alias name for columns used in the Select clause.

9. Inthe Where field, enter a meta or select a meta from the list of available meta types and use the
operators to construct the Where clause for the base query criteria.

10. The Group By field is a read-only field which gets populated with meta that are defined in the Select
clause. For a Non-Aggregate function, this field is not visible. A maximum of six meta are supported
in the Group By field.

11. Inthe Order By field, perform the following:

a. In the Column Name column, enter the name of the columns by which you want to sort the
results.

Note: by default the first meta in the select clause will be dispalyed.

b. In the Sort by column, select one of the following ways to sort the results:
o Ascending Order
o Descending Order
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12. In the Limit field, enter the limit to be put on the query while fetching data from the database. If a
result set is sorted by the limit represents the top (or bottom) N values to be returned. If the result set
is not sorted, the first N values are returned.

13. Click Save.

Deploy a Rule

In RSA NetWitness Platform you can deploy the selected rules on the service (for example, Reporting
Engine), using the Deployment Wizard.

Prerequisites
Make sure that:
o The services on which you deploy a rule is up and running.

o The Live Services is configured.

To deploy a rule, perform the following:
1. Goto CONFIGURE > LIVE CONTENT.

2. Inthe Search Criteria panel, search Live resources (for example, search for the Application Rule
resource Type).

3. Inthe Matching Resources panel, seclect Show Results > Grid.

b

Select the checkbox to the left or the rules that you want to deploy.

In the Matching Resources toolbar, click 5. Deplcy.

Click Next.

Select the service on which you to deploy a rule (For example, Reporting Engine) and click Next.
Click Deploy.

The rule is deployed successfully.

Use Meta Aliases for Reporting

When you refer to meta data in Reports and Charts, you can only view aliases for the meta names.
These aliases makes them more understandable to a broader audience.

® =N »

You cannot provide alias values for any meta in the WHERE clause because NetWitness Platform uses
the WHERE clause to fetch data from the data source (for example, in the Concentrator) and data
sources do not support aliases. In other words, you cannot provide the alias value HTTP for the HTTP
port # 80.

Note: * You cannot create aliases for meta other than the ones that have existing aliases by Reporting
Engine. Also, the format of the aliases cannot be changed.
* Aliases are not supported for Alerts and CSV reports.

To use alias in a rule, perform the following:

1. Goto MONITOR > Reports.
The Manage tab is displayed.
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2. In the Rule List panel, do one of the following:

o Select a rule and click 4 in the Rules toolbar.
. Click ¥ * - Edit

3. Specify the meta with aliases in the Select field.

The following example specifies the eth.type, ip.proto, medium, service, tcp.dstport, and tcp.srcport
meta in the Select field.

Build Rule

MetWitness Platform DE

Mame Metwork Actvity

Custom -

eth.gype, ip.proto, medium, service, top.dstport, top.sroport

Alias P
Where
Eiiis eth.type,ip.prote.medium,service, iop.dstport.top. sroport
Then Enter a then clauss..

! 3
Order By Column Kame Sort By

zzending

I

Enter the column name...

Thresheld : B
Lirmit 20 &

Save Reset Test Rule

4. Click Test Rule.
The following example displays the results under the eth.type, ip.proto, medium, service,
tcp.dstport, and tep.sreport alias columns that were specified in the Select field of the rule.
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Data Soqurce

Sroker - Broker

Format

2018

0z
14

10:37:00

IP Protacol

Hetwork Medium

Network Activity

Service Type

TCP Destination Port

2018 33 10:36:59

TCP Source Pore

Tabular w
Time Range

Past L

2 o Weeks -

| sz relative time calculation

10 P TCP

1 P TCP

13 P TCP

12 P TCP

15 = CF Ethernet OTHER z=h 61252

RSA-Supplied Alias Definitions

The alias files in this section are examples only and are based on current alias definitions in the
Reporting Engine. NetWitness Platform cannot modify these definitions in the Reporting Engine
depending on the changes in the concentrator xml file. Since any changes in the Concentrator xml file
are not reflected in the Reporting Engine.

The details of different meta are explained in each of the meta.aliases.
eth. type

ALIAS FORMAT=$alias
0=802.3
257=Experimental
512=Xerox PUP
513=Xerox PUP
1024=Nixdorf
1536=Xerox NS IDP
1537=XNS Address Translation
2048=IP
2049=X.75 Internet
2050=NBS Internet
2051=ECMA Internet
2052=CHAOSnet
2053=X.25 Level 3
2054=ARP
2055=XNS Compatibility
2076=Symbolics Private
2184=Xyplex
2304=Ungermann-Bass network debugger
2560=Xerox IEEE802.3 PUP
2561=Xerox IEEE802.3 PUP Address Translation
2989=Banyan Systems
2991=Banyon VINES Echo
4096=Berkeley Trailer negotiation

(3Mb only)
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4097=Berkeley Trailer encapsulation for IP
4660=DCA - Multicast

5632=VALID system protocol

6537=Artificial Horizons

6549=Datapoint Corporation (RCL lan protocol)

15360=3Com NBP virtual circuit datagram (like XNS SPP)

15361=3Com NBP System control datagram not registered

15362=3Com NBP Connect request (virtual cct) not registered

15363=3Com NBP Connect repsonse not registered
15364=3Com NBP Connect complete not registered

15365=3Com NBP Close request (virtual cct) not registered

15366=3Com NBP Close response not registered
15367=3Com NBP Datagram (like XNS IDP) not registered
15368=3Com NBP Datagram broadcast not registered
15369=3Com NBP Claim NetBIOS name not registered
15370=3Com NBP Delete Netbios name not registered

15371=3Com NBP Remote adaptor status request not registered

15372=3Com NBP Remote adaptor response not registered
15373=3Com NBP Reset not registered

16972=Information Modes Little Big LAN diagnostic
17185=THD - Diddle

19522=Information Modes Little Big LAN

21000=BBN Simnet Private

24576=DEC unassigned

not registered

24577=DEC Maintenance Operation Protocol (MOP) Dump/Load Assistance

24578=DEC Maintenance Operation Protocol (MOP) Remote Console

24579=DECNET Phase IV
24580=DEC Local Area Transport (LAT)

24581=DEC diagnostic protocol (at interface initialization?)

24582=DEC customer protocol

24583=DEC Local Area VAX Cluster (LAVC)
24584=DEC AMBER

24585=DEC MUMPS

24592=3Com Corporation
28672=Ungermann-Bass download
28673=Ungermann-Bass NIUs
28674=Ungermann-Bass diagnostic/loopback
28675=Ungermann-Bass ??? (NMC to/from UB Bridge)
28677=Ungermann-Bass Bridge Spanning Tree
28679=0S/9 Microware

28681=0S/9 Net?

28704=LRT (England) (now Sintrom)
28720=Racal-Interlan

28721=Prime NTS (Network Terminal Service)
28724=Cabletron

32771=Cronus VLN

32772=Cronus Direct

32773=HP Probe protocol

32774=Nestar

32776=AT&amp; T/Stanford Univ.
32784=Excelan

32787=Silicon Graphics diagnostic
32788=Silicon Graphics network games
32789=Silicon Graphics reserved
32790=Silicon Graphics XNS NameServer
32793=Apollo DOMAIN

32814=Tymshare

32815=Tigan

32821=Reverse Address Resolution Protocol (RARP)
32822=RAeonic Systems

32823=IPX (Novell Netware?)
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32824=DEC LanBridge Management
32825=DEC DSM/DDP

32826=DEC Argonaut Console

32827=DEC VAXELN

32828=DEC DNS Naming Service

32829=DEC Ethernet CSMA/CD Encryption Protocol
32830=DEC Distributed Time Service
32831=DEC LAN Traffic Monitor Protocol
32832=DEC PATHWORKS DECnet NETBIOS Emulation
32833=DEC Local Area System Transport
32834=DEC unassigned

32836=Planning Research Corp.
32838=AT&amp; T

32839=AT&amp; T

32840=DEC Availability Manager for Distributed Systems DECamds
32841=ExperData

32859=VMTP

32860=Stanford V Kernel

32861=Evans &amp; Sutherland
32864=Little Machines
32866=Counterpoint Computers
32869=University of Mass. at Amherst
32870=University of Mass. at Amherst
32871=Veeco Integrated Automation
32872=General Dynamics

32873=AT&amp; T

32874=Autophon

32876=ComDesign

32877=Compugraphic Corporation
32878=Landmark Graphics Corporation
32890=Matra

32891=Dansk Data Elektronik
32892=Merit Internodal

32893=Vitalink Communications
32896=Vitalink TransLAN III Management
32897=Counterpoint Computers
32904=Xyplex

32923=EtherTalk - AppleTalk over Ethernet
32924=Datability

32927=Spider Systems Ltd.
32931=Nixdorf Computers

32932=Siemens Gammasonics Inc.
32960=DCA Data Exchange Cluster
32966=Pacer Software

32967=RApplitek Corporation
32968=Intergraph Corporation
32973=Harris Corporation

32975=Taylor Instrument
32979=Rosemount Corporation

32981=IBM SNA Services over Ethernet
32989=Varian Associates

32990=TRFS (Integrated Solutions Transparent Remote File System)
32992=Allen-Bradley

32996=Datability

33010=Retix

33011=AppleTalk Address Resolution Protocol (AARP)
33012=Kinetics

33015=Apollo Computer

33023=Wellfleet Communications
33026=Wellfleet BOFL

33027=Wellfleet Communications
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33031=Symbolics Private
33067=Talaris

33072=Waterloo Microsystems Inc.
33073=VG Laboratory Systems
33079=IPX

33080=Novell Inc

33081=KTI

33087=M/MUMPS data sharing
33093=Vrije Universiteit (NL)
33094=Vrije Universiteit (NL)
33095=Vrije Universiteit (NL)
33100=SNMP

33103=Technically Elite Concepts
33169=PowerLAN

33149=XTP

33238=Artisoft Lantastic
33239=Artisoft Lantastic

33283=QNX Software Systems Ltd.
33680=Accton Technologies (unregistered)
34091=Talaris multicast
34178=Kalpana

34525=IPv6

34617=Control Technology Inc.
34618=Control Technology Inc.
34619=Control Technology Inc.
34620=Control Technology Inc.
34848=Hitachi Cable (Optoelectronic Systems Laboratory)
34902=Axis Communications AB
34952=HP LanProbe test?
36864=Loopback (Configuration Test Protocol)
36865=3Com XNS Systems Management
36866=3Com TCP/IP Systems Management
36867=3Com loopback detection
43690=DECNET

64245=Sonix Arpeggio

65280=BBN VITAL-LanBridge cache wakeups
34915=PPPoe

34916=PPPoe

2056=Frame Relay ARP

16962=IEEE bridge spanning protocol
25944=Bridged Ethernet/802.3 packet
65278=IS0O CLNP/ISO ES-IS DSAP/SSAP

ip.proto

ALIAS FORMAT=Salias
0=HOPOPT
1=ICMP
2=1IGMP
3=GGP
4=IP
5=8T
6=TCP
7=CBT
8=EGP
9=IGP
10=BBN-RCC-M
11=NVP-ITI
12=PUP
13=ARGUS
14=EMCON
15=XNET
16=CHAOQOS
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17=UDP
18=MUX
19=DCN-MEAS
20=HMP
21=PRM
22=XNS-IDP
23=TRUNK-1
24=TRUNK-2
25=LEAF-1
26=LEAF-2
27=RDP
28=IRTP
29=IS0-TP4
30=NETBLT
31=MFE-NSP
32=MERIT-INP
33=SEP
34=3PC
35=IDPR
36=XTP
37=DDP
38=IDPR-CMTP
39=TP++
40=IL
41=1Pv6
42=SDRP
43=IPv6-Rout
44=TPv6-Frag
45=IDRP
46=RSVP
47=GRE

4 8=MHRP

4 9=BNA
50=ESP

51=AH
52=I-NLSP
53=SWIPE
54=NARP
55=MOBILE
56=TLSP
57=SKIP
58=IPv6-ICMP
59=IPv6-NoNx
60=IPv6-Opts
61=AnyHost
62=CFTP
63=AnyNetwork
064=SAT-EXPAK
65=KRYPTOLAN
66=RVD
67=IPPC
68=AnyFile
69=SAT-MON
70=VISA
71=IPCV
72=CPNX
73=CPHB
T4=WSN
75=PVP
76=BR-SAT-MO
77=SUN-ND
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78=WB-MON
79=WB-EXPAK
80=ISO-IP
81=VMTP
82=SECURE-VM
83=VINES
84=TTP
85=NSEFNET-IG
86=DGP
87=TCF
88=EIGRP
89=0SPFIGP
90=Sprite-RP
91=LARP
92=MTP
93=AX.25
94=IPIP
95=MICP
96=SCC-SP
97=ETHERIP
98=ENCAP
99=AnyPrivate
100=GMTP
101=IFMP
102=PNNI
103=PIM
104=ARIS
105=SCPS
106=0QNX
107=A/N
108=IPComp
109=SNP
110=Compag-Pe
111=IPX-in-IP
112=VRRP
113=PGM
114=AnyHop
115=1L2TP
116=DDX
117=IATP
118=STP
119=SRP
120=UTI
121=SMP
122=8M
123=PTP
124=ISIS
125=FIRE
126=CRTP
127=CRUDP
128=SSCOPMCE
129=IPLT
130=SPS
131=PIPE Pr
132=SCTP St
133=FC Fi
134=RSVP-E2E-
255=Reserved

medium
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ALIAS FORMAT=$alias
1=Ethernet
2=Tokenring
3=FDDI
4=HDLC
5=NetWitness
6=802.11
7=802.11 Radio
8=802.11 AVS
9=802.11 PPI
10=802.11 PRISM
11=802.11 Management
12=802.11 Control
13=DLT Raw
32=Logs

service

ALIAS FORMAT=$alias
0=0OTHER
20=FTPD
21=FTP
22=SSH
23=TELNET
25=SMTP
53=DNS
67=DHCP
69=TFTP
80=HTTP
110=POP3
111=SUNRPC
119=NNTP
123=NTP
135=RPC
137=NETBIOS
139=SMB
143=IMAP
161=SNMP
179=BGP
443=SSL
502=MODBUS
520=RIP
1024=EXCHANGE
1080=SOCKS
1122=MSN IM
1344=ICAP
1352=NOTES
1433=TDS
1521=TNS
1533=SAMETIME
1719=H.323
1720=RTP
2000=SKINNY
2040=SOULSEEK
204 9=NFS
3270=TN3270
3389=RDP
3700=DB2
5050=YAHOO IM
5060=SIP
5190=A0L IM
5222=Google Talk
5900=VNC
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6346=GNUTELLA
6667=IRC
6801=Net2Phone
6881=BITTORRENT
8000=QQ
8002=YCHAT
8019=WEBMAIL
8082=FIX
20000=DNP3
1000000=KERNEL
1000001=USER
1000003=SYSTEM
1000004=AUTH
1000005=LOGGER
1000006=LPD
1000008=UUCP
1000009=SCHEDULE
1000010=SECURITY
1000013=AUDIT
1000014=ALERT
1000015=CLOCK

tcp.dstport

ALIAS_FORMAT=$Value
7=echo
9=discard
13=daytime
17=qgotd
19=chargen
20=ftp-data
21=ftp
22=ssh
23=telnet
25=smtp
37=time
42=nameserver
43=nicname
53=domain
70=gopher
79=finger
80=http
88=kerberos
101=hostname
102=iso-tsap
107=rtelnet
109=pop?2
110=pop3
111l=sunrpc
113=auth
117=uucp-path
119=nntp
135=epmap
137=netbios-ns
139=netbios-ssn
143=imap
158=pcmail-srv
170=print-srv
179=bgp
194=irc
389=1dap
443=https

(Salias)
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445=cifs
464=kpasswd
512=exec
513=1login
514=cmd
515=printer
520=efs
526=tempo
530=courier
531=conference
532=netnews
540=uucp
543=klogin
544=kshell
556=remotefs
636=1daps
749=kerberos-adm
993=imaps
995=pop3s
1109=kpop
1433=ms-sql-s
1434=ms-sgl-m
1512=wins
1524=ingreslock
1723=pptp
2053=knetd
1122=msn im
1352=notes
1521=tns
1533=sametime
1718=h323
1720=rtp
1863=msn im
2049=nfs
3389=rdp
5050=yahoo im
5060=sip
5190=aim
6346=gnuetella
b667=1irc
9001=tor
9030=tor
9535=man

tcp.srcport

ALIAS FORMAT=Svalue
7=echo
9=discard
13=daytime
17=qgotd
19=chargen
20=ftp-data
21=ftp
22=ssh
23=telnet
25=smtp
37=time
42=nameserver
43=nicname
53=domain
70=gopher
79=finger

(Salias)
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80=http
88=kerberos
101=hostname
102=iso-tsap
107=rtelnet
109=pop?2
110=pop3
111l=sunrpc
113=auth
117=uucp-path
119=nntp
135=epmap
137=netbios-ns
139=netbios-ssn
143=imap
158=pcmail-srv
170=print-srv
179=bgp
194=irc
389=1dap
443=https
445=cifs
464=kpasswd
512=exec
513=1login
514=cmd
515=printer
520=efs
526=tempo
530=courier
531=conference
532=netnews
540=uucp
543=klogin
544=kshell
556=remotefs
636=1daps
749=kerberos—-adm
993=imaps
995=pop3s
1109=kpop
1433=ms-sqgl-s
1434=ms-sgl-m
1512=wins
1524=ingreslock
1723=pptp
2053=knetd
1122=msn im
1352=notes
1521=tns
1533=sametime
1718=h323
1720=rtp
1863=msn im
2049=nfs
3389=rdp
5050=yahoo im
5060=sip
5190=aim
6346=gnuetella
6667=1irc
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9001=tor
9030=tor
9535=man

udp.dstport

ALIAS FORMAT=Svalue (Salias)
7=echo
9=discard
13=daytime
17=qgotd
19=chargen
37=time
39=rlp
42=nameserver
53=domain
67=bootps
68=bootpc
69=tftp
88=kerberos
11l=sunrpc
123=ntp
135=epmap
137=netbios-ns
138=netbios-dgm
161=snmp
162=snmptrap
213=1ipx
443=https
445=cifs
464=kpasswd
500=1isakmp
512=biff
513=who
514=syslog
517=talk
518=ntalk
525=timed
533=netwall
550=new-rwho
560=rmonitor
561l=monitor
749=kerberos—-adm
1167=phone
1433=ms-sql-s
1434=ms-sgl-m
1512=wins
1701=12tp
1812=radiusauth
1813=radacct
2049=nfsd
2504=nlbs

Test a Rule

You can test a rule based on the time range and the data source selected.

Configure a Rule

46



Reporting User Guide

To test a rule, perform the following:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Inthe Rule List panel, do one of the following:

e Select a rule and click 4 in the Rules toolbar.

. Click ¥ - Eqit
The Build Rule view tab is displayed.

3. Click Test Rule.
The Test Rule view is displayed.

Data Source

w

Format

Time Range
Past hd

2 & |Hours ~

[[] Use relative time calculation

X Axis

w

Y Axis

Note: When you click Test Rule, the rule is not saved. You have to click Savein the Build Rule
view to save the rule.

4. From the Data Source drop-down list, select a data source.
Y ou must select the appropriate data source for the rule defined.

5. From the Format drop-down list, select the format in which you want the result displayed.
6. From the Time Range drop-down list, select one of the following.
o Past -To specify number of years, days, weeks, months, days or hours.

o Range - To specify a date range and time period.

Note: In the User Interface (UI), the date or time displayed depends on the time zone profile
selected by the user.
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7. X-Axis and Y-Axis are used to specify the meta to be plotted in charts.
In X-Axis, the Meta for the 'Group by' rule is displayed. In Y-Axis, the aggregate functions used in
the rule are displayed.

Note: Sum, Count, Countdistinct and Average are the supported aggregate functions for rule. By
default, for Custom Rules with multiple 'Group by', you can select only the first meta in X-Axis.

8. Click Run Test to execute the rule.
The rule data (if any) for the selected time range is displayed.

Create a Lists or List Group

To create a list, perform the following:

Lists can be added within a group or in the root folder.

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Lists.
The List view is displayed.

View  [LIST] BlacKlisted IPs
Rules  Reports  Charts  Alerts Warehouse Analytics Search Report Details [
Groups Lists
+ Tlawe + | &
Groups ~ 0 Name ~ Group DateModified | Actions
e (-] [ Blackiisted IPs. 2017-05-03 08:39 L]
» B Compliance © O Complance Dats 201705030833 3
> [Ferng Candidetes @ [ Compiance yseems 2017.0503 0834 )
[ ervorcacevey O | O ContentDetvery Netvorks 2017.0503 0828 B
[ Listof Alas Hoss 201705030831 3
[ Listof IP Addresses 20170503 0832 3
[ Listof Message ID 2017.0503 0833 )

3. In the List toolbar, click +.
The Build List view tab is displayed.
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Manage View [LIST] Content Delivery Ne... @ _

Build List

Mame Content Delivery Networks
Description List of CDNs
List Values Insert Values

Value

www,google.com
frp.microsoft.com
ftp.symantec.com
unisys.skillport.com

Enter value...

[ Quotes will be inserted for all the values

4. In the Name field, enter a unique name for the list.

5. Inthe Description field, enter a description for the list.
6. Inthe List Values field, do one of the following:

o Click Insert and enter the values separated by commas. You can paste a list of values from a file
or other lists.

o In the Value column, enter the values.

7. 1If you want quotes to be inserted directly for the values at runtime, select Quotes will be inserted
for all the values.

8. Click Save.
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To create a list group, perform the following:
1. Goto MONITOR > Reports.

The Manage tab is displayed.
2. Click Lists.

The List view is displayed.

Manage View [LIST] Blacklisted IPs
Rules Reports Charts Alerts Lists Warehouse Analytics search Report Details &5
Groups Lists
+ Tl & + | L=
— T mame ~ e Date Modified ‘Actiont
&y o [ Blackiistad IPs 2017-05-03 0839 I
» (I compliance (o] [J Compliance Data 2017-05-03 08:32 &
> EaFivering Candidates (] [ Compliance Systems 2017-05-03 08:34 &
DNEMWkA“iViW a [ Content Delivery Networks 2017-05-03 08:28 & ©
[ List of Alias Hosts 2017-05-03 08:31 & ©
[ List of IP Addresses 2017-05-03 08:32 & ©
[ List of Message ID 2017-05-03 08:33 & ©
3. Do the following:
o To create a list group:
1. In the List Groups panel, click +
A new list group is added to the List Groups panel.
Groups
+ (o BN - R
Groups ~
Al o
(I situational Awareness  E)
[ Threat ﬂ
[ User Activity 6 )
2. Enter the name for the list group and press ENTER.
o To create a list subgroup:
1. In the List Groups panel, select the list group to which you want to add a subgroup.
2. Click ¥,
A new list subgroup is added to the list group.
3. Enter the name for the list subgroup and press ENTER.
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Create and Schedule a Report

You can create a simple or complex report and configure its execution properties by scheduling a report.
A report can include multiple rules and you can schedule different time range to execute the same report.
For example, depending on your requirement, you can schedule a report to run daily, weekly or monthly.

When you run a report, the results are stored in Reporting Engine.
After you generate a report, you can perform the following:

o Send the reports by email to other users by configuring the output actions. You can also configure the
output actions before generating a report.

o Download the reports as PDF or Comma-Separated Values (CSV) format files.

Note: The cancel operation is not supported for Respond Reports.

Create a Report or Report Group

To create a report to a group or sub-group, perform the following:
1. Goto MONITOR > Reports.

The Manage tab is displayed.
2. Click Reports.

The Report view is displayed.

3. Inthe Reports toolbar, click + .
The Build Report tab is displayed.
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)

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN l:@‘admin z {i}

Overview Reports

Manage [REPT] New Report @

Enter Re NETWITNESS Text Rules

cnter keport Na

nter Report Name RSA PLATEORM
Header 1

QU mMUuSsT a0d 1ext and rules 1o the report.

Header 2
Header 3
Header 4
Table of Contents
Body Text
Comment

4. Enter the name of the report.

5. Drag and drop the text and rules to the report.

Note: The text entered is optional and you may need this option only when you want to display
user-defined headers or content.

6. Click Save.

A confirmation message that the report is saved successfully is displayed.

To create a group to the default folder or add sub-groups under a report group, perform the
following:

1. Goto MONITOR > Reports.
The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.

3. In the Report Groups panel, click + .

A default group is added in the Report Groups panel.
4. Enter the name of the new group.
5. Press Enter.

The group is added to the Report Groups panel.
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Schedule a Report

Note: When you schedule a Warehouse report, you can use a supported task scheduler to allocate
specific resources in a cluster for the scheduled job. For more information on "supported task
schedulers", see Task Scheduler for Warehouse Reporting.

To schedule a report, perform the following:
1. Goto MONITOR > Reports.

The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.

3. In the Build Rule page, click + (0 create a rule.

4. Click Save.
5. Click Use.
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Build Rule
Rule Type

Mame

Summarize

Group By

Seszion

Metwitness Platform DB

Source and Destination details
Ewvent Count -
ipdst

|IF Address

ip.dst =1

ipdst

Enter a then clausz=...

L |

Column Name Sort By
Total Aszcending
- ~

0 v

20 o

Save Reset Test Rule

6. Select the New report or Existing Report.
7. Select a report group and click Select.

8. Enter the Report name and select the rule.
9. Click Schedule.

The Schedule Report view is displayed.

If you provide another user with access permissions to a report, you must also provide permissions
for the report group, the rules used in the report, and the rule groups otherwise an error message is

displayed.

10. To execute the reports as per the schedule, select the Enable checkbox.

11. Inthe Schedule Name field, enter a name for the schedule report configuration.

Create and Schedule a Report
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12.

13.

14.

15.

16.

From the Data Source field, select the data source.

Note: If the data source is not listed, then ensure you have Readpermissions set for the data
source. This is applicable for NWDB, Respond and Warehouse data source. For more information,
see "Configure Data Source Permissions" topic in Reporting Engine Configuration Guide.

(Optional) From the Warehouse Resource Pool drop-down, select the pools or queues available in
the cluster to schedule the report to run on either the pool or queue. This drop-down list is available
only if you select a Warehouse DB report.

Note: All the queues or pools you specified in the Explore page for the Reporting Engine are
listed. If no pools or queues are configured in the Explorer page, this drop-down is disabled and the
jobs are submitted to the clusters without any a queue or pool name.

Note: If the pool or queue configured in the report schedule is removed from the Cluster, then in
the Capacity Scheduler, the queue name remains undefined. However, in the Fair Scheduler, the
specified pool name will be created using the

property mapred.fairscheduler.allow.undeclared.pool.

From the Time Zone drop-down, select a time zone to display all the time-related data in a report
output in the specified format. This setting is configurable from the Reporting Engine Explore view
(/com.rsa.soc.re/configuration/reportoutputformatterconfig/reportoutputformatterconfig).

From the Run field, select the type of run schedule. (For example, Now or Hourly).

Depending on the type of run schedule, choose one of the following:

o If you select a Later or Monthly run schedule, you must provide a value for the day and time in
the respective field provided.

o Ifyou select an Hourly run schedule, you must specify the minutes in the At Minute field.
o If you select a Daily run schedule, you must enter a value in the At field.

o If youselect a Weekly run schedule, you must enter a value in the At field and also select the
week days.

Note: While scheduling a report, if you select Past option or Range (specific/generic) option or
an end time range very close to the current time, you must ensure that the aggregate data in the
data source is returned. If there is an aggregation delay in the data source, the end time you choose
must account for the delay, otherwise reports lose non-aggregate data for that time range.

For information on how to generate a report with variables, see Create a Parameterized Report Using

Variable.

(Optional) In the Output Actions panel, do the following:
a. Enter the email address and subject.

b. Edit the body of the message for the report.

c. Select the format of the attachment.

d. Enter a value for the CSV and Multi-value delimiters.

e. (Optional) In the Other Options field, do the following:
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17.
18.

19.

i. Click ¥ and select SFTP, URL, or Network Share output action.
A row gets added with the selected output action.

ii. Select the appropriate options to send the report in PDF or CSV format, or both to the RE
configured SFTP, or URL, or Network Share output action.

(Optional) To add a list in the Dynamic List panel, see Generate a List from the Scheduled Report.

(Optional) To choose a logo in the Logo panel, see "Manage and Select a Report Logo" section in
Manage Lists, Rules or Reports.

Note: If you do not specify a logo, the default RSA logo will be used.

Click Schedule.

The scheduled report executes as scheduled and provides the configured outputs.
Report-RuleToTestSpecialChars-1 NETWITNESS
Generated on - 2017-08-09 08:03 (+00:00) R SA PLATFORM

2016 95 08:03:00 (+00:00) Time Range 2017 95 08:02:59 (+00:00)

RuleToTestSpecialChars-1/ nw-conc? - Concentrator

User Account

[ - T N T S Tt R

After you create and Schedule a report, you can perform any of the following tasks:

You can notify the email recipient when the report execution completes and send reports in PDF and
CSV formats as attachments in the email.

You can generate a list based on the scheduled report and view them in the Lists module.

You can send a scheduled report in PDF or CSV format, or both to the RE configured SFTP location,
or URL, or Network Share.

You can change the default logo and view them in the scheduled report.

You can modify the NetWitness Platform Reporting Engine config details, by navigating to the
Reporting Engine General Tab. See the "Reporting Engine General Tab" topic in the Reporting
Engine Guide.

Examples

When you schedule reports in the Schedule Report view, by default, the results for the Past option are
presented based on the user specified time zone. The following examples provide a clear picture on what
results to expect when you select Hours, Days, Weeks, Months, or Years for the Past option based on
the absolute or relative duration.
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Note: By default, the relative duration checkbox is de-selected. This implies that the results for the
Past option are presented based on the absolute duration.

o Based on Absolute duration - Absolute Duration allows a report to be scheduled at an absolute time

with respect to the current time, excluding the seconds and considering the time interval as a whole.
For example, 12.00pm is the absolute time with respect to the current time (12.45 pm).

o Hours - Suppose that you select Hours and specify one hour. If the current user specified time is
4.20PM, the report is generated for the time range, 3.00PM to 4.00PM.

o Days - Suppose that you select Days and specify one day. If the current date is August 27, 2014
and the current user specified time is 10.15AM, the report is generated for the range: August 26,
2014, 12.00AM to August 27, 2014, 12.00AM.

o Weeks - Suppose that you select Weeks and specify one week. If the current date is August 27,

2014 2.30PM and the day is Wednesday, the report is generated for the range: Saturday, August 16,

2014, 12.00AM to Saturday, August 23, 2014, 12.00AM.

o Months - Suppose that you select Months and specify one month. If the current date is August 27,
2014 2.30PM, the report is generated for the range:
July 01, 2014, 12.00AM to July 31, 2014, 12.00AM.

o Years - Suppose that you select Years and specify one year.If the current date is August 27, 2014
2.30PM, the report is generated for the range:
January 01, 2013, 12.00AM to December 31, 2013, 12.00AM.

o Based on Relative duration - Relative Duration allows a report to be scheduled at a time relative to

the current time which might vary based on the current time. For example, 12.45 pm is the relative
time with respect to the current time (12.45 pm).

o Hours - Suppose that you select Hours and specify one hour. If the current user specified time is
4.20PM, the report is generated for the time range, 3.20PM to 4.20PM.

o Days - Suppose that you select Days and specify one day. If the current date is August 27, 2014
and the current user specified time is 10.15AM, the report is generated for the range: August 26,
2014, 10.15AM to August 27, 2014, 10.15AM.

o Weeks - Suppose that you select Weeks and specify one week. If the current date is August 27,
2014 12.30PM and the day is Wednesday, the report is generated for the range: Thursday, August
21,2014 12.30PM to Wednesday, August 27, 2014 12.30PM.

o Months - Suppose that you select Months and specify one month. If the current date is August 27,
2014, 2.30PM the report is generated for the range:
July 27, 2014 2.30PM to August 27, 2014 2.30PM.

o Years - Suppose that you select Years and specify one year.If the current date is August 27, 2014

2.30PM, the report is generated for the range: August 27, 2013 2.30PM to August 27, 2014 2.30PM.

Generate a List from the Scheduled Report

You can generate a list from the output of the scheduled report. Make sure that your lists are created in
NetWitness Platform prior to generating a list to schedule a report.
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To generate a list from the Build Report view, perform the following:

L.

10.

11.
12.

Go to MONITOR > Reports.
The Manage tab is displayed.
Click Reports.

The Report view is displayed.

. In the Report List panel, select a report and click % " > Schedule Report.

The Schedule a Report view tab is displayed.

In the Dynamic List panel, click +.

The Generate List dialog box opens.

Click Browse.

The List Selection panel is displayed.

Choose a list item and click Select.

The list name gets populated in the List Name field.

Select a valid rule to filter the report results further based on the rule definition.
Select a value for the Column field.

The column forms the values for the list that gets created.

If you want to overwrite the existing list, select the Overwrite Existing List? checkbox.
Click Save.

The list name gets populated in the Generate List panel.

Generate List

List Name: $[/Per User Repaort/List of Service:| | Browse
Rule Access o Co v
Column filemame b

[ Overwrite Existing List ?

Cancel Save

(Optional) Select a list from the Generate List panel and click = to delete the selected list.

(Optional) Select a list from the Generate List panel and click 4 1o edit the list details.
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Create a Parameterized Report Using Variable

You use variables for reporting in the RSA NetWitness Platform Reporting module. Parameterized
reporting allows you to specify values dynamically at runtime without changing the rule definition so you
can view the results based on a particular value. You can achieve parameterize reporting by using
variables in the query or rule. For information on adding a rule, see Configure a Rule. At runtime, you
can enter the value for the variable or select the value from the list based on which the result set is
displayed.

The syntax to specify the variable is as follows:

- Examples of Supported
Description

Syntax

Insert $ before a variable. columnname=${<variable>}
Enclose a variable within
braces.

The syntax to define the variable is the same for NetWitness DB and Warehouse DB data sources.
When you assign the value of the variable in a Run Configuration, you must enclose the value within
single quotes: '<value>"'.

Some examples where a variable can be used are provided in this section.
View Source IP Addresses for a Specific Destination Country

The following is an example of a NetWitness DB rule to view the source and destination ip addresses
for a specific destination country. Here the value for source country is defined as a variable $ {1ocal
country}.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN @jadmin “ @

Overview  Reports

Manage [RULE] IP addresses for a s... @

Build Rule

Rule Type

Name

Summarize

Netwitness Platform DB

P addresses for a specific destination country

Custom d

ip.src, ip.dst, country.dst

Source IP address

country.src = ${Local_Country}

Meta

PH - Concentrator hd
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At runtime, you are prompted to enter the value for the variable. The figure below shows the 1ocal
Country variable where you can enter the value. If you enter the value as United states, all the source
and destination ip addresses with destination country as United states are listed.
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Data Source 2012 35 00:00 IP Addresses For A Specific Destination ... 2013 3 08:00
Conc-240 hd
Format 5L No Source IP Address Destination IP address Destination Country |~
Tabular v 1 United States
Time Range 2 United States
Range v 3 United States 2
From 4 United States
2012-06-0 ] At 00:00 v 5 United States
To ) 6 United States m
2013102 At 08:00 v 5 United States
Variable Value a United States
Country United st... =] United States
7 Select List 10 United States
11 United States
12 United States
13 United States
14 United States
15 United States
186 United States
17 United States il

You can use the above rule to schedule a report. You can schedule two types of reports:

Report with Dynamic Variables

Iterative Report

Report with Dynamic Variables

Dynamic variables allows the user to specify the values for a variable defined in a rule while scheduling

a

report.

To schedule a report with Dynamic Variable, perform the following:

1. Goto MONITOR > Reports.
The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.
3. On the Build Report page, click + to create a report.
4. Add the rule by drag and drop which has the user defined variable from the Rules tab.
5. Click Schedule.
The Schedule Report view tab is displayed.
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Schedule Report

Enable ™
Report Mame Report-IP address for a specific destination country
Schedule Name | Dynamic Variables Report

MetWitness DB | Concentrator-194 - C |+

Time Zone UTC {(GMT+00:00) v | [l Set Default
Run Now ~
On Past ¥ 30 & Days v | [ Use relative time calculation
Variables lterative Report [
Variable ~ Value Iterative

B Rule: IP address for a specific destination country

local_Country S[Country_List] Mo [

] Output Actions

#) Logo

Reset £ Configure

6. To execute the reports as per the schedule, select the Enable checkbox.

7. Inthe Schedule Name field, enter a name for the schedule report configuration.

From the Data Source ficld, select the data source.

Note: If the data source is not listed, then ensure you have Read permissions set for the data
source. This is applicable for NWDB and Warehouse data source. For more information, see
"Configure Data Source Permissions" topic in the Reporting Engine Configuration Guide.

9. (Optional) From the Warehouse Resource Pool drop-down, select the pools or queues available in
the cluster to schedule the report to run on either the pool or queue. This drop-down list is available
only if you select a Warehouse DB report.

Note: All the queues or pools you specified in the Explore page for the Reporting Engine are
listed. If no pools or queues are configured in the Explorer page, this drop-down is disabled and the
jobs are submitted to the clusters without any a queue or pool name.
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10.

I1.

12.
13.

Note: If the pool or queue configured in the report schedule is removed from the Cluster, then in
the Capacity Scheduler, the queue name remains undefined. However, in the Fair Scheduler, the
specified pool name will be created using the property
mapred.fairscheduler.allow.undeclared.pool.

From the Time Zone drop-down, select a time zone to display all the time-related data in a report
output in the specified format.This setting is configurable from the Reporting Engine Explore view
(/com.rsa.soc.re/configuration/reportoutputformatterconfig/reportoutputformatterconfig).

From the Run field, select the type of run schedule. (For example, Now or Hourly). Depending on
the type of run schedule, do either of the following:

o Ifyouselect a Later or Monthly run schedule, you must provide a value for the day and time in
the respective field provided.

o If you select an Hourly run schedule, you must specify the minutes in the At Minute field.
o Ifyou select a Daily run schedule, you must enter a time value in the At field.

o If youselect a Weekly run schedule, you must enter a value in the At field and also select the
week days.

Note: While scheduling a report, if you select Paste option or Range (specific/generic) option or
an end time range very close to the current time, you must ensure that the aggregate data in the
data source is returned. If there is an aggregation delay in the data source, the end time you choose
must account for the delay, otherwise reports lose non-aggregate data for that time range.

In the variables field, click 4.

Do one of the following:

o Enter the value for the variable, or

o Choose the list value for the variable.

List Selection Window

¥ Refresh

List Name ~
25

CJCampliance
= Country_List

CFileering Candidate
= Local_Country

CLlogs

CONetwork Activity
= TCP_Source_Port

[ User Activity

Close Select
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14. Click Select.
15. Click Schedule.

The scheduled report executes as scheduled and provides the configured outputs.

Manage (VR (o SIS EUN S Wl [REFT] Report-IP address f... ®
LI =]

Report-IP address for a specific

destination country
Generated on - 2016-02-19 14:06 (+00:00)

2016 | 55 14:06:00 (+00:00)

IP address for a specific destination country / Concentrator-194 - Concentrator

1P Source

View All Destination IP Addresses for a Source IP Address

IP Destination

NETWITNESS 1 Eerblr?ﬂaryyw,ﬂ"ﬁ
< February 2016 - >
14:05:59 (+00:00) somoT oW TP s
1 2 3 4 5 6
= 7 3 9 10 1 12 13
14 15 16 17 Tﬁn
Reports
Tme
13:46
13:56
1356
3:56
400
14:00
1404
14:06

The following is an example of a Warehouse rule to view all the destination IP addresses for a specific
source IP. The source IP address ip src is defined as a variable ${IP Address}.
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Build Rule

Rule Type ‘Warehouse DB

Expert Mode

Mame Destination |P for a specific Source P
Select ip.src, ip.dst, ccuntr;—'.::lztl

Frem TeIzions -~

Aliaz ip.src, ip_dst, country_dst

Where ip.5rc is net NULL and ig,

Group By
Having

Order By Codumn Mame

Enter the column name

Limit 20 o

I: Save Reset Test Rule

At runtime, you are prompted to enter the source IP address. The figure below shows the TP Address
variable, and you can enter a valid source IP address. All the destination IP addresses with the specified

source IP are listed.

Data Source 10 .
2013 ;5 00:00
Warehouse - WC20433  +
Format 5L No ip_sre
Tabular v 1
Time Range 2
Range hd 3
From 4
2013-10-08 At 00:00 v | ¢
To [
2013-10-2 | At  08:00 v ;
Variable Value =3
IP_Address "W 9
£ select List 10
11
.
13
14
15
16
17

2013 1 08:00

Destination IP For Specific Source [P

-

ip_dst country_dst

m

Associate a Variable to a List of Values
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You can associate the variable to a list. For example, you can create a list called Local Country
and enter all the country names as values. You can select the list Local Country as the value for the
variable Local Country. At Run Configuration, the Local Country listis populated and you can
select the country based on which results are displayed.

B[] Logs

0] Network Activity
B[] Per User Report
oy

Iterative Report
An iterative report generates a report for every value in the list.

To schedule an iterative report, perform the following:
1. Go to MONITOR > Reports.

The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.

3. On the Build Report page, click + to create a report.

4. Add the rule which has the user defined variable from the Rules tab.

5. Click Schedule.
The Schedule Report view tab is displayed.
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Schedule Report

Enable ™
Report Mame Report-IP address for a specific destination country
Schedule Name | Dynamic Variables Report

MetWitness DB | Concentrator-194 - C |+

Time Zone UTC {GMT+00:00) v | [l Set Default
Run Now ~
On Past ¥ 30 & Days v | [ Use relative time calculation
Variables Iterative Report [
Variable ~ Value Iterative

B Rule: IP address for a specific destination country

local_Country S[Country_List] Mo [

] Output Actions

#) Logo

Reset 4* Configure

To execute the reports as per the schedule, select the Enable checkbox.

In the Schedule Name field, enter a name for the schedule report configuration.

From the Data Source ficld, select the data source.

Note: If the data source is not listed, then ensure you have Read permissions set for the data
source. This is applicable for NWDB and Warehouse data source. For more information, see
"Configure Data Source Permissions" topic in the Reporting Engine Configuration Guide.

(Optional) From the Warehouse Resource Pool drop-down, select the pools or queues available in
the cluster to schedule the report to run on either the pool or queue. This drop-down list is available
only if you select a Warehouse DB report.

Note: All the queues or pools you specified in the Explore page for the Reporting Engine are
listed. If no pools or queues are configured in the Explorer page, this drop-down is disabled and the

jobs are submitted to the clusters without any a queue or pool name.
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Note: If the pool or queue configured in the report schedule is removed from the Cluster, then in
the Capacity Scheduler, the queue name remains undefined. However, in the Fair Scheduler, the
specified pool name will be created using the property
mapred.fairscheduler.allow.undeclared.pool.

10. From the Time Zone drop-down, select a time zone to display all the time-related data in a report

1.

output in the specified format. This setting is configurable from the Reporting Engine Explore view
(/com.rsa.soc.re/configuration/reportoutputformatterconfig/reportoutputformatterconfig).

From the Run field, select the type of run schedule. (For example, Now or Hourly). Depending on
the type of run schedule, do either of the following:

o If youselect a Later or Monthly run schedule, you must provide a value for the day and time in
the respective field provided.

o If you select an Hourly run schedule, you must specify the minutes in the At Minute field.
o Ifyou select a Daily run schedule, you must enter a time value in the At field.

o If youselect a Weekly run schedule, you must enter a value in the At field and also select the
week days.

Note: While scheduling a report, if you select Paste option or Range (specific/generic) option or
an end time range very close to the current time, you must ensure that the aggregate data in the
data source is returned. If there is an aggregation delay in the data source, the end time you choose
must account for the delay, otherwise reports lose non-aggregate data for that time range.

12. In the variables field, do the following:

a. To run iterative reports, select the Iterative Report checkbox.

b. To Iterate on List value, click *.
The List Selection Window opens.
c. Choose a list and click Select.

The list item selected gets added to the Iterate on List field.
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d. Select the variable on which the selected list value has to be applied.

Variables Iterative Report M
lterate On List  |$[/Local_Country] R
Apply To var w
Variable ~ Value Iterative

B Rule: My_Rule

r
var $[/Local_Country] Yes

13. Click Schedule.
The scheduled report executes as scheduled and provides the configured outputs.

The following figure shows the Iterative Report view.

Sub Reports

This report has been generated for each value in the configured list. Selectthe report
that you Want 1o view.

X
values State View Report
balivia' Completed @ View
nicaragus’ Completed @ View
honduras' Completed @ View
gibraltar' Completed @ WView
martinique’ Comp ered Wiew
cote dV'hgire' Completed L] WView
congo, the democratic republic of the Completed @ Wiew
faroe islands' Completed @ View
el salvador' Completed @ View
grenada’ Completed @ Wiew
maldives' Completed @ View
maoldova, republic of Completed @ View
tunisia’ Completed @ View
jordan Completed @ WView
french guiana’ Comp ered Wiew
kemiA Camnlered @ Wi v

| Page 1 | ofl | | C Displaying 1 - 25 of 25
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Manage View [RULE] IP address for a spe... [REPT] Report P address fo.. [REPT] ReportIP address f.. ®
B850

Report-IP address for a specific

1 Friday
destinati NETWITNESS February 19, 2016
estination COUntT’y PLATFORM

Generated on - 2016-02-19 14:24 (~00:00)

< February 2016~ >

2016 | 3 | 14:24:00 (+00:00) Time Range 2016 % | 14:23:59 (+00:00) somoT ow T F s
1 2 3 4 5 6

IP address for a specific destination country / Concentrator-194 - Concentrator 7 8 9 10 11 12 13

1P Source IP Destination

14 15 16 17 18 JRE]
B

2

| Page [1 |of1 | | | PageSize |30 ~ Displaying 1- 2 0f 2

Reports
me

1423

Create a Report Using a Rule

You can create a report using a rule. When you create a report using a rule, a default report is created
with this single rule. You can further edit the report to add more rules.

To create a report using a rule, perform the following:
1. Goto MONITOR > Reports.
The Manage tab is displayed.
2. Choose any of the following:
o Create a report using a rule when you create or edit the rule:
a. In the Build Rule view, click Use.
The Use Rule dialog is displayed.
b. Click Report.

c. Select New Report or Existing Report based on your requirement.
d. Click Select.

o Select a rule in the Rule List panel and click & in the Rule toolbar. From the drop-down
menu, select Use > Report.

« In the Rule List panel click B > Create Report.

Note: Custom rules can be used to create a Report and If you select the view for the rule as "Area" or

"Pie", a window pops up for X-Axis and Y-Axis inputs. By default, you can select only the first meta
in X-Axis.

Create and Schedule a Report 70



Reporting User Guide

View a Report

You can view a report or list of all reports. You can also view the scheduled reports to know the state of
the scheduled report. If the scheduled report is in a stop or disable state, you can start or enable the
scheduled report.

After you view a report, you can perform any of the following tasks:
1. You can print, save, email and view reports on full screen.

2. Youcan also select a date from the calendar to view a list of successfully run reports for the chosen
date.

To view a report, perform the following:
1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. Inthe Report List panel, click ¥ " > View Scheduled Reports.

4. Click the #Schedules column.
The Schedule Reports view tab is displayed with the status of each of the scheduled report.

MONITOR

REPORTS

Manage View [REPT] Malware Activity Re... @
Report Schedule
+ | | ¢ #© |  AuvtoRefresh Filter Schedule By Name
O Name ~ Schedule Last Run Duration(H:M:5) AvglHNLS) State View Report Actions
O Malware Activity Hourly 2017-08-0909:15  00:00:03 00:00:02 Completed & Jie Lo 30
| Page |1 |of1 | | G Pagesize 30 v Displaying 1-10f 1
RS /\ NETWITNESS® PLATFORM 11.2.0.0

5. Select a scheduled report and click View.
One of the following is displayed:

o The selected report.

o The Sub reports panel for a scheduled report having 'Iterative' selected.

For each value in the configured list a report is displayed.
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Note: If the report status is partial or complete, the "last run timestamp" and the "last run
(seconds)" are updated. However, the average time taken to run the report is updated only when
the report status is complete and not when it is partial.

To view a list of all reports, perform the following:
1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. Inthe Report panel, click View All Reports.
A list of reports along with their schedule name and time are displayed on the View tab.

Note: If no list is displayed, select a date from the calendar to view a list of reports for
that date.

RSA RESPOND MONITOR

REPORTS

Manage

Chart  Alert  Warehouse Analytics
Reports Wednesday
August 23,2017

Filter By Report Or Schedule Name

Repc Time < August 2017 - >
s m T w T F s

2017-08-23 02:00 ! 2 3 4 °

€ 7 8 9 10 1 12
1314 15 16 17 18 19
20 21 2 E

RS /\ NETWITNESS  PLATFORM 11.200

4. You can select a scheduled report and print, save as PDF/CSV, send email notifications, or view it
on full screen.
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RSA RESPOND MONITOR
REPORTS
[YELEESS View [REPT] Aggregation &
[ IEN =]
Aggregation

Generated on - 2017-08-21 09:56 (+00:00)

2017 3 07:00:00 (+00:00) Time Range

Average Function / nw-malware - Broker

Source IP Address Destination IP Address

R'S/\ NETWITNESS PLATFORM

NETWITNESS
PLATFORM

2017 95 08:59:59 (+00:00)

avalsize)
14641758

9059450

8684244

@ admin® (D

Monday
August 21, 2017

August 2017

s M T w T F s

1 2 3 4 5
6 7 8 9 10 1 12
13 14 15 16 17 18 19

» 1~ B

Reports
Time

09:56
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Investigate a Report

You can investigate a report by directly navigating to the Investigation View from the report. With the
Investigate a report option, you can investigate each event mentioned in the report.
To investigate a report, perform the following:
I. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. Inthe Report toolbar, click View All Reports.
The View All Reports tab is displayed.

Note: If no reports are displayed in the View All Reports, select a date for which you want to
display the reports.

4. Double-click the report name to view the report details.
The Report details screen is displayed.

MONITOR

REPORTS

Manage [REPT] test chart @
#Ho=2C
t(?esnter(a:tlzdacrnt-2017-06-0710:131+00:00) R SA Ef;‘{vpggﬁss 0 Yx:_’dg;fday
2017 % 07:20:00 (+00:00) Time Range 2017 % 07:30:00 (+00:00) . Iy © .
s M T W T F s
12 3
Session Analysis / Concentrator 4 s e e o 10
Session Analysis Total events count
1 watchlist dst 3 " n
2 first carve a4
3 first carve not dns 4
4 5
5 7 Reports
[ n-50k 11 Time v

sessinn size 1€

You can click on the session analysis to investigate on the report.

Note: If you want to manually copy the result data and use it for investigation, make sure that the
binary values are prefixed with 'hex:'.
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Manage Lists, Rules or Reports

You can set access control, delete, edit, import, or export a list, rule or report.

Manage a List

You can perform the following procedures to manage a list.
o Access Control for a List and List Group

o Edit a List

o Delete a List or List Group

o Duplicate a List

o Export a List or List Group

o Import a List or List Group

Access Control for a List and List Group

You can set up the access permissions for the user roles to manage lists or list groups. The Reporting
provides access control at the list and list group level. Only a user who has the right set of permissions
can perform the tasks in the Reporting. The access control is managed by the administrator

from the ADMIN > Security > Roles tab.

As an administrator you must ensure that the roles created for specific tasks have access to all the
permissions higher in the hierarchy of roles.

Lists or list groups can be assigned to a specific set of user roles. When users log into NetWitness
Platform, they can access only those lists to which they belong. Users who belong to a user role with the
Read & Write access permission have full access rights on the lists. Further, the access can be
strengthened so that lists are accessed only by those who have the Read Only access.

Note: You must have Read Only permission for a list group to view the lists within that group.

For example, if you want Security Analysts to have access to all the lists in a list group, you can set the
permission Read & Write at the list group level. And, if you do not want the Operator role to have
access to a specific set of lists in a list group, you can set the permission No Access at the list group
level.

At the list or list group level, you can set the following access permissions for the user roles in
NetWitness Platform. For more information, see List View:

o Read & Write
e Read Only

e No Access
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Lists Permissions

Blacklisted IPs

Roles ~ Read & Write Read Only Mo Access
Administrators O O O
Analysts

Data_Privacy_Officers
Malware_Analysts
Operators
Response_Administ...

S0C_Managers

000 0|0|0|0
000 0|0|0|0
© ® ® ® ® ® ®

Security_Administra...

Cancel Save

The following table lists the columns in the Lists Permissions panel:

Roles Describes roles of the users logged into the NetWitness Platform user interface.

Read & Allows users to access, view, edit, delete, import, and export lists on the Lists view.

Write Users can also change the permission on the rule.

Read Allows users to only access and view the list on the lists view.
Only

No Doesn't allow users to access or view the lists.

Access

Access Control for a List

To change the list permissions, you must select a list and set access permissions using the List
Permissions panel.

If you want to change the access permission for a specific user role, you must set it at the list level.
Except for administrators, the default permission set for all the other user roles is No Access before
applying job permissions.

Access Control Multiple Lists

You can select multiple lists at once and set access permissions using the Lists Permissions Panel. The
access permission that you choose is applied to all the selected lists.
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Note: The "*" beside the role name indicates that other permissions are available for the user role. If
you want to change the access permission for the required user role, select the user role and change
the access permission.

Lists Permissions

Multiple objects selected

Roles ~ Read & Write Read Only No Access
Administrators ® O O
Analysts O O O]
Data_Privacy Officers O O ®
Malware_Analysts O O ®
Operators O O ®
50C_Managers O O ®

Cancel Save

Note: If a user (other than ADMIN) creates a list, ADMIN cannot access that list.

Access Control for a List Group

To change the list group permissions, you must select a list group and set access permissions using the
Lists Permissions panel.

If you want to change the access permission for a specific user role, you must set it at the list group
level. Except for administrators, the default permission set for all the other user roles is No Access
before applying job permissions.

You can also apply permissions to subgroups and lists in the group by selecting the checkbox.
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Lists Permissions

Network Activity

Roles -~ Read & Write Read Only Mo Access
Administrators O] O O
Analysts

Data_Privacy_Officers
Mahware_Analysts
Operators
Response_Administ...

50C_Managers

0000000
OO0 00000
©® ® ® ® ® @

Security_Administra...

[] Apply these permissions to sub-groups and Lists in this group

Cancel Save

The following scenarios describe defining permissions for list groups or subgroups and lists in the groups:

o Scenario 1: Permissions applied to list group or subgroup based on the user role.

Each of the levels will have a permission set depending on the user role. For example, if a list group
is assigned the role of Security Analyst, permissions are set to Read & Write for the list group.

o Scenario 2: Permissions applied to subgroups and lists in the group.

The access permissions that you set can be applied to subgroups and child objects of this group.
Permission at the list group level will be inherited by the subgroups and lists in the group.

Permissions applied to list
Permissions applied to subgroup

Role (Analysts) | group or subgroup based

and lists in the group
on the user role

Group Read & Write Read & Write
Subgroup Read Read & Write - Inherited
Lists Read Read & Write - Inherited

Access permission for a list or list group

Ensure that you have at least Read & Write access permission so that you can set access permissions
for lists or list groups.
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To set access permission for a list, perform the following:
1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Lists.
The List view is displayed.

Manage View [LIST] Blacklisted IPs
Rules Reports Charts Alerts Lists Warehouse Analytics Search Report Details 2
Groups Lists
+ [SAN -2 + | e
aome 1| mame ~ o Date Modified Actions
All [ 5] O Blackiisted IPs 2017-05-03 08:39 & o
» [0 Compliance (o] [ Compliance Data 2017-05.03 08:32 &
[ Fikenng Candicaces o [ Compliance Systems 2017-0503 08:34 &
[ Network Activity o
[0 Content Delivery Networks 2017-05-03 08:28 & o
[ Listof Alias Hosts 2017.05.03 0831 &
[0 Listof 1P Addresses 2017-05.03 08:32 &
[ Listof Message ID 2017-0503 0833 &

3. Inthe List View panel, select a list.

4. Click 2 > Permissions in the List toolbar.
The List Permissions dialog is displayed.

Lists Permissions

Blacklisted IPs

Roles ~ Read & Write Read Only Mo Access
Administrators . O O
Analysts O O ®
Data_Privacy_Officers O O ()
Malware_Analysts O O O]
Operators O O )
Response_Administ... O O ®
S0C_Managers O O O]
Security_Administra... O O @

Cancel Save
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5. Select the appropriate access permission for each of the user roles and click Save.

A confirmation message that the permission is successfully set for the selected list is displayed.

To set access control for a list group, perform the following:

1. Goto MONITOR > Reports.

The Manage tab is displayed.

2. Click Lists.

The List view is displayed.

Manage View [LIST] Blacklisted IPs
Rules Reports Charts Alerts Lists Warehouse Analytics search Report Details &5
Groups Lists
+ - Clwe + 17w
— T mame ~ e Date Modified Actions
Al [ 5] [ Blackiisted IPs 2017-05-03 08:39 & v
» (I compliance (o} [ Compliance Data 2017-05-03 08:33 e
» EFiering Cangicates (] [ Compliance Systems 20170503 08:24 & v
DNEMWkA“iViW e [l Content Delivery Networks 2017-05-03 0828 ﬁ ©
[ List of Alias Hosts 2017-05-03 08:31 ﬁ ©
[ List of IP Addresses 2017-05-03 08:32 ﬁ ©
[ List of Message ID 2017-05-03 08:33 ﬁ ®
3. Inthe List Groups panel, select a list group.
N + ..
4. Click > Permissions.
The List Permissions dialog is displayed.
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Lists Permissions

Cancel Save

Network Activity
Roles ~ Read & Write Read Only
Administrators O] O O
Analysts O O ®
Data_Privacy_Officers O O -
Mahware_Analysts Q O .
Operators @] O 0]
Response_Administ... O O O]
S0C_Managers O O O]
Security_Administra... @) O ®
[] Apply thess permissions to sub-groups and Lists in this group

5. (Optional) Select the appropriate checkbox to apply these permissions to subgroups and child objects

of this group.
6. Click Save.

A confirmation message that the permission is successfully set for the selected list group is

displayed.

Edit a List
To edit a list, perform the following:
1. Goto MONITOR > Reports.
The Manage tab is displayed.
2. Click Lists.
The List view is displayed.
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Manage View [LIST] Blacklisted IPs
Rules Reports Charts Alerts Lists Warehouse Analytics Search Report Details ke3
Groups Lists
+ Clme + | L
Groups ~ O Name ~ Group Date Modified Actions.
o (] [ Blacklisted IPs 2017-05-03 08:39 -1
» B Cempliance o [ Compliance Dats 2017-05-03 08:33 .=
» (Rihering Candidaces ° [ Compliance Systems 2017-05-03 08:34 I
[INetwork Activity (o)
[J Content Delivery Networks 2017-05-03 08:28 L« 382
[ List of Alias Hosts 2017-05-03 08:31 L« 382
[ List of IP Addresses 2017-05-03 08:32 L« 382
[ List of Message ID 2017-05-03 08:33 L« 382

In the List View panel, select a list that you want to edit and do one of the following.

e Click 4 in the List toolbar.

o Inthe List View panel, click - > Edit.

Note: You can only edit one list at a time.

Modify the required fields and add new values to the list.
Click Save.

A confirmation message that the list is saved successfully is displayed.

Delete a List or List Group

To delete a list, perform the following:

1.

Go to MONITOR > Reports.
The Manage tab is displayed.
Click Lists.

The List view is displayed.

Manage View [LIST] Blacklisted IPs
Rules Reports Charts Alerts Lists. Warehouse Analytics Search Report Details &
Groups Lists
+ Tlawe + | &
Groups ~ 0 Name ~ Group Date Modified Acton:
e (-] [ Blackiisted IPs. 2017-05-03 08:39 XIS
» 3 Compliance (-] o 201705030833 #e
»Dificerng Condideres @ || 201705030834 EE
[ ervorcacevey ° a 20170503 08:28 L1
[ Listof Alas Hoss 201705030831 EE
[ Listof IP Addresses 20170503 0832 EE
[ Listof Message ID 2017.0503 0833 B

3. Inthe List View panel, do one of the following:

« Select a list or multiple lists that you want to delete and click ~— in the Lists toolbar.

o In the Actions column, click B > Delete.

A confirmation dialog is displayed.
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Do you want to delete the selected List(s)?

Note: Before you delete a list, make sure that the list is not associated with any rule.

4. Click Yes to delete the list.

A confirmation message that the list is deleted is displayed and the selected list is deleted from the
List View panel.

To delete a list group, perform the following:
I. Goto MONITOR > Reports.

The Manage tab is displayed.
2. Click Lists.

The List view is displayed.

Manage = [LIST] Blacklisted IPs
Rules  Reports  Charts  Alerts Warehouse Analytics Search Report Details [
Groups Lists
+ Tl + | *
Groups ~ O Name » DateModified | Actions
e (-] [ Blackiisted IPs. 2017-05-03 08:39 L]
o [ Compliance Data 2017-05-03 08:33 E)
o [ Compliance Systems. 2017-05-03 08:34 -3
O | O ConteneDetvery Necworks 20170503 08:28 Be
[ Listof Alas Hoss 201705030831 3
[ Listof IP Addresses 20170503 0832 3
[ Listof Message ID 201705030833 )

3. Inthe List Groups panel, select the group and click

A confirmation dialog is displayed.

Do you want to delete the selected group?

Caution: If you delete a group, all subgroups and lists in that group are deleted.

4. Click Yes to delete the selected group.

Note: If you try to delete a list group that has lists referenced in a rule or an alert, a warning message
that Lists are referenced in a rule is displayed.
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Duplicate a List

To duplicate a list, perform the following:
1. Goto MONITOR > Reports.

The Manage tab is displayed.
2. Click Lists.

The List view is displayed.

Manage View [LIST] Blacklisted IPs
Rules Reports Charts  Alerts Lists Warehouse Analytics Search Report Details )
Groups Lists
+ - C & + |5 &
@ B trme @y Date Modified Actions
e (-] [ Blackiisted IPs. 2017-05-03 08:39 XIS
» B Compliance L] [ Compliance Data 2017.05:03 0833 R
YDy Cnddes @ | [ 201705030834 10
Eiemwerk vy ° [ Content Delivery Networks 20170503 0828 e
[ List of Alias Hosts 2017-05-03 08:31 &
O Listof IP Addresses 2017-05-03 08:32 &
[ st of Message ID 20170503 08:33 e
3. Inthe List View panel, select a list that you want to duplicate.
Note: You can only duplicate one list at a time.
4. In the List toolbar, click Tfj
Export a List or List Group
To export a list, perform the following:
1. Goto MONITOR > Reports.
The Manage tab is displayed.
2. Click Lists.
The List view is displayed.
Manage View [LIST] Blacklisted IPs
Rules Reports Charts  Alerts Lists Warehouse Analytics Search Report Details )
Groups Lists
+ Tlawe + | &
@ B trme @y Date Modified Actont
e (-] [ Blackiisted IPs. 2017-05-03 08:39 X
» B Compliance L] [ Compliance Data 2017.05:03 0833 R
» Cfikering Candidaces o [0 Compliance Systems 2017-05-03 08:34 &
Eiemwerk vy ° [ Content Delivery Networks 20170503 0828 e
[ List of Alias Hosts 2017-05-03 08:31 &
O Listof IP Addresses 2017-05-03 08:32 &
[ st of Message ID 20170503 08:33 e

3. Inthe List View panel, do one of the following:
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e Select a list and click &c > Export in the List toolbar.

e In Actions column, click & > Export

You can export multiple lists at a time. To select multiple lists, select the checkbox of the lists to be
exported. A browser-specific export dialog may be displayed allowing you to open or save the file.

To export a list group, perform the following:

You can export selected list groups to an external file that can be later imported to NetWitness Platform.
If nothing is selected in the List Library panel, the entire list tree is exported. When you export, the
result is a single export file in binary format.

1.

Go to MONITOR > Reports.
The Manage tab is displayed.
Click Lists.

The List view is displayed.

Manage View [LIST] Blacklisted IPs
Rules. Reports Charts Alerts Lists Warehouse Analytics Search Report Details e
Groups Lists
+ - Clae + | &
Groups ~ O Name ~ Group Date Modified Actions
& (-] [ Blacklisted IPs 2017-05-03 0839 &
» O compliance (o] [] Compliance Data 2017-05-03 08:33 [ 30
F [fiering Candidates o [ Compliance System: 2017-05-03 08:34 LE
I Netwark Activity ]
[ Content Delivery Netwarks 2017-05-03 08:28 LE
[ List of Alias Hosts 2017-05-03 08:31 XS
[ Listof IP Addresses 2017-05-03 08:32 XS
[ Listof Message ID 2017-05-03 08:33 LE

In the List Groups panel, select the list group containing the lists which you want to export.

Click % > Export.

You can export multiple list groups at a time. To select multiple list groups, press and hold the CTRL
button and select the list groups to be exported. The exported file is saved to the local drive.

Import a List or List Group

To import a list, perform the following:

You can import lists from instances of NetWitness Platform into the list tree in the List View panel.
Lists must be in a valid binary file exported from a NetWitness Platform instance.

1.

Go to MONITOR> Reports.
The Manage tab is displayed.
Click Lists.

The List view is displayed.
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Manage View [LIST] Blacklisted IPs
Rules Reports Charts Alerts Lists Warehouse Analytics Search Report Details ke3
Groups Lists
+ Clme + | L
Groups ~ O Name ~ Group Date Modified Actions.
o (5] [ Blacklisted IPs 2017-05-03 08:39 -1
» B Cempliance o [ Compliance Dats 2017-05-03 08:33 .=
» (Rihering Candidaces ° [ Compliance Systems 2017-05-03 08:34 I
[INetwork Activity (o]
[J Content Delivery Networks 2017-05-03 08:28 L« 382
[ List of Alias Hosts 2017-05-03 08:31 L« 382
[ List of IP Addresses 2017-05-03 08:32 L« 382
[ List of Message ID 2017-05-03 08:33 L« 382

3. Inthe List toolbar, click & > Import.

The Import List dialog box is displayed. You can import multiple lists at a time. To select multiple
lists, press and hold the CTRL button and select the lists to be imported.

4. Click Browse and select archived file containing the lists.

Import List

=+ Browse... Delete
File Name ~ Owverwrite ?
Archive.zip Clist

5. Click Import.

Note: During the import process, if a duplicate list exists and you do not select the overwrite option,
the list is imported and no message about duplicate lists is displayed.

To import a list group, perform the following:

You can import list groups from instances of NetWitness Platform into the list tree in the List Groups
panel. Lists must be in a valid binary file exported from a NetWitness Platform instance.

1. Goto MONITOR> Reports.
The Manage tab is displayed.

2. Click Lists.
The List view is displayed.
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Manage View [LIST] Blacklisted IPs
Rules Reports Charts Alerts Lists Warehouse Analytics Search Report Details ¥
Groups Lists
+ Clme + I L
Groups ~ O Name ~ Group Date Modified Actions.
o (5] [0 Blacklisted IPs 2017-05-03 08:38 F1C
» O Compliance o [ Compliance Dats 2017-05-03 08:33 # o
» [ fikenng Candidaces ° [ Compliance Systems 2017-05-03 08:34 -
I Netwaork Activity (o]
[ Content Delivery Networks 2017-05-03 08:28 L XS
[ Listof Alias Hosts 2017-05-03 08:31 L XS
[ Listof IP Addresses 2017-05-03 08:32 L XS
[ Listof Message ID 2017-05-03 08:33 L XS
-

3. Inthe List Groups panel, click > Import.
The Import List dialog box is displayed.

4. Click Browse and select archived file containing the list groups.

Import List

=+ Browse... Delete
File Name ~ Owverwrite ?
Archive.zip Clist

Close Import

You can import multiple list groups at a time. To select multiple list groups, press and hold the CTRL
button and select the list groups to be imported.

5. Click Import.

Note: During the import process, if a duplicate list group exists and you do not select the overwrite
option, the list group is imported and no message about duplicate list group is displayed.

Manage a Rule

You can perform the following procedures to manage a rule.

o Access Control for a Rule and Rule Group

o Delete a Rule or Rule Group

o Duplicate a Rule
» Edita Rule

o View Dependents of a Rule

o Export a Rule or Rule Group
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Access Control for a Rule and Rule Group

To set access permissions the user will have depending on the user role to manage a rule or rule group.
The Reporting provides access control at the rule and rule group level. Only a user who has the right set
of permissions can perform the tasks in the Reporting. The access control is managed by the
administrator from the ADMIN > Security > Roles tab.

When creating users and user roles, the administrator must ensure that the roles created for specific
tasks have access to all the permissions higher in the hierarchy of roles.

Rules or Rule Groups can be tied to a specific set of user roles so that when a user logs into NetWitness
Platform, the only rules they can access are rules accessible to the group to which the user belongs.
Users that belong to a user role with the ‘Read & Write’ access permission have full access rights on the
rule. Further, the access can be tightened so that rules are accessed only by those who have the ‘Read
Only’ access.

Note: You must at least have ‘Read Only’ permission on a group to view the rules within that group.

At the rule level, you can set the following access permissions for the user roles:
o Read & Write
o Read Only

e No Access

Suppose, you want the Security Analysts to have access to all the rules in a Rule Group, you can set the
permission 'Read & Write' at the Rule Group level. And, if you do not want the Operator role to have
access to a specific set of rules in a rule group, you can set the permission 'No Access' at the Rule
Group level. The permission is set only for the rule group but not the rules or subgroups in the Rule
Group.

Access Control for a Rule Group

When you want to change the rule group permissions, you must select a rule group and set access
permissions using the Rule Permissions panel.

Before applying rule group permissions, the default permission set for all the user roles is 'No Access'
permission, and the checkboxes are deselected.
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Rules Permissions

Roles ~ Read & Write Read Only Mo Access
Administrators 2 -
Analystl 8

Analysts s

Ewvent Stream A... 2
Malware_Analysts .

Managers 8

Operators 8

Security ) =

[ Apply these permissions to sub-groups and Rules in this group

Cancel sSave

If you want to change the access permission for a specific user role, you must set these at the rule group
level, as shown in the figure. Suppose, you want the Administrators to have access to all the rules in a
Rule Group, you can set the permission 'Read & Write' in the Rule Group Permissions panel.
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Rules Permissions

Cancel sSave

Roles ~ Read & Write Read Only Mo Access
Administrators . O O
Analystl L

Analysts L
Ewvent Stream A... L
Malware_Analysts D] D] -
Managers L
Operators L
Security L

[ Apply these permissions to sub-groups and Rules in this group

You can also apply permissions to subgroups and rules in the group by selecting the checkbox.

The two scenarios are explained in brief:

o Scenario 1: Permissions applied to Rule Group/ Sub Group/ Rules based on the user role.

o Scenario 2: Permissions applied to Sub Group and Rules in the Group.

Permissions applied to Rule Group/

Role
Sub Group/ Rules based on the user
(Analysts)
role
Group Read & Write
Sub Group Read
Rules Read

Permissions applied to Sub

group and Rules in the

Group

Read & Write
Read & Write - Inherited
Read & Write - Inherited

The access permissions that you set can be applied to subgroups and child objects of this group.

The Rule Group will be assigned the role of a Security Analyst and permissions are set to Read &

Write rule group.

For scenario 1, each of the levels will have a permission set depending on the user role. For scenario 2,
the permission at the Rule Group level will be inherited by the Sub Group and Rules in the Group.

Access Control for a Rule

Manage Lists, Rules or Reports
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When you want to change the rule permissions, you must select a rule and set their access permissions
using the Rule Permissions panel.

Before applying the Rule permissions, the default permission set for all the user roles is 'No Access'
permission and the checkbox is deselected.

Rules Permissions

Source and Destination Details

Roles = Read & Write Read only No ACcess
Admin1 .
Adminlstrators L
Analystl .
Analysts »

Malware_Analysts

Operator] »
Operators »
50C_Managers .

Cancel Save

If you want to change the access permission for a specific user role, you must set these at the rule level,
as shown in the figure. Suppose, you want the Administrators to have access to a specific rule, you can
set the permission 'Read & Write' in the Rule Permissions panel.
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Rules Permissions

Source and Destination Details

Roles ~ Read & Write Read Only
Administrators .

Analystl .
Analysts

Event Stream A

Malware_Analysts

Managers
Operators
Security L
Users 2

Cancel Save

Mo Access

Access Control for a Rule When Multiple Rules are Selected

When you want to change permissions of multiple rules, you can select multiple rules at a time and set
their access permissions using the Rules Permissions Panel. The access permission that you choose will

be applied to all the selected rules.

access permission.

Note: The '*' besides the role name indicates the other permissions available on the user role. If you
want to change the access permission for the required user role, select the user role and change the
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Rules Permissions

Cancel Save

Log in as a specific user and view the access details

Multiple objects selected

Roles ~ Read & Write Read Only Mo Access
Administrators® -
Analystl*

Analysts .

Event Stream A... .
Malware_Analysts .

Managers .

Operators .

Security®

|Jzers* -
“*=* indicates other permissions on the object. Select the required cbject only to modify
the permission

When you log in to the NetWitness Platform UI as a user having 'Read access' permission, all the rules
will be denoted with the symbol ((F) and when you click on the symbol the 'Read Only' callout is

displayed on the Rules List panel.
When you log in to the NetWitness Platform

Ul as a user not having 'Read & Write' access permission on a Rule, all the rules will be denoted with

the symbol ( @) and the rules appear grayed out on the Rules List panel.

The following figure shows the Rules List panel when logged in with minimal 'Read & Write' access

permission.

O Name ~ Type Date Modified Actions
[ *{raw_log)-RULE Warehouse 2014-07-13 09:46 o JE
O Warehouse 2014-07-16 07:34 o JE
[] Accounts Created MNetWitness DB |dentity Management 2014-07-1410:56 o JE
[] Accounts Created SAW M Warehouse 2014-07-1405:40 o JE
[] Accounts Created SAW Warehouse 2014-07-2505:48 o JE
[ Accounts Created SAW(1) Warehouse 2014-07-25 09:54 -
] Accounts Deleted MNetWitness DB |dentity Management 2014-06-26 08:35 -

Note: If a user (other than administrator) creates a rule, ADMIN cannot access that rule.

Tabular Listing

The following table lists the columns in the Rules Permissions panel:
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Roles The role of the user logged into the NetWitness Platform user interface.

Read & The user can access, view, edit, delete, import, and export rules on the Rules view. The

Write user can also change the permission on the rule.

Read The user can only access and view the rule on the Rules view

Only

No The user cannot access or view the rule for which this permission is set.
Access

Set Access Control for a Rule

You can set access control for a rule. The Reporting Engine provides access control at the rule level.
Only a user who has the right set of permissions can perform tasks on the rule. The administrator when
creating users and roles must ensure that the roles created for specific tasks have access to all the
permissions higher in the hierarchy of roles.

At the rule level, you can set the following access permissions for the user roles in NetWitness Platform:
o Read & Write — View or edit the rules in the rule group.
o Read Only — View the rules in the rule group.

o No Access — Cannot view or edit the rules in the rule group.

Prerequisites

Make sure that you have a minimal 'Read & Write' access permission to set access permissions for a
rule.

To set access control for a rule, perform the following:
1. Goto MONITOR > Reports.

The Manage tab is displayed.

2. Inthe Rules list panel, select the rule.

3. Click & > Permissions in the Rule toolbar.
The Rules Permissions dialog is displayed.
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Rules Permissions

Access to Compliance Data Details

Roles ~ Read & write Read Only NO ACCESS
Admin .
Administrators .

Analystl .
Analysts >
MalwareAnalysts .
Cperator] >
Ciperators =
50C_Managers $

Cancel Save

4. Select the following appropriate access permission for the user role and click Save.
o Read & Write
o Read Only
e No Access

Set Access Control for a Rule Group

You can set access control at the rule group level. Only a user who has the right set of permissions can
perform the tasks on the rule. The administrator when creating users and roles must ensure that the roles
created for specific tasks have access to all the permissions higher in the hierarchy of roles.

At the rule group level, you can set the following access permissions for the user roles in NetWitness
Platform:

o Read & Write — View or edit the rules in the rule group.
o Read Only — View the rules in the rule group.

o No Access — Cannot view or edit the rule in the rule groups.

Prerequisites

Make sure that you have a minimal 'Read & Write' access permission to set access permissions for a
rule group.

To set access control for a rule group, perform the following:
1. Goto MONITOR > Reports.

The Manage tab is displayed.
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2. In the Rule Groups panel, select the rule group and do one of the following:

e Click # and select Permissions.

o Right-click the selected rule group and select Permissions.

The Rules Permissions dialog is displayed.

Rules Permissions

Cancel Save

Access to Compliance Data Details

Roles =~ Read & write Read Only No ACCess
Admin $
Administrators .

Analyst] s
Analysts *
MalwarsAnalysts .
Cperator] 2
Operators s
50C_Managers -

3. (Optional) Select the appropriate checkbox to apply these permissions to subgroups and child objects

of this group.
4. Click Save.

A confirmation message that permission is successfully set for the selected rule group is displayed.

Delete a Rule or Rule Group

To delete a rule, perform the following:
1. Goto MONITOR > Reports.

The Manage tab is displayed.
2. In the Rules panel, do one of the following.

o Select a rule and click = in the Rule toolbar.

e Click - > Delete.

A confirmation dialog is displayed.
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Do you want to delete the selected Rule(s)?

Note: If a rule is being used in a report, a warning that the rule is in use and cannot be deleted
is displayed.

3. Click Yes to delete the rule.

A confirmation message that the rule is deleted successfully is displayed and the selected rule is
deleted from the Rule List panel.

To delete a rule group, perform the following:
1. Goto MONITOR > Reports.

The Manage tab is displayed.

2. Inthe Rule Groups panel, select the rule group that you want to delete.
3. Click =.

A confirmation dialog is displayed.

Do you want ta delete the selected group?

Note: If any one of the rules in the group is being used in reports, a warning that the rule is in use
and cannot be deleted is displayed.

4. Click Yes to delete the group.

A confirmation message that the group is deleted successfully is displayed and the selected group is
deleted from the Rule Groups panel.
Duplicate a Rule

To duplicate a rule, perform the following:
1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Inthe Rules list panel, select a rule that you want to duplicate.

3. In the Rule toolbar, click TZ:j
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Edit a Rule

To edit a rule, perform the following:
1. Goto MONITOR > Reports.

The Manage tab is displayed.
2. In the Rules list panel, do one of the following:

e Select a rule and click 4 in the Rule toolbar.

. Click ® % > gait
The Build Rule view tab is displayed.

MetWitness Platform DB

Mame Analyst rule

Summarize Custom -

Select username.bin, user.srcbin, user.srcbin

Alias

Whers wsername.bin exists | | user.dstbin exists | | user.srcbin exists

Group By wsername.bin.user_src.bin,user.src.bin

Then Enter 3 then clauz=...
L 3

Order By Column Name sort By
Enter the column name... Azcending

=]
L%

u
L]
L)

Save Reset Test Rule
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Note: If a rule is edited, the updated rule definition is applied to the Reports, Charts, and Alerts
where the rule is included.

3. Modify the required fields.
4. Click Save.

A confirmation message that the rule is saved successfully is displayed.

When you edit a rule, ensure to re-select the Rule for which you want the Chart to be generated, so that
the edited rule is applied. If you do not re-select the Rule and attempt to save or test the rule, the rule is

saved and a warning message is displayed.

View Dependents of a Rule

You can view dependents of a rule. You must traverse a rule list, select a rule for which you want to

identify the dependency over a report, chart, or alert.

The following figure shows the Rule View where you select the rule

Details'.

'Access to Compliance Data

Name -~

Accessto Compliance Data Detais

iance Data Summary

ompiiance Systems Detais

ompi

= Systems Summary
AlertIDs by Profied Sou

| Page 1 |of18 | » P | C Pagesize 30 ~

roe P

Type Group

NetWitness DB Compliance

Manzgement

agement

Date Modifled Actions

20140501 11225 [+ 35 -

2014-05-01 1125

AR ARAE - ARRE- AR~ AMAE - ARRE-JRAE-INAE - MRC- IRAE - ARAE - JRAC - It -

011125

Displaying 1- 30 of 511

The following figure shows the dependency of the rule over alerts and reports.
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Rule Dependencies

The following entities reference this rule:
Entity Name Path

B Reports =

All compliance

Pavan/Al compliance
CEAE G . Crrnmlizme Dot i o —
SSAE1E- Compliznce Report Compliznce/SSAE-16/55AE 16-C...
Access to Compliance Data - Detail

Compliance’Access to Complianc. .

BASEL Il - Compliznce Repart Compliznce/BASEL I/BASELI1-C...

SO - Comoliznc oot N - - .
50K - Compliznce Report Compliance/S00050X - Complian. ..

FERPA - Compliance Report Compliznce/ FERPA/FERPA - Com...

PAA - Compliznce Report N )
HIPAA - Compliznee Report Compliance/HIPAA/HIPAA - Com...

The following table lists the various columns in the Rule Dependencies dialog and their description.

Entity Name  The name of the entity referencing the rule.

Path The path where the entity is located in the user interface.

To view dependents of a rule, perform the following:
1. Goto MONITOR > Reports.

The Manage tab is displayed.
2. Click Rules.

The Rule view is displayed.

3. Inthe Rule List panel, click ¥ > Dependents.
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The Rule Dependencies dialog is displayed.

Rule Dependencies

The fallewving entities reference this rule:
Enitfty Name Psth

B Reports -
Pavan/Al complisnoe
Compliance/SSAE-16/SSAE16-C...
Compliance/Access to Complianc. ..
BASEL Il - Compliance Report Compliance/BASEL [/BASEL Il - C...
Compliance/50X50% - Complian. ..

pliantE REport Compliance/FERPA/FERPA - Com...

RiatiLE mEpst Compliance/HIPAAHIPAS - Com. . -
Close

Export a Rule or Rule Group

Note: Make sure that you have rules in the rule group.

To export a rule, perform the following:
1. Goto MONITOR > Reports.

The Manage tab is displayed.
In the Rules list panel, do one of the following:

ﬁv

o Select a rule and click
e Click ®C > Export.

2. A browser-specific export dialog may be displayed, allowing you to open or save the file. You can
export multiple rules at a time. To select multiple rule, press and hold the CTRL button and select the
rules to be exported.

> Export in the Rule toolbar.

To export a rule group, perform the following :

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Inthe Rule Groups panel, select the rule group containing the rules which you want to export.
Y ou can export multiple rules groups at a time. To select multiple rule groups, press and hold the
CTRL button and select the rules groups to be exported.

3. Click ® > Export.
A browser-specific export dialog may be displayed allowing you to open or save the file.
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Manage a Report

Y ou can perform the following procedures to manage a report.

o Access Control for a Report or Report Group

o Delete a Report or Report Group

« Duplicate a Report

« Edit a Report
« Refresh a Report Group or Report List

o Edit a Scheduled Report

o Delete a Scheduled Report

« Export a Report
o Export a Report Group

o Import a Report or Report Group
« Enable or Disable a Scheduled Report
« Start or Stop a Scheduled Report

» View an Execution History of a Scheduled Report

o« Manage and Select a Report Logo

o Search Reporting Details

Access Control for a Report or Report Group

This section covers the access permissions the user has depending on the user role to manage a report
and report group. The Reporting provides access control at the report and report group level. The user
who has the right set of permissions can only perform the tasks in reporting module. The access control
is managed by the administrator from the ADMIN > Security > Roles tab.

When creating users and user roles, the administrator must ensure that the roles created for specific
tasks have access to all the permissions higher in the hierarchy of roles.

Reports and Report Groups can be tied to a specific set of user roles so that when a user logs into
NetWitness Platform, the reports with the access rights for the specific user role can be viewed. Users
that belong to a user role with the ‘Read & Write’ access permission can define reports. Further, the
access can be tightened so that reports are accessed only by those who have the ‘Read Only’ access.

Note: You must have ‘Read Only’ permission for a group to view the reports within that group.

At the report level, you can set the following access permissions for the user roles in NetWitness
Platform:
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o Read & Write
e Read Only

e No Access

Suppose, you want the NetWitness Platform to have access to all the reports in a Report Group, you can
set the permission 'Read & Write' at the Report Group level. And, if you do not want the Operator role
to have access to a specific set of reports in a report group, you can set the permission 'No Access' at
the Report Group level.

The permission is set only for the report group but not the reports, rules, or subgroups in the Report
Group.

Access Control for a Report Group

When you want to change the report group permissions, you must select a report group and set access
permissions using the Reports Permissions panel.

Before applying report group permissions, the default permission set for all the user roles is '"No Access',
except for Administrators, as shown in the figure.

Reports Permissions

Roles = Read & Write Read Only Mo Access
Adminl . -
Adminlstrators L

Analyst] 2

Analysts 2

Malware_Analysts
Operator]

Operators

[1 Apply these permissions to sub-groups and Reports in this group

Cancel Save

If you want to change the access permission for a specific user role, you must set these at the report
group level, as shown in the figure. <suppose,>Administrators to have access to all the reports in a
Report Group, you can set the permission 'Read & Write' in the Report Group Permissions panel.

You can also apply permissions to subgroups and reports in the group, as well as apply read-only
permission to rules in the reports by selecting the appropriate checkboxes, as shown in the figure.
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Reports Permissions

Roles =~ Redd & Write Read Only Mo ACCEss
Admin1 @ @ ® -
Administrators ® @ Q

Analyst] o ] -

Analysts o o Ll
Malware_Analysts 0] @] ]

Operator] o @ Il L
Operators Q o ®

[+ Apply these permissions to sub-groups and Reports in this group

™ Apply Read-only permizsion to Rules in the Reports

Cancel Save

The three scenarios are explained in brief:
o Scenario 1: Permissions applied to Report Group/ Sub Group/ Report based on the user role.

o Scenario 2: Permissions applied to Sub Group and Report in the Group.

o Scenario 3: Read-only permission applied to Rules in the Report.

Permissions Permissions
oy applied to Report | applied to Sub Permission (Read-
ole
Group/ Sub Group/ | group and only) applied to
(Analyst) . .
Report based on Reportin the Rules in the Report
the user role Group
Group Read & Read & Write Read & Write Read & Write
Write
Sub Read Read Read & Write - Read & Write
Group Inherited
Report Read Read Read & Write - Read & Write
Inherited
Rules Read Read Read Read

The Report Group will be assigned the role of a Security Analyst and permissions are set to Read &
Write report group.
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For scenario 1, each of the levels has a permission set depending on the user role. For scenario 2, the
permission at the Report Group level (Read & Write) is inherited by the Sub Group and Reports in the
Group. For scenario 3, the Read permission is set for the Rules except that the permission set for the
rules cannot be higher than the permissions set for the Report Group.

Access Control for a Report

When you want to change the report permissions, you must select a report and set their access
permissions using the Report Permissions panel.

!

Before applying the Report permissions, the default permission set for all the user roles is 'No Access
permission and the checkbox is unchecked, as shown in the figure.

Reports Permissions

Aggregate Functions

Roles ~ Read & Write Read Only Mo ACCESS
Adminl .
Adminlstrators L
Analyst] >
Analysts .
Malware_Analysts .
Cperataor] .
Cperators *
50C_Managers .
[] Apply Read-only permission to Rules in the Reports

Cancel Save

If you want to change the access permission for a specific user role, you must set these at the report
level, as shown in the figure. Suppose, you want the Administrators to have access to a specific report,
you can set the permission 'Read & Write' in the Report Permissions panel.

You can apply read-only permission to rules in the reports by selecting the checkbox, as shown in the
figure.
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Reports Permissions

Aggregate Functions

Roles ~ Read & Write Read Only Mo Access
Admint @ < ®
Administrators ® Q Q
Analyst Q o -
Analysts Q o ]
Malware_Analysts Q o =
Operator] Q o =
Operators Q Q =
SOC_Managers o o ®
[] Apply Read-only permission to Rules in the Reports

Cancel Save

The two scenarios are explained in brief:
o Scenario 1: Permissions applied to Report Group/ Sub Group/ Report/ Rules.

o Scenario 2: Read-only permission applied to Rules in the Report.

Permissions applied to

Role Report Group/ Sub Group/ | Permission (Read-only)

(Analysts) | Report/ Rules based on applied to Rules in the Report

the user role

Group Read & Read & Write Read & Write
Write

Sub Read Read Read & Write

Group

Report Read Read Read & Write

Rules Read Read Read

The Report will be assigned the role of a Security Analyst and permissions are set to Read &
Write reports.

For scenario 1, each of the levels has a permission set based on the user role. For scenario 2, the Read
permission is set for the Rules except that the permission for the rules cannot be higher than the
permission for the Reports.
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Note: If the permission for the rules is higher than the permission for the Reports then the permission
is be applied only to the reports. For example, if you set the permissions for the Report Group as No
Access and then specify the option Apply Read-only permission to Rules in the Reports, then the read-
only permission is not set for the rules.

Access Control for a Report When Multiple Reports are Selected

When you want to change permissions of multiple reports, you must select several reports and set their
access permissions using the Report Permissions panel. The access permission that you choose is
applied to all the selected reports.

Reports Permissions

Multiple objects selected

Roles = Read & wrlte Read Only Mo ACCess
Admin J
Administrators .

Analystl 8
Analysts 2
Malware_Analysts s
Operator] s
Operators 8
50C_Managers -
[] Apply Read-only permission to Rules in the Reports

Cancel Save

Access Control for a Report When Multiple Reports with several rules are
Selected

When you want to change permissions when multiple reports with several rules are selected, you must
select the checkbox in the Report Permissions panel, as shown in the figure. The read-only access
permission is applied to all the rules of the selected reports, provided that the permission of the rules are
lower than the permission of the reports.
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Reports Permissions

Multiple objects selected

Roles = Read & Write Read Only Mo Access
Admin (]
Administrators =

Analystl L]
Analysts L]
Malware_Analysts (]
Operator] L]
Operators L]
50C_Managers (]
¥ Apply Read-only permission to Rules in the Reports

Cancel Save

Log in as a specific user and view the access details

When you log in to the NetWitness Platform UI as a user having 'Read access' permission, all the

reports is denoted with the symbol ([I]) and when you click on the symbol the 'Read Only' callout is
displayed on the Report List panel.

When you log in to the NetWitness Platform Ul as a user not having 'Read & Write' access
permission on a Report, all the reports are denoted with the symbol ( %) and the reports appear grayed
out on the Report List panel.

The following figure shows the Report List panel when logged in with minimal 'Read & Write' access
permission.

O | Name ~ Group Date Modifled # Schedules  Actlons

O |P Addresses From E Cow ab 2014-05-16 07-05 ] = 2

[ repor b 2014-05-19 10:55 0 = 2

0 report b 2014-05-15 18:04 0 & -

[0 testArra b 2014-05-15 19:46 0 & -

Note: If a User (other than the super user) creates a report there will be no access to that report for
the super user.

Tabular Listing

The following table lists the various columns in the Reports Permissions Panel:

Roles The role of the user logged into the NetWitness Platform UI.
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Read & Write

Read Only

No Access

Apply these permissions

to subgroups and Reports in
this group

Apply Read-only

permission to Rules in the
Reports

The user can access, view, edit, import, export, and delete the report
on the Reports view. The user can also change the permission on the
report.

The user can only access and view the report on the Reports view.

The user cannot access or view the report for which this permission is
set.

Select the checkbox to apply the selected permissions to the report
group, subgroups in the group and reports in the group.

Note: This checkbox is populated only when you set access
permissions for a Report Group.

Select the checkbox to automatically apply permissions to the rules in
the reports.

Set Access Control for a Report

Prerequisites

Make sure that you have a minimal 'Read & Write' access permission to set access permissions for a

report.

To set access permissions for a report, perform the following:
1. Goto MONITOR > Reports.

The Manage tab is displayed.

2. Click Reports.

The Report view is displayed.

3. Inthe Report List panel, select a report.

4. Click ¥ * > Permissions.

The Reports Permissions dialog is displayed.
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Reports Permissions

Aggregate Functions

Roles = Read & Write Read Only Mo ACCESS
Admin 2
Administrators 2

Analyst] .
Analysts .
MalwareAnalysts 2
COperator] 2
Cperators .
50C_Managers .
[[] Apply Read-only permission to Rules in the Reports

Cancel Save

5. Based on the user role, select the appropriate buttons.

6. (Optional) Select the checkbox, if you want to provide read access permission to rules in the reports.

Note: On selecting the check box, all dependent rules are given READ access permission,
provided the permissions for the report is higher compared to the permissions of the rules.

7. Click Save.

A confirmation message that the permission is set for the selected report is displayed.
Set Access Control for a Report Group
Prerequisites

Make sure that you have a minimal 'Read & Write' access permission to set access permissions for a
report group.

To set access permissions for a Report Group, perform the following:
1. Goto MONITOR > Reports.
The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.
3. Inthe Report Groups panel, select or right-click on a report group.

4. Click ¥~ > Permissions.
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The Reports Permissions dialog box is displayed.

Reports Permissions

Roles = Read & write Read Only Mo Access
Admin . -
Administrators 2

Analyst] .

Analysts .
MalwareAnalysts .

Operator] .

Operators .

[7] Apply these permissions to sub-groups and Reports in this group

Cancel Save

Based on the user role, select the appropriate buttons.

(Optional) Select the appropriate checkbox to apply the selected permissions to subgroups and reports
in the group.

(Optional) Select the appropriate checkbox to provide read access permission to rules in the reports.

Note: On selecting the check box, all dependent rules is given READ access permission, provided
the permissions for the report is higher compared to the permissions of the rules.

Click Save.

A confirmation message that the permission is successfully set for the selected report group is
displayed.

Delete a Report or Report Group

To delete reports in a group or subgroup from the Report List panel:

1.

Go to MONITOR > Reports.

The Manage tab is displayed.

Click Reports.

The Report view is displayed.

In the Report List panel, do one of the following:
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o Select the reports and click =.

o Click 3. > Delete.

A confirmation dialog is displayed.

Do you want to delete the selected Report(s)?

4. Click Yes to delete the report.

A confirmation message that the report is deleted successfully is displayed and the selected report is

deleted from the Report List panel.

Delete a Report Group
Prerequisites

Make sure that you have no reports associated with the report group.

To delete report groups in the default folder or subgroups under a report group, perform the following:

1.

Go to MONITOR > Reports.

The Manage tab is displayed.

Click Reports.

The Report view is displayed.

In the Report Groups panel, select the report group and click =.

A confirmation dialog is displayed.

Do you want to delete the selected group?

Click Yes to delete the group.

A confirmation message that the group is deleted successfully is displayed and the selected group is
deleted from the Report Groups panel.

Duplicate a Report

You can duplicate a report to schedule multiple report for the same report. The duplicated report is
displayed in the Reports List panel with suffixes. For example, Report (1).

Generally, the duplicate option is used in two scenarios:
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o You want to make a copy of the report, to move the same report to another group.

e You want to retain most of the configuration settings for an object but modify few of these settings.
For example, when you have a complex query in a rule or several rules in a report, it is very much
appropriate to use the duplicate option.

To duplicate an existing report, perform the following:
1. Goto MONITOR > Reports.

The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.

3. Inthe Report List panel, select a report that you want to duplicate and click B,
The report is saved successfully and added to the Report list.

You can move the duplicated report to another group.

Edit a Report
To edit reports in a group or subgroup from the Report List panel, perform the following:
1. Goto MONITOR > Reports.
The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.
3. The Build Report view tab is displayed.

1P sre report RSN sz | [ R

Heager 1 Hl
B P Sources Tabular
Hezzer2 H2

B P Sources Line ~ | Optiens 9 | Heacers H3

Hesgerd H4

4. Modify the text and add more rules to the report (if required).
5. Click Save.

A confirmation message that the report is saved successfully is displayed.
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Refresh a Report Group or Report List

You can refresh a report group or reports to view the re-arrangement of groups or reports.

To refresh a report group or reports, perform the following:

1.

Go to MONITOR > Reports.
The Manage tab is displayed.
Click Reports.

The Report view is displayed.

. Do the following to move the group or reports to a new location:

o Inthe Report Groups panel, drag and drop the group.

o Inthe Reports List panel, drag and drop the reports to the desired group in the Report Groups
panel.
The report group or reports are moved to the new location.

Do the following to refresh a group or report list:

o Inthe Report Groups panel, click c
The report group gets refreshed.

 In the Report List panel, click < .
The Report list gets refreshed.

Edit a Scheduled Report

To edit a scheduled report from the Scheduled Reports List panel, perform the following:

1.

Go to MONITOR > Reports.
The Manage tab is displayed.

Click Reports.

The Report view is displayed.

In the Report List panel, select a report and click # " > View Scheduled Reports.
The View Scheduled Reports tab is displayed.
In the Scheduled Reports List panel, do one of the following:

o Select a report and click 4 .

o Select a report and click ¥ > Edit Schedule.
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The Schedule Report tab is displayed.
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5.

10.

11.

12.

13.

In the Schedule Report tab, do the following:
a. Inthe Schedule Name field, modify the name for the schedule report configuration.

b. To execute the reports as per the schedule, select the Enable checkbox.

c. From the Data Source field, select the datasource.

Note: If the data source is not listed, ensure you have Read permissions set for the data
source. This is applicable for NWDB and Warehouse data source. For more information,
see "Configure Data Source Permissions" topic in the Reporting Engine Configuration Guide.

(Optional) From the Warehouse Resource Pool drop-down, select the pool or queue for the report.

Note: The Warehouse Resource Pool drop- down is displayed only if the Warehouse Rule is
selected. If no pools or queues are entered for the Reporting Engine, this field is disabled.

From the Run field, select the type of run schedule. (For example, Now or Hourly).

Select the date range to run the query based on absolute duration or select the Use relative time
duration checkbox to run the query based on relative duration.

(Optional) In the Output Actions panel, do the following:
a. Type the email address and subject.

b. Edit the body of the message for the report.

c. Select the format of the attachment.

d. Type a value for the CSV and Multivalue delimiters.
(Optional) In the Other Options field, do the following:

a. Click ¥ ° > SFTP or URL or Network Share. Based on the selected option, a row gets added
in the Other options field.

b. Select the appropriate options to send the report in PDF or CSV format to the configured SFTP,
URL or Network Share.

(Optional) To add a list in the Dynamic List panel, see Generate a List from the Scheduled Report
section in Create and Schedule a Report.

(Optional) To choose another logo in the Logo panel, see Manage and Select a Report Logo section.

Note: If you do not specify a logo, the default RSA logo is used.

Click Schedule.

The scheduled report executes as scheduled and provides the configured outputs.

Delete a Scheduled Report

To delete a scheduled report from the Scheduled Reports List panel, perform the following:

1.

Go to MONITOR > Reports.
The Manage tab is displayed.
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2. Click Reports.
The Report view is displayed.

3. Inthe Report toolbar, click View All Schedules.
View Scheduled Reports is displayed.

4. In the Scheduled Reports List panel, select the report.

5. Click #.2 >Delete Schedule.

A confirmation dialog is displayed.

Do you want to delete the selected Schedule(s)?

6. Click Yes to delete the scheduled report.

A confirmation message that the scheduled report is deleted successfully is displayed and the
selected schedule is deleted from the Scheduled Reports List panel.

Export a Report

You can export the selected reports to an external file that can be later imported to another NetWitness
Platform environment.

Prerequisites
Make sure that you have reports in the report group.

To export selected reports in the Report Groups panel to an external file, perform the following:
1. Goto MONITOR > Reports.

The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.
In the Report List panel, do one of the following:
o Select a report and click ¥ * > Export.
. Click # = > Export.

3. You can export multiple reports at a time. To select multiple reports, check the checkbox of the
report to be exported. The exported file is saved to the local drive in an archived format.

Open CSV files with Unicode characters in MS Excel

To open downloaded CSV files containing Unicode characters in MS Excel, follow these steps:
1. Download and save the CSV file.

2. Open Microsoft Excel and navigate to the Data tab.
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3. Click on From Text menu item; find the CSV file that you downloaded and click Import.
The Text Import Wizard is displayed.

Select Delimited or Fixed Width data type from the Original data type radio button.
Click File origin drop down list and select 65001: Unicode (UTF-8) and click Next.

Select the delimiter that was used in the file that you imported and click Next.

N S ok

Select the data format for each column of data that you want to import and click Finish.
The correct output is displayed in an MS Excel sheet.

Export a Report Group

You can export a selected report groups to an external file that can be later imported to another
NetWitness Platform environment.

Prerequisites
Make sure that you have reports in the Report Group.
To export selected report groups in the Report Groups panel to an external file, perform the following:
1. Goto MONITOR > Reports.

The Manage tab is displayed.
2. Click Reports.

The Report view is displayed.
3. Inthe Report Groups panel, select a report group and click and select one of the following:

o Export - This selection exports a report in a .zip file.

o Export as Text - This selection exports all the content from the Reporting Engine in a .zip file
which contains the data in text format.
You can export multiple report groups at a time. To select multiple report groups, press and hold

the CTRL button and select the report groups to be exported. The exported file is saved to the
local drive.

Import a Report or Report Group

You can import a group containing subgroups and reports from other instances of NetWitness Platform
into Report Groups panel. Reports must be in a valid binary file that was exported from another
NetWitness Platform instance.

During the import process, you select the binary file and specify whether existing reports with the same
name must be overwritten or not by the reports contained in the binary import file.

« If you choose to overwrite, all duplicate rules, lists and reports are overwritten by the contents of the
binary import file.

« If you choose not to overwrite, and a duplicate rule, list or report exists in the target folder, the import
fails and display a message about duplicate reports.

Y ou cannot import reports to a specific report group. The imported files are stored in the Allroot folder.

Prerequisites
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Make sure that you have the reports or report groups exported from other instances of NetWitness
Platform.

To import groups containing subgroups and reports from other instances of NetWitness Platform into
Report Groups panel, perform the following:

1. Goto MONITOR > Reports.
The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.

3. Inthe Report Groups panel, select a folder to import the file.
4. Do one of the following:

o In the Report Groups panel, click *# “ > Import to import a group.

o In the Report toolbar, click *# * > Import to import a report.
The Import Report dialog is displayed. You can import multiple reports and report groups at a
time. To select multiple reports or report groups, press and hold the CTRL button and select the
reports or report groups to be imported.

5. Click Browse to select the binary file.

NetWitness Platformprovides a file system view of the files.
6. Locate the binary file and click Open.

The file gets added to the Import Report list.

7. (Optional) To overwrite any existing rule in the library with an identically named rule in the binary
file when importing, check the Rule checkbox. If you do not select the Overwrite option, and an
identical rule is encountered in the binary file, the binary file is imported and no error message is
displayed.

8. (Optional) To overwrite any existing list in the library with an identically named list in the binary
file, check the List checkbox. If you do not select the Overwrite option, and an identical list is
encountered in the binary file, the binary file is imported and no error message is displayed.

9. (Optional) To overwrite any existing report in the library with an identically named report in the
binary file when importing, check the Report checkbox. If you do not select the Overwrite option,
and an identical report is encountered in the binary file, the binary file is imported and no error
message is displayed.

10. Click Import to import the binary file.

Enable or Disable a Scheduled Report

To enable or disable a scheduled report from the Scheduled Reports List panel, perform the
following:

1. Goto MONITOR > Reports.
The Manage tab is displayed.
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2. Click Reports.
The Report view is displayed.

3. Inthe Report List panel, select a report and click # " > View Scheduled Reports.
View Scheduled Reports is displayed.
4. Select a report from the Scheduled Reports List panel.

5. Click ® > Enable.
The state of the report is changed to ‘Running’, if the report is scheduled to run immediately.

6. Click #.2 > Disable.
The state of the report is changed to ‘Inactive’.

Start or Stop a Scheduled Report

To start or stop a scheduled report, perform the following:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. Inthe Report List panel, select a report and click ¥ " > View Scheduled Reports.
The View Scheduled Reports view is displayed.

4. Select a report from the Scheduled Reports List panel.

5. Click 3 > Start.
The state of the report is changed to ‘Running’, if the report is scheduled to run immediately.

6. Click ®. > Stop.
The state of the report is changed to ‘Completed’.

View an Execution History of a Scheduled Report

You can view the execution history of a scheduled report. You can view the history of a scheduled report
that is run. You can view the history based on the following criteria:

o Number of past schedules executed

o Start date and end date for the date range

You can view the details such as how many times the scheduled report was executed, the time of
execution (seconds), execution state. You can also view the report generated on a full screen.
To view the execution history of a scheduled report, perform the following:

1. Goto MONITOR > Reports.
The Manage tab is displayed.
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Click Reports.
The Report view is displayed.

In the Report List panel, do one of the following:

« Click # > View Scheduled Reports.

o Click the #Schedules column.
The Schedule Reports view tab is displayed with the status of each of the scheduled report.

Do one of the following:
o Select a scheduled report and click ¥ " > Execution History.

o Select a scheduled report and click 9
The Execution History view is displayed.

Note: By default, you can view 10 number of execution history of a scheduled report. The
execution history shown depends on the Retain Report History Configuration set on the Generaltab
of the ADMIN > Services > Reporting Engine Configview.

For example, if you set the Retain Report History Configuration to 100 days, the data displayed on
the Execution History view. is the past 100 days execution history details considering the current
date information.

From the Get history by: field, select the type of history to be fetched. (For example, Past or Range
(Specific))
In the Count field, enter the number of executions to be displayed.

Click Show History.
The execution history of the scheduled report is displayed.

Manage and Select a Report Logo

Prerequisites
Make sure that you have the Reporting Engine service defined prior to managing a logo.

Manage Report Logos

To manage logos, perform the following:

1. Goto ADMIN > Services.
The Services view is displayed.

2. Inthe Services List panel, select an Reporting Engine service and click View > Config.
The services config view is displayed.

3. Select the Manage Logos tab.
All the available logos are displayed.

Add a Logo
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To add a logo, perform the following:
1. Inthe Manage Logos tab, click +.

A file browser opens where you can choose the file from the local drive.
2. Select the logo and click Select.

The selected logo gets added to the Manage Logos section.

Delete a Logo

To delete a logo, perform the following:

1. Inthe Manage Logos tab, do one of the following:
o Select the logo and click = .

o Perform (Ctrl+click) to select multiple logos and click =.

A confirmation dialog is displayed.

A Are you sure you want to delete the selected logos?

2. If you want to delete the logo, click Yes.
The selected logo is deleted from the Manage Logos section.

Set Default Logo

To set a default logo, perform the following:

In the Manage Logos tab, select a logo and click & Setdefault
The chosen logo is set as the default logo for the RE service.

Selecta Logo
To select a logo, perform the following:
1. Goto ADMIN > Reports.
The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.
3. Inthe Report List panel, select a report.

4. Click # > View Scheduled Reports.
The View scheduled reports view tab is displayed.

5. Select a scheduled report and click # " > Edit Schedule.
The Schedule a Report view tab is displayed.
6. Inthe Logo panel, click Change Logo.
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The Change a Logo dialog box is displayed.
7. Do one of the following:
o Click Upload new logo to upload another logo.

o Select a logo from the list.

8. Click Select.
The selected logo is available on the Logo panel.

Search Reporting Details

This section provides instructions on how to perform a keyword search on name and content for each of
the Reporting components. You can perform a keyword search on name and content for each of the
Reporting components (Rule/Report/Chart/Alert/List) on the Reporting UI.

Note: You cannot search based on date and numeric values.

The following figure shows the search parameters available in the Reporting Module:

m Reports Charts Alerts Lists Warehouse Analytics ﬁl
0 Rule
Groups Rules [ Report
+-C e + EETIR, p o=
hd v 0 Alert

Groups ~ Name ~ Type Group Date Modifled

0 Name

All B - ] Access to Compliance Data Details NetWitness DB Compliance 2014-08-01 11
» [ Aggregate Function (5] 1 G
Access to Compliance Data Summary NetWimess DB Compliance 2014-09-01 11
) 2]
yOI [ Accounts Created Netwitness DB Identity Management 2014-09-01 1125 | §%
O [ Accounts Created SAW Warehouse Warehouse 201409011125 |43
[ compliance e )
Accounts Deleted Netwitness DB Identity Management 201409011125 |4
» O Custom Rules [ ]
) Diata Exfiliration [ Accounts Deleted SAW Warehouse Warehouse 201409011125 |43
Dlfilering Candidate @ Accounts Disabled NetWitness DB Identicy Management 201409011125 |43
[ Filtering Candidates o .
[ Accounts Disabled SAW Warehouse Warehouse 201409011125 |43
»O3 o
s I itness 1 114-08-01 11:25
» Dldentity Managemen:  @E) Accounts Modified NetWitness DB Identiy Management 2014-08-01 11:2: &
[Ba} [ ] [0 Accounts Modified SAW Warehouse Warehouse 20140901 1125 48 = e
yO (15 | page |1 |of17 | 3 M | C PageSize 30 ~ Displaying 1 - 30 of 505

The following are the search parameters available on the Reporting Ul:
1. Search for entities (rule, report, chart, alert, list).

2. Search for the entities based on either the name or content.

Note: Searches are case insensitive. For example, Completed is equivalent to completed.

Prerequisites

In the Reporting Module, you can perform a keyword search based on the name and content (definition).
In this context, content implies definition of each of the reporting components. For instance, the value
defined in the rule, report, report schedule, chart, and alert panel. You can also prioritize your search by
selecting either or all of the components: Rule, Report, Chart, Alert, or List.

Note: You cannot search based on the List values and list path stored in schedule definition panel.

For example, to search for the rule name (ExpertRule), you must select Rule, Name, and Content in the
filtering options drop-down to view all the rule names that matched the search. You can
similarly search for a report, chart, alert, or list definition.
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To search for reporting details from the Manage tab, perform the following:

L.

Search Syntax and Different Types of Search

Go to MONITOR > Reports.
The Manage tab is displayed.

Click # and select the appropriate criteria to search.
In the Search field, enter the text to be searched.

The search drop-down list is displayed:

Reports Charts Alerts Lists Warehouse Analytics

Groups Rules

+ - Cn + go| P
Groups ~ Name ~

All -

Access to Compliance Data Details

» [ Aggregate Function
Access to Compliance Data Summary

[na]

y O Accounts Created
O Aczounts Created SAW
[ compliance

Accounts Deleted
» [ custom Rules
[ Data Extiltration Accounts Deleted SAW

[ Filcering Candidate Accounts Disabled

[ Fileering Candidates
Accounts Disabled SAW

0o®0ocBooooblool

rO
» D ientity Mianagsment Accounts Modified
(] Accounts Modified SAW

2]

» [ Network Activity | Page 1 of17 | }» M | C PageSize 30 v

Type

NetWitness DB

NetWitness DB

NetWitness DE

‘Warehouse

NetWitness DB

‘Warehouse

Netiitness DB

Warehouse

NetWitness DB

Warehouse

Group
Compliance
Compliance
Identity Management
Warshouse
Identity Mansgement
Warehouse
Igentity Managsment
Warehouse
Identity Management

Warehouse

[eperd

]

™ Expert Rule - Hourly Repart

B Import-Export Reperts
Repo

| Page 1 of1 |

I c

DEte oaTET

2014-09-01 11:25

2014-09-0111:25

2014-09-0111:25

2014-09-01 11:25

2014-09-0111:25

2014-09-01 11:25

2014-09-0111:25

2014-09-01 11:25

2014-09-01 11:25

2014-09-0111:25

Displaying 1 - 30 of 505

"REETone

o

BF| %8| |CF| | |0 |03 || 0| B |0 (2

The following table explains the search syntax and the possible searches that can be performed on the
Reporting UI.
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Search Types Description

Word or phrase based search Word Based Search:

To search for a word such as "action" or "meta", you must enter the
word in the search box.

The following figure shows the search results for the text action.

actic-n| |ﬁ

- action meta (>ample/DemolDemosample/action meta) «

ﬂ""— action meta (Samplef Dem/attion meta)

- Login-Action

{HE-IM Alert Hules! | est-Login-Acion)

{

&7 action meta
chart (sample/Demodaction meta chart)

- Login-Action

. (Per User Based Heport | Est-Login-Acton)
2 Login-
Action (Test-Login-Action)

@ : L
% Dynamic Report With List for IP SRC

(Per User based Heport/Liynamic Keport With List tor (¥ SHL)
™ Source and Destination Details
tAseregate FunchonHule Brouc>ource and Lestinaton

| Page |1 | oft1 | |

Phrase based search:

A Phrase is a group of words surrounded by double quotes such as
"action meta". To search for a phrase, you must enclose phrases in
double-quotes in the search box.

The following figure shows the search results for the phrase "action

"
meta’.
"action meta’ |ﬂ
& action meta (TR 2L TR
- arction meta (5ample/Demo/Demaozamplelaction meta)
ﬁ"" action meta chart (Sample/Dema/action meta chart)
| Page 1 of1 | |
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Wildcard Search (Single/
Multiple/ Special Character
Search)

The question mark "?" symbol
is used to perform a single
character wild card search and
asterisk "*" symbol is used to
perform multiple character
wildcard search.

Single character search:

The single character wildcard search looks for terms that match
with the single character replaced. For example, to search for
"Expert" or "Export" you can use the search syntax:

Exp?rt

The following figure shows the search results for the wildcard
character Exp?rt.

Exp?r‘tI |'1:"
=7 Import-Export Reports

{Report Groupdimport-Export Reports)
'FExper‘t Rule - : e : i

{Expert Rule - Hourly Report)

Hourly Report

ffd] Import-Export Reports
{Report GroupsImport-Export Reports)

| C

| Page 1 of1 |

Multiple character search:

Multiple character wildcard search looks for 0 or more characters.
For example, to search for Expert, or Experts, you can use the
search syntax:

Expert*
The following figure shows the search results for the wildcard
multiple character Expert®.

Exper‘t*l |'1:"
= Expert Rule - Hourly Report

(Expert Rule - Hourly Report)

% Import-Export Reports
{Repart GroupsImport-Export Reports)

| Page |1 | of1 | | ¢

Special character search:

Certain punctuation and special characters are ignored during
search (@#$%"&*(){}"~=+-[1\?|!:,.). For example, a search for
action-login will be interpreted during search as "action" "login",
that is, if rules exist with name "action-login" and "action@login"
and search string is "action-login", the search result will return both
the rules.

“actinn-lE,%i.'.'.'."l |ﬂ

(RE-IM Alert Rules/Test-Login-Action)

™ ‘Login-Action
™ Login-Action

(Per User Based Heport/ | est-Login-Action)

@ Login-
Action (Test-Login-Action)
| Page 1 | oft1 | | O
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Search Types Description
Search based on name or Search based on name:
content

When you want to search based on the name of a report,
select Reportand Namebox from the filtering options drop-down.

For example, to search for the report name "Report With Multiple
Rules", you can use the search syntax:

"Access to Compliance Data"

Note: When you search for a report, it implies you can search for
the report schedules as well.

The search result will return the report containing the specific

name.
"Access to Compliance Data”| |¢'
2 Access to Compliance Data - Detail i
o (Compliance/Access to Compliance Data - Detail)
¥ Access . "

to Compliance Data - Top 25
= {Lomplance/Access to Lomplance Lkata - |op £2)
& SSAE

16 - Compliance Report
(Lomphances>Ak-1bisbAE Th - Lomphance Heport)

% GPG-

13 - Compliance Report

o (Lomphance/P-130M-13 - Lomphance Heport)
Al

CDI"I"I|:I|iEII'ICE (Pavan/All compliznce])

¥ sox- Compliance Report

= (Compliance/S00050X - Compliance Report)
% NERC-CIP -

— ' n

| Page |1 | oft1 | |

Search based on content:

When you want to search for the content within an alert, say alert
description, select Alert and Content box from the filtering

options drop-down. For example, to search for the alert description
"Device IP Got Detected", you can use the search syntax:

"Device IP Got Detected"

+ = @ | ®Enable ODisable | & & | B Template  E View Schedule <& View Alerts
[l Enabled | Pushed 2 Name Description
o e Yes AT-09863 TCO40 Device IP Got Detected
O @ Mo Con-Broker
o e No Payload

The search will return the result having the specific content.

"Device |P Got Detected”| |ﬁ|
& AT-09863 TCO40 (AT-02863TC040)
| Page |1 | of1 | | &
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Troubleshooting

Thi

s section provides troubleshooting instructions for issues faced when using the Reporting module

in NetWitness Platform.

Configuring SFTP Server Issue
Procedure

Try the following steps if you face any issues while configuring the Linux SFTP server:

1.

S A

If the Report Output Action for the configured SFTP fails, you must SSH to the SFTP server and try
to connect locally to check if SFTP is working fine.

Connect to SFTP server:

If the Local connection fails, open the file sshd_config> vi /etc/ssh/sshd_config.

Check for the entry in the file:

# override default of no subsystems
Subsystem sftp /usr/libexec/openssh/sftp-server

If this entry does not exist, add the two lines mentioned in Step 3 at the bottom of the file and Save it.
Restart service from SSH > service sshd restart.
Retry the SFTP connection now.

Make sure SFTP port is not blocked by SA server appliance firewall. Update iptables rules to allow
sftp port.

Meta Values in Investigation Link Issue

When the device information on the datasource is changed, the Investigation link for the

Issue ) .
meta values of the executed reports is not displayed on the NWDB results page.
: Remove and re-add the datasource to Reporting Engine.
Resolution
Note: This workaround is not applicable for reports that are already generated.
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Internet Explorer 10 Browser Issue

When you click the Test Rule multiple times in quick succession, results with large input
data may not displayed in Internet Explorer 10.

If this issue occurs, try one of the following steps:
o Close the Test Rule window on Internet Explorer 10 and run the test again.

o Use other browsers like Chrome or Mozilla Firefox to test the rule execution.

Dynamic List Editing Issue

A dynamic list cannot be added from the Edit option on the 'View All Schedules' page to
an existing schedule.

1. Reports > Select the report >

2. Click the #Schedules for the specific report

3. Select the schedule to be modified from the Report Schedule page
4. Edit the schedule

Deployment Failure Issue

Deployment of reports fail, if the dependencies of certain compliance reports in Live are
not deployed prior to the reports.

Retry the deployment. If the problem persists, try to deploy the rule or list dependencies
first and then deploy the reports.

Respond Server Issue

When the Forward Alerts to Respond option is enabled and RabbitMQ connections to the
Respond Server are blocked, some of the Reporting Engine threads may be blocked.

Disable the Forward Alerts to Respond option until the RabbitMQ broker in the
NetWitness Platform server at the Respond has begun and accepts the connections.

Post-Upgrade Issue

Post-upgrade from 10.6.x to 11.2, Categories meta for incident collection is not supported.

When using the Categories meta for incident collection, the results rendered are in an
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incorrect format. Hence this meta is not supported and you cannot use the categories
meta in either select clause or where clause. Also, it is not available in the list of metas
for selection in the Rule Builder page.
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Appendix

This section provides detailed information about the supported aggregate functions, rule syntax, advanced
rules query syntax in Reporting and task scheduler for Warehouse Reporting.
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Rule Syntax

This section describes the different rule syntax supported in the Reporting Engine.

NWDB Rule Syntax

The NWDB rule is one of the rule syntax supported in the Reporting Engine. To enhance the execution
time of your reporting entities, see "Reporting Guidelines" section in Reporting Overview.

A Rule is a function that manipulates the result set of a rule in order to make the output in a report more
meaningful or add additional functionality to a rule other than querying data and displaying it. Any
combination of these rule actions can be used to create unique and interesting representations of the
information collected by NetWitness Platform.

The Reporting Engine supports the following categories of NWDB data source rule syntax:
« select clause
o Non-Aggregate Rule
o Aggregate Rule
o alias
o where clause
o where clause Operators
« then clause
o Limit field
o Rule Actions

o Rule Operators

Select Clause
The select clause is a comma separated list of values. For example: select sessionid,time,service.

There are two types of select clause for NWDB Rule:
o Non-aggregate rule

o Aggregate rule

Non-Aggregate Rule

When you want to define a rule without any grouping, choose 'None' in the Summarize field. In a non-
aggregate rule, you can select any number of metas in the Select clause. For example, select service,
sessionid, time.
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Build Rule

Rule Type MetWitness Platform DB

Mame Mon-Agzregate Rule

summarize Mone -

|Select service, sessionid, time

Alias F Source

Where service=443

[Then Enzer a then clause..

[Crder By Column Name Sort By
Enter the column name._.. Azcending

Limit 20 .
Save Reset Test Rule

Aggregate Rule

When you want to query for a specific meta and its associated aggregate value then you must use the
Aggregate rule. To get an aggregate, you must choose either of the three metas (Event Count, Packet
Count, Session Size) or choose 'Custom' in the Summarize field to include an aggregate function in
the Select clause. For example, select ip.src, sum (ip.dst). When Custom aggregate rule is enabled, the
following fields are populated in the user interface:

o Group By
e Order By
o Session Threshold

The following figure shows the Build Rule view for Aggregate Rule.
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Build Rule
Rule Type NetWitness Platform DB
Mama AggEregate Rule
Summarize Custom -
Select ipsre, countdistinct{ip.dst)
Alias IP Source
Where ip.src exists
Group By ipsrc
Then Enter 3 then clauss.
1 2
Order By Column Mame ~ Sort By
r
p.src Azcending
r
countdistinct{ip.dst) Ascending
Enter the column name._. Azcending
Session - -
o
Threshold =
Lirnit 20 o
Use Sawve Reset Test Rule

There are two types of aggregate values that can be queried:
o Collection aggregation

o Meta aggregation

Collection Aggregation

With collection aggregation, you can get aggregates related to Event, Session or Packets. The following
values can be queried in a collection aggregation:

o« Event Count: The total count of events.

o Packet Count: The total count of packets.
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o Session Size: The total session size.

These options are listed in 'Summarize' field and any one of them can be selected in a rule.
For example, choose any of the Collection aggregates (Event Count or Packet Count or Session Size) in
the 'Summarize' field and select ip.src.

Build Rule

Rule Type MetWitnezs Platform DE
Namse Collection Aggregation
SiEes Event Count =
B ipzre

Alias IP Source

Where

ipsrc
Then Enter a then clauss..
]
Order By Column Name Sort By
Tatal Aszcending

Seszion - .

Threshold b

Lirnit 20 a

Save Reset Test Rule

Meta aggregation

With meta aggregation, you can get aggregates of meta values. The following are the supported meta
aggregate functions:
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sum(meta)

o count(meta)

o countdistinct(meta)
o min(meta)

e max(meta)

o avg(meta)

o first(meta)

o last(meta)

o len(meta)

o distinct(meta)

Supported Meta Aggregate Functions

The NWDB service supports the following meta aggregate functions and syntax in this release.

o T =

sum The sum of all meta values.

(<meta>) For example, if you provide the field sum(payload) in the select clause, the resultset is
the sum of payload size.

Note: The meta field chosen for the sum aggregate function must be of numeric data

type.
count The total number of meta fields that would be returned.
(<meta>) For example, if you provide the field count(ip.dst) in the select clause, the resultset is

the number of times an ip.dst value is returned.

countdistinct The total number of distinct meta fields that would be returned. For example, if you

(<meta>) provide the field countdistinct(ip.dst) in the select clause, the resultset is the number of
times a distinct ip.dst value is returned.

min The minimum of all meta values.

(<meta>) For example, if you provide the field min(payload) in the select clause, the resultset is
the min of payload size.

max The maximum of all meta values.

(<meta>) For example, if you provide the field max(payload) in the select clause, the resultset is
the max of payload size.
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O

avg The average of all meta values.
(<meta>)

For example, if you provide the field avg(payload) in the select clause, the resultset is
the avg of payload size.

Note: The meta field chosen for the avg aggregate function must be of numeric data

type.

first The first occurrence of the meta value.

(<meta>) For example, if you provide the field first(ip.src) in the select clause, the resultset is the
first occurrence of ip.src for that group.

last The last occurrence of the meta value.

(<meta>)

For example, if you provide the field last(ip.src) in the select clause, the resultset is the
last occurrence of ip.src for that group.

len(<meta>) Converts all field values to a UInt32 length instead of returning the actual value. This
length is the number of bytes to store the actual value, not the length of the structure
stored in the meta database.

For instance, the meta value "NetWitness" returns a length of 10. All IPv4 fields, like
ip.src, returns 4 bytes.

distinct The distinct values of the meta.

(<meta>) For example, if you provide the field distinct(ip.src) in the select clause, the resultset is

all the distinct ip.src for that group.
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Y ou must select 'Custom' in 'Summarize' field and provide the meta and the meta aggregate functions in
the select clause.

Build Rule
Rule Type Metwitness Platform DB
Mame Custom1
summarize Custom =
Select ip.src, sumy{payload)
Alias IP Source
Where
Graup By insre
Then Enter 3 then clauze...
4 b
Order By Column Name sort By
ip.src Ascending
Enter the column name... Azcending
Seszion - »
20 &
Save Reset Test Rule
Note: Meta aggregate functions cannot be used in a WHERE clause and the rule actions like min
threshold/max_threshold can be used to filter aggregate functions. It is advised to use a more refined
WHERE clause to get a better rule performance while using 'group by'.

Aggregate Query for Multiple Meta
To execute aggregate query for multiple Meta, follow these steps:
1. Goto MONITOR > Reports.

The Manage tab is highlighted and the Rules view is displayed.
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2. In the Rule toolbar, click + > NetWitnessDB.
For example, enter the following meta in the fields highlighted below:

SELECT: ip.src, service, count(alias.host)
ALIAS: Source IP Address, Service Type, count(alias.host)
WHERE: ip.src = 59.96.136.142

Note: In the alias field you can enter a name for columns used in the select clause. If you do not
specify the alias for one of the field in the select clause, then the default description will be used.
For example, if the select clause has Fieldl, Field2, Field3, Field4, and alias has only Fieldl,
Field3, Field4, then for Field2 a default description is used.

3. Click the Test Rule button at the bottom of the screen.

The Test Rule page is displayed.

Test Rule
12 . 02
"\:\;" 2014 ;5 04:49 Rule With Aggregates 2015 o5 04:49
i =
Farmat Source IP Address service Type count(alias.host)
Tabular ~ 1 HTTD 36

Time Range

Past hd
S |Weeks v

;’\l Use relative time calculation

Summarize

Summarize determines the type of summarization or aggregation for the rule.
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m Config Value

Summarize To query metas without any custom grouping, select:

o None: The data is grouped by session in this case.

To get collection (sessions/events/packets) related aggregates, select either of the
following:

o EventCount: The total count of events.
o Packet Count: The total count of packets.

o Session size: The total session size.

To get meta based aggregates, select:

o Custom: This indicates that expected meta aggregate function is defined in rule select
clause.

Order By

Order By determines how to sort the result set.

m Configuration Value

Column The Column Name is the name of the columns by which you want to sort the results. By

Name  default, the value is empty. When you click on a column, the value gets populated based on
the Summarize field.

o For 'None' and 'Custom’, the value gets populated based on the entries made in
the Select field. You can select from this list or add custom name.

o For Event Count, Packet Count and Session size, accepted values are Total and Value.
o Total - sort by aggregate value
o Value - sort by group by meta

Sort By Sort By determines the order in which you want to sort the results. The following are the
values:

o Ascending Order
o Descending Order

Session Threshold

The session threshold is the optimization setting to stop scanning the matching sessions for each possible
unique value for the selected meta. The threshold is an integer between 0 (default) and 2147483647. The
threshold 0 scans for all matching sessions.

Note: If you provide a non-zero value (a value higher than zero), the aggregate results are
inaccurate. This can be used only when you are interested in unique values and not aggregate values.

Supported where Clause
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where <field1> [<field- The where clause is a comma separated list of language field values and
operator>] ranges that is used by NwValues function. In the where clause, string

< values have to be enclosed within single quotes. For example, where
value1>,<value2>,<value3- username ='admin' && service = 22.

value4> <logic-operator>

<field2>,and so on

where <field1> [<field- You can use a list in the where clause if you have multiple values to
operator>] <List1> report on. For example, where ip.src exists && alias.host exists
&& alias.host contains $[User Reports/List of Alias Host]. When you
use the list you must specify in the format $[<path>/<List name>].

In the where clause, make sure the syntax is correct based on the meta type.

For example,

For all text meta type use quotes for example, username = ‘user!’.

For all IP Addresses, Ethernet Addresses, and Numeric meta types do not use quotes for

example, service = 80 && ip.src = 192.168.1.1.

For date and time meta types, if the date and time format is 'YYYY-MM-DD HH:MM:SS*, use quotes.
If the date and time format is 1448034064 (number of seconds since EPOCH (Jan 1, 1970)), do no use
quotes.

Note: If list is used in the rule, make sure that the list values are quoted or unquoted based on the type
of the meta used. Checking the Quotes will be inserted for all the values checkbox in list definition
page (for more information see, "Create Lists or List Groups" section in Configure a Rule) would
quote all the list values.

Supported where Clause Operators

= Returns results where the field is equal to any provided value. For example, tcp.dstport =
21-25,110 returns session with TCP destination ports of 21, 22, 23, 24, 25, or 110.

= Returns results for fields that do not match the values specified. For example, eth.type
1=0x0800 returns sessions outside of hex value (decimal value of 2048) that is all non-IP
based protocols.

begins Checks for a value at the beginning of a text or binary field.

contains  Searches a text or binary value for a partial match.

ends Checks for a value at the end of a text or binary field.
exists If the field value exists, regardless of value, the operation evaluates to true.
lexists If the field value does not exist, the operation evaluates to true.

length Evaluates the length of the field. For example, username length 20-u returns any username
that is 20 or more characters long.
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regex Performs a regular expression search against text or binary values.

not Not operator is used to negate a clause or condition. For example, (not(user.dst ends "$"))
will not display values for user destination.

Supported then Clause

then The then clause contains a rule action that manipulates the original result set of a rule in
<rule order to make the output in a report more concrete or add additional functionality other than
action>  querying data and displaying it. For example, dedup (filename).

Limit field

This indicates the limit to be put on the query while fetching data from the database. If a result set is
sorted by event

count, packet count, or session size, the limit represents the top (or bottom) N values to be returned. If
the result set is not

sorted, the first N values are returned.

Rule Actions
The NWDB data source rule syntax supports the following rule actions:
e dedup

o filter on

o filter out

o lookup and add
o max_threshold
o min_threshold

o regex

e sum count

e sum values

o show whats new

dedup (string field)

dedup removes the duplicate entries in an unsorted result set and displays only pertinent data.
The dedup rule action removes duplicate entries of a specific field in the report, so that only the first
occurrence of that value is listed in the report.

Note: The dedup rule action cannot be used with an aggregate rule.
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For example, the meta data generated by an individual session is often repetitive, especially when you
have sessions with a lot of DNS lookups or web sessions that access the same host multiple times for

various resources (such as, javascript, css). To remove the duplicate entries of the host, you can use
the dedup rule action.

Example:

The following example is a lengthy result set that can be trimmed by removing the duplicate values in the

same session.

Test Rule

Data Source

204.31-Conc hd
Format

Tabular hd
Time Range

Past hd

2 % Wesks ¥~

[#f Use relative time calculation

o

2015 57 04:05

Source |P Address

q . 02
Rule without Dedup Rule Actions 2015 45 04:05
Service .
T Hostname Aliases .y
S5L
HTTP
HTTP
HTTP blackboard. jason.org
HTTP blackboard.gwu.edu
HTTP [mail.goog! E.C:'TII"E google.comBmail google comfimail.goog e.::-ﬂl
HTTP
HTTF
HTTE w.skysports.com, www.skysports.com
HTTP
HTTF I
£1 - M v
—_— u.edu, pfl.imag.gwu.edu

The following figure shows the use of dedup rule action to remove the duplicate entries from the result

set.
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Build Rule

MetWitness Placform DE

MName Rules with Dedup Rule Actions

Summarize None -

Select ip=re, zervice, alias. host

Aliaz Source | Address, Service Type, count(alias.host)
Where ip=rc exists & serviceexists &8 alias.host exists
Then deduplalizs host):

Enter a then clauszs...

! ’
e Column Name Sort By

Enter the column name... Azcending
Lirnit 1000 =

Save Reset Test Rule

The duplicate value for each entry in the rule result set is reduced to one value.
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Test Rule
Data Source o o - 0z
- 2015 57 04:12 Rule with Dedup Rule Actions 2015 45 04:12
204.31-Conc A
Servi .
Format Source IP Address _l:::m Hostname Aliases Y
Tabular ~
1 550 Microsoft Secure Server Authority
Time Range
Past - 2 HTTP thumbs3 ebaystatic.com
3 HTTP au.download windowsupdate.com
2 ) Weeks v
4 HTTP nlackboard.jason.org
@ Use relative time calculation
3 HTTP Dlackboard.gw
& HTTP mail google.com
7 HTTP i
& HTTP
£l HTTP
10 HTTP
11 HTTP
12 DNS
13 HTTP
14 HTTP v

filter_on (string filter, string field, bool matchExact)

filter on removes values that do not contain the filter criteria from the result set. If the result
set contains multiple fields, you must select a specific field to which the filter is applied. To add
additional results to a single result set, include function such as lookup and add.

The matchExact parameter determines if the match is an exact match or contains a match.
o If matchExactis setto false, any value that contains the filter text is considered a match.

o If matchExact is set to true, only values that match the provided filter text is included in the result
set.

Note: Unless the matchExact parameter is specified, the default behavior of the rule action is to match
exactly the text specified in the filter parameter. To specify that results containing the filter text must
be kept in the result set, users must set the matchExact parameter to false.

Example:

The following figure displays the list of countries and their event count.
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Test Rule
Data 5 02 . . 02
sta e 2015 ;5 01:00 Rule without Filter_On 2015 ;5 03:00
204.31-Conc hd
Format Source Country Total events count A
Tabular hd 1 united states 15105
Time Range 2 china 1174
Range A
3 united kingdom 381
From
02/10/15 01:00:00 4 spain 362
To 5 canada 344
02/10/15 03:00:00 6 paland 118
7 france 85
8 258
5 203
10 braz 200
1 italy 193
12 bulgaria 170
13 argentina 162
14 taiwan 160
b
F L= S aen

The following figure shows a filter on rule action to filter out countries except Spain, China, United
States and United Kingdom from the result set.
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Build Rule

Rule Type MetWitness Platform DB

MName Rule with Filter_On_True

Summarize Ewvent Count -

Select COUMNEry.src

Alias Country Source

Where COUNTRY.Sre exists

Group By COMNErY.Sre

Then filter_on ("spain,china, united kingdom', country.src’);

Enter a then clauze..

Order By Column Name sort By

Total Descending

200 o
Save Reset Test Rule

The following figure shows the output with the filter _on rule action.
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Sourc o1 - s < 03 TN
Dat= Zource 2018 ,, 06:59:00 Rule with Filter_On_True 2018 ; 06:58:59
Admin- Concentrator b

Country Source Total events count

Format

1 china 325101
Tabular L4

2 zpain BAEAD
Time Range

ied kingdom ]

S o3 united kingdo 58335
2 % Months

[# Use relative time calculation

Close

Another way of filtering out the entries from the result set is to create a list of variables which you want
to filter out. For example, you can create a list with United Kingdom, France and Germany as values in
the list. You can use this list in the rule action to get the same result set. For example, if you create a list
called COUNTRY_LIST, you can use the list as follows:

filter on ('$COUNTRY LIST', 'country.src', 'false');
filter out (string filter, string field)
filter out (string filter, string field, bool matchExact)

filter out removes the values that contain the filter criteria from the result set. If the result set contains
multiple fields, you must select a specific field to which the filter is applied (for example, you can use
a lookup and add to add results to a single result set).

The matchExact parameter determines if the match is an exact match or contains a match.
o If matchExact is set to false, any value that contains the filter text is considered a match.

o If matchExact is set to true, only values that match the provided filter text is excluded from the result
set.

Note: Unless the matchExact parameter is specified, the default behavior of the rule action is to
match exactly the text specified in the filter parameter. To specify that results containing the filter text
must be removed from the result set, users must set the matchExact parameter to false.

Example:

The following figure displays the list of countries and their event count.
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Test Rule

Data Source
204 31-Conc

Format

Tabular

Time Range

Range

Fram

0271015 01:00:00
To

02/10/15 03:00:00

2015

02
10

01:00

Source Country
united states
china

united kingdom

Rule without Filter_Out

2015 92
Total events count
15105
1174
381
362

344

200
198
170
162

160

1En

03:00

W

The following figure shows the filter out rule action to remove the event count for Spain, China, United
States and United Kingdom from the result set.
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Build Rule
Rule Typ
Mama

Summarize

Group By

Order By

Seszion

MetWitness Platform DB
Rule with Filter_Out_True
Ewvent Count k4
COUNTIyY.Sre
Country Source

Counory.src exists

CoUNCry.src

filter_on ("spain,china,united kingdom', country.src’);

Enter a then claus=..

4

Column Name Sort E}'
Total Descending
200 &

Save Reset Test Rule

The following figure shows the output with the filter out rule action.
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Sourc o1 . A . 02 o
Dats Source 2018 ,, 00:00:00 Rule with Fileer_Qut_True 2018 ,; 23:59:59
#dmin- Concentrator L

Country Source Total events count

Format

1 china 323101
Tabular il

2 spain B4843
Time Range
— 3 united kingdom 58389

a3t ~

2 & Months =

¥ Use relative time calculation

lookup and add (string select, string field)
lookup and add (string select, string field, int limit)
lookup and add (string select, string field, int limit, boolean inherit)

lookup and add (string select, string field, int limit, boolean inherit,
string extraWhere)

lookup and add(string select, string field, int limit, boolean inherit, string
extraWhere, boolean aggregate)

This rule action iterates through a list of values in a result set and lookup additional meta data to further
describe the relationships between various elements in a result set.

Note: The lookup and add rule action can be used only with an aggregate rule.

The first parameter, select, designates the type of meta data that must be added to elements of the result
set. The second parameter, field, specifies where in the result set the append must apply to. Also, a limit
can be applied to avoid crowding the result set with a large result set.

By default, subsequent queries to the SDK will inherit the where clause of the parent rule. To use a
unique where clause, you can specify a boolean value in the fourth parameter as false and in the
fifth parameter you can specify a different where clause.

Note: If you are using a unique where clause in your query, make sure that you use a single quote (')
for enclosing arguments and double quotes (") for string values.

Now, with the addition of Custom summarization and Group By feature, the result can be achieved
even without having lookup and add rule action. The new rule syntax with groupby displays the result in
a flat structure which is better than the earlier rule syntax without groupby Hence it is recommended to
manually edit/update rules with lookup and add rule action and use groupby clause wherever it is
applicable.
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Note: Lookup And Add rule action is supported only if the SELECT clause has one meta and
aggregate function.

For example, see below scenarios: In Example 2a, lookup and add rule action is used. Instead of using
lookup and add rule action, the same result can be achieved by using Custom summarization and
Group By feature. See Example 2b below.

But, lookup and add rule action is still supported for NWDB rules on the following conditions:
o All versions of NWDB rules with Summarization as Event Count, Packet Count, or Session Size.

o For Custom summarization, the lookup and add rule must have only one group by meta with only one
aggregate function where the aggregate function must be either sum() or count().

Note: It is not supported for “Summarize-None”.

For example, lookup and add rule action can be used for the following rules:
« select ip.src, sum(size) group by ip.src

select ip.src, count(filename) group by ip.src

It cannot be used for the following rules:

select ip.src, sum(size),count(filename) group by ip.src

select ip.src, sum(size),avg(size) group by ip.src

select ip.src,ip.dst count(filename) group by ip.src,ip.dst

Examples:
1. lookup_and_add('ip.dst','ip.src’, 2);

This rule action would iterate through each ip.src in the initial result set and lookup the top two
destination IP addresses with each ip.src.

The following figure shows the rule definition.
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Build Rule
Rule Type
Mamse

Surnmarize

Group By

Metwitness Platform DB

Lookup and add
Ewent Count
ipsrC

Source |? Address

zervice exisis

ipsrc

Enter a then claus=..

Column Hame

Total

[ =]

20

Save Reset

leokup_and_add{'ip.dst’, ip.src’.2);

sort By

Ascending

L4

<

Test Rule

The following figure shows the result set containing the source IP addresses and the top two destination

IP addresses with each ip.src.
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pata auree 2018 g; 10:12:00 Lookup and add 2018 o 10:11:59

Adrmin- Concentrator -
Source IP Address Total events count =
Earmat
1.ip.src 1
Tabular -
X 1. ip.dst 1
Time Range
- , 2. ip=src 1
1.ip.dsz 1
2 -+ Mot
3. ip.sre 1

¥ Use relative time calculation

2a. lookup_and_add('ip.dst','ip.src', 2); lookup and_add('service','ip.src', 3);

This rule action would iterate through each ip.src in the initial result set and lookup the top two
destination IP addresses with each ip.src and the top three ports used by each ip.src.

The following figure shows the rule definition.
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Build Rule
Rule Type
Mame

Surmmarize

NetWitness Platform D8
Lookup and add2

Event Count w
D.=rC

Source P Address

senvice exists L& ip.src exists

aakup and addlip.dsyip.sre’, 21
r

lookup and add("service',ip.dst’, 2}

Cniter a then clauis...

Column Name

Total

1 -

20 -

Save Rezat Test Rule

Sarn By

Descending

The following figure shows the result set containing the source IP addresses and the top two destination

IP addresses with each ip.src and the top three ports used by each ip.src.
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Data Source

Admin- Concentrator L4
Format

Tabular b4
Time Range

Past b
2 & Months =

| Use relative time calculation

2018 g, 10:21:00

Source |P Address
1.ipsrc

1. ip.dst

1. zervice OTHER

2 ip.dst

1. =ervice OTHER

2 ipsrc

1. ip.dst

1. zervice OTHER

2. =zervice HTTE

2 ipdst

1. =ervice HTTF

2. service OTHER

3.ipsrc

1. ip.dst

1. service HTTF

Lockup and add2 2018 g:

Total events count

33583

27

26810
7487
234
191

515

32
25325
2250

215

10:20:59

Close

Y ou can make the query as complex as you want by selecting different fields in the result set and by

appending to different parts. For example, you may want to know what files each source IP had

touched. However, because the parent rule has a WHERE clause of service = 6667 and the default

behavior of this rule action is to append to the original WHERE clause, it becomes necessary to override
the parent WHERE clause. The easiest way to understand this concept is to look at the previous lookup
and_add call lookup _and add('ip.dst','ip.src',2). The actual query that is sent to the server is
SELECT ip.dst WHERE service = 6667 &&ip.src = 206.42.199.194. In order to force the WHERE

clause to override the service = 6667 portion of the WHERE clause (inherited from the parent rule), the
user can specify a 4th parameter of false as shown in example 3.

2b. Without Lookup_and_add Rule

This rule uses the Custom summarization and Group By feature to sort the results.

The following figure shows the rule definition.
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2uild Bule

Rule Type MWetWitness Platform DB
Name Without LA

Surmmarize Cus=tam -

p.=7C, ip.dst. service, countsessionid)

Aliaz Source P Address

senvice exists L& ip.src exists

Group By p.57C,ip.dst service
:r"'E"" CriLer a Lhen clause...
Crrder By Column Name Sart By
r r
count{sessionid) Descending
CrLer tha | I narme ALCardang

]
L

(=]
=]
L

“ Save Reze: Test Rule

The following figure shows the result set containing the source IP addresses and the top two destination
IP addresses with each ip.src and the top three ports used by each ip.src.
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Test Rule

Data 5 o1 - 03
#zoures 2018 ; 10:41:00 Without LUA 2018 ,; 10:40:59
Admin- Concentrator b
Source [P Address Destination |P Address Service Type countsessionid)
Format
1 S5L 13942
Tabular b
2 HTTP 10613
Time Range
3 HTTP 8381
Pazt -
4 HTTP 4553
2 | |Months « —
5 HTTP 4183
Cd stive i slculati
Use relst ime calculation e J— 2657
: ¢ : 3452
g OTHER 3383
E S5L 1887
10 HTT 2848
11 HTT 2747
12 HTT 2548
13 HTTF 2538
14 OTHER 2385
15 HTTP 2374
-
16 uTTE 7787

3. lookup_and_add('filename’, 'ip.src', 2, false);

This call would issue a query to the server, like SELECT filename WHERE ip.src =

90.0.0.142 rather than SELECT filename WHERE service = 6667' && ip.src =
90.0.0.142 because you have specified the rule action to ignore the initial WHERE clause of the parent
rule.

The following figure shows the rule definition.
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Build Rule

Rule Type

Matwitness Platfarm DB

Loagkup and add overriding WHERE clause
Event Count w
D.ErC

Source P Address

lookup and add(*filename' ip.src’ 2 false);

Cnter a then clausa..
Column Hame Zart By
"
Total Descending
-~
L -
Save Rezetr TeztRule

The following figure shows the result set.
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2 ce 01 AR T 03 AT
Data Sour 2018 ,, 10:48:00 Lookup and add overriding... 2018 ,; 10:47:59
Admin- Concentrator v

Source IP Address Total events count
Forrnat
1.ip.sre 26810
Tabular hd
1. filename adserver 125
Time Range
= 2. filename + adbrite_iab_iframe_url + 105
ast v
2.ip.src 25325
2 ¢ Months w
1. filename online 735
¥ Use relative time calculation
2. filename bind 698
4. ip.src 23605
S.ip.src 21485
1. filename bind 43
2. filename <none> 22

The test list is in a group name netwitness, you can access that list with the following syntax.

You can even narrow down these appended results even further to only include filenames that have .gif
as filename extension by using the fifth parameter in the rule action. The fifth parameter allows you to
specify additional WHERE clause criteria. The files with .gif filename extension would be stored in
the test list within a group named DocTeamList. You can access this list with the following

syntax: threat.source = $[DocTeamList/test]

This can be referenced in the extra where clause parameter in the following manner:

4. lookup and_add('filename’, 'ip.src’, 5, false, 'filename CONTAINS $[DocTeamList/test]");
The following figure shows the rule definition.
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Build Rule
MetWitness Platform DB

Enter a then clauzs.

4
Order By Column Name Sort By
Tatal Ascending
Zgszian ~
Threshold -
Lirmit 10 o

Save Reset Test Rule

MName Infected files in network

Summarize Event Count =

Zelect ip.Erc

Alias Source |? Address

Where zervice exists

Group By insre

Then . lookup_and_add{'filename’, ‘ip.src’. 5. false, "filename CONTAINS S[DocTeamlistite...

The following figure shows the result set.
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Test Rule

e 2013 33 07:00 Infected Files In Network 2013 2 09:00
Concentrator-1 w
Format Source IP Address Total events count o
Tabular w 1.ip.src 2115
Time Range 1.filename 207
Past hd 2.filename 13
2 2 Hours o~ 3. filename 13 =
4. filename 13
3. filename 12
2.ip.src 826 R
1. filename 12
2.filename 1
3.filename .
3.ip.src 226
1. filename 24
2.filename >
3. filename 5
4. ip.src 226
1. filename 24
2.filename 2 i

5. lookup_and_add('ip.dst','ip.src', 2,true,,false);

This rule action would iterate through each ip.src in the initial result set and lookup the top two
destination IP addresses with each ip.src. The 'aggregate’ parameter is set to 'false', this implies that
aggregates would be skipped for lookup values and hence the lookup query executions will complete
faster.

Note:

The default value for 'aggregate' is 'true'. When 'aggregate' is set to 'false', Reporting Engine passes
threshold=1, Sort by='value' and Order=Ascending to NWDB to make lookup queries run faster.

. You must set the 'aggregate' to false, when rule contains aggregate functions or when the rule is run
against a wide time range. This helps the rule to complete the execution faster.

The following figure shows the rule definition.
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Build Rule

tule Type MNetWitness Platform DB
Mame Feturn non-aggregate values
Summarize Ewent Count -

ipsrc
Alias Source [P address
Where ip.dst exists
ipsrc
Then leokup_and_add{'ip.dst’.ip.src’, 2.true, false);

Enter a then clauss...

‘ ]
Order By Column Kame Sort By

Total Descending
Seszion q P

<y

Feset Test Rule

The following figure shows the result set.
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Dara Source 02 A 03 ol fis
- 2018 ,, 05:11:00 Return non-aggregate valu... 2018 4,5 05:10:59
Admin- Concentrater ¥
Source IP address Total events count =
Format |
1.ip.sre 357293
Tabular w |
Time Ranze I .
2 ip.src 158871
Pazr vl |
p.dst
2 3| |Weaks v
2.ip.ds
= lative ti lewlat
\Use relative time calculation 2. ip.sre 185120
1.ip.dst
|
4 ip.src ed352
p.dst
2. ip.ds
S.ip.src 60124
2.ip.dst
6. ip.sre 54135
| o dle -
|

max_threshold (string quantity)
max threshold (string quantity, string field)

max_threshold removes any results with a quantity that is larger than the maximum threshold quantity
from a result set. The quantity can either be in terms of count or size and it is relative to the sorting
options of the parent rule. This means that if you sort a rule by size, the rule action expects you to
specify the parameter in bytes (you can append KB, MB, GB, TB to the parameter to make size
conversion easier).

max_threshold rule can also be used to filter values based on the aggregate function values. Use the
syntax based on the type of summarization used in the rule as below:

o max_threshold(String quantity): Can be used to filter Event Count, Packet Count, and Session Size.
o max_threshold(String quantity, String field): Can be used to filter values of Custom aggregates or any

metas.

Examples:
1. max_threshold(200);

The following figure shows the result without the max_threshold argument. The output results have event
counts exceeding 200.
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. L1 o1

Data Source 2003 :: 05:30 Max_Threshold_ 2013 ,, 05:30
Conc-240 b

SLNo Source IP Address Total events count i
Format
Tabular W 1 1884 E
Time Range 2 6
Past v 3 [

B
o

10 O |Years v

5 6
s .
7 [
8 6
9 6

=]
=

1" 6
12 6
13 6
14 6
15 6
16 6
17 6

The following figure shows a the max_threshold rule action that puts a limit of 200 bytes on the output.
Any output having more than 200 bytes of data are not listed.
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Build Rule
Rule Type
Marme

Surnmarize

Group By

Order By

Seszion

Metwitness Platform DB

Max Threshold

Ewent Count -

ipsrC

Source |? address

ipsrc

Max_Threshold(200);

Enter a then clauszs.

4

Column Name Sort E}'
Total Descending
20 &

Save Reset Test Rule

The following figure shows the result when the max_threshold rule action is applied. The result

numbered 1 in the above screen capture is removed from the result.
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Data Source 2003 1 05:30 Max Threshold 2013 §1 05:30
Conc-240 v
5L No Source IP Address Total events count e
Format
Tabular v 1 6
Time Range 2 6
Past e 3 6
10 & Years v h ¢
5 6
s s
7 6
8 : s
9 6
10 &
11 G
12 ]
13 &
14 &
15 6
16 6
17 8 il

2. max_threshold(5,count(alias.host));

The following figure shows the result without the max_threshold argument. The output results have count
of alias.host exceeding 5.

Test Rule
Data Source 01 0 0z
; 2015 35 15:02 Max Threshold Initial 2015 gz 15:02
204.31-Conc v
L Source
Format Source |P Address Source Country cDestlnatlon Destination IP address User cull."mh ~
Tabular - ountry Account {alias.host)
Time Range 1 United States UInited States B15
past - 2 United States United States 424
2 S Wesks v 3 United States United States 342
MUse relative time calculation 4 United States United States 318
5 UInited States 250
Run Test
6 Ini 222
7 United States United States 220
8 United States United States 217
5 United States UInited States 21
10 United States UInited States 211
11 United States UInited States 183
12 United States United States 184
13 United States UInited States 166
W
14 United States UInited States a4
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The following figure shows a the max_threshold rule action that puts a limit of 5 on the output. Any
output having value more than 5 is not listed.

Build Rule

Aule Type

Mame

Summarize

Group By

Order By

Seszion

NetWitness Platform DB

Max Threshold Count Alias Host
Custom -
ip-sre, country.src, country.dst, ip.dst, usersrc, count{alias.host)

Source |? address

ipsrc exists

ipsrc,country.src,countny.dst,ip.dst user.src

Max_Thresheold(5.count(alias.hast]);

Enter a then clauszs...

1

Column Name ~ Sort By
countialias. host) Descending
Enter the column name. . Azcending
100000 o

Sawve Reset Test Rule

The following figure shows the result when the max_threshold rule action is applied. Any output having
value more than 5 is removed from the result.
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Tours 03 - 03
Dara Soures 2016 ,; 05:31:00 Max Threshold Count Alias... 2018 ,; 05:30:59
Admin- Concentrator b
- Source IP address Source Country e Destination [P Address | 0Ur©F USET | o netalias host)
Sarmat Country Account
Tabulsr MR United States 5
Time Range
Dast w | 2 _'_:_'_E_" United States -1
2 S Years w 3 United States 5
¥ Use relacive time caloulation
4 ndia United States 5
5 - e St s
B ____='_ United States 5
7 United States 5
g . United States 5
] ] 5
10 @il 0000 United S s -

min_threshold (string quantity)

min_threshold removes results with a quantity that is smaller than the minimum threshold quantity from a
result set. The quantity can either be in terms of count or size and it is relative to the sorting options of
the parent rule. This means that if you sort a rule by size, the rule action expects you to specify the
parameter in bytes (you can append KB, MB, GB, TB to the parameter to make size conversion easier).

min_threshold rule can also be used to filter values based on the aggregate function values. Use the
syntax based on the type of summarization used in the rule as below:

o min_threshold(String quantity): Can be used to filter Event Count, Packet Count, and Session Size.
o min_threshold(String quantity, String field): Can be used to filter values of Custom aggregates or any

metas.

Examples:
1. min_threshold(200);
The following figure shows a sample of the min_threshold query.
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Build Rule

Rule Type MetWwitness Platform DB

Mame Min Threshald

Summarize Event Lount -

Selex ipsrc

Alias Source |? address

Wihere

Group By ipsre

Then Min_Threshold{200);
Enter a ther clauszs..
L]

Drderg.-" Column Name ~ Sort By
Tatal Azcending
20 &

Save Reset Test Rule

The above figure puts a limit of 200 bytes on the output. Any output having less than 200 bytes of data is
not listed. The output with the min_threshold rule action is applied.
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Test Rule

D:*-'Sj“;“ 2003 g; 05:30 Min_Threshold 2013 g; 05:30
onc-240 v
SL Ne Source IP Address Total events count
Format
Tabular w 1 1884
Time Range
Past bl
10 3 Years w

As shown, all the values are greater than 200 bytes.
2. min_threshold(100,count(alias.host));

The following figure shows the result without the min_threshold argument. The output results have count
of alias.host below 100.

Test Rule
Data Source o1 A e 0z
- 2015 ., 16:06 Min Threshold Initial 2015 47 16:06
204.31-Conc w
Destination = count
Format Source IP Address Source Country Destination IP address User " ~
Tabular b EuunLEY Account jalla=hat]
Time Range 1 United States United States 1
Fast - 2 United States United States 1
2 % Weeks v ] United States United States 1
[# Use relative time calculation | 4 United States United States 3
5 United States United States 3
Run Test
6 United States United States 4
7 United States United States 4
8 United States United States 4
] United States United States 4
10 United States United States 4
11 United States United States 4
12 United States United States 4
13 United States United States 4
W
14 United States United States 4
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The following figure shows a the min_threshold rule action that sets the minimum limit of 100 on the

output. Any output having data less than 100 is not listed.

Build Rule

Enter a then clauss...

Qrder By Column Name

countialias.host)

Enter the column name...

Seszion

=1
L

100000

Save Resef Test Rule

L]

Rule Type Netwitness Platform DB

MNama Min Threshold Count Alias Host

Surmnmarize Custom -

Select ip.src, country.src, country.dst, ip.dst, user.src, count{alias.host)
Alias Source P address

‘Where ipsTC exists

Group By ipsrc,country_src,country.dst,ip.dst user.src

Then Min_Threshold(5.countialias.host));

sort By
Descending

Azcending

The following figure shows the result when the min_threshold rule action is applied. Any output having

data less than 100 is removed from the result.
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Sourc 03 2. : A 03 -0
Data Source 2016 ,; 05:36:00 Min Threshold Count Alias... 2018 ,; 05:35:59
Admin- Concentrator -

Destination L
Farmat Source IP address Source Country F— Destination IP Address  User countialias_ host)
¥ Account
Tabular -
1 67226
Time Range
2 28872
Past b
3 21642
2z o YWears L a United States u 21238
¥ Use relative time calculation 5 United States United States 20464
g 18045
7 United States United States 11664
2 10827
9 10827
10 U 8936
" o 2366
12 U B0s52
13 U J7ES
14 U 7658
-

Close

regex (string regex, string field)

The regex rule action applies regular expression to the result set. The following is the format of the
regex rule action:

regex(regular_expression, meta name)
Where:

o regular expression - Regular expression to match the value of the meta.

« meta name - Meta or field name on which the regex has to be applied.
For a comprehensive list of supported regex patterns, refer to
http://docs.oracle.com/javase/7/docs/api/java/util/regex/Pattern. html.
Sample regex rule action:

If you want to list filenames of all the PNG and JPEG format files from various sessions, you can write
a rule with the following regex rule action:

regex(".+.(pngljpg)", filename);

The following figure shows the rule.
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Rule Type
MNarme

Summarize

Group By

Build Rule

MetWitness Platform DE
Feg Exprazzion
Event Count -
filename

File Name

filename

regex|”.+.(png|jpg)”. filename);

Enter a then clauss..

Column Name ~

Total

- -
o o
20 o

Save Reset Test Rule

Sort By

Descending

The output with the regex rule action applied is

shown in the following figure.
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Test Rule

pea Soarce 2003 g 05:30 Reg Exp 2013 g; 05:30

onc-2& i

Format SL No Filename Mo
count

Tabular bl

1 0.jpg 2
Time Range
2
Past b

10 ¢ Years v 2

s

2
2

lose
Close

sum_count ()

Totals the quantifiers for a given result set. For example, calling a sum_count() for a rule that is sorted
by event count totals the size of all values in the result set and displays the total in place of the result set.

Example:

The following figure shows the sum_count() rule action.
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Build Rule

NetWitness Platform DB

Name Sum fields

Summarize  Event Count v

Select country.src

Alias Sum

Where country.src = 'United States','China’,'Canada’
Group By country.src

Then sum_count():

Enter a then clause...

OrderBy Column Name Sort By
Total Descending
Session 0 2

]
o
<>

Use Save Reset Test Rule
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With sum_count() rule action, the output shows the total size of all the event counts.

Diata Source

#dmin- Concentrator -
Format

Tabular w
Time Range

Past b

z o Years w

"', Uze relatve time caloulation

2016

fs  05:50:00 Sum fields 2018 7 05:49:59

Sum Total events count

otal Session_count of counory.src 2330415

sum values ()

Totals the number of values for a given result set. Use this action to display how many matches exists

for a given rule.

Example:

The following figure shows the sum_values() rule action.
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Build Rule

Rule Type MetWitness Platform DB
Mame Sum Values

summarize Event Count -
Zelect COUntry.Erc

Alias Values

Where

Group By COUntry.Erc

Then sum_values{);

Enter a then clause...

Order By Column Mame Sort By

Total Descending

Session , a
Limit .
Use Lave Reset Test Rule

The following figure shows the result with sum_values rule action.
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Data Source 2016 i 05:54:00 Sum Values 2018 3 05:53:59
Admin- Concentrator o
No of unique country.src values

Format o

1 178
Tabular o
Time Range
Past o

2 % Years v

[+ Use relative time calculation

Run Test

show_whats new()

The show whats new() rule action takes any result in a result set and filters out any value that is
available in the NetWitness meta database prior to the time frame of the currently running report. When
a report runs, NetWitness Platform determines the ID of the first session in the time range of the report.
If a value in a result set has a first session id that is greater than the first session id of the report time
frame, it did not exist in the NetWitness meta database prior to the report being run and so is new to the
NetWitness system relative to the time frame of the report.

The show_whats new() rule action is also supported for Custom Aggregate Rule. When multiple meta's
are selected in the Custom rule, the first meta is considered for filtering out the old values. See
"Example 2" below to understand how this rule action is used for Custom Aggregate Rule.

Note: The show whats new() rule action can be used only with an aggregate rule.

Examples:
1. show_whats _new() for aggregate rule with Event Count

In the following example, all the Source IP Addresses available for the past two weeks are listed.
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Test Rule

Data Source

204.31-Conc hd
Format
Tabular A

Time Range

Past w

2 5 Wesks v

[# Use relative time calculation

10

11

12

13

14

1c

2015

o0
27

12:12:59

Source IP Address

WO_SWN

2015 55

Total events count
58554
12073
5048
2258
2238
1770
1705
1634
1437
1408

1112

o9

12:12:59

W

The following figure shows the use of the show_whats new rule action to list only the new entries for

the past two weeks.
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Build Rule

Rule Type Netwitness Platform DB
Name ShowwhatsMew
summarize svent Count ™
Select ip.=sre

Alias Values

Where

ipsrc

r

show whats_new():

Enter a then clause...

Column Name Sort By
Total Descending
1 -
200 -

Use Save Reset Test Rule

The following figure lists the new entries for the past two weeks.
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Test Rule

ata Source 2018
Admin- Concentrator b
Format

1
Tabular -
2
Time Range
E]
Past A
4
2 2 |Weeks v
5
W Lize relative time calculation c
F
2
3
10
11
12
13
14
15
16

0z
19

05:56:00

Values

ShowWhatsNew

03
2018 .
Total events count

26810

SE20
5760
53z
5606
5329

AR

05:55:59

2. show_whats new() for Custom aggregate rule

In the following example, all the Source IP Addresses available for the past two weeks are listed.

Data Source
2015
204.31-Conc hd
Format
Tabular hd 1
Time Range 2
Past hd
3
2 % |Weeks ~ 4
[ Use relative time calculation 5
6
7
]
9
10
11
12
13
14
1z

o
27

12:27:35

Source IP Address

WO_SWN_aggregate

2015 5

sum{size}

12:27:35

W

The following figure shows the use of the show_whats new rule action to list only the new entries for

the past two weeks.
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Build Rule

Aule Type MetWitness Platform DB
Mame SWh_aggregate
aummarize Custom ¥
Select ip.src, sum(size)
Alias Source |2 Address
Where ip.src exists
Group By ip.src

r
Then show whats_new():

Enzer a then clause...

Order By Column Name Sort By
r r
ip-src Descending
Encer the column name... Azcending
Zeszion o 5
Threshold
Limit 2000 -
Use Save Reset Test Rule

The following figure lists the new entries of Source IP Addresses for the past two weeks.
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Data 5 02 02
ata souree 2015 o 10:41 ShowWhatsNew 2015 49 10:41
1031.126.151 - Concentra v
Format Source IP Address sum{size} s
Tabular hd 1 1788
Time Range el 1788
Past w
3 1632
2 T Days ¥ 4 1788
[¥f Usze relative time calculation 5 261084
7 596
] 66224
] 764
10 57904
11 149436
12 3095563
13 4176
14 1764
b
v aTea

The power of this feature is that it doesn't matter when the report is run in identifying values that are
new to NetWitness. The caveat with this feature is that if a data reset occurs, you will lose your data.
However, it is easy to baseline a system and identify changes and new items without a tremendous
amount of strain on the system (depending on the size of your result set).

Supported Rule Operators

The NWDB Reporting Engine data source rule syntax supports a subset of rule operators that are
supported by NetWitness Platform.

* Use an asterisk (*) as the sole operator in a rule to select all traffic.

= Equals operator

1= Does not equal operator

&& Logical AND operator

I Logical OR operator

-u Upper boundary. For example, tcp.port = 40000-u selects all TCP ports above 40000.
1- Lower boundary. For example, tep.port =1-40000 selects all TCP ports below 40000.

- The dash (-) operator only applies to numeric values. Separate the lower and upper
boundaries of the range with a dash (-). For example, tep.port = 25-443 selects all TCP
ports between 25 and 443.
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Sample Supported Queries

Respond Rule Syntax

The supported rule syntax for the RESPOND service through descriptions and examples of supported and
unsupported syntax. There is a finite set of syntax that you can use to construct rules for reports using the
RESPOND service in this release.

The Reporting Engine supports the following categories of RESPOND data source rule syntax:

o select clause
o Non-Aggregate Rule
o Aggregate Rule

o alias

o where clause

o where clause Operators

e Group By

e Order By

o Limit field

Note: List is not supported in Respond Data source rules.

Select Clause

The select clause is a comma separated list of values. For example: select alert.severity, alert.name,
count(*).

There are two types of select clause for RESPOND Rule:
o Non-aggregate rule
o Aggregate rule

Non-Aggregate Rule

When you want to define a rule without any grouping, choose 'None' in the Summarize field. In a non-
aggregate rule, you can select any number of metas in the Select clause. For example, select
alert.severity, alert.name.

Aggregate Rule

When you want to query for a specific meta and its associated aggregate value then you must use the
Aggregate rule. To get an aggregate, you must choose 'Custom’ in the Summarize field to include an
aggregate function in the Select clause. For example, select alert.severity, alert.name, count(*).

The following figure shows the Build Rule view for Aggregate Rule.
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Build Rule

Rule Type Respond DB

Mame TestScreenshot

Summarize |'&n'|e| hd

From alert -

Select alert.name, alert.severity. count{alerc.name)

Alias Mame

Where alert.marne="Brute Force Login From Same Source”

Crder By Column Mame Sort By
Encer the column name... Azcending

LI 20 +
Save Reset Test Rule

Supported Aggregate Functions

The rules on RESPOND service supports the following aggregate functions and syntax.

count
max
min
sum

avg
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Note: The aggregate functions must be added in the end of a select clause for aggregate query. For
example, alert.name, alert.severity, sum(alert.numEvents). By default, a maximum of 10,000 rows
results are fetched and this can be configured using the rsa.response.query.QueryProperties.

Examples of select Clause Syntax

The following table provides examples of the select Clause Syntax.

s o

select Select specific metas from an RESPOND Data Source (Y ou must
columnl separate each column with a comma.).

b
column2 column3, ... ,columnN

Examples of Supported Select Queries
select alert.name, alert.numEvents, count(alert.numEvents)
select alert.severity, avg(alert.severity)

select alert.timestamp, incidentCreated where alert.timestamp >= 1475658011

Summarize

Summarize determines the type of summarization or aggregation for the rule.

m Config Value

Summarize To query metas without any custom grouping, select:

e None:

To get meta based aggregates, select:

o Custom: This indicates that expected meta aggregate function is defined in rule select
clause.

Alias

Some meta names may not be descriptive, in this case description can be added in the the alias field to
make column names more readable. For example, SELECT: alert.severity, alert.name, count(*)
ALIAS: Alert Severity, Alert Name

In the alias field you can enter a name for columns used in the select clause. If you do not specify the
alias for one of the field in the select clause, then the default description will be used. For example, if
the select clause has Fieldl,Field2,Field3,Field4, and alias has only Fieldl, ,Field3,Field4, then for
Field2 a default description is used.

Where Clause

The where clause is a language field values and ranges that is used by RESPOND function. In the where
clause, string values have to be enclosed within single quotes.
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T

alert.host summary = For TEXT or string type data, enclose the string or text in single or double
(Primary) Link status  quote. If there is any special character such as an apostrophe within the data
"Down'" on interface  then you need to add an additional single or double quotes. For example,

INTNAME.' alert.name = ’top alerts from Cote d"Ivoire'.
alert.timestamp >= For Date and Time (date/timestamp data type columns), use the
1475658011 EPOCH syntax.

Supported Where Clause Operators

= (equals) columnl = 'value'
!= (does not equal) columnl \="value'
> columnl > value'
>= columnl >="value'
< columnl < 'value'
<= columnl <= "'value'
Group By

N

group by : alert.severity, alert.timestamp, RESPOND picks the metas for Group By field from the
incidentCreated selected Select clause automatically.

Note: Group by field is enabled for
Aggregate queries and are not editable.

Order By

Order By determines how to sort the result set and is not case sensitive.
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Column Name The Column Name is the name of the
columns by which you want to sort the
results. By default, the value is empty.
When you click on a column, the value
gets populated based on the Summarize
field.

o order by alert.name asc
« order by incidentCreated desc
o order by count(numEvents)

« order by status

Sort By Sort By determines the order in which
you want to sort the results such as
ascending or descending.

Note: For all queries, it is mandatory
for you to select the order by field.

Limit field

This indicates the limit to be put on the query while fetching data from the database. If a result set is
sorted by event count, packet count, or session size, the limit represents the top (or bottom) N values to
be returned. If the result set is not sorted, the first N values are returned.
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Warehouse DB Simple Rules Syntax

The section explains the simple rules query syntax and examples.

The following examples illustrate simple rules in the default mode:

All Event Categories Report

Attacks Event Categories Report

Source: China Event Categories Report

IP Source and Destination Event Categories Report
Time Threat Categories Report

Array Query Report

Raw Log Query Report

All Event Categories Report

This rule fetches all event categories, source country, and destination country from the sessions table by
defining alias names (temporary column names) for each of the fields to be fetched from the table, that
is, country_src for the source country, and country_dst for the destination country.

Build Rule
Rule Type ‘Warehouze DB
Expert Mode
Mame All Event Categories
Select country_src, country_dst
From zessions W
Alias country_src, country_dst
Where country_src IS MOT NULL AND country_dst IS NOT MULL
Group By country_src, country_dst
Having
Order By Column Name Sort By
Enter the column name._.. Ascending
Limit 20 2
Use Save Reset Test Rule

The following figure shows the result set of the All Event Categories rule.
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o Bo=® B

All Event Categories
Generated on - 2014-09-02 09:38

Sl
2014 & 00:00

event_cat_name

| Page 1 ofa | » M |

Time Range

All Risk Suspicious By Destination IP / NWAPPLIANCE11244 - Decoder

countey_sec

2014 % 09:00

country_ast

Displaying 1 - 15 of 50

Tuesday
September 2, 2014
< September2014 - o
S M T w T F s

'

Reports
Time

09:38

Attacks Event Categories Report

This rule fetches the event categories, source country, and destination country from the sessions table by
defining alias names (temporary column names) for each of the fields to be fetched from the table and
selecting only those columns whose event category name like 'Attacks.%'.

Build Rule
Rule Type Warehousze OB

Expert Mode

Group By
Having
Crrder By Column Mame
Enter the column name..
Limit 20 s

Mame Artacks Event Categories

Select event_cat_name, country_src, country_dst

From ezzionz -~

Aliaz EvEnt_C3t_Name, country_src country_dst

Where event_cat_name |5 NOT MULL AMD country_sre IS MOT MULL AMD country_dst 15

MOT MULL AMD event_cat_name LIKE ‘Attacks. %"

Event_cat_name, country_src c:}untry_:lst

Sort By

Azzending

Test Rule

The following figure shows the result set of the Attacks Event Categories rule.
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=8 = 0
Attacks Event Categories

enerated on - 2014-09- NETWITNESS
Generated on - 2014-09-02 10:28 R SA PLATFORM

2014 g3 | 08:00 Time Range 2014 | g3 10:00

Attacks Event Categories /

event cat_na

| Page [1 (ofa | > 2 | Displaying 1 - 15 of 50

0 Tuesday
September, 2014

< September 2014 - >

S M T w T F s
1
Reports

Time

1029

Source: China Event Categories Report

This rule fetches the event categories, source country, and destination country from the sessions table by
defining alias names (temporary column names) for each of the fields to be fetched from the table and

selecting only those columns whose source country is 'China'.

Build Rule
Rule Type Warehouse DB

Ezpert Made [

Mame Source: China Event Categories

Select event_cat_name, country_src, country_dst

From zessions -

Alias SVENt_Cat_name. country_src, country_dst

Where event_cat_name |5 NOT NULL && country_srg 15 MOT NULL 22 country_dst IS NOT

MULL && country_src = "China’

Group By event_cat_name, country_src, country_dst
Having
Order By Column Name sart By

Enter the column name...

i
i

ending

ﬂ Sawve Reset Test Rule

The following figure shows the result set of the Source: China Event Categories rule.
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= 850

Event Categories - Source China NETWITNESS

Generated on - 2014-09-11 07:05 PLATFORM
2014 g 00:00 Time Range 2014 % 00:00

Source: China Event Categories /

event_cat_name country_src country_dst

bW N -
i

s e —————

12 Attacks.Access.Informational

Page 1 of1 Displaying 1-12 of 12

IP Source and Destination Event Categories Report

This rule fetches the IP address of source and destination country from the sessions table by defining
alias names (temporary column names) for each of the fields to be fetched from the table and selecting
only those columns whose destination country is NOT NULL.

Build Rule
Rule Type ‘Warehouse DE
Expert Mode
MName Destination Country By |P Source
Select ip_src, country_dst
From Sessions -
Alias ip_src, country_dst
Where device_class IS WULL && country_dst 15 NOT NULL
Group By country_dst, ip_src
Having
Order By Column Name Sort By
Enter tha calumn nama... Ascending
Lirnit =] fo-
Use Save Reset Test Rule

The following figure shows the result set of the IP Source and Destination Event Categories rule.
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o 85 B

Destination Country By IP Source
Generated on - 2014-09-11 07:29

2014 9 o00:00 Time Range

Destination Country By IP Source /

ip_src

= 20w N

]

| Page 1 |ofa | > 2 |

RSA

country_ast

NETWITNESS'
PLATFORM

2014 5 00:00

Displaying 1 - 15 of 50

Time Threat Categories Report

This rule fetches the threat category events, the time the log or event was ingested into Log
Decoder/Decoder, and the source IP addresses from the sessionstable by defining alias names
(temporary column names) for each of these fields to be fetched from the table.

Build Rule
Rule Type Warehouse DB

Ezpert Made

MName by Time Threat Categaories

Select time, threat_category, ip_src

From SESSIOnS -

Alias time, threat_category, ip_src

Where device_class IS5 NULL

Group By time, threat_category, ip_src

Having

Order By Column Name Sort By
Enter the column name... Ascending

Limit 20 o

E Sawve Reset Test Rule

The following figure shows the result set of the by Time Threat Categories rule. The time displayed in

the time field is the UNIX time (For example, 1388743446).
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Note: In the “Select” clause the syntax would be “UNIX time” to convert to UTC time in report. For
example, you can use the Epoch time converter tool to convert UNIX time (1388743446) to UTC
(Coordinated Universal Time) (1/3/2014 3:34:06 PM).

o8- =B

Threat Categories - By Time

Generated on - 2014-00-11 07:44

2014 5}  00:00

by Time Threat Categories /

time
16 1388743446
17 1388743446
18 1388743446
19 1388743446
20 1388743446
21 1388743446
22 1388743446
23 1388743446
24 1388743446
25 1388743446
26 1388743446
27 1386743446
28 1388743446
29 1388743446
20 1288742446

€« € | Page 2 of 4 > |

threat_category

Time Range

NETWITNESS
PLATFORM

2014 o} | 00:00

Displaying 16 - 30 of 50

Array Query Report

This rule fetches an array of alias host names from the sessions table which contains the

value 'www.google.com'.

Build Rule
Rule Type ‘Warehouse DE

Expert Mode (m

MName arrsy_contains query
Select alias_host

From Sessions -
Alias

Where array_contains{alias_host, "
Group By

Having

Order By Column Name

Enter tha column name...

Limit 100 o

Use Save Reset

Test Rule

sort By

Aszcending

The following figure shows the result set for querying an array from sessions.
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a8 =2

ARRAY_CONTAINS

Generated on - 2014-00-11 07:55

2014 ,,  00:00 Time Range

array_contains query [

alias_host

age 1 of 7 > »

RSA

NETWITNESS
PLATFORM

&
0

2014 | 53 | 0000

aying 1-15 of 100

Raw Log Query Report

Raw logs can be queried either from the logs or sessions table.

This rule uses raw_log as a meta for querying raw log from logs whose packet ID is NOT NULL.

Build Rule
Rule Type ‘Warehouse DE

Expert Mode

MName raw_|log - Rule

Select raw_|og

From logs -

Alias

Where packetid 15 NOT NULL

Group By

Having

Order By Column Name Sort By

Enter the calumn name... Ascending

Limit 50 o

Use Sawe Reset Test Rule

The following figure shows the result set for querying raw logs from logs.
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=80-=50

RAW LOG FROM LOGS

Generated on - 2014-09-11 08:08

2014 | & 00:00

raw_log - Rule /

raw_log

Time Range

NETWITNESS
PLATFORM

2014 | 53 00:00

This rule uses ${raw_log} as a meta for querying raw log from sessions whose source IP address is

NOT NULL.

Build Rule

Rule Type Warehouse DB

Expert Mode (|

Mame 4{raw_log}-Rule

Select ${raw_log))

From sessions -
Alias

Where ip 5rc IS NOT NULL
Group By

Hawing

Order By Column Name

Lirnit 50

<

Use Sawe Reset

Enter the column name...

sort By

Ascending

Test Rule

The following figure shows the result set for querying raw logs from sessions.
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o8- =B
$(RAW_LOG)
Generated on - 2014-09-11 08:23

2014 3% | 00:00 Time Range

$(raw_log)-Rule /

raw_log

NETWITNESS
PLATFORM

2014 | 37 | 00:00
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Warehouse DB Advanced Rules Syntax

The section explains the advanced rules query syntax and examples.

General Syntax of an Advanced Rule

The following figure shows how to define an advanced query.

Meta
Build Rule
NFS_LD111 -
Rulz Type Warehouse DB
b 4
Expert Mode [
[a: .
Mame Expert-Threat Categories: By Time (Time variable)
access_point |:
Query [DROP Table IF EXISTS sessi - acCesses
JCREATE External TABLE T
ROW FORMAT i asian
ale
................................................. alert_id
alias_ho
-
alias_ip
4 | »
Lists
. X
type""string”, "null"], "default™:"null"},
ing”, "null"], "default""null"}, = ~
:_class", "type":["string". "null"]. "default""null"} ¥= Inzert T o
0[] Compliance i
8 [ Filtering Candidate
................... = i Local_Country
- . -
§ireport andtimal B[] Logs
Alias Time, Threat Category, IF Source 0] Metwork Activity
B[] Per User Report
\:I Save Reset Test Rule o -
4| >

The following syntax is an example of an advanced query:

DROP Table IF EXISTS sessions21022014;

CREATE External TABLE sessions21022014

ROW FORMAT SERDE ‘org.apache.hadoop.hive.serde2.avro.AvroSerDe’
STORED AS INPUTFORMAT

'org.apache.hadoop.hive.gl.io.avro.AvroContainerInputFormat'
OUTPUTFORMAT 'org.apache.hadoop.hive.gl.io.avro.AvroContainerOutputFormat'

LOCATION '/RSA/rsasoc/vl/sessions/data/2013/12/2'

TBLPROPERTIES ('avro.schema.literal'="
{

"type":"record";
"name":"nextgen";

"fields":
[

{"name":"time", '"type":["long"”, "null"], "default'":"null"},

{"name":"threat category", "type":["string", "null"], "default":"null"},
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{"name":"ip src", "type":["string", "null"], "default":"null"},

{"name":"device class", "type":["string", "null"], "default":"null"}
]
"}i

set mapred.input.dir.recursive=true;

set hive.mapred.supports.subdirectories=true;

select from unixtime (time), threat category, ip.src from time variable where
threat category isnot NULL and time >= ${report starttime} and time <= S${report
endtime};

Note: Reporting Engine treats a line beginning with <hyphen> <hyphen> as a comment in Expert
Warehouse Rule.
For example,
set mapred.input.dir.recursive=true;
-- This is an Expert comment
set hive.mapred.supports.subdirectories=true;

The general syntax of an advanced query is as explained below:

1. Drop and create an external table, and then format the row:
Firstly, we drop the table, if the table already exists and create an external table sessions21022014
DROP TABLE IF EXISTS sessions21022014
CREATE EXTERNAL TABLE sessions21022014

Note: You must create an external table only if you are using an other table. For example, if you
are using an other table apart from sessions21022014 then you must drop the table and create an
external table.

Then, specify the row format as Avro.SerDe interface to instruct HIVE as to how a record is to be
processed. Avro.SerDe allows you to read or write Avro data as HIVE tables and store them as input

format and output format.

ROW FORMAT SERDE 'org.apache.hadoop.hive.serde2.avro.Avro.SerDe'

STORED AS INPUTFORMAT
'org.apache.hadoop.hive.gl.io.avro.AvroContainerInputFormat'

OUTPUTFORMAT 'org.apache.hadoop.hive.gl.io.avro.AvroContainerOutputFormat'

2. Specify the HDFS location:

Secondly, you must specify the HDFS location '/RSA/rsasoc/v1/sessions/data/2013/12/2' from where
the data is queried before executing the HIVE statements.The location parameter specifies the data
to be fetched depending on the date input provided. This is a variable parameter hence you can fetch
values depending on the date entered.

3. Define the table schema:
Thirdly, you define the table schema by defining columns with a specific data type and default value
as 'null'.
TBLPROPERTIES ('avro.schema.literal'="
{"type":"record";

"name":"nextgen";

"fields":

[

{"name":"ip src", "type":["string", "null"], "default":"null"}
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]
"}i
Import data from directory which contains sub directories:
Then, you must enable HIVE to recursively scan all sub-directories and fetch all the data from all

sub-directories.
set mapred.input.dir.recursive=true;
set hive.mapred.supports.subdirectories=true;

Fetch data from the HIVE table:
Once you execute all the above statements, you can query the database with the HIVE
query select clause to fetch the data from the HIVE table.

The following examples illustrate advanced rules in the expert mode:

Hourly, daily, weekly, and monthly report
Table partition based on location report

Join logs and sessions based on unique id report
List report

Parameterized report

Partition based table with multiple locations

Automated partition using custom function (10.5.1 onwards)

Hourly, Daily, Weekly, and Monthly Report

In these example rules, you can create various reports for December 02, 2013 (as in the below figure).
The date variable in the LOCATION statement can be altered, depending on which you can
create an hourly, daily, weekly, and monthly report.

Hourly Report

In this example rule, you can create an houly report for December 02, 2013. The LOCATION statement
can be altered to generate an hourly report.

LOCATION '/RSA/rsasoc/vl/sessions/data/2013/12/2' - the date input (2013/12/2) indicates
year/month/day. The entire data for 02 December, 2013 is retrieved using this location statement.
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Schedule Report

Enable 4
Report Mame Al Event Categories
Schedule Mame |Hourly Report

Warehouse DB | NF5_LD111

Run Hourly

On Past

Variables Nowvariables defined
) Oulpul ACtione

w) Loge

| At Minute

ENE

~| |12 2 |Hours || [] Use relative time calculation

Previous m Reset | & Configure

The result set of this query would be an hourly report.

Daily Report

In this example rule, you can create a daily report for December 2013. The LOCATION statement can
be altered to generate a daily report.

LOCATION '/RSA/rsasoc/vl/sessions/data/2013/12' - the date input (2013/12) indicates year/month.

The entire data for December, 2013 is retrieved using this location statement.

Schedule Report

Enable [+
Report Mame All Event Categories
Schedule Mame |Daily Repart

Warehouse DB | MFS_LD111

Fun Daily

On Past

Wariables Mo wariables defined
) Output Actions

w) Loge

Frevious Schedule Reset | 4% Configure

2 & Hours |w|[] Us= relative time calculation

The resultset of this query would be a daily report.

Weekly Report

In this example rule, you can create a weekly report for December 2013. The LOCATION statement
can be altered to generate a weekly report.

LOCATION '/RSA/rsasoc/vl/sessions/data/2013/12' - the date input (2013/12) indicates year/month.

The entire data for December, 2013 is retrieved using this location statement.
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Schedule Report

Enable I
Report Mame AllEwentCategories

Schedule Name |Weekly Report

Warehouse DB |NF5_LD111 -
Run Weekly w AT -
™ sunday [ Monday [ Tuesday [ Wednesday
[] Thursday [[] Friday [] Saturday
On Past ~| |2 2 Hours |w| [ Use relative time calculation
Variables Nowvariables defined
) Outpul At

v Loge

Previous Schedule Reset | |&F Configure

The result set of this query would be a weekly report.

Monthly Report

In this example rule, you can create a monthly report for the year 2013. The LOCATION statement can

be altered to generate a monthly report.

LOCATION '/RSA/rsasoc/vl/sessions/data/2013' - the date input (2013) indicates year. The entire

data for the year 2013 is retrieved using this location statement.

Schedule Report

Enable [+
Report Mame AllEventCategories

Schedule Mame |Monthly Report

Warehouse DB | MFS_LD111 -
Run Monthly «| Day (1 &| At [12:30 b4
On Past w2 o Hours |« ¥ Use relative time calculation
Variables Mo wariables defined
) Oulpul Actiods
v Logd

Previous Schedule Reset | |4 Configure

The result set of this query would be a monthly report.

For more information on LOCATION definition, see Specify the HDFS location in the "General

Syntax of an Advanced Rule" section.

Y ou must perform the following steps in sequence to view the resultset of an advanced rule:

1. Define an Advanced Rule
2. Add an advanced rule to a Report
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3. Schedule a Report
4. View a scheduled Report

The following figure shows how to define an advanced rule.

Meta
Build Rule
- P
Warehouse DB NFSLD1 v
Expert Mode X
Name Expert-Threat Categories: By Time {Time variable) a5 -
Query DROFP Table IF EXISTS sessions21022014; access_point |:|
CREATE External TAE acresses
CLeSSEs
ROW FORMAT i
action
alert
alert_id
alias_host
. -
alias_ip
4 3
ictc
", "default™"null"}, Lists
Y] ing”. "null"]. "default™"null"}, X
tring”, "null”], "default":"null"},
e ["string”, "null"] "default™"null"
pe":["string™, "null"]. "default":"null"} = Insart ET
@[] Compliance a
! om time_variable where 0[] Filtering Candidate
threat_category  NULL AND time >= ${repo me} AND time <= —
${repo = Local_Country
Alias Time, Threat Category, IP Source ag Logs
&[] Network Adctivity
Use Save Reset Test Rule &[] Per User Report
[} -
< ’
The following figure shows how to add an advanced rule to a report (For
.
example, AllEventCategories).
. T
AllEventCategories RSA NETWITHESS ext m
Header 1 H1
=] Expert-Threat Categories: By Time (Time variable) v (€] A H2
Header 3 H3

Headerd

Table of Contents
Body Text =

Comment [---]

Schedule Save

The following figure shows how to schedule a daily report.
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Schedule Report

Enable [+
Report Mame All Event Categories

Schedule Mame |Daily Report

Warehouse DB | MFS_LD111 -
Run Daily = | Ar | 12:30 b4
On Past | |2  &|Hours |w| [ Use relative time calculation
Variables Mo wariables defined
) Dutput Actions

) Loge

Previous Schedule Reset | 4% Configure

If you want to generate a report for a specific time range, you need to manually define the time range in
the query using the following two variables:

${report starttime} - The starting time of the range in seconds.
${report endtime} - The ending time of the range in seconds.

For example, SELECT from unixtime (time), threat category, ip.src FROM time
variable WHERE threat category is not NULL AND time >= ${report starttime}
AND time <= ${report endtime};

The following figure shows the result set of scheduling a daily report.

=852

Expert-Threat Categories (By Time) NETWITNESS

Generated on - 2014-09-11 11:10 PLATFORM
2014 | §%  00:00 Time Range 2014 | §%  00:00

Expert-Threat Categories: By Time (Time variable) /

Time

malware

8 malware
& malware
o malware
malware

malware

13 malware

malware

= malware

Table Partition Based on Location Report

In this example rule, you can create a table partition based on location. Each table can have one or more
partition keys which determines how the data is stored. For example, a country dst of type STRING and
an ip_src of type STRING. Each unique value of the partition keys defines a partition of the table.

In the example provided, we execute a HIVE query to fetch destination country and IP address of source
from the sessions05032014 table and group the result set by these fields.
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This rule provides information about the table created, row formatted, location (directory path) for avro
data files in Warehouse, and returns a result set as per the HIVE query to indicate that the query
returned a result set. For more information on these statements, see "General Syntax of an Advanced

Rule" section.

Build Rule

Rule Type Warehouse DB

Expert Mode [

Mame Expert - Group By Destination Country

Query DROP Table IF EXISTS
CREATE External TABLE ;
ROW FORMAT SE

"fields":
[
{"name""ip_src", "type":["string”. "null"], "default":"null"},

{"name”:"country_dst", "type":["string", "null"], "default®:"null"}
1
%
select country_dst, ip_src from sessi
country_dst is not null group by country_

4where jp_src iz not null and

Alias

ﬂ Save Reset Test Rule

Meta

MNFS_LD111 ~

access_point |:|

3CCesses
action
alert
alert_id
alias_host
alias_ip

4

Lists

Filter *

= Insert = o ome

B[] Compliance "
a[JF Itering Candidate

i Local_Country
B[ Logs
B[] Metwork Activity
&[] Per User Report

O -

4| »

The following figure shows the result set of creating a table partition based on location report.

o8- =B

Destination Country By IP Source

Generated on - 2014-08-11 11:27

2014 % 09:00 Time Range

Expert - Group By Destination Country /

ip_src

[ RV T R SR VI

W h @ N = o

| Page 1 ofa | » P |

NETWITNESS
PLATFORM

2014 | % | 11:00

Displaying 1 - 15 of 50

Join Logs and Sessions Based on unique_id Report
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In this example rule, you can create a rule to join logs and sessions table to fetch unique_id, IP address

of source and destination, and packet ID based on unique id.

In the example provided, we execute a HIVE query to fetch certain fields from both the sessions_table

and logs_table by performing a join based on the 'unique id' field.

This rule provides information about the table created, row formatted, location (directory path) for avro
data files in Warehouse, and returns a result set as per the HIVE query to indicate that the query
returned a result set. For more information on these statements, see the ""General Syntax of an

Advanced Rule" section.

id Meta
Build Rule
MFS_LDT11 o]
Rule Type Warehouse DB
Fi b4
Expert Maode I
as -
Mame ExpertRule-Join )
access_point |:
Query DROP Table IF EXIZTS SCCEESES
CREATE External TABL .
ROW FORMAT SERDE acten
STORED A5 N -
alert_id
alias_host
- -
alias_ip
4 ]
P
"rype":[Mlong", "null7], "default™: " null"}, Ll sts
tring”, "null"], "default":"null "}, i x
#Z Inzert = fo i - 25
&[] Compliance a
select s.unique_it 3! & [ Filtering Candidate
OM (s.unigue_id = Lunigue —
= Local_Country
4 »
B[ JLogs
Alias B ] Network Activity
B[ Per User Report
Save Reset Test Rule
(] -
< | | »
The following figure shows the result set of joining logs and sessions table based on unique id.
=80-=0
ExpertRule-Join
cerrcdon. 244011 12 R S A NETWITNESS
2014 9% 22:00 Time Range 2014 % 11:00
ExpertRule-Join [
unique_id ip_src ip_dst packetid
1 000000B285041EE20000511A0000536E 78970880
2 00000182DC0421E20000511A000053BE B1526784
3 000002B28D041BE2000051 1ADODOSIBE 76348440
4 000009B82C2041FE20000511A0D0053BE 79822848
5 00000AB2670418E20000511A000053BE 73859072
-] 00000CB2F70423E20000511AO000053BE B3206256
7 00000EB25A0417E20000511A0000538E 73007104
8 0000128286041 EE20000511A000052BE 79036416
9 000018B28E041BE20000511A000053BE 76414976
10 00001AB298041CE2000051 1A40000538E 77266942
11 00001AB2DD0421E2000051 1 ADDO0S3BE 81592320
12 00001 CB2C3041FE20000511A000053BE 79888384
12 00001 CB2FB423E20000511A000053BE 83361792
14 000022B2580417E2000051 1 AODOOS3BE 73072640
15 000024B2D10420E20000511A000053BE 80805888
| Page 1 of4 1 » M | Displaying 1 - 15 0f &
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List Report

In this example rule, you can create a List report to fetch IP address of source and destination, and
device type from the lists_test table where device type is not null and IP address of source is fetched

from the appropriate event list.

This rule provides information about the table created, row formatted, location (directory path) for avro
data files in Warehouse, and returns a result set as per the HIVE query to indicate that the query
returned a result set. For more information on these statements, see the "General Syntax of an Advanced

Rule" section.

Build Rule
Rule Type Warehouse DB

Expert Mode 4

MMeta
NFS_LD111

05

2014 §;  00:00

ExpertRule-Lists /

IP Source

nmp N =

I Page |1 of 1 |

Time Range

IP Destination

Country Source
netscrean
netscreen
netscreen
netscreen

Nnetscreen

Mame Expert Rule - Lists access point |:|
Query DROP Table IF EXISTS lists_test; ACCESSES
CREATE External TABLE lists_test :
ROW FORMAT org. he. action
alert
alert_id
alias_host
. -
aliaz_ip
4 3
Lists
X
4= Insert = fo K - JC
@[] Compliance -
@[] Filtering Candidate
= Local_Country
B[] Logs
Aliaz |IP Source. IP I:es:inatichr| B[] Network Activity
B[] Per User Report
Use Save Reset Test Rule o
-
4 | v
The following figure shows the result set of executing a list report.
o8 =2
ExpertRule-Lists R S A NETWITNESS
Generated on - 2014-09-11 1201
PLATFORM

2014 | §] 00:00

Displaying 1 - 5 0of 5

Parameterized Report
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In this example rule, you can create a rule to fetch IP addresses of source and destination, and device
type from the runtime_variable table based on the specified run time

variable $ {EnterIPDestination}. Atrun time, you are prompted to enter a value for the [P address
of destination ip_dst. Based on the value entered, the result set is displayed.

This rule provides information about the table created, row formatted, location (directory path) for avro
data files in Warehouse, and returns a result set as per the HIVE query to indicate that the query
returned a result set. For more information on these statements, see the "General Syntax of an Advanced
Rule" section.

Meta
Build Rule
MFE_LOT11 -
Rule Type Warehouse DB
x
Expert Mode ¥4 .
5 .
MName Expert - Run Time Variable
access_paint |_|
Query DROFP Table IF EXISTS runtime variable; accesses
CREATE External TABLE 1y _variable .
ROW FORMAT | action
alert
nerQutputFormay alert,id
alias_hos
............... =
alias_ip
1 4
Lists
g "rype":[Mlong", "null?), "default™"null"}. . %
""device_type", "type":["string”. "null"], "default":"null"},
"type":["string”, "null"], "default":"null™
i wype":["string”, "null"], "default 1 3 Insert & o8
o] Compliance -
@[ JFiltering Candidare
IE Local Country
a7l o5
Alias IP Source, IP Destination, Device Type o[ Newvork Activity
E‘.ID Par Liser Repart
Use Save Reset Test Rule
(| -
< | v
The following figure shows the result set of executing a parameterized report.
=H8H-= 2
Expert - Run Time Variable
Generated on - 2014-09-11 1214
2014 % o000 Time Range 2014 % | 00:00
Expert - Run Time Variable /
1P Source 1P Destination Device Type
1 netscreen
2 Nnetscrean
=3 nNnetscreen
I Page 1 of 1 | | Displaying 1 - 3 of 3

Partition Based Table with Multiple Locations

The following is an example of partition based table with multiple locations:
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set mapred.input.dir.recursive=true;

set hive.mapred.supports.subdirectories=true;

DROP TABLE IF EXISTS AVRO COUNT;

CREATE EXTERNAL TABLE AVRO COUNT

PARTITIONED BY (partition id int)

ROW FORMAT SERDE 'org.apache.hadoop.hive.serde2.avro.AvroSerDe'
WITH SERDEPROPERTIES (

'avro.schema.literal'="/{

"name": "my record", "type": "record",

"fields": [

{"name" :"sessionid", "type":["null", "long"], "default" : null},
{"name":"time", "type":["null", "long"], "default"™ : null}

!

)

STORED AS

INPUTFORMAT

'org.apache.hadoop.hive.gl.io.avro.AvroContainerInputFormat'
OUTPUTFORMAT
'org.apache.hadoop.hive.gl.io.avro.AvroContainerOutputFormat';
ALTER TABLE AVRO COUNT ADD PARTITION (partition id=0) LOCATION
'/rsasoc/vl/sessions/data/2015/07/22/8";

ALTER TABLE AVRO COUNT ADD PARTITION (partition id=1) LOCATION
'/rsasoc/vl/sessions/data/2015/07/22/9";

ALTER TABLE AVRO COUNT ADD PARTITION (partition id=2) LOCATION
'/rsasoc/vl/sessions/data/2015/07/22/10/";

ALTER TABLE AVRO COUNT ADD PARTITION (partition id=3) LOCATION
'/rsasoc/vl/sessions/data/2015/07/22/11/";

ALTER TABLE AVRO COUNT ADD PARTITION (partition id=4) LOCATION
'/rsasoc/vl/sessions/data/2015/07/22/12/";

SELECT COUNT (*) as TOTAL FROM AVRO COUNT WHERE time >= ${report_
starttime} AND time

<= ${report endtime};

The partition based table with multiple location is as explained below:

1. Enable HIVE to recursively scan all sub-directories and read all the data from the sub-directories.
set mapred.input.dir.recursive=true;
set hive.mapred.supports.subdirectories=true;

2. Drop and create an external table, and then format the rows:
DROP TABLE IF EXISTS AVRO COUNT;
CREATE EXTERNAL TABLE AVRO COUNT
PARTITIONED BY (partition id int)
ROW FORMAT SERDE 'org.apache.hadoop.hive.serde2.avro.AvroSerDe'
WITH SERDEPROPERTIES (

'avro.schema.literal'="{

"name": "my record", "type": "record",

"fields": [

{"name":"sessionid", "type":["null", "long"], "default" : null},
{"name":"time", "type":["null", "long"], "default" : null}

IS
)
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STORED AS

INPUTFORMAT
'org.apache.hadoop.hive.gl.io.avro.AvroContainerInputFormat'
OUTPUTFORMAT
'org.apache.hadoop.hive.gl.io.avro.AvroContainerOutputFormat';

Note: You must create an external table only if you are using any other table. For example, if
you are using any other table apart from AVRO_COUNT then you must drop the table and
create an external table.

Note: Points to remember when you create a table:

- Dropping a 'non-external' table deletes the data.

- The table is partitioned on a single column called partition id and this is the standard column
for Reporting Engine.

- The default value of any column is null as the AVRO file may not contain the specified
column.

- The column names should be in the lowercase as HIVE is case insensitive but AVRO is
case sensitive.

- You must specify avro.schema.literal in the SERDEPROPERTIES .

For more information on the "rule syntax", refer to Apache HIVE.

3. Add partitions:

Once you define a table, you must specify the HDFS locations from where the data needs to
be queried before you execute the HIVE statements. The location parameter specifies the data to be
fetched depending on the specified date. The data is spread across multiple locations or directories in
HDFS. For each location you need to add a partition with unique values assigned to the partition
column. The locations can be any directory in the HDFS

ALTER TABLE AVRO COUNT ADD PARTITION(partition_id=0) LOCATION
'/rsasoc/vl/sessions/data/2015/07/22/8";

ALTER TABLE AVRO COUNT ADD PARTITION(partition_id=l) LOCATION
'/rsasoc/vl/sessions/data/2015/07/22/9";

ALTER TABLE AVRO COUNT ADD PARTITION(partition_id=2) LOCATION
'/rsasoc/vl/sessions/data/2015/07/22/10/";

ALTER TABLE AVRO COUNT ADD PARTITION (partition id=3) LOCATION
'/rsasoc/vl/sessions/data/2015/07/22/11/";

ALTER TABLE AVRO COUNT ADD PARTITION (partition id=4) LOCATION
'/rsasoc/vl1/sessions/data/2015/07/22/12/";

Note: HIVE reads each file in these locations as AVRO. Incase if there is a non-AVRO file
available in one of these locations then the query may fail.

4. Run the query
SELECT COUNT (*) as TOTAL FROM AVRO COUNT WHERE time >= ${report
starttime} AND time
<= S{report endtime};
When a table is created, you can execute specific queries to filter the data. For example, after you
create the table you can filter the data as shown in the below examples:
Sessions with a specific Source IP Address:
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SELECT * FROM AVRO COUNT WHERE time >= S report starttime} AND
time <= ${report endtime} AND ip src = '127.0.0.1";

Group by based on user destination:

SELECT * FROM AVRO COUNT WHERE time >= S{report starttime} AND
time <= ${report endtime} GROUP BY usr dst;

Automated Partition using Custom function

In 10.5.1, you can use the custom function to automate the addition of partitions to a user defined table in
the expert mode.

General syntax

RE WH CUSTOM ADDPARTITIONS (table, namespace, rollup, [starttime,
endtime])
The following table describes the custom function syntax:

N

1 table The table name for which the partition has to be added.
2 namespace The namespace can be sessions or logs.
3 rollup This value determines the level of directory path to be included in partitions. The

value can be HOUR, DAY, or MINUTE. If Warehouse Connector is configured
for Day rollup, setting this value as HOUR produces ZERO results. The number
and location of each partition is based on time range used to run the rule and the
rollup value.

4 (Optional)  To generate partitions for a specific time range other than the time range
starttime,  mentioned in the rule, you must specify the starttime and endtime in Epoch
endtime Seconds.

Note: Expressions are not supported for the starttime and endtime.

The custom function is invoked when Reporting Engine executes the rule either during test rule or
scheduled report. While running a expert rule, whenever Reporting Engine identifies the function

declaration, it extracts the required

arguments and insert 7 number of ADD PARTITION HiveQL statements and executes them on

the Hive Server.

The location and directory structure is determined by the argument passed in the rule and the Hive
datasource configuration

in Reporting Engine. The number of partitions depends on the rollup specified and the time range used
while executing the rule. For example, with the rollup as HOUR and the time range as PAST 2 Days
results in 48 partitions for 48 Hours while

with the rollup as DAY, Reporting Engine creates 2 partitions, one for each day.

The partition query is generated by the Syntax Template as set in Reporting Engine's Hive Configuration
attribute AlterTableTemplate.

Note: By default, this function starts adding partitions to a table with partition id from 0 to N-1. Hence
this requires that the table must be partitioned by single integer column named partition id.
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The following is an example of automated partition using custom function:
set mapred.input.dir.recursive=true;
set hive.mapred.supports.subdirectories=true;
DROP TABLE IF EXISTS AVRO COUNT;

CREATE EXTERNAL TABLE AVRO COUNT

PARTITIONED BY (partition id int)

ROW FORMAT SERDE 'org.apache.hadoop.hive.serde2.avro.AvroSerDe'
WITH SERDEPROPERTIES (

'avro.schema.literal'="{
"name": "my record", "type": "record",
"fields": |
{"name" :"sessionid"™, "type":["null", "long"], "default"™ : null}
, {"name":"time", "type":[ "null" , "long"], "default" : null}
, {"name" :"unique id", "type":["null", "string"], "default" : null}
IDS
)
STORED AS
INPUTFORMAT

'org.apache.hadoop.hive.gl.io.avro.AvroContainerInputFormat'
OUTPUTFORMAT

'org.apache.hadoop.hive.gl.io.avro.AvroContainerOutputFormat';

RE_WH_CUSTOM_ADDPARTITIONS(AVRO_COUNT, 'sessions', 'DAY');
SELECT COUNT (*) as TotalSessions FROM AVRO_ COUNT
WHERE time >= S${report starttime} AND time <= S${report endtime};

Creating Custom Tables Report

In 10.6.1, you can use and create Custom Tables on the Hive Server. Reporting Engine supports running
queries on user defined tables and the ability to create a new table from a Single Rule output. When this
feature is enabled in the Warehouse Rule Builder UI, user can see a list of custom tables available in
Hive Server.
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Build Rule

Rule Type

Expert Mode [

Name

Select

Warehouse DB

sessions

Alias

logs

Group By
Having

Order By

-

Where aatc_temp_d1

aatc_temp_d2

aatc_temp_fl1

aatc_temp_fl2

aatc_temp_ms
adf_log_filter_results
adf_orc_collected_log_ids
adf_orc_collected_log_ids_with_pid
adf_orc_collected_session_ids

adf_orc_collected_session_ids_with_pid

20

| | Save

<>

Reset Test Rule

Meta
Hive-104 v
X
0s -
_cl
access_point
~ accesses
- action
ad_computer_dst
ad_computer_src
ad_domain_src
ad_username_src
-
4 3
Lists
X
¥= Insert Fol - 1
v CJAEMO
Localhost
[ TesMe

To enable this feature set customTablesEnabled to TRUE by navigating to Reporting Engine ->
Explore ->Hive Config.

- Change Service

= RE (Reporting Eng... <!
|2 BB RE (REPORTING_ENGINE)
B[ com.rsa.soc.re.security

B[ Jcom.rsasocre

fcom.rsa.socre/Configuration/HiveConfig/hiveConfig ~

AlterTableQueryTemplate
AuroSchemalldTemplate
ColumnsToBeDropped
CreateDataTableTemplate
CreateMetaTableTemplate

CustomTablesEnabled

DropTempSchemalocationTemplate
ExcludedCustomTables
InitQueries
Jass_config_template
JdbcDriver

Jgs=_debug
JoinFromTemplate
KerberosCanfigFile
KerberosKeyTabfFile
PartitionTemplate
SchemaFileBuilderQuery
WarehouseCTASTemplate

WarehnuzeResnurcePnalNames

1

RE (Reporting Engine)

ALTER TABLE WTABLENAME% ADD %PARTITIONS%

hdfs:/l/${hiveconf:hive exec.scratchdir}SCHEMA_TEMP_DIRECTORY%/000000_0

partition_id

create external table WTABLENAME®Y partitioned by (partition_id int) ROW FORMAT SERDE 'crg.apache.hadeop hive serde2.avro.A
create external table if not exists WTABLENAMEY ROW FORMAT SERDE 'org.apache hadoop.hive.serde2.avro.AvroSerDe' WITH SE
true

default

drop table if exists ®%TABLENAMEY

dfs -rmr ${hiveconf:hive.exec.scratchdirl/%5SCHEMA_TEMP_DIRECTORY%

reporting.* rsasoc.* temp.*

set mapred.input.dir.recursive=true set hive.mapred.supports.subdirectories=true set mapred.task timeout=1200000 set mapred

COM.SUN.Security.jgss.ini { com.sun.security.auth.module KrbSLoginMedule required useKeyTab=true useTicketCache=true d
org.apache.hive.jdbc HiveDriver
false

U6SESSIONS_TABLEYW left outer join HLOGS_TABLE% on (3LOGS_TABLEY.unique_id = %SESSIONS_TABLEY.unique_id and %LOGS_]

Jerc/krbS.conf

PARTITION (partition_id=%PARTITIONID%) LOCATION "BWLOCATION%'
insert overwrite directory ‘${hiveconfhive.exec.scratchdirf/WSCHEMA_TEMP_DIRECTORYY' select concat{ WSCHEMAY',") from %M

CREATE TABLE %TABLENAMES% STORED AS ORC AS %RESULT%

Creating Custom Table from Regular Rules
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To schedule a report which contains a single SAW rule, a new text input with a Warehouse CTAS
Name is added. The user can now specify a Custom Table name that will be created out of the output of
the rule in Report.

Note: This feature is available only if the Report contains a single SAW rule on the Schedule page.
Otherwise, this option is hidden.

The process to use the feature is explained below:

1. Create a rule to filter with data in SAW.

Build Rule
Warehouse DB
Expert Mode [
Name HTTP_SESSIONS_DAILY
Select *
From sessions v
Alias
Wwhere service IS NOT NULL AND service = 80
Group By

Lists
Having

X
Order By Column Name Sort By
= v 54 v
Enter the column name... Ascending ¥= Insert B
B[JAEMO
= Localhost

B[] TesMe

Limit 20000000 o
Use Save Reset Test Rule

2. Create a Report with the above rule.
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Report-HTTP_SESSIONS_DAILY R S J\ B e Rules

Header 1 H1
M HTTP_SESSIONS_DAILY Tabular v ® Hemder 2 H2

Header 3 H3
Header 4 H4
Table of Contents =
Body Text =
Comment =

Previous Save

3. Create a Schedule and enter the CTAS Table Name.

Manage WView [REPT] Warehouse CTAS 001 [REPT] DailyHTTPSessionsC... @

Schedule Report

Enable b

Report Name Warehouse CTAS 001

Schedule Mame | DailyHTTPSessionsCreatedByCTAS

Warehouse DB | Hive-104 w

WarehoUse | DailyHTTPSessionsCreatedByCTAS

iz B

Time Zone UTC (GMT+00.00) w| [ Set Default

Run o w

on Past w1 o |Days || [ Use relative time calculation

Variables Mo variables defined

*) Dutput Actions
*! Logo
Reset | |#* Configure

4. Run the Report and Reporting Engine will create the Result Summary as below for the Schedule.
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Manage View

[REPT] Warehouse CTAS 001

Warehouse CTAS 001

Generated on - 2016-04-04 09:35 (+00:00)
04 -00- .
2016 | o3 00:00:00 (+00:00)

HTTP_SESSIONS_DAILY /

total_records minimum_time
1 10451 20160403 00:22:57
| Page 1 of1 | | | PageSize 3p ~

[REPT] Warehouse CTAS 001 &

Time Range

NETWITNESS'
PLATFORM

1016 | 53 | 23:59:59 (+00:00)

maximum _time

20160403 23:5%:59

Displaying 1-10f 1

0 Monday
April 4, 2016

< April 2016 - ¥

5 M T w T F 5

-

1 2

Reports

Time.

5. On the next schema refresh or restart of Reporting Engine, the CTAS Table is listed.
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Manage
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Expert Mode
MName
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Where

Group By
hi=ung

Order By

Warehouse DB
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Hive-104

o=

o1

SLLESSES

r.‘|\r_u:|.r;;|.;|;|n|

avro_purge_result
dailyhttpsessionscreatedbyctas

dummy

dummy1
elat_avro_export_location_based_logs_table
elat_base_orc_sessions_logs_join_table
elat_filtered_orc_logs_table
elat_filtered_orc_sessions_table
elat_orc_collected_uniqueids_per_log_table

elat_orc_log_filtering_results_table

‘elat text filtered logs

[2] <

action

| 0 arcess_point

ad_computer_dst >

ENE

a

Lists

<]

gl 4= Insert

i Localhost

B[] TesMe

[#]
o
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Task Scheduler for Warehouse Reporting

A task scheduler in a Hadoop cluster schedules the jobs consisting of tasks, and allocates specific
resources to each job running in a cluster. By default, the task scheduler allocates equal number of
resources to all the jobs. For example, if 10 jobs are running they will share resources of the cluster
equally. However, you can configure the task scheduler to control the execution of the jobs such that one
job runs faster than others by allocating more resources (pools or queues) to the job. This helps you
prioritize to run a few reports over others.

Features
NetWitness Platform supports two task schedulers:
o Fair Scheduler (org.apache.hadoop.mapred.FairScheduler)

o Capacity Scheduler (org.apache.hadoop.mapred.CapacityTaskScheduler)

Fair Scheduler

This scheduler divides the total capacity of the cluster into logical pools. You can submit a job to any one
of these pools. All the jobs submitted to a pool share the resources allocated to the pool only. Once a
pool has free resources, the freed resources are given to other pools with jobs running. For example, a
fair scheduler has 100% resources with two pools namely Pool A and Pool B which share the total
resources at 40% and 60% respectively. If Pool A has four jobs running, it allocates 10% resources to
each job. When the four jobs are completed, the freed resources are allocated to Pool B.

Note: You can configure a pool to run more than one job in parallel.

Capacity Scheduler

This scheduler divides the total capacity of the cluster into queues. Each queue is allocated a pre-
configured share of the total capacity. A job may be submitted to any of these queues. If more than one
job is submitted to the same queue, the jobs will be executed sequentially. For example, if a capacity
scheduler has 100% resources with three queues namely the Default, Low and High and they share the
total resources at 20%, 30% and 50% respectively. If Default has two jobs D1 and D2, Low has three
jobs L1, L2 and L3, and High has four jobs H1, H2, H3 and H4, these jobs are executed in their
respective queues sequentially. If the jobs in a queue are completed, the freed resources will not be
distributed to other queues.

219 Appendix



Reporting User Guide

Query Aggregates

This section explains the supported aggregate functions.

Supported Aggregate Functions

The following table lists the supported Aggregate Functions.

Aggregate

Description
Function

count Returns the count of meta values, which includes duplicate Numeric Numeric
values as well.

countdistinct  Returns the total number of distinct or unique values. Numeric Numeric
distinct Returns all the unique values. Any Any
first Returns the first occurrence of the meta value. Any Same as
input
last Returns the last occurrence of the meta value. Any Same as
input
sum Returns a sum of all non-NULL values of metaKey in a group. Numeric Numeric
avg Returns the average value of all non-NULL values of the Numeric  Numeric

(Average) metaKey within a group.

min Returns the minimum for all values of metaKey in each group.  Any Any
(Minimum) This value is based on order by field.

max Returns the maximum for all values of metaKey in each group. Any Any
(Maximum)  The maximum value is the value that is returned by order by

field.
length Returns the length of the values of metakey. This is called a Any Numeric

"scalar function”" in SQL.

Examples of Queries and Results per Function
Count

This function returns the number of values for a specified meta key, that exclude null values but include
duplicate ones. .

Example

The following figure shows a sample query for count function used for the destination IP and the
respective source IP.
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Build Rule

Rule Type MetWitness Platform DB
Namse Count function
Summarize Custom k4
Select ipsre, count{ip.dst)
Alias Source |P Address
Where ipsrc exists

Group By ipsrc

Then Enter a them clauss..

3
Column Name =~ Sort By
Enter the column name._. Ascending
r r

countlip.dst) Descending
Seszion - A
................. 0
Threshold :
Lirnit 10 L+

Save Reset Test Rule

The following figure shows the result for the above query.
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Sourc o1 - q 03 e
Patz Source 2018 i 08:02:00 COunt function 2018 2 08:01:59
Concentrator - Concentrai »

Source IP Address countlip.dst)

Format

1 55073
Tabular L4

2 2733
Time Range

neq

Past mlE 251

4 2178
2 & Months =

5 2053
¥ Usze relative time calculation _

5 1531

2 1042

£l 970

10 947

Close

Here, for each unique ip.src (source IP), the page returns the total number or count of ip.dst (destination
IP) values, which include the duplicate values as well.

Note: If your RSA NetWitness Platform is currently on 10.5 or newer version and any of the
NetWitness Platform Core devices are on 10.3 or 10.4 versions, then some of the aggregate functions
may display unexpected errors. However, aggregate functions such as sum() and count() are supported
in 10.4 version.

Countdistinct

The countdistinct function returns the count of unique or distinct values for the metakey. In other words,
countdistinct function can be used to retrieve a number of distinct values for the specified metakey.

The following figure shows a sample query where the countdistinct function is used along with IP source
(ip.src) and data size(size).

Example
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Name

MetWitness Platform DB

Count disting: funddon

Custem -

p.ere, size, countdistinadfilename)
Souwrce P Address

p.ere exists &4 filename exists

p.ETC.5izE

Criter a then clauss...
Column Mame = Zart By
Cnter the column narme, Ascerding

r r
countdistinct[filenamea) Descending

1
L

=
3

Save Rezst Test Rule
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The following figure shows the result for the above query.

Data Sourc o1 A A - 03 o
t = 2018 ;5 08:06:00 Count distinct function 2018 5 08:05:59
Concentrator - Concentrat »
Source P Address Data Size countdistinct{filename)
Format
1 138674 122
Tabular -
2 592008 &7
Time Range
Past 3 2375324 4
Ehi -
4 148562 64
2 S| |Months =
5 95476 56

"‘_ Uze relatve time caloulation

6 24520 55
7 72578 54
: 127548 53
3 100184 5
10 106026 5

Here, the page displays the data size along with the total number or count of distinct filenames from the
respective IP source. Unlike the count function, the countdistinct excludes the duplicate values from the
result.

Distinct
This function returns all the unique or distinct values of the metakey.
Example

The following figure shows a sample query for distinct function used to retrieve e-mails, between
various source and destination IP (ip.dst).

Appendix 224



Reporting User Guide

Rule Type

Mame

Summarize

Crrder By

Session

Threshaold

Build Rule

MetWitness Platform DB

p.=re, ipadst. distinademail)
Source |P Address

p.src exists &8 email exists

p.srCipodst

Columin Name =

riLer e colurmn name.
"
distinctiemail)

10 v
Save Rezat TestRule

Zart By

Aacerdi
v
Descending

The following figure shows the result for the above

query.
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Test Rule

Dista Source

Format

Tabular

Time Range
Past

2 %! Months
v

Concentrator - Concentrar «

1 U5 resalve Dimee casiulalson

2018 3! 08:09:00

10

Source IF Address

Distinct function

Destination IF address

distincn @mall]

z=tern@gwusedu, ntionous $E2EErookedu
zzofia@gwu.edu. wallet=xb [@singaporemyway.com
zorthographyBharmycareys.com

zmilesBEgwu.adu, Zi@gwu.edu, rowland@gwu.edu,
methi@gwu.edu,. jengwi@gauedu,
dwekywatchmi@skywatch.pr.
dwredmaplegrovem@redmaplegrove.org
zli@gwu.edu. [yan@emmes.com

zli@gwu.edu. zhenggi@nhlbi.nibugow, yani@emmes.com
zibetZalanperiman.com

zhanania@law.gwu.edu, jarrenBnokis.com
zeepirim@Bresmes.nl, jlusius@law gou.edu

zdaviBgwu.edu, _erkt | yer@alazksoublichealthoorg

2018 [7 D8:08:59

Close

Here, the page displays the list of unique e-mails that were exchanged between the respective IP source

and destination.

First

This function is used to retrieve the first value from an ordered sequence of values for a specified

metakey.

Example

The following figure shows a sample query for first function used to retrieve the first destination city

name.
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Suild Rule
Rule Type Metwitness Platform DB
Mame First furction

Custom -

p.=re, ipodist, Firstlciny. dst)

Alias Source P Address

Whers p.zre exists B& ciny.dst exists
Group By p.sreip.dst

Then Criler a then clausa...

L

Reszet TestRule

Zart By

AL erding
r
Descending

The following figure shows the result for the above

query.
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Test Rule
Data Source 2018 9 08:12:00 First function 2018 §; 08:11:59
Concentrator - Concentra «
Source |F Address Destination IF address Firsticity.dst)
Format
— 1 Dang Ha
sbular -
2 Hanwoi
Tims Range
Past w2 Hanai
2 2 |Months « - Kiangx
5 Changzha
"". USE resalve time casiulalsin E
B Seoul
g Harzukaichi
9 Hirashima
1 Tokyo

Here, the page displays the the first destination city for the corresponding source and destination IP. You
can use the first function to isolate a particular value from a search result.

Last

This function is used to retrieve the last value from an ordered sequence of values for a specified
metakey.

Example

The following figure shows a sample query for last function used to retrieve the most recent user name.
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Suild Rule

Rule Type Metwitness Platform DB
Mame Last function

Summarize Justom -

p.=re, ip.dst. lastifullname)

Alias Source P Address

p.ere exists &4 fullname exists

Group By p.ErCip.det
:r"'E'F' Crter a then dause...
Order By Column Kame = sart By
CnLer the colurmn rarme, Ascanding
F r
ip.dst Descending
) -
10 r

“ Save Rezat TestRule

The following figure shows the result for the above query.
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Dista Source 2018 2 08:14:00 Last function 2018 )} 08:13:59

Concencrator - Concentra «

Source IF Address Destination IP address lastifullmame)
Formiat
— 1 sip:ckpark2007Enaver.com:5060>
sbular w
2 sipeckpark2 007 @naver.com:5060-
Time Range
Past w |3 sip:05535ETES5Evoip.euteliain
- A 4 sipstarkscateddverizon.nen@6s. 142.233.155:443>
2 % |Months w
S sip: 17735693093 Bruphone.com>
"". USE resalve time casiulalsin
b sipestarksabd Iverizon. nen@] 28.164.99.184:1471
7 siprwhitmeycaldwell@68.142.233.153:443

Here, the page displays the list of most recent or last usernames in full, that were exchanged between
the source and destination IP.

Sum

This function returns the total of the non-NULL values of the metaKey within a group.
Example

The following figure shows the query for the Sum function used for packets.
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Build Rule

Rule Type MetWitness Platform D8
Mame Sum function

Summarize Custoam -

country.dst, size. sumipackets)

Destination Country

Whers country.dst exists

Graup By oountry.dst size

:I-F'E'F' Criter a Lthen clause...

Drder By Column Name Sart By
country.dst Descending
Crber tha codurmin narme, AL ]

]
£

Save Reze: Test Rule

The following figure shows the result of the above query.
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st Source 2018 " 08:18:00 Sum function 2018 3} 08:17:59
c — as 05
oncentrator - Concentra «
Destination Country Data Size sumipackets]
Formiat
— 1 Iimbabwe 293 2
zbular w
2 rgin I=lamds, British be77532 3052
Time Range -
Dast w| | 3 rgin I=lands, British 15400 28
4 =i Islands, British 7 4
2 Z| |Months = = T =6
5 etnam 408 |
"". USE resalve Dime Caiulalsn
B Etnam 156 2
8 Etnam 206 2
] etnam 218 2
10 ETnam 298 10

Close

Here the page displays the total or sum of the packets along with the size of the data for the respective
destination country.

Avg
The average function returns the average of non-NULL values of the meta within a group.
Example

The following figure shows a sample query for average data size transmitted between a source and
destination IP.
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D.57C, ip.dst. avelsze)

Build Rule
Rule Type NetWitnese Platfarm DB
Nama Awerage function
_‘EJ"“l"“lﬂ"i:E Custom -

Allaz Source P Address
‘Where DLETC exists
Group By p.srC.p.dst
:r'-'E'F' Criter 4 Lhen clauss,
_-C"dEI'E'-}' Codumn Name Zart By
ruvgjsize'l Descending
:IIIT' W LOAUrTIn Narmee. Al el o
10 w
Save Reze: Test Rule
The following figure shows the result for the above query.
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313 Source

Format

Tabular

Time Range
Pazt

2 % |Months

o

1 USE resatve eme Cakiu

Concentrator - Concentra «

2018

o1 08:25:00

Source |F Address

Average function

Destination IF address

2018 1 08:24:59

awgisize|
16780425
12175750
11987350
10716EDE4
0215054
771154
B092ESE
7184440
6598030

BSETEEZ

Close

Here, the page displays the average size of data exchanged between source and destination IP:

Max and Min

Max and Min functions provide the maximum and minimum for given values of a meta respectively.

The following figure shows a sample query for max and min functions for various data sizes, for source

IP and destination country.

Example
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Build Rule
Rule Type Metwitness Platform D8
MName Max and Min function

Custam -

p.=7C, country.dst, mam{size), min(size)

Source P Address

‘Where p.=re exists B8 country.dst exists
Graup By R
:I-F'E'F' Criter a Lthen clause...
Drder By Column Name zart By
[ ip.src r.ﬂuscend ing
Crber tha codurmin narme, AL ]
10 e
Sawve Reset Test Rule
The following figure shows the result for the above query.
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Data Source 2018 2! 08:28:00 Max and Min function 2018 |, 08:27:59
Concentrator - Concentra «
_ Sowurce IP Address Destination Cowntry max|size) min[size)
Format
— 1 United States 256 256
sbular w
2 Un 2868 B56
Time Rangs
Past w |3 Un 162 162
4 Un 264 132
2 % |Months 5 3
5 Un 136 136
"f. USE resalve time casiulalsin
B United 169928 169928
2 Unitad States 256 256
9 Unized Stanes 3974 3602
10 United States 286 286

Close

Here, the page displays the max(size) and min(size) columns, along with the list of source IP and
destination country. The max(size) column lists the maximum data sizes exchanged while the min(size)
column lists the minimum data sizes that were exchanged.

Filter aggregate meta results with Max_threshold

You can further filter the results of any function by using the threshold rule action.

Example
Following is a sample query for max_threshold used along with the Max function in the Then field is:
max_threshold(5000,max(size))

The following figure shows the Build Rule screen for the above query.
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Build Rule

Rule Type MetWitness Platform DB

MName Max Threshold

Summarize Custem =

Select ip.src, directory. max(size)

Alias Source IP Address

Where ip.src exists & directory exists
Group By ip.src,directory

Then max_threshold{5000, max{size))

Enzer a then clause...

Crder By Column Name ~ Sort By
Enter the column name... Descending
ip.src Lzcending

session o o

Use Save Reset Test Rule

Here the max_threshold is applied for data size with an upper limit of 5000. The following figure
shows the result.
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lest Rule

Dats Source 2016 2 09:04:00 Max Threshold 2018 3. 09:03:59
Admin- Concentratar bl
Source IP Address Directory ma(size)
Format
1 running: fusrilocaldlibexec 196
Tabular ~
2 4480

Time Range

3 Abio 3384
Past ~
4 Abo Directors, 4032
2 2 Years -
= = 5 Abio nitiatives 3538
o stive i = i
Uze relative time calculation & Aboutthe CilBoardafDirectore/E 455
7 AbouttheCouncilE ors/Opp s 4008
F . B
2 AbouttheCouncilB ecto oEram 371z
E 3384
10 age phao 3224

Here, the result page displays the max(size) column, that lists the data sizes lesser than 5000 as this is
the maximum threshold in the query, along with the corresponding IP source and the respective directory.

Filter aggregate meta results withMin_threshold

Similarly, min_threshold is used to filter the results for any function. A similar scenario as max_
threshold is considered to explain this.

Example
Query for min_threshold used along with the Max function in the Then field is:
min_threshold(5000,max(size))

The following figure shows the Build Rule screen for the above query.
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Build Rule

Rule Type

Mame

Summarize

Graue By

Session

Use

MetWitness Platform DB

Min Thresheald

Custom i
ipsrc, directory. max(size)
Source [P Address

ip.src exists L& directory exists

ip_src,directory

min_threshold{5000, max(size])

Enzer a then clause...

Column Mame ~ Sort By
Enter the column name... Descending
ip=rc Azcending

o *

10 v

Save Reset Test Rule

Here the min_threshold is applied for data size with a lower limit of 5000. The following figure

shows the result.
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Test Rule

Data s 0z OV - 03 -
Sr8 moures 2016 09:06:00 Min Threshold 2018 09:05:59
(= 05
Admin- Concentrator -
Souwrce |P Address Directory ma(size)
Format
1 Mmages 92640
Tabular A
2 -nzarchivi/IMG 199936
Time Range
3 -nzarchiviMNzAEBE/MNSAEBES 199936
Past A
a ~-mfpankin 7432
2 3 Years v - ) o
5 AbouttheCouncilBoardofDirectars/Membership, /032
" Lse relative time calculation merlin
& . - - - , - P 7680
cgi/p/downloadFilefd/6504/n/offfother/1/name/SummaryoftheFeb27Farumdoc
Run Test
- 7 -ais/images 18340822
2 - 18340822
3 -judal 225768
10 —judai mage 22576

Here, the result page displays the max(size) column, that lists the data sizes greater than 5000 as this is
the minimum threshold in the query, along with the corresponding IP source and the respective directory.

Note: Max_threshold and Min_threshold rule actions are common across all the functions, and can be
used along with the other queries in the Then field to retrieve the respective output.

Length

This function returns the length of a meta value. In other words, Length function returns the number of
bytes used to store the actual value.

For instance, for the value "Analytics" it returns the length as 9. Similarly, for an IPv4 ip.src, it returns 4
(representing 4 bytes).

Example

The following figure shows a sample query for the length function used for usernames.
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Build Rule

Rule Type

Mame

Summarize

Session

Use

MetWitness Platform DB

Length of User Mame

Custom b

ip.src, username, len{username)
Source IP Address

ip.src exists &4 username exists

ip.src,username

Enter a then cause...

Column Mame -~

Enter the column name....

r
LSsEmame
0 +
10 +
Save Feset Test Rule

Sort By
Dezcending

F
Descending

The following figure shows the result for the above query.
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Test Rule

peem Soures 2018 ! 09:10:00 Length of User Name 2018 . 09:09:59

Admin- Concentrator b

Source |P Address User Account len{username) =
Format

da 88 A AT
Tabular - 77

=i

Time Range

=i

Pazt -

-
[

i)
w

]
=il

2 —+- Months

=i

™ Use relative time calculation

=i

A R A A P R A .

DWW M MO WD WD MDD WD WD D WD D D

Here, the page displays the length of the usernames associated with the user account and their respective
source IP.

Additional Information

When you query for aggregates (E.g. sum(size)) with Group By on a meta which has multiple values in
a session, then the session with multiple values is accounted for aggregate calculation for each value of
that meta.

Example

When you query for the Count aggregate function with Group By on Alias.host and if the column has
multiple values in a session, then the session is counted for each occurrence, including the duplicate
values.

Consider the following table.

host-a, host-b, host-a

2 host-b, host-c, host-a, host-c ¢ 20
3 host-b, host-c, host-d b 30
4 host-c, host-a a 40

In the above table, alias.host for host-a and hest-c¢ has duplicate values listed for a single session. Let us
consider the following query:

Select : alias.host, count(ip.src), sum(size)
Group By : alias.host

Appendix 242



Reporting User Guide

Here, host-a and host-c are present in 3 sessions and they are duplicated for two different sessions.
However, the output is as shown below.

i ost]| couniro
4 80

host-a

host-b 3 60
host-c 4 110
host-d 1 30

Output table shows that the count for host-a and host-c is 4. This is because for each alias.host value,
the entire session is considered. Similarly to calculate sum (size), the same sessions are considered for
each alias.host value.

In the report output if the number of rows has reached NWDB maximum aggregate rows defined in RE
configuration, then a message Max Aggregate Row Limit Reached is displayed to indicate that there is
more information to be displayed. The default limit is 1000, and you can change this value as per your
requirement, in the Reporting Engine Configuration page .

Report-AggregateRows NETWITNESS'
Generated on - 2016-05-12 12:05 (+00:00) PLATFORM

2016 22 10:00:00 (+00:00) Time Range 2016 22 11:59:59 (+00:00)
AggregateRows / 2FA-CONC {Max Aggregate Row Limit Reached)
ip.sre Total events count
1.ip.src 10.100.50.57 1
2.ip.src 93.189.156.232 1
3.ip.src 128.222.180.240 1
4. ip.src 172.20.20.92 1
5.ip.src 10.8.21.100 2

1. service HTTP 2
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Configure and Generate a Chart

Chart is a graphical visualization of data. You can view different kinds of charts, including multiple
types of plot, line, bar, and area charts.

Any NWDB rule in the Reporting Engine system which is not sorted by none can be used to instantly
create a chart. For more information on "How to create an NWDB rule", see Configure a Rule.

The chart interval can be adjusted from the chart definition panel itself. Every time a chart is executed, it
stores its result data locally in the Reporting Engine, so that it can be reviewed in either the Dashboard
View or Chart View without any performance considerations.

The following is an overview of the entire process of configuring and generating a chart.

| |
| | Schedule a Chart |
e »
) .
Test a Chart Investigate a Chart

Manage Chart Groups

and Charts

Setup Access Control for
Charts

Modify or Delete a Chart

Import and Export a Chart

To configure and generate a chart, perform the following:
1. Configure Reporting Engine

Configure an NWDB rule

Configure a Chart

Schedule a Chart

View a Chart

Test a Chart

Investigate a Chart

© N kW

. Manage a Chart Group and Chart

Configure Reporting Engine

Y ou must configure the Reporting Engine before you can configure and generate a chart. You must also
specify the data source in the Reporting Engine from which the data is extracted. For more information
on how to configure a Reporting Engine, see "Configure Reporting Engine"topic in Reporting Engine
Configuration Guide.

Configure an NWDB Rule
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The NetWitness rule which is not sorted by none is used to create a chart. The NetWitness database
extracts the meta from the Reporting Engine and provides the meta for rules. These rules are an essential
building block in managing a chart.

Note: If the rule contains the lookup and add, sum count, or sum values rule actions, the associated
chart will not contain data.

Configure a Chart

You can configure a chart using the NWDB rules.

Schedule a Chart

After a chart is defined with the required components, you can configure its execution properties by
scheduling a chart. Here, you can quickly view, add, and edit the schedule details for a chart.

View a Chart

You can view the scheduled charts in the Chart View.

Test a Chart

You can run the test on a chart and view all the chart details based on the selected time range.

Access Control for a Chart

The Reporting Module provides access control at the chart level. Only a user who has the right set of
permissions can perform the tasks in Reporting module. The access control is managed by the
administrator from the Administration > Security > Roles tab.

When you create users and user roles, ensure that the roles that you create for specific tasks have access
to all the necessary permissions. This could require permissions at several levels of the role hierarchy.

Charts can be tied to a specific set of user roles so that when a user logs in NetWitness, the charts with
the access rights for the specific user role can be viewed. Users that belong to a user role with the 'Read
& Write' access permission can define charts. Further, the access can be tightened so that charts are
accessed only by those who have the 'Read Only' access.

At the chart level, you can set the following access permissions for the user roles in NetWitness:

o Read & Write

e Read Only

o No Access

To change the access permission for a specific user role, you must set the permission at the chart level.

For example, for Administrators to have access to a specific chart, you could set the permission 'Read
& Write' in the Charts Permissions dialog.

You can apply read-only permission to rules in the charts by selecting the checkbox.

Two scenarios that describe how to set access control are explained here:
o Scenario 1: Permissions applied to Chart Group/ Subgroup/ Chart/ Rules based on the user role.

o Scenario 2: Read-only permission applied to Rules in the Chart.
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Permissions applied

to chart group, Permissions (Read-only)
ROe subgroup, chart or applied to rules in the
(Analyst)
rules based on the chart
user role
Group Read & Write Read & Write Read & Write
Subgroup Read Read Read & Write
Chart Read Read Read & Write
Rules Read Read Read

The chart is assigned the role of a Security Analyst and permissions are set to 'Read & Write' charts.

For scenario 1, each of the levels has a permission set based on the user role. For scenario 2, the Read
permission is set for the rules except that the permission for the rules cannot be higher than the
permission for the charts.

Note: If the permission for the rules is higher than the permission for the chart, the permission is not
applied. For example, if you set the permissions for the Report Group as No Access and specify the
option Apply Read-only permission to Rules in the Reports, the read-only permission is not set for the
rules.

Access Control fora Chart When Multiple Charts are Selected

To change permissions for multiple charts, you must select several charts and set their access
permissions using the Charts Permissions panel. The access permission that you choose is applied to all
the selected charts.

Access Control fora Chart When Multiple Charts with Several Rules are
Selected

To change access permissions for a specific user role when multiple charts with several rules are
selected, select the checkbox in the Charts Permissions panel.

The read-only access permission is applied to all the rules of the selected charts, provided that the
permission of the rules are lower than the permission of the charts.

Note: If a user (other than the super user) creates a chart, the super user cannot access that chart.

Access Control for a Chart Group

To change chart group permissions, select a chart group and set the access permissions using the Charts
Permissions panel. Before chart group permissions are applied, the default permission set for all the user
roles is 'No Access'.

To change the access permission for a specific user role, set the permission at the chart group level. For
example, for administrators to have access to all the charts in a Chart Group, set the permission 'Read &
Write' in the Charts Group Permissions panel.

You can also apply permissions to subgroups and charts in the group, and apply read-only permission to
rules in the charts by selecting the appropriate checkboxes.
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Three scenarios that describe how to set access control are explained here:
o Scenario 1: Permissions applied to chart groups, subgroups, or charts based on user roles.
o Scenario 2: Permissions applied to subgroups and charts in the group.

o Scenario 3: Read-only permission applied to rules in the chart.

Permissions

Permissions

applied to . -
applied to Permissions (Read-
Role chart groups, .
subgroups and | only) applied to rules
(Analyst) | subgroups, or . .
charts in the in the chart
charts based
group
on user roles
Group Read & Read & Write Read & Write Read & Write
Write
Subgroup Read Read Read & Write - Read & Write
Inherited
Chart Read Read Read & Write - Read & Write
Inherited
Rules Read Read Read Read

The chart group is assigned the role of a Security Analyst and permissions are set to 'Read & Write'.
For scenario 1, each of the levels will have a permission set depending on the user role.

For scenario 2, the permission at the chart group level will be inherited by the subgroup and by charts in
the group.

For scenario 3, the Read permission is set for the rules. However, the permission set for the rules cannot
be higher than the permissions set for the chart group.

The following table lists the columns in the Charts Permissions panel:

Roles The role of the user logged into the NetWitness UI.

Read & Write The user can access, view, edit, import, export, and delete the chart
in the Charts view. The user can also change the permission for the
chart.

Read Only The user can only access and view charts on the Charts view.

No Access The user cannot access or view charts for which this permission is
set.
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[] Apply these permissions to Select the checkbox to apply the selected permissions to the chart
group, subgroups in the group and charts in the group.

sub-groups and Charts in this

group Note: This checkbox is populated only when you set access
permissions for a Chart Group.

[] Apply Read-only Select the checkbox to automatically apply permissions to the rules in

permission to Rules in the the charts.

Charts
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Configure a Chart

After a chart is defined with the NetWitness rules with NWDB as the data source, you can configure its
execution properties.

Create a Chart Group

To add groups to the default folder or to add subgroups under a chart group:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. Inthe Chart Groups panel, click +.
A default group is added in the Chart Groups panel.
4. Enter the name of the new group.

5. Press Enter.
The group is added to the Chart Groups panel.

Create a Chart

To add charts to a group or subgroup:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Charts to display the Chart view.

3. In the Chart toolbar, click +.
The Build Chart tab is displayed.

Build Chart

Enable ™

MName

Rule Basis Select Rule Browse
Data Source Broker “

Interval (Minutes) |5 o

Limit 10 o

Test Chart Reset
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10.
11.

12.

Enter the name of the chart.

For the Reporting Engine to collect the data and generate chart results, select the Enable checkbox.
In the Rule Basis field, do the following:

a. Click Browse. The Add Rule dialog box is displayed.

b. Navigate the Rule tree and select a rule.

c. Click Select.

The Rule appears in the Rule Basis field.

Select the data source from the Data Source drop-down list.

Note: If the default data source is configured in the Reporting Engine, then the data source is
displayed by default on the Build Chart page. If the data source is not displayed, ensure you
have Read permissions set for the data source. This is applicable for NWDB and Warehouse
data sources. For more information, see the "Configure Data Source Permissions" topic in the
Host and Services Configuration Guide.

(Optional) To modify the Interval value, click the up or down arrow.
The Interval value is the interval in minutes at which the rule which forms the basis of the chart is
run to collect data.

Select the Limit value to limit the number of records to be displayed.

X-Axis and Y-Axis are used to specify the meta to be plotted in charts.
In the X-Axis, the meta for the 'Group by' rule is displayed. In the Y-Axis, the aggregate functions
used in the rule are displayed.

Note: Sum, Count, Countdistinct and Average are the supported aggregate functions for chart.
By default, for Custom Rules with multiple 'Group by', you can select only the first meta in X-
Axis.

Click Save.
A confirmation message that the chart is saved successfully is displayed.
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Schedule a Chart

You must schedule a chart to further investigate on the chart details.

By enabling a chart, the chart executes as scheduled and provides the configured output with the state of
the chart changed to ‘Scheduled’.

To schedule a chart:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. Inthe Chart List panel, select a chart or several charts that display © in the Enabled column.

4. Click ®.
A confirmation message indicates that the chart(s) state is changed successfully.
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View a Chart

After you view a chart, you can perform the following:
1. You can print, save, email and view charts on full screen.

2. You can also select a date from the calendar to view a list of successfully run charts for the chosen
date.

To view a chart:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. Inthe Chart List panel, do one of the following:

o Select a chart and click - > View.

o Select a chart and click View from the View Chart column.
The View Chart view tab is displayed.

4. In Chart Options, do the following:

a. Select the Time Range.

Note: When you select the Time Range option, you can select a pre-set time range such as last
hour, last 3 hours and the Last N Days...or you can customize the selection by choosing Last N
Days or Custom. If you select Last N Days option, you can view the historical data for a
maximum of 15 days. If you select the Custom option, you can select a start date and end date
to view the data for the selected date range.

b. Select the Series, either Chart Values over Time or Chart with Totals.
When you select Chart Values over Time, the chart displays the change in values for the
selected time. When you select Chart with Totals, the chart displays a total for each aggregate
value for the selected time.

c. Select Items to Plot to define the number of events to view on the chart.
d. From the Chart Type drop-down list, select the chart type.

e. Click Reload to reload the selected chart.
If there is a delay in retrieving the historical data for the selected time range, a message is
displayed.

After the chart is generated, a notification is displayed in the notification tray available in the
NetWitness toolbar. For more information on the NetWitness toolbar, see the "Browser Window"
topic in the NetWitness Getting Started Guide.

View all Charts List

To view a list of all the charts:
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Go to MONITOR > Reports.

The Manage tab is displayed.

Click Charts.

The Chart view is displayed.

In the Chart toolbar, click View All Charts.

All the executed charts for the selected date are displayed in a new tab.

Note:
* If no list is displayed, you can select a date from the calendar to view a list of charts.
* If you want to view a specific chart, enter the chart name in the search criteria.

Click the chart name to view the chart details for that date.
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Test a Chart

You can test a chart in the Test a Chart view.

To test a chart:

1.

S A

Go to MONITOR > Reports.
The Manage tab is displayed.

Click Charts.
The Chart view is displayed.

Do one of the following:
o In the Chart toolbar, click +.

o Inthe Chart panel, double-click a chart or select a chart and click 4

o Inthe Chart List panel, click 8 > Edit.
The Build Chart view tab is displayed.

Click Test Chart to view the chart.
The View Chart view tab is displayed.

Select the From and To date ranges.
Select the Series, either Time Series or Summary.
From the Chart Type drop-down list, select the chart type.

Click Run Test to run the test.
The chart data (if any) for the selected time range is displayed.

Test a Chart
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Investigate a Chart

You can investigate the chart by navigating directly to the Investigation module from the chart.

To investigate a chart:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. Inthe Chart toolbar, click View All Charts.
All the executed charts for the selected date from the Chart Options panel are displayed on a new
tab.

4. Click the chart name to view the chart details such as the time at which the chart is executed and the
default data source used for the chart execution.

5. Do one of the following:
o Click a data point on the chart to investigate.

o In the toolbar, click Investigate to investigate for the entire time range.
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Manage a Chart Group and Chart

You can manage chart groups and charts using the following procedures.

Manage a Chart Group

Depending on the access permissions set for the user role, you can modify or delete, import or export,
drag and drop a chart, or refresh a chart group.

Modify a Chart Group
To modify a chart group in the default folder or subgroups under a chart group:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. Inthe Chart Groups panel, select the chart group to modify.
The selected chart group is modified and can be viewed on the Chart Groups panel.

Delete a Chart Group
To delete a chart group in the default folder or subgroups under a chart group:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. Inthe Chart Groups panel, select the group and click = .
A confirmation dialog asks for confirmation that you want to delete the selected group.

4. Click Yes to delete the group.
The selected group is deleted from the Chart Groups panel.

Importa Chart Group
To import chart groups from other instances of NetWitness Platform:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. From the Chart Groups panel, select a folder to import the file.
4. Do one of the following:

o In the Chart Groups panel, click 2 > Import.
The Import Chart dialog box is displayed. You can import multiple chart groups at the same

Manage a Chart Group and Chart
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time. To select multiple chart groups, press and hold the CTRL button and select the chart groups
to be imported.

5. Click Browse to select the binary file.
NetWitness provides a file system view of the files.

6. Locate the binary file and click Open.
The file is added to the Import Chart list.

7. (Optional) To overwrite any existing rule in the library with an identically named rule in the binary
file when importing, select the Rule checkbox. If you do not select the Overwrite option, and an
identical rule is encountered in the binary file, the binary file is imported and no error message is
displayed.

8. (Optional) To overwrite any existing list in the library with an identically named list in the binary
file, select the List checkbox. If you do not select the Overwrite option, and an identical list is
encountered in the binary file, the binary file is imported and no error message is displayed.

9. (Optional) To overwrite any existing chart in the library with an identically named chart in the binary
file when importing, select the Chart checkbox. If you do not select the Overwrite option and an
identical chart is encountered in the binary file, the binary file is imported and no error message is
displayed.

10. Click Import to import the binary file.
Exporta Chart Group

To export selected chart groups:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. Inthe Chart Groups panel, select a chart group and click & and do one of the following:

o Export - This selection exports a chart in a .zip file.

o Export as Text - This selection exports all the content from the Reporting Engine in a .zip file
which contains the data in text format.

You can export multiple chart groups at the same time. To select multiple chart groups, press and
hold the CTRL button and select the chart groups to be exported. The exported file is saved to the
local drive.

Drag and Drop Chartto a Group
To drag and drop a chart from the Charts List panel to a group in the Charts Groups panel:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.
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3. Select a chart from the Chart List panel and drag and drop the chart to a group in the Chart Groups
panel.
The chart is copied to the group in the Chart Groups panel.

Refresh a Chart Group

To refresh chart groups:
1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. Inthe Chart Groups panel, drag and drop the group.
The chart group is moved to the new location.

. ~
4. In the Chart Groups panel, Click % .
The chart group is refreshed.
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Manage a Chart

Depending on the access permissions set for the user role, you can modify or delete, duplicate, import
and export, enable or disable charts, search for existing charts, and refresh a chart list.

Access Control for a Chart

To set access permissions for a chart:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. Inthe Chart List panel, select a chart.

4. Click & > Permissions.
The Charts Permissions dialog box is displayed.

5. Based on the user role, select the appropriate buttons.

6. (Optional) Select the checkbox if you want to provide read access permission to dependent rules.

READ access permission.

Note: On selecting the check box, all dependent rules with No access permission are granted a

6. Click Save.

A confirmation message that the permission is successfully set for the selected chart is displayed.

Modify a Chart

To modify a chart in a group or subgroup:

I. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. Inthe Chart List panel, do one of the following:

o Double-click a chart or select a chart and click z
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4. Modify the name of the chart.
5.
6. (Optional) In the Rule Basis field, do the following:
a. Click Browse.
The Add Rule dialog is displayed.
b. Navigate the Rule tree and select a rule.
c. Click Select.
The Rule appears in the Rule Basis field.
7. Select the data source from the Data Source drop-down list.
8. (Optional) To modify the Interval value, click the up or down arrows.
9. Select the limit value to limit the number of records to be displayed.
10. Click Save.
Delete a Chart

To delete a chart in a group or subgroup:

o Select a chart and click

Build Chart

Lo 08

> Edit.
The Build Chart view tab is displayed.

[CHRT] Cleartext Authentic... &

Enable 4

Mame Cleartext Authentications by Service

Rule Basis Mser Activity/Cleartext Authentications by Ser
Data Source Choose ... v

Interval (Minutes) |15 o

Limit 10 o

Reset

Browse

For the Reporting Engine to collect the data and generate chart results, select the Enable checkbox.

Note: If the data source is not listed, then ensure you have Read permissions set for the data
source. This is applicable for NWDB and Warehouse data sources. For more information, see
the "Configure Data Source Permissions" topic in the Host and Services Configuration Guide.

A confirmation message that the chart is modified successfully is displayed.
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1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. Inthe Chart List panel, do one of the following:

o Select the charts and click = .

> Click ™ > Delete,
A confirmation message asks if you want to delete the selected chart.

4. Click Yes to delete the chart.
A confirmation message that the chart is deleted successfully is displayed and the selected chart is
deleted from the Chart List panel.

Duplicate a Chart
To duplicate an existing chart:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. From the Chart List panel, select a chart to be duplicated.

4. In the Chart toolbar, click @
The chart is duplicated and gets added to the Chart List panel.

Import a Chart
To import charts from other instances of NetWitness:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. From the Chart Groups panel, select a folder from which to import the file.
4. Do one of the following:

o In the Chart toolbar, click - > Import.
The Import Chart dialog box is displayed. You can import multiple charts at the same time. To
select multiple charts, press and hold the CTRL button and select the charts to be imported.

5. Click Browse to select the binary file.
NetWitness provides a file system view of the files.

6. Locate the binary file and click Open.
The file is added to the Import Chart list.
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7. (Optional) To overwrite any existing rule in the library with an identically named rule in the binary
file when importing, select the Rule checkbox. If you do not select the Overwrite option, and an
identical rule is encountered in the binary file, the binary file is imported and no error message is
displayed.

8. (Optional) To overwrite any existing list in the library with an identically named list in the binary
file, select the List checkbox. If you do not select the Overwrite option, and an identical list is
encountered in the binary file, the binary file is imported and no error message is displayed.

9. (Optional) To overwrite any existing chart in the library with an identically named chart in the binary
file when importing, select the Chart checkbox. If you do not select the Overwrite option and an
identical chart is encountered in the binary file, the binary file is imported and no error message is
displayed.

10. Click Import to import the binary file.
Exporta Chart

To export selected charts to an external file:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. Inthe Chart List panel, select a chart and click 8- and do one of the following:

o Export - This selection exports a chart in a .zip file.

o Export as Text - This selection exports a chart from the Reporting Engine in a .zip file which
contains the data in text format.

You can export multiple charts at the same time. To select multiple charts, select the checkboxes of
the charts to be exported. The exported file is saved to the local drive.

Enable a Chart

To enable a chart:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. Inthe Chart List panel, select a chart or several charts that display © in the Enabled column.

4. Click *.
A confirmation message indicates that the chart(s) state is changed successfully.

Disable a Chart
To disable a chart:

1. Goto MONITOR > Reports.
The Manage tab is displayed.
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2. Click Charts.
The Chart view is displayed.

3. Inthe Chart List panel, select a chart or several charts that display ® in the Enabled column.

4. Click ©.

A confirmation message indicates that the chart(s) status is changed successfully.
Search an Existing Chart
To search for an existing chart:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. Inthe Chart toolbar, enter text in the Search text box.

4. Click o > Chart.
The charts with the substring in their name are displayed in the search drop-down list.

En1ai|| |'f}
"F Email senders {User Activity/Email Senders)
'{,‘T’ Email senders {User Activity/Email Senders)
| Page 1 of1 | | C
Refresh a Chart

To refresh charts:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. Inthe Chart List panel, drag and drop the charts to the desired group in the Chart Groups panel.
The charts are moved to the new location.

4. Do the following:

o In the Chart List panel, click C .

o Inthe Chart Toolbar panel, select Auto Refresh.
The Chart list is refreshed.
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Alerting Overview

Alerts can be used to generate timely insights about current security issues, vulnerabilities, and exploits.
For example, when a malicious email is sent from a compromised account, you would need an alert that
automatically notifies you when such an event occurs.

The following concepts of alerting will help you understand more about alert rules, conditions,
notifications, and templates.

Alert Rules

Alert rules specify the logic for alert generation. Alert rules allow you to set up threshold limits and
define how to be notified if these limits are exceeded. For example, you may set up a rule to be alerted if
the CPU usage remains abnormally high for 5 minutes or more.

Alert Definitions

The alert definition is similar to defining rules for reports. These rules must be defined based on your use
case. Alert definitions are made by selecting the alert rules you define in the Build Rule view. You
select this rule while defining an alert.

Note: You can only alert using rules defined for NetWitness data source.

Once an alert is created, this data is collected from the Reporting Engine and displayed on the user
interface.

Once an alert is defined, you can schedule the alert to run every minute (by default), or run at the present
time, or run at the near future.

Note: In the NetWitness Platform user interface, wherever Date and Time is displayed, it is always
according to the user selected time zone profile.

Create/Modify Alert

Enzble 0
Rule Basis: Logen Failures Browse
Data Sources:  nw-concd - Concentratar ~| [ Push to decoders

Description

Severity: 1] -

Notification: ] Record [ sMTP [ ShMP [ Syslog
Record SMTP SNMP Syslog
Execute Each event v
Body User: ${meta.user.dst} {Full Name: ${meta.corp.name} - Department: ${meta.corp.dep} - Status: ${meta.corp.status} - Privileges: ${meta.corp.privileges}), Hostname: §{metz.alias.host}
Sody Template v
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Alert Notifications

The following are the components required to configure alert notifications:

« Notification server — Notification Server is used to send alert notifications. For example, SMTP mail
server. Once you configure a notification server, you can add it to a rule. When the rule triggers an
alert, the rule will use that server to send alert notifications.

o Notifications — Alert outputs, which can be email, SMTP, SNMP, and Syslog.

o Templates — The pre-defined format of an alert message.

When ever the rule condition is encountered, alerts get generated based on the severity level and notifies
the user depending on the notification method set for that specific alert. The following are the various
notification methods:

o Email/ SMTP: Simple Mail Transfer Protocol (SMTP) sends alert emails for system activity. Email
alerts can be sent to their intended recipients by selecting SMTP as notification type.

o SNMP: Simple Network Management Protocol (SNMP) sends alerts to multiple computers for SNMP
traps. SNMP alerts can be sent to other computers by selecting SNMP as notification type.

o Syslog: Syslog alerts generate notifications from Syslog messages. Syslog alerts can be sent by
selecting Syslog as notification type.

Alerts can be configured to notify events that require attention, or as mechanisms to take automated
actions based on conditions configured in an alert. An alert is sent when conditions within the entity have
met the criteria selected for the alert. The notification criteria determines when and at what frequency
the alert is generated.

Alert Templates

Alert templates are pre-defined format for an alert message. You can use these templates to create
alerts.

Access Control for Alerting

Depending on the user role, the user is provided with specific set of access permissions in order to
manage an alert. The Administrator manages the access rights provided to each user role from the
Administration > Security > Roles tab. You can set access permissions for the user roles to manage an
alert. The Reporting module provides access control at the alert level.

Note: Reporting Engine Alert permissions are prefixed with 'RE' to distinguish them from Event
Streaming Analysis (ESA).

When you create users and user roles, ensure that the roles that you create for specific tasks have access
to all the necessary permissions. This could require permissions at several levels of the role hierarchy.

Alerts can be combined with a specific set of user roles so that when a user logs into NetWitness, the
only alerts they can access are alerts accessible by the role to which the user belongs. Users that belong
to a user role with the ‘Read & Write’ access permission can define alerts. The access can further be
tightened so that the alerts are accessed only by those who have the ‘Read Only’ access.

At the alert level, you can set the following access permissions for the user roles in NetWitness:
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o Read & Write
e Read Only

e No Access

Note: Before applying the Alert permissions, the default permission set for all the user roles is 'No
Access' permission and the checkbox is unchecked.

If you want to change the access permission for a specific user role, you must set it at the alert level.
Except for administrators, the default permission set for all the other user roles is 'No Access'
permission.

The two scenarios are explained in brief:

o Scenario 1: Permissions applied to alert/ rules based on the user role.

o Scenario 2: Read-only permission applied to rules in the Alert.

Permissions Permission
Role applied to Alert/ (Read-only)
(Analysts) Rules based on the | applied to Rules
user role in the Alert
Alert Read & Write Read & Write Read & Write
Rules Read Read Read

The Alert is assigned the role of a Security Analyst and permissions are set to Read & Write alerts.

For scenario 1, each of the levels has a permission set based on the user role. For scenario 2, the Read
permission is set for the Rules except that the permission for the rules must not be higher than the
permission for the Alerts.

If the permission for the rules is higher than the permission for the Alerts, the permission is not applied.
For example, if you set the permissions for the Alert as No Access and then specify the option Apply
Read-only permission to Rules in the Alerts, the read-only permission is not set for the rules.

Access Control for an Alert When Multiple Alerts are Selected

When you want to change permissions of multiple alerts, you must select several alerts and set their
access permissions using the Alert Permissions panel. The access permission that you choose is applied
to all the selected alerts.

Log in as a specific user and view the access details

When you log in to the NetWitness Ul as a user having Read access permission, all the alerts will be
denoted with the symbol ([:I:]) and when you click on the symbol the 'Read Only' callout is displayed on
the Alert List panel.

When you log in to the NetWitness Ul as a user not having Read & Write access permission on an
Alert, all the alerts will be denoted with the symbol ( %) and the alerts appear grayed out on the Alert
List panel.

The following figure shows the Alert List panel when logged in with minimal Read & Write access
permission.

Alerting Overview 266



Reporting User Guide

7| enabled | pushed? Name Description Actions
o e No ST_Communication to Blacklisted Hasts Record
No Firewall Deniied Connections Record

No Firewall Destination IP Addresses Record

ojoo
e e 0

Yes Top 10 Destination IP Addresses Record

Note: If a user (other than ADMIN) creates an alert, ADMIN cannot access that alert.

The following table lists the various columns in the Alert Permissions panel:

Roles The role of the user logged into the NetWitness user interface.

Read & Write The user can access, view, edit, import, export, and delete the alert on the
Alerts page. The user can also change the permission on the alert.

Read Only The user can only access and view the alert on the Alerts page.
No Access The user cannot access or view the alert for which this permission is set.
I:l The user can automatically apply permissions to the rules in the alerts.

Apply Read-only
permission to Rules in the
Alerts
The following is an overview of the entire process of alerting:

View an Alert

Manage Alerts and
Alert Templates

Investigate an Alert

Setup Access Control for
Alerts

Modify or Delete an Alert

Import and Export an Alert

To configure and generate an alert on Reporting Engine, perform the following:
1. Configure Reporting Engine

Configure an Alert

Schedule an Alert

2
3
4. View an Alert
5. Investigate an Alert
6

Manage an Alert and Alert Template
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Configure Reporting Engine

Ensure that:

e You have Decoders that are connected to the Concentrator added to the Reporting Engine for the
selected data source, before creating an alert rule.

o You have installed and configured a Syslog server that supports TCP/TLS in your environment. For
example, WinSyslog. You can configure the Reporting Engine to send Syslog messages over TCP
with Transport Layer Security (TLS) when an alert is triggered.

To configure the Reporting Engine to send Syslog alerts over TCP with Transport Layer Security (TLS):

Obtain the required certificates.

Append the CA certificate to the ca.pem file on the NetWitness server.

Configure the Syslog server to accept messages from client machines.

bl e

Configure the delivery of alert messages in the NetWitness UI.

Task 1: Obtain the required certificates
To generate certificates for configuring Reporting Engine to send Syslog messages over TCP with TLS:

1. Generate a Certifying Authority (CA) certificate. For more information,
see http://www.rsyslog.com/doc/tls_cert ca.html.

Note: You can ignore this step if you already have a CA running in your environment.

2. Generate a key pair for the Syslog server. For more information, see http://www.rsyslog.com/doc/tls
cert_machine.html.

Note: You can ignore this step if you have already configured security for the Syslog server using the
key and certificates generated by the same CA.

Task 2: Append the CA certificate to the ca.pem file on the NetWitness
Server

To append an existing CA certificate to the ca.pem file:

1. Manually append the contents of the CA certificate that you generated to the
/ete/pki/CA/certs/ca.pem file.

2. Run the following command on the NetWitness server to have the certificate populate to the
Truststore:
keytool —-import -file /etc/pki/CA/certs/ca.pem -keystore cacerts

Task 3: Configure the Syslog Server to accept messages from client
machines

To configure the Syslog server to accept messages from client machines that have the same CA
certificates:
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1. Copy the following files to your secure TCP server target location:

e cCa_cert.pem
e server_cert.pem

o server key.pem
Where:

ca _cert.pem - is the CA certificate
server cert.pem - is the server certificate
server_key.pem - is the server key

For more information, see the documentation specific to your Syslog server. If you are using
rsyslog, refer to http://www.rsyslog.com/doc/tls_cert server.html.

Task 4: Configure the delivery of alert messages in NetWitness

Configure Reporting Engine to send Syslog messages over TCP with Transport Layer Security (TLS)
when an alert is triggered by enabling SECURE_TCP in the Qutput Actions tab for the Reporting
Engine service in the Reporting Engine Services Config View. For more information, see the
"Reporting Engine Output Actions" topic in the Host and Services Configuration Guide.
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Configure an Alert

You can configure an alert by setting up alert notifications and adding a notification method to a rule.

Note: Only Administrators can set up these notifications.

To configure an alert:

1. Go to Monitor> Reports.
The Manage tab is displayed.
2. Click Alerts.
The Alert view is displayed.

3. Inthe Alert toolbar, click +.
The Create/Modify Alert panel is displayed.
4. Click Enable to enable the alert.
5. Inthe Rule Basis field:
a. Click Browse.
The Lookup Rule Basis dialog box is displayed.
b. Navigate the Rule tree and select a rule.
c. Click OK.
The Rule name is displayed in the Rule Basis field.

6. From the Data Sources drop-down list, select a data source.

Note: If the data source is not listed, then ensure you have Read permissions set for the data
source. This is applicable for NWDB and Warehouse Connector data sources. For more
information, see "Configure Data Source Permissions' topic in the Host and Services
Configuration Guide.

7. Select the Push to decoders checkbox for the Reporting Engine to send the rule to the Decoder.
8. (Optional) Enter an alert description in the Description field.
9. From the Severity drop-down list, select the severity level.

10. In the Notification field:

a. Select the appropriate notification.
The selected notification tab is displayed in the Create/Modify Alert dialog box.

b. (Optional) Deselect the notification to disable the notification tab.

¢. Define an action in one of the Notification tabs:

Configure an Alert
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i. Inthe Record tab field:
a. From the Execute drop-down list, select the frequency for recording an alert.

b. Enter the RECORD message. You can create a new message or select a template in the
Body Template field and modify the template here.

c. (Optional) If templates have been defined, select a template for the RECORD message
that you can use as is or modify.

1. In the SMTP tab field:

a. From the Execute drop-down list, select a value to identify the number of times to send an
email message for the alert.

b. Enter an email address or comma-separated list of email addresses to send this alert.
c. Enter the subject of the email message.

d. Enter the body of the message. You can create a new message or select a template in the
Body Template field and modify the template here.
iii. In the SNMP tab field:

a. From the Execute drop-down list, select a value to identify the number of times that you
want to send an SNMP message for the alert.

b. Enter the SNMP message. You can create a new message or select a template in the
Body Template field and modify the template here.

iv. In the Syslog tab field:

Note: You can configure Multiple Syslog servers on the Syslog Configuration panel. For
more information, see ""Reporting Engine Output Actions" topic in the Host and Services
Configuration Guide.

a. Click F.
The New Syslog Configuration dialog box is displayed.
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New Syslog Configuration

Syslog Configs  Choose ... v
Execute Once v
Facility Local? (23) b
Severity Warning v
Body https://${sa.host}finvestigation/

${device.id}/navigate/event/DETAILS/S
f{meta.zessionid}

Body Template |Choose.. b

Cancel Save

b. From the Syslog Configs drop-down list, select a value for the syslog configuration.

c. From the Execute drop-down list, select a value to identify the number of times to send a
Syslog message for the alert.

d. From the Facility drop-down list, select the facility.
e. From the Severity drop-down list, select the severity level.

f. Enter the Syslog message. You can create a new message or select a template in the
Body Template field and modify the template here.

Note: If you want to add a metakey, specify the same in the format: $ {meta.metakey}.
For example, ${meta.ip.dst}.

g. Click Save.
The Syslog configuration gets added to the alert.

11. Click Create.

NetWitness creates an alert with a confirmation message that the alert is saved successfully.
NetWitness generates the alert and executes the output actions every minute.
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Schedule an Alert

You must schedule an alert to search for events on a regular schedule.

To schedule an alert:

1.

2
3.
4

Go to Monitor> Reports to view the Manage tab.

. Click Alerts to open the Alert view.

Select an alert to schedule.

. On the Alert toolbar, click Enable.

The selected alert is scheduled.
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View an Alert

You can view an alert or a list of all alerts.

You can view the alerts triggered and investigate any alert in the Investigation module and customize
these views to show alerts for a specific period of time, and set the maximum number of alerts displayed
in a single page.

To view an alert:
1. Go to Monitor> Reports to view the Manage tab.
2. Click Alerts to open the Alert view.

3. On the Alert toolbar, click View Alerts.
The View Alerts view is displayed.
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Investigate an Alert

You can investigate every alert that is triggered on the Alert View. For more detailed investigation on a
particular alert, you can view the alert on the Investigation module.

To investigate an alert:

1. Inthe Alert section toolbar, click View Alerts to navigate to the View Alerts view.
2. Do one of the following:

o Click the T button against the alert you want to investigate.
The Investigation module displays the details of the first session that registered the match for the
given alert for immediate analysis.

o Click on the alert name of the alert you want to investigate.
The Investigation module displays all matches for that particular alert for the hour surrounding the
registered alert.
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Manage an Alert and Alert Template

You can manage alerts, scheduled alerts, and alert templates using the following procedures.

Manage an Alert

Depending on the access permissions set for the user role, you can modify or delete, import and export,
enable or disable alerts, view or refresh an alert list.

Access Control for an Alert When a Single Alert is Selected
To set access permissions for an alert:

1. Go to Monitor> Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. Inthe Alert List panel, select an alert.

4. Click > Permissions.
The Alert Permissions dialog box is displayed.

5. Based on the user role, select the appropriate options.

6. (Optional) Select the checkbox if you want to automatically provide read access permission to
dependent rules.

Note: When the check box is selected, all dependent rules with the No access permission will be
given the READ access permission.

7. Click Save.
A confirmation message that the permission is successfully set for the selected alert is displayed.

Access Control for an Alert When Multiple Alerts are Selected
To change permissions of multiple alerts:
1. Inthe Alert List panel, select all the alerts whose permissions must be set.

2. Click > Permissions.
The Alert Permissions dialog box is displayed.

3. Select the permission to set for the respective user role.

4. Click Save.
A confirmation message that the permission is successfully set for all the selected alerts is displayed.

Editan Alert

For example, if you want to be notified about the alert over an email on a different Email ID, you will
have to modify the alert notification section with the new Email ID details to be reverted over an email
when an alert is generated. Additionally, you can also modify the alert description and alert notification
in the Create or Modify Alert panel.

To edit an alert:
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. Go to Monitor> Reports.

The Manage tab is displayed.

Click Alerts.
The Alert view is displayed.

In the Alert List panel, select an alert and click 4
The Create or Modify Alert tab is displayed.

Manage View [ALRT] Firewall Denied Con... @

Create/Modify Alert

Enable &
Rule Basis: Firewsll Denied Connections Browse
Data Sources: Broker v [ Push to decoders

Description

Severity: [esaseverityHign]

Notification: [ Record O smTp [ snme [ sysiog
Record SMTP SNMP Syslog

Execute Once ~

Body Template v

Save

In the Rule Basis field, navigate the rule tree and select another rule.
The Rule name is displayed in the Rule Basis ficld.

(Optional) Select a data source from the Data Sources drop-down list.

Note: If the data source is not listed, then ensure you have Read permissions set for the data
source. This is applicable for NWDB and Warehouse data source. For more information, see
"Configure Data Source Permissions" topic in the Host and Services Configuration Guide.

(Optional) Modify the alert description in the Description field.
Modify the appropriate Notification tabs - RECORD, SMTP, SNMP, and Syslog.

Click Save.
A confirmation message that the alert is modified successfully is displayed.

Delete an Alert

To delete an alert:

1.

Go to Monitor> Reports.
The Manage tab is displayed.

2. Click Alerts.

The Alert view is displayed.
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3.

4.

In the Alert List panel, select the alert and click ~ .
A warning dialog asks for confirmation that you want to remove the selected alerts.

Warning

Are you sure you want to remove selected alert(s)?

Mo Yes

Click Yes to delete the alert.
A confirmation message that the alert is deleted successfully is displayed and the selected alert is
deleted from the Alert List panel.

Importan Alert

To import an alert from other instances of NetWitness in the Alerts List panel:

1.

7.
E

Go to Monitor> Reports.
The Manage tab is displayed.

Click Alerts.
The Alert view is displayed.

In the Alert toolbar, click ¥ * > Import.
The Import Alert dialog box is displayed.

Click Browse to select the binary file.
NetWitness provides a file system view of the files. You can import multiple alerts at a time. To
select multiple alerts, select the checkbox of the alert to be imported.

Locate the binary file, and click Open.
The file is added to the Import Alert list.

(Optional) To overwrite any existing alert in the library with an identically named alert in the binary
file when importing, select the Alert checkbox. If you do not select the Overwrite option, and an
identical alert is encountered in the binary file, the binary file is imported and no error message is
displayed.

Click Import to import the binary file.

xportan Alert

To export an alert to an external file that can be later imported to NetWitness:

1.

Go to Monitor> Reports.
The Manage tab is displayed.

Click Alerts.
The Alert view is displayed.

In the Alert List panel, select an alert and click £~ and do one of the following:
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o Export - This selection exports an alert in a .zip file.

o Export as Text - This selection exports all the content from the Reporting Engine in a .zip file
which contains the data in text format.

You can export multiple alerts at a time. To select multiple alerts, check the checkbox of the alert
to be exported.

4. Click % * > Export.
The exported binary file is saved to the local drive.

Enable an Alert

To enable an alert:

1. Go to Monitor> Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. Inthe Alert List panel, select the alert that displays © in the Enabled column.

4. Click ® Enable

A confirmation message shows that the change to the alert(s) state was successful.

Disable an Alert

To disable an alert:

1. Go to Monitor> Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. Inthe Alert List panel, select the alert that displays ® in the Enabled column.

4. Click © Disable
A confirmation message shows that the alert(s) status is changed successfully.

View an Alert List

To view an alert list:

1. Go to Monitor> Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. Inthe Alert toolbar, click View Alerts.
The View Alerts view tab is displayed.

4. Select the last number of days from the drop-down list.

5. Enter a value for the Max no of alerts.
The alerts list is displayed based on the chosen filter value.

Refresh an Alert List

279 Manage an Alert and Alert Template



Reporting User Guide

To refresh the list of alerts:

1. Go to Monitor> Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. From the Alert toolbar, click c to refresh the alerts list.
The Alert List panel is refreshed.
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Manage a Scheduled Alert

You can enable or disable a scheduled alert, and view all scheduled alerts.

Enable a Scheduled Alert

To enable a scheduled alert:

1. Go to Monitor> Reports.
The Manage tab is displayed.
2. Click Alerts.
The Alert view is displayed.
3. Click 2 View Schedule
The View Alerts Schedule view tab is displayed.
4. Inthe Alerts Schedule List panel, select the scheduled alert (s) to be enabled.
5. Click #.
A confirmation message indicates that the alert(s) status is changed successfully and the alert is now
available in the Alert List panel.
Disable a Scheduled Alert
To disable a scheduled alert:
1. Go to Monitor> Reports.
The Manage tab is displayed.
2. Click Alerts.
The Alert view is displayed.
3. Click E View Schedule'
The View Alerts Schedule view tab is displayed.
4. Inthe Alerts Schedule List panel, select the scheduled alert (s) to be disabled.
5. Click ©.

A confirmation message indicates that the alert(s) status is changed successfully and the alert is now
available in the Alert List panel.

View all Alerts Scheduled

To view all the alerts scheduled:

I.

Go to Monitor> Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.
3. Inthe Alert toolbar, click View Schedule.
The View Alerts Schedule view is displayed with a list of all the scheduled alerts.
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Manage an Alert Template

You can modify or delete an alert template, and view all alert templates.

Editan Alert Template

To edit an alert template:
1. Go to Monitor> Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.
3. Click B Template

The Template view is displayed.

4. In the Template List panel, select a template and click 4.

The Create/Modify Template dialog box is displayed.
5. Click Save.

A confirmation message that the template is modified successfully is displayed.
Delete an Alert Template

To delete an alert template:

1. Go to Monitor> Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. Click B Template
The Template view tab is displayed.

4. In the Template List panel, select a template and click ~— .
A confirmation dialog is displayed.

Are you sure you want to delete selected template(s)?

5. Click Yes to delete the template.
A confirmation message that the template is deleted successfully is displayed.

View all Alert Templates
To view all alert template messages:

1. Go to Monitor> Reports.
The Manage tab is displayed.
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2. Click Alerts.
The Alert view is displayed.

3. Inthe Alert toolbar, click Template.
The Template view tab is displayed with a list of templates.
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Reporting References

This section provides information about the Reporting user interface. You can look at your place in the
workflow for creating and generating a report with theNetWitness Platform, get a quick look at the

important features, and follow links to the detailed concepts and procedures.
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Build Chart View

In the Build Chart view, you can define and test a chart. You build a chart by assigning a name and then
selecting a rule to include.

Note: Only the NetWitness Platform DB rules can be used in charts.

Workflow
| Schedule a Chart —
>

|
: : | .
Configure Reporting Engine JIN Configure a Chart |
|
|

— —
l ! Test a Chart Investigate a Chart
Manage Chart Groups
and Charts

What do you want to do?

Administrator/ Configure Reporting Engine For more information, see "Configure Reporting

Analyst Engine" in the Reporting Engine Configuration
Guide.

Administrator/ Configure a chart* Configure a Chart

Analyst

Administrator/ Schedule a chart Schedule a Chart

Analyst

Administrator/ View a chart View a Chart

Analyst

Administrator/ Test a chart Test a Chart

Analyst

Administrator/ Investigate a chart Investigate a Chart

Analyst

Administrator/ Manage a chart group and Manage a Chart Group and Chart

Analyst chart

*You can complete these tasks here.

Quick View

The following figure is an example of the Build Chart view.
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Build Chart

Enable 4

Mame

Rule Basis Select Rule Browse
Data Source Broker ~

Interval (Minutes) |5 o

Limit 10 o

Test Chart Reset

The following table describes the features in the Build Chart view.

o o

Enable

Chart
Name

Rule
Basis

Data
Source

Interval
(Minutes)

Limit

Save

Specifies if the Reporting Engine must collect the data and generate chart results. If the
Enable checkbox is not selected, the results are not rendered.

Identifies the name of the chart.

Displays the Add Rules dialog box from which you select a rule that is the basis of a chart.
The rule that you select must be a rule which is not sorted by none.

If the default data source is configured in the Reporting Engine, the data source is
displayed on the Build Chart page. If a chart is configured to run on any other data source,
that data source is displayed on the Build Chart page instead of the default data source.
The Reporting module works with the following data sources:

o Broker

o Concentrator
o Decoder

o Log Decoder
o Log Collector

The chart data refresh interval in minutes.

The number of records for which a chart is generated.

Saves a chart to the database.
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s o

Test Plots a test chart based on the chart definition.
Chart
Reset Resets the chart details.
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Build List View

In the Build List view, you can enter or import values to create a list and save or reset the values. You
can use lists when you are writing reporting rules to simplify the process of specifying values in the rule.

Workflow

This workflow shows the procedure to define lists or list groups. You can set access control at the list or
list group level so that only users with specific roles can access the lists.

You must ensure that Reporting Engine is configured on the NetWitness Platform.

You are here

Configure Reporting Create and Schedule a

Report > View a Report

\
What do you want to do?

Engine

Manage Lists, Rules or

Reports

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure

Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide

Administrator / Create a List or List Configure a Rule

Analyst Group/Create or Deploy a

Rule/Test a Rule*

Administrator / Create and Schedule a Report Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports

*You can complete these tasks here.

Related Topics
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o List View
o Lists Permissions Dialog

Quick View

The following figure shows the Build List View.

Manage View [LIST] Content Delivery Ne... @ _

Build List

Mame Content Delivery Networks
Description List of CDNs
List Values Insert Values

Value

www,google.com
ftp.microsoft.com
ftp.symantec.com
unisys.skillport.com

Enter value...

[ ] Quotes will be inserted for all the values
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To access this view
1. Goto MONITOR > Reports.

The Manage tab is displayed.
2. Click Lists.

The Lists view is displayed.

3. In the Lists toolbar, click + .
The Build List tab is displayed.

The following table describes the features in the Build List view.

e

Name
Description

List Values

Quotes will
be inserted

for all the
values

Save

Reset

Identifies and labels the list.
Provides a short description for the list.

Provides the grid of values associated with selected list from the List Library panel. You
can import these values from a file or list. You can also enter values manually.

Automatically includes quotes for the values at runtime if checkbox is selected. If the
checkbox is not selected and if a value in the list contains a comma, then that value has
to be enclosed within single quotes. This syntax does not apply to list values for

an NWDB rule.

Saves the rule which can be used to create a report, a chart or an alert.

Deletes all the information from the fields.
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Build Report View

In the Build Report view, you can create a report, add text and rules, and schedule a report.

Workflow

This workflow shows the procedure to create and schedule a report.

You are here

Configure Reporting

| |
! |

Configure a Rule 'l_’_ Create and Schedule a . View a Report
I

Engine

Investigate a Report
Manage Lists, Rules or

Reports

What do you want to do?

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report*  Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports

*Y ou can complete these tasks here.

Related Topics

o Configure and Generate a Report

o Report View
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o Scheduled Reports View

« Reports Permissions Dialog

Quick View

The following figure shows the Build Report View.

RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Overview Reports
Manage View [REPT] New Report @
Text Rules
Enter Report Name... R SA Ef;_\#gg&ss
Header |
ou mu atexta rules to the rep

To access this view
1. Goto MONITOR > Reports.

The Manage tab is displayed.
2. Click Reports.
The Reports view is displayed.

3. Inthe Reports toolbar, click + .
The Build Report tab is displayed.

The Build Report view consists of the following panels:

Report Panel
Text Panel
Rules Panel

Report Panel

The Report panel allows you to create a report by assigning a name to the report. The content in a report
depends on the items selected from the Text and Rules panels.
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Aggregate Functions R SA ?fmggfass'

|WJ Count Aggregate Function Tabular v|| Options ®

|WJ Sum Aggregate Function Tabular v|| Options ®

When you add rules to a report, you can change the output format of these rules either to tabular, area,
line or pie by clicking the ¥ button.

The following table lists the features of the Report Panel and the description.

o o

Name This field allows you enter the name of the report.

Options  This field allows you to select the output format of the report such as Tabular, Area, Bar,
Bubble, Column, Line, Pie, Step Line, Step Area, Spline Area and Spline.

Schedule Clicking this option generates the report.

Save Clicking this option saves the report.

Text Panel

The Text panel consists of a list of text elements that add to the look and feel of the report. You can use
these text elements to format the report.

o To add more structure to reports, you can use these headers defined in the Text panel to indent up to
four levels. This allows you to identify specific sections in a report that can be included in the Table
of Contents for easy navigation in the report result.

o To add headers to the Report panel, drag and drop H1, H2, H3, or H4 onto the Report pane based on
the desired level of indentation.
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Text Rules
Header 1 H1
Header 2 H?
Header 3 H3
Header 4 H4

Table of Cantents

Body Text

Caomment

The following table lists the text elements used to format a report:

Header 1 The Header 1 element adds a first-level heading to
H1 the report definition.

Header 2 The Header 2 element adds a second-level heading
H? to the report definition.

Header 3 The Header 3 element adds a third-level heading to
H3 the report definition.
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Header 4 The Header 4 element adds a fourth-level heading
H4 to the report definition.
Table of Contents The Table of Contents adds table of contents to the
= report definition.
Body Text The Body Text element adds body text to the report
= definition.
Comment The Comment element adds comments to the report

definition.

Note: The Comment element is not displayed
when you view all the reports.

Rules Panel

The Rules panel consists of a list of rules that are defined in the Rules. From the rules list, you can drag
and drop rules onto the Report panel to associate those rules with the report.

You can search for a specific rule using search text box provided in the Rules panel.
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Text Rules

Filter

B []10.4 System Test Upgrade Set
|=m All Risk Suspicious By Session Size
|Em All Risk Warning By Destination [P
|=@ All Risk Warning By Session Size
|Em All Risk Warning By Seurce [P

b [ JDarshan-Regression

» [JHunting

b [Jldentity

b [(Jldentity Management

b [JSIT10.3.2

»[JSIT104.02

b [ Security Analytics

b [ Situational &wareness

b [ ]Threat

b [ User Activity

Q
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Build Rule View

The Build Rule view explains the actions and associated procedures that you can perform under Rules.

Workflow

This workflow shows the procedure to create or deploy a rule.

You are here

Configure Reporting Create and Schedule a

Report > View a Report

Investigate a Report
Manage Lists, Rules or

Reports

Engine

What do you want to do?

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure

Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide

Administrator / Create a List or List Configure a Rule

Analyst Group/Create or Deploy a

Rule/Test a Rule*

Administrator / Create and Schedule a Report Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports

*Y ou can complete these tasks here.
Related Topics

o Rule Permissions Dialog

e Rule View

Quick View
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RSA| RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN

Reports
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d® coumnname o
Lt
Save Reset Test Rule
R S/\ NETWITNESS PLATFORM 11.2.00

To access the Build Rule view:

I. Goto MONITOR > Reports.
The Manage tab is displayed.

2. In the Rule toolbar, click + > NetWitnessDB.
The Build Rule view tab is displayed

Features

The Build Rule view includes the following panels.

Rule panel
Meta panel
Lists panel

Rule Panel

The Rule panel allows you to create a rule for the selected database type.
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The following figure shows the Rule panel.

Build Rule

Rule Type NetWitness Platform DB

Name Source and Destination details

Summarize  Event Count v

Select ip.dst

Alias IF Addresz

Where ip.dst =1

Group By ipdst

Then Enter @ then clauze..
! »

. Column Name Sort By
Total Azcending

Reset Test Rule

The following table describes the features in the Rule panel.

Fowrs [Desrbton

Rule Type A drop-down list of supported database types for which you can create rules. The options
are: Netwitness DB and Warehouse DB.

Name The name of the rule that you are creating or editing.

Summarize A drop-down list of summarize options. The options are: None, Event Count, Packet
Count, Session Count and Custom.

Select The meta key for which you need the aggregate values; for example, ip.dest.
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O

Where A Where clause that defines the conditions that trigger the rule execution; for example,
ip.dest = 127.0.0.1.

Group By  The grouping method for the results. For example, specifying ip.dest produces a report in
which like ip.dest values are grouped.

Then A Then clause that defines the rule actions for additional processing on the output.

Order By  The sequencing method used to show results. For example, specifying Order By the value
in the Total column, Ascending, produces a report in which the results are sorted in
ascending order based on the value in the Total column.

Session A selection list for the session threshold, which specifies maximum number of sessions
Threshold  that should be processed for aggregate functions.

Limit A selection list for the maximum number of result rows to be fetched.
Use Clicking Use enables you to use the Rule to generate a Report, Alert of Chart.
Save Clicking Save saves the rule that you are editing and the Build Rule panel remains open.

Before testing a rule, you must save it if you want to keep your changes.
Reset Clicking Reset clears all the field information .
Test Rule  Clicking test rule opens the Test Rule dialog.
Test Rule Dialog

To access the Test Rule view:
1. Goto MONITOR > Reports.

The Manage tab is displayed.
2. In the Rule List panel, do one of the following:

e Select a rule and click Z in the Rules toolbar.
. Click ® 7 > gait,

The Build Rule view tab is displayed.
3. Click Test Rule.
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The Test Rule view is displayed.

Data Source

Format

Time Range
Past

X Axis

Y Axis

2 % | Hours

[[] Use relative time calculation

w

The following table describes the features in the Test Rule Dialog.

Fors focron

Data Source

Format

Time Range

Use relative
time
calculation

A drop-down list of data sources for the type of rule you are testing. Possible data
sources are: Concentrator, Broker, Decoder or Log Decoder.

A drop-down list of the formats for displaying results for the rule. Possible formats are:
Tabular, Area, Bar, Bubble, Column, Line, Pie, Step Line, Step Area, Spline Area, and
Spline.

A drop-down list of time range specification methods.

o Selecting Past allows you to specify a number of years, months, days, weeks, or
hours. For example, Hours, Days, Weeks, Months, or Years.

o Selecting Range allows you to specify a date range and time period. For example,
start date to end date.

In the user interface, the date or time displayed depends on the time zone profile
selected by the user.

Selecting this option calculates the time range relative to the current time.
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o o

X Axis X-Axis and Y-Axis specify the metadata to be plotted in charts.
In the X-Axis drop-down list, the meta types for the Group by setting in the rule are
listed. You can select multiple meta types when the rule has a single Group by setting.
For Custom Rules with multiple Group by values, you can select only the first meta
type for the X-Axis.

Y Axis In the Y-Axis drop-down list, the aggregate functions used in the rule are listed. Sum,
Count, Countdistinct and Average are the supported aggregate functions for rules.
You can select one or more aggregate functions.

Run Test Clicking Run Test executes a test of the rule last saved in the Rule Builder dialog.
When the test is complete, the rule data (if any) for the selected time range is
displayed.

Meta Panel

The Meta panel provides a list of available meta types that you can use to build the rule. You can use the
meta types in the Select, Where, and Then clauses. The Reporting Engine maintains an active list of the
available meta names by continuously synchronizing with the data source to which it is connected.

The following figure displays the Meta panel.

Meta
MWAPPLIAMCET12877-WorkBench : newes +
Filter X

05 -

SC0ESE.pOint |:|
action

ad.computer.dst

ad.computersrc

ad.doemain.dst

ad.domainsrc

sd.usernamedst

S0.usernamesrc -

4 | | »

The following table describes the features in the Meta panel.

Choose Based on the rule type that you have selected, the available data sources are displayed
in the drop-down list of the Meta panel. Select the required data source. The available
meta types for the data source are displayed. Select a meta.

Filter Filter the meta for a specific meta value.

Lists Panel

A List is a placeholder for a set of values that you can use in a meta or a variable. For example, you can
define a list with all the whitelisted event source IP addresses. Once the List is defined then you can use
the List name in the rule. This provides the flexibility of adding, modifying, and deleting the list values.

The Lists panel is a collection of Lists. The Reporting Engine maintains an active list of the available list
names by continuously synchronizing with the collection to which it is connected.
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The following figure displays the Lists panel.

Lists

Filter 3
42 Insert = Lo - JC
0[] Compliznce -

@[] Fitering Candidate
i= Local Country

0[] Logs

0 ] Metwork Activity

0[] Per Uszer Report
0[] Test-41_Fina

0[] Test-List§_Fina

/I

The following table describes the features in the Lists panel.

# - Import or Export a list.

| Import
‘ Export
o Refresh the Lists.

¥ nsert - If you select the NetWitness DB rule type, the options Where and Then are displayed.

| where | Insert the list in the Where or Then clause in the rule.

I Then ‘

¥ Insert © If you select the Warehouse DB rule type, the option Where is displayed. Insert the list
| where i in the Where clause in the rule.
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Chart Permissions Dialog

In the Chart Permissions dialog, you can manage access permissions for user roles at the chart and chart
group level. Only a user with the 'Read & Write' permission can configure the chart in the Reporting

module.
Schedule a Chart —
-
Configure Reporting Engine I Configure a Chart
-

-
Test a Chart Investigate a Chart
| You are here l |
|
| Manage Chart Groups [
' and Charts |
| |

| |
What do you want to do?

Workflow

Administrator/ Configure Reporting Engine For more information, see "Configure Reporting

Analyst Engine" in the Reporting Engine Configuration
Guide.

Administrator/ Configure a chart Configure a Chart

Analyst

Administrator/ Schedule a chart Schedule a Chart

Analyst

Administrator/ View a chart View a Chart

Analyst

Administrator/ Test a chart Test a Chart

Analyst

Administrator/ Investigate a chart Investigate a Chart

Analyst

Administrator/ Manage a chart group and Manage a Chart Group and Chart

Analyst chart*

*Y ou can complete these tasks here.

Related Topics

o Configure and Generate a Chart

Quick View
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The Chart permissions dialog allows you to set chart permissions depending on the user role.

The following figure is an example with the important features labeled.

Charts Permissions

Cleartext Authentications by Service

Roles ~ Read & Write Read Only Mo Access
Administrators -

Analysts -
Data_Privacy_Officers L L -
Malware_Analysts L L -
Operators -
Response_Administr... -
S50C_Managers -
Security_Administra... -
[ Apply Read-only permission to Rules in the Charts

Cancel Save

Click Monitor> Reports to view the Manage tab.

Click Charts to open the Chart view.

In the Chart List panel, select a report and click # ~ > Permissions. The Chart Permissions
dialog box is displayed.

Based on the user role, select the appropriate options.

Rl (Optional) Select the checkbox if you want to automatically provide read access permission to
dependent rules.

I Click Save.

The following table lists the columns in the Charts Permission dialog.

Roles Displays all the user roles in the NetWitness user interface.
Read & Write Allows you to apply 'Read&Write' access to the chart.

Read Only Allows you to apply only 'Read' access to the chart.

No Access By selecting this permission, you cannot access or view the chart.
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] Apply these Allows you to apply permissions to the chart group, subgroups in the group
and charts in the group.

permissions to sub-

gﬁ.o ups and Charts in Note: This checkbox is populated only when you set access permissions for
Uil EEY a Chart Group.

[] Apply Read-only Allows you to automatically apply permissions to the rules in the charts.

permission to Rules in

the Charts
Cancel Cancels all the changes made to the permissions.
Save Saves the selection and provides access to the role based on the selection.
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Chart View

In the Chart View, you can see the available charts and groups in a grid format and also schedule them
by enabling the charts.

Workflow

You are here

\
Schedule a Chart _r.‘
\
[
-
l Test a Chart Investigate a Chart

Configure Reporting Engine Configure a Chart

|

|
e

|

|
—

Manage Chart Groups
and Charts

What do you want to do?

Administrator/ Configure Reporting Engine For more information, see "Configure Reporting

Analyst Engine" in the Reporting Engine Configuration
Guide.

Administrator/ Configure a chart Configure a Chart

Analyst

Administrator/ Schedule a chart* Schedule a Chart

Analyst

Administrator/ View a chart View a Chart

Analyst

Administrator/ Test a chart Test a Chart

Analyst

Administrator/ Investigate a chart Investigate a Chart

Analyst

Administrator/ Manage a chart group and Manage a Chart Group and Chart

Analyst chart

*Y ou can complete these tasks here.

Related Topics

o Configure and Generate a Chart

Quick View

The following figure is an example with the important features labeled.
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MONITOR @ (@ admin

Reports

Manage 1
Rules Reports Alerts Lists Warehouse Analytics Search Report Details k<]
Groups Charts ,/n !
+ T + | | # o | [@viewAllCharts ™ Auto Refresh ‘
Groups ~ [T Enabled Name ~ Group State Duration(H:M:5) Avg(H:M:5) Max{H:M:S) View Chart Actions.
A (2] 0o © Cleartext Authentications by Servi User Acti.. Inactive o5
By stuational wareness @0 ] Cleartex jords by Service User Acti..  Inactive o
e e (m} Email Senders User Acti... Inactive o
[ user Activity (]
= Firewall Denied Connections Siuation...  Inactive oo
m] Firewall Destination IP Addresses Siwation... Inactive o
[m] Firewall Events Situation... Inactive &5
= Firewall Systems Situation... Inactive oo
= Firewall Users Siuation...  Inactive o5
m] IDS Signatures Situation...  Inactive [- X0
[m] Log Destination Ports Situation... ~ Inactive 5o
0 C Log Event Categories Situation... Inactive e .
| Page 1 | of1 | | C' Pagesize 30 v Displaying 1 - 28 of 28
RS /\ NETWITNESS' PLATFORM 11.200

The Chart view includes the following panels:

Chart Groups panel
Chart toolbar
Chart View panel

Chart Groups Panel

The Chart Groups panel allows you to organize charts in a group. You can create a group, add charts to
the group and move charts among groups. The following figure shows the Chart Groups panel.

Groups
+ (ORI - 2
Groups ~

All

[ Threat
[ User Activity (e )

[ 28 )
[ situational Awareness m
[ 4

The Charts Groups Panel includes the following options:

Description

+ Adds a new chart to the Reporting module.
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o o

- Deletes one or more selected charts.
& Edits a chart.
o Refreshes the view.
L g Provides the following options: Import, Export and Permissions.

Chart Toolbar

The Charts toolbar allows you to add, modify, delete, duplicate, activate, deactivate, import and
export a chart. You can also set access permissions for charts in a group.

+ | | | [@viewall Charts & Auto Refresh

The Chart toolbar includes the following options:

o Jomewn

+ Adds a new chart to the Reporting module.
- Deletes one or more selected charts.

& Edit charts.

o Enables the selected charts.

o Disables the selected charts.

E Creates a duplicate copy of the selected chart.

L g Provides the following options: Import, Export, Export as Text and Permissions.
View All Charts Displays all the executed charts.
Auto Refresh Automatically refreshes the charts list.

Chart View Panel

The Chart View Panel presents all the charts in a tabular or grid format.
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[ Enabled | Name ~ Group State Duration(H:M:S) Avg(H:M:S) Max(H:M:S) View Chart Actions

O Cleartexs Authensications by Servi... User Acti.. Inactive e =

o o Cleartext Passwords by Service User Acti..  Inactive B

o o Email Senders User Acti.. Inactive £ 30

o o Firewall Denied Connections Situation... Inactive [ 30

o o Firewall Destination IP Addresses Situation...  Inactive & -

o o Firewall Events Situation...  Inactive B

[me] Firewall Systems Situation... Inactive f. 30

o o Firewall Users Situation... Inactive [ 30

o o 1DS Signatures Situation... Inactive o JO

o o Log Destinaticn Perts Situation...  Inactive B

o o Log Event Categories Situation... Inactive [ 30 .
| Page 1 of1 | | C' PageSize |30 ~ Displaying 1 - 28 of 28

The following table lists the columns in the Chart View panel and their description.

Description
Enabled ® - The chart is enabled.
© - The chart is disabled.
Name The name of the chart.
Group The Chart Group to which the chart belongs.
State The state of the chart:
o Queued

o Completed
o Failed

Duration The time taken to execute the latest chart.
(H:M:S)

Avg(H:M:S) The average time taken to run the chart.
Max(H:M:S) The maximum time taken to run the chart.
View Chart A hyperlink that redirects to the View a Chart panel.

o 3G The actions menu has the following options: Enable, Disable, View, Delete, Edit,
and Export.
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Execution History Panel

The Execution History panel allows you to fetch and display history details.

Workflow

This workflow shows the procedure to view report or report groups.

You are here

| :

|
Configure Reporting Create and Schedule a X |

View a Report
Engine Report Jl-, - |
|
| \ .
Investigate a Report
Manage Lists, Rules or

Reports

What do you want to do?

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report
Analyst reports*

Administrator / Investigate a Report Investigate a Report
Analyst

Administrator / Manage/Access control for lists, Manage Lists, Rules or Reports
Analyst rules or Reports

*Y ou can complete these tasks here.

Related Topics

o Configure and Generate a Report

o Generate List Panel

o Scheduled Reports View
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Quick View

The following figure is an example of the Execution History view.

Dynamic Report With List for Alias Host: Execution History
[

Execution Date ~ Execution Duratlion (5ec) State View Report

Get history by:
Past # Executions ~ ||| 2014-08-31 0&:58 2703.435 Completed

20714-08-30 15:24 3158.262 Completed
10 )

Show History

| Page |1 | oft1 | I C Displaying1-2of 2

Features

The View Execution History has the following panels:

Execution History Options panel
Execution History Output panel

To access this view:
1. Goto MONITOR > Reports.

The Manage tab is displayed.
2. In the Rule List panel, do one of the following:

o Hover the mouse over a report and click ¥ " > View Scheduled Reports.

o Click #Schedules column.
The Schedule Reports view is displayed with the status of each of the scheduled report.

3. Select a scheduled report and do one of the following:

« Click # .2 > Execution History.

o Click ® from the Scheduled Reports Toolbar Panel.
Execution History Options Panel
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The Execution History Options panel allows you to fetch the history details based on either past n
number of scheduled reports or a specific date range.

The following table lists the operations in the Execution History Options panel:

Get history by:

From
To

Count

Show History

This is the criteria to view the execution history:

« Past # Executions: The past n number of scheduled reports.

By default this option is displayed.

« Range (specific): The start date and end date for the date
range.

Note: The From and To field is populated in the NetWitness
Platform UTI only when you select 'Range (Specific)' from
the Get history by list.

The start date for the date range.
The end date for the date range.

The number of execution history of the scheduled report to be
displayed.

Shows the history details based on the selected criteria.

Execution History Output Panel

The Execution History Output panel displays the history details with the execution date, execution
duration (seconds), state of the scheduled report, and a link to view the report.

The following table lists the various columns in the Execution History Output panel:

The date on which the scheduled report was executed. By default, the execution

Execution Date

date is in descending order.

Execution Duration The time duration taken to execute the scheduled report.

(Sec)
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State The state of the scheduled report:

o Scheduled: If a report is scheduled to run on an hourly, daily, weekly, monthly,
or later time, the state of the report is displayed as scheduled, for the first run.

o Queued: If a report is still waiting to get executed, the state of the report is
displayed as queued.

o Running: If the report schedule is in progress, the state of the report is
displayed as running.

o Partial: If in a report with several rules, a single rule execution failed or an
output action failed or creation of PDF/CSV failed, the state of the report is
displayed as partial. For example, consider a report with five rules and

four rules are executed successfully and one fails, then the state is displayed
as Partial.

o Failed: If in a report with several rules, all the rule schedule executions failed,
the state of the report is displayed as failed.

o Completed: If a report schedule is successfully executed, the state of the
report is displayed as completed.

o Canceled: When cancel request is completed, the state of the report is
displayed as canceled.

o Inactive: If a report schedule is disabled, the state of the report is displayed as
Inactive.

o Not available: If the report schedule executed information is not available, the
state of the report is displayed as not available.

View Report The hyperlink to View a Report on full screen.
Close Closes the execution history view.
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Generate List Panel

The Generate List dialog allows you to generate and customize a list.

Workflow

This workflow shows the procedure to create and schedule a report.

You are here

Configure Reporting

| |
! |

Configure a Rule 'l_’_ Create and Schedule a . View a Report
I

Engine

Investigate a Report
Manage Lists, Rules or

Reports

What do you want to do?

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report*  Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports*

*Y ou can complete these tasks here.
Related Topics

o List View

 Build List View
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o Lists Permissions Dialog

Quick View

The following figure is an example of the Generate List dialog.

M overwrite Exi sting List Y

To access this view:

List Name: $[/Per User Report/List of Service!| | Browse
Rule Access o G v
Calumn filename v

Cancel Save

1. Goto MONITOR > Reports.

The Manage tab is displayed.

2. Click Reports.

The Report view is displayed.

3. Inthe Report List panel, select a report and click # " > Schedule Report.

The Schedule a Report view tab is displayed.

4. In the Dynamic List panel, click +.

The Generate List dialog is displayed.

Features

The following table lists the features in the Generate List dialog.

I

List Name
Browse
Rule
Column

Overwrite Existing
List?

Save

The name of the list chosen from the List Selection panel.

Click this button to select a list from the List Selection Window dialog.
Select a rule to be used to create the list.

Select a value for the column.

Overwrites the existing list.

Adds the desired list to the Generate List panel of the Schedule Report
view.

The List Selection Window dialog consists of lists that are defined in the Lists panel. Here, you can
select a list to associate it with the report. The following figure shows the dialog.
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List Selection Window

2 Refresh

List Name =~

==
==|:|C0r'1plian:e
@ [ Filtering Candidate

= Local_Country

20 Logs
& [ Network Activity
@[ Per User Report
-+ All_FInal

= Lists_Final

3

Clase Select
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Import Chart Dialog

In the Import Chart dialog, you can import charts containing subgroups and charts from other instances of
NetWitness into the Chart Groups panel. Charts must be in a valid binary file that was exported from

another NetWitness instance.
Schedule a Chart —
-
Configure Reporting Engine I Configure a Chart
— —b
Test a Chart Investigate a Chart
| You are here l |
|
| Manage Chart Groups [
' and Charts |
| |

| |
What do you want to do?

Workflow

Administrator/ Configure Reporting Engine For more information, see "Configure Reporting

Analyst Engine" in the Reporting Engine Configuration
Guide.

Administrator/ Configure a chart Configure a Chart

Analyst

Administrator/ Schedule a chart Schedule a Chart

Analyst

Administrator/ View a chart View a Chart

Analyst

Administrator/ Test a chart Test a Chart

Analyst

Administrator/ Investigate a chart Investigate a Chart

Analyst

Administrator/ Manage a chart group and Manage a Chart Group and Chart

Analyst chart*

*Y ou can complete these tasks here.

Related Topics

o Configure and Generate a Chart

Quick View
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This dialog displays differently when you use it to import groups containing subgroups and charts from
other instances of NetWitness into the Chart Groups panel.

The following figure is an example of the Import Chart dialog.

mport Chart

4+ Browse.. = Delete

File Name Overwrite 7

Click Monitor> Reports to view the Manage tab.

Click Charts to open the Chart view.
In the Chart Groups panel, select a folder to import the file.

In the Chart Groups panel or Chart toolbar, click & ~ > Import to import the file.

The following table describes the features in the Import Chart dialog,.

Browse Displays a view of the local file system so that you can select the chart to be imported.
Delete Deletes an imported report from the list of imported charts.

File Name Displays a list of chart files that will be imported to your Charts module when you click
Import.

Overwrite? Allows you to select the option to overwrite an existing version of the chart you are
importing. If you do not select the Overwrite option, a duplicate file is imported and no
error message is displayed.

Close Closes the dialog. If you have charts to select for import, but have not clicked Import.
The charts are not imported, and are not saved in this dialog.

Import Imports the selected charts to your Charts module.
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Import Report Dialog

In Import Report dialog, you can import groups containing subgroups and reports from other instances of
NetWitness Platform into Report Groups panel. Reports must be in a valid binary file that was exported
from another NetWitness Platform instance.

Workflow

This workflow shows the procedure to manage reports or report groups.

Configure Reporting Confiaure a Rule Create and Schedule a .
Engine 9 Report — View a Report

\

~

You are here |

| Investigate a Report
Manage Lists, Rules or |
Reports |

What do you want to do?

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports*

*You can complete these tasks here.

Related Topics
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Configure and Generate a Report

Report View
Build Report View

o Reports Permissions Dialog

Quick View

=+ Browse.. = Delete

Flle Mame

Overwrite ?

To access the Import Report dialog:
1. Goto MONITOR > Reports.

The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.

3. Inthe Report Groups panel, select a folder to import the file.

4. Do one of the following:

« Inthe Report Groups panel, click * * > Import to import a group.

« In the Report toolbar, click # “ > Import to import a report.

The following table lists the features of the Import Report dialog.

e

Browse This option displays a view of the local file system so that you can select the report to be
imported.

Delete This option deletes an imported report from the list of imported reports.

File Name Displays a list of report files that will be imported to your Reports module when you
click Import.

Overwrite? Allows you to select the option to overwrite an existing version of the report you are
importing. If you do not select the Overwrite option, a duplicate file is imported and no
error message is displayed.

Close This option closes the dialog. If you select a report and not clicked Import. The reports
are not imported, and are not saved in this dialog.

Import This option imports the selected reports to your Reports module.
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Investigate a Chart View

In the Investigate a Chart view, you can view and investigate chart details. There are options for filtering
and sorting the information in the chart, as well as options for the type of chart, the number of items to
chart, and charting values or totals. When viewing a chart, you can open the charted sessions in the

Investigation module and save the chart as a PDF.
Schedule a Chart —
-
| You are here |
— - |
Test a Chart \ Investigate a Chart |
| |
| |

Workflow

Configure Reporting Engine Configure a Chart

Manage Chart Groups
and Charts

What do you want to do?

Administrator/ Configure Reporting Engine For more information, see "Configure Reporting

Analyst Engin" in the Reporting Engine Configuration
Guide.

Administrator/ Configure a chart Configure a Chart

Analyst

Administrator/ Schedule a chart Schedule a Chart

Analyst

Administrator/ View a chart View a Chart

Analyst

Administrator/ Test a chart Test a Chart

Analyst

Administrator/ Investigate a chart™ Investigate a Chart

Analyst

Administrator/ Manage a chart group and Manage a Chart Group and Chart

Analyst chart

*You can complete these tasks here.

Related Topics

o Configure and Generate a Chart

Quick View
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The following figure is an example with the important features labeled.

Manage View [CHRT] Cleartext Password... @

: -
“i’mvesngate 12 Full Screen H (! 2 Friday
Behaviars of Compromise Sepuember 28,2017
Display [ X s M ¥ Axi ¥ Legend: - Septamber 2017 - ‘
s M T w T F H
1 2
- 3 4 5 6 7 8 9
é 10 n" 12 13 14 15 16
g 17 138 19 20 21 22 23
g 24 25 26 27 28 n
o o 04 042 o o [ o o Charts
- EMPTY - E i
Behaviors of Compromise
—B
Chart Options
Time Range Series Items To Plot Chart Type
Last3Hours v| @ e |5 g Line v
The View a Chart panel includes the following panels:
Chart toolbar
Chart Output panel
Chart Calendar panel
Chart Options panel
Chart Executed list
Chart Toolbar

The Chart toolbar has options that allow you to investigate, and view the chart on another screen.

T Investigate I Full Screen

The following table lists the options in the Chart toolbar.

Investigate  Investigates the chart details.

- Full Screen  Displays the chart on a full screen.
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Lists Permissions Dialog

In the Lists Permissions dialog, you can manage access permissions for a user role at the list or list
group level. Only a user with Read and Write permission can configure the list in the Reporting
Module.

Workflow

This workflow shows the procedure to manage lists or list groups. You can set access control at the list
or list group level so that only users with specific roles can access the lists. You can use lists to define
rules for generating reports, charts and alerts.

You must ensure that Reporting Engine is configured on NetWitness Platform.

Configure Reporting Create and Schedule a .
Engine Report — View a Report

\

~ /Y

You are here |

: | Investigate a Report
Manage Lists, Rules or |

| Reports |

|

|

What do you want to do?

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports*

*Y ou can complete these tasks here.

Related Topics
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o List View

o List section in the "Role Permissions" topic in the System Security and User Management Guide.

Quick View

The following figures are examples of the Lists Permissions dialog and List Group Permission dialog:

Lists Permissions

Blacklisted IPs

Roles ~ Read & Write Read Only Mo Access
Administrators ® @] O
Analysts O @] ®
Data_Privacy_Officers O O ®
Malware_Analysts O O ®
Operators @] @] ®
Response_Administ... O @] ®
50C_Managers O O .
Security_Administra... O @] ®

Cancel Sawve

rmissions

Network Activity

Roles ~ Read & Write Read Only Mo Access
Administrators O] @] ]
Analysts @] @] ®©
Data_Privacy_Officers O O ®
Malware_Analysts O O ®©
Operators Q Q ®
Response_Administ... O O ®
S0C_Managers O O O
Security_Administra... @] @] ®
[] Apply these permissions to sub-groups and Lists in this group

Cancel Save

To access this view
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1. Goto MONITOR > Reports.

The Manage tab is displayed.

2. Click Lists.

The Lists view is displayed.

3. Inthe Lists view, select a report.

4. In the Lists toolbar, click ¥ * > Permissions.
The Reports Permissions dialog is displayed.

The following table describes the features in the Lists Permissions dialog:

o= o

Roles

Read & Write

Read Only
No Access

Apply these permissions to
subgroups and lists in this

groups
Cancel

Save

Describes roles of the users logged into the NetWitness Platform user
interface.

Allows users to access, view, edit, delete, import, and export lists on
the Lists view. Users can also change the permission on the rule.

Allows users to only access and view the list on the lists view.
Doesn't allow users to access or view the lists.

Automatically applies permissions to the subgroups and lists in the
groups, if checkbox is selected.

Cancels all the changes made to the permissions.

Saves the selections and provides access to the roles based on the
selections.
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List View

In the List view you can see available lists and groups in a grid.

Workflow

This workflow shows the procedure to define lists or list groups. You can set access control at the list or
list group level so that only users with specific roles can access the lists. You can use lists to define
rules for generating reports, charts and alerts.

You must ensure that Reporting Engine is configured on NetWitness Platform.

You are here

Configure Reporting Create and Schedule a

Report > View a Report

Investigate a Report
Manage Lists, Rules or

Engine

Reports

What do you want to do?

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure

Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide

Administrator / Create a List or List Configure a Rule

Analyst Group/Create or Deploy a

Rule/Test a Rule*

Administrator / Create and Schedule a Report Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports

*Y ou can complete these tasks here.

Related Topics
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o Lists Permissions Dialog

o Build List View

Quick View

The following figure shows the List view.

Manage

w

Rules  Repons  chans  mens [  werehouse anaiytics Search Report Detals &
Groups Lists ‘/H
+ [+ -] + | &
Groups ~ Name Group Date Moddied Action:
L] (/] ] Blackhsted IPs 201705030839 &
45 Complance o ) Compliance Data 20170503 0833 &
Catew Geeup L] Compliance Symems 2017:05-03 08:34 £
¥ [ Filuering Candidates o] .
1 Content Delvery Meswerks 20170503 08:28 L
5 Networte Actvity o
[ List of Alas Hosts 2017-05-03 08:31 &
[ Listof IP Addresses 2017-0502 08:32 &
[ Listof Message ID 20170803 0833 &
| Page 1 of1 | & PagesSize 30 Displaying 1-7of 7

To access this view
1. Goto MONITOR > Reports.

The Manage tab is displayed.
2. Click Lists.

The Lists view is displayed.

The List view includes the following panels:

List Groups panel
List toolbar

List View panel
List Groups Panel

The List Groups panel provides a list of groups used to organize lists and has a toolbar that allows you to
create and manage the groups.

P pmserpin

+

& O

Allows users to add a new group to the Reporting module.

Allows users to delete groups.
Refreshes the view.

Allows users to access following options: Import, Export and Permissions.
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You can perform the following actions using the List Groups panel.
o Refresh lists in a group.

o Move lists between different groups. You can move a list from one group to another by dragging and
dropping the list in the required group.

o Create list groups.
o Delete list groups.
o Import list groups.
o Export list groups.

o Set access control for list groups.

List Toolbar
[
+ Allows user to add a new list to the Reporting module.
- Allows user to delete one or more selected lists.
] Allows user to edit lists.
= Creates a duplicate copy of the selected list.
T Allows user to access the following options: Import, Export and Permissions.

List View Panel
The List View panel displays all the lists defined in a tabular format.

Name Displays the name of the list.

Note: For Name field, the icon to extend the column size is not displayed at the
end of the column field. You have to hover the mouse a little to the left side to
see the icon for extending the column.

Group Displays the list group to which the list belongs.

Date Modified  Displays the date and time when the list was modified.
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Reports Permissions Dialog

In the Reports Permissions dialog, the users with 'Read & Write' access permission can configure
permissions.

Workflow

This workflow shows the procedure to manage reports or report groups.

Configure Reporting Create and Schedule a .
Engine Report — View a Report

\

~

You are here |

: | Investigate a Report
Manage Lists, Rules or |

| Reports |

|

|

What do you want to do?

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports*

*You can complete these tasks here.

Related Topics

o Configure and Generate a Report

o Report View

Reporting References 330



Reporting User Guide

o Build Report View

o Import Report Dialog

Quick View

Reports Permissions

Aggregate Functions

Roles ~ Read & Write Read Only M@ ACCess
Adminl o (&) =
Administrators -

Analyst1 o (&) L3
Analysts o o ®
MalwareAnalysts o (&) L3
Operator] (o] (o] (1]
Ciperators o o (m
50C_Managers o (&) L3
[] Apply Read-only permission to Rules in the Reports

Cancel Save

To display the Reports Permissions dialog:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. Inthe Report List panel, select a report.

4. Click ¥~ > Permissions.
The Reports Permissions dialog is displayed.

Note: When you select the check box, all dependent rules are given READ access permission,
provided the permissions for the report is higher compared to the permissions of the rules.

The following table describes the features in the Reports Permissions dialog.

(o e

Roles Displays all the roles who can get access to the permissions.

Read&Write Allows you to get Read&Write access to the Rules in the
Reports.

Read Only Allows you to get Read Only permissions to the Rules in the
Reports.
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No Access If you select this option, you will not get permission to the
Rules in the Reports.

Apply Read-only permissions to Allows to set Read Only permissions to the Rules in the
Rules in the Reports Reports for all the roles .

Cancel This option cancels all the changes made to the permissions.
Save This option saves the selections and provides access to the

roles based on the selections.
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Report View

In the Report view, you can create and manage the report or report groups.

Workflow

This workflow shows the procedure to create and schedule a report.

You are here

Configure Reporting

| |
! |

Configure a Rule 'l_’_ Create and Schedule a . View a Report
I

Engine

Investigate a Report
Manage Lists, Rules or

Reports

What do you want to do?

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report*  Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports

*Y ou can complete these tasks here.

Related Topics

o Build Report View

o Import Report Dialog
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o Scheduled Reports View

« Reports Permissions Dialog

Quick View

MONITOR @ admin @ (3
REPORTS
Manage
Rules Charts Alerts Lists Warehouse Analytics “ E] Search Report Details k<]
Groups Reports
+ sl -2 ‘ + =4 | B #© | [@viewalReports [ view
Groups ~ O Name ~ Group Date Modified #Schedules | Actions
All [ Malware Activity Report Hunting 2017-08-07 08:55 1 &
[ DarshanRegression O Hunting Summary Hunting 2017-08-07 06:10 1 Lo
[ Hum
[ Al Risk Warning Siuational Awareness 2017-08-07 09:23 1 5
[security Analytics
[ Security Analytics Administration Report Security Analytics 0 o 28
[ Situational Awareness
O Identity Manay 1 &5
[J Report-RuleTo 1 1 &
[J Report-RuleTo 1 &
O Report-RuleToTestSpeci 1 TF -
¥ Report-RuleToTestSpecialChars-4 Darshan-Regression 2017-08-09 06:11 1 -
| Page 1 |of1 | | C' Pagesize 30 Displaying 1- of 9

To access this view:

1. GotoMONITOR > Reports.
The Manage tab is displayed.

2. Click Reports.
The Reports view is displayed.

Features

The Report view includes the following sections:

Report Groups panel
Report toolbar
Report List panel

Report Groups Panel

The Report Groups panel allows you to organize reports in a group. You can create a report group, add
reports to the group, and move reports among groups. You can view all reports by selecting All option
under the Groups column.
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Groups
+ (ORI - 2
Groups ~

All
[ Aggregation
[ JHunting

[ Security Analytics

000090

[ Situational &wareness

N

-+ This option allows you to add a new report to the Reporting module.
= This option allows you to delete one or more selected report.
F This option refreshes the view.
(- X The actions menu has the following options: Import, Export and
Permissions.
Reports Toolbar

The Reports toolbar allows you to add, modify, delete, duplicate, import and export reports. You can also
set access permissions for a report in a group.

+ | & ~ | @ view All Reports View all Schedules
m

-+ This option allows you to add a new report to the Reporting module.

= This option allows you to delete one or more selected reports.

This option allows you to edit a chart.

@ N

This option creates a duplicate copy of the selected report.

The actions menu has the following options: Import, Export , Export as Text and
Permissions.

&
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o o

Buenareots his option allows you to view a list of reports along with their schedule name and time.

View A This optior: allows you to view all the scheduled reports.

Report List Panel

The Report List panel lists all the reports in a tabular format.
O Mame ~ Group Date Modified #schedules | Actlons
[1 AnalystReport 2016-01-14 23:40 1 0 -
[1 DPOReport 2016-01-14 2341 1 FYE
[ Report-All-Meta-Types 2015-12-01 1334 1 &
[] Report-All-Meta-Valid-Types 2015-12-01 10:00 1 oe
[ Report-All-Rule-Actions 2015-12-01 1334 1 &
[1 Repor-Rule_l 2016-02-25 15:41 0 0~
[ test 2015-12-01 10:02 0 FYE

| Page |1 | of1 | | C PageSize 30 v Displaying 1-7 of 7

The following table describes the columns in the Report List panel.

Name The name of the report.

Group The Report Group to which the report belongs.
Date The date and time when the report was modified.
Modified

#Schedules The count indicates the number of schedules created for a report.

Actions The actions menu has the following options: Schedule Report, View Scheduled Reports,
Delete, Edit, and Export.
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Rule Permissions Dialog

The Reporting module provides access control at the rule level. Only a user who has the right set of
permissions can perform tasks on the rule. When creating user roles, the administrator must ensure that
the roles created for specific tasks have access to all the permissions higher in the hierarchy of roles.

Workflow

This workflow shows the procedure to manage rule or rule groups.

Configure Reporting Confiaure a Rule Create and Schedule a .
Engine 9 Report — View a Report

\

~

You are here |

| Investigate a Report
Manage Lists, Rules or |
Reports |

What do you want to do?

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports*

*Y ou can complete these tasks here.

Related Topics

o Rule View

Quick View
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This figure shows the Rules Permissions dialog for a single rule.

Rules Permissions

Source and Destination Details

Roles = Read & Write Read only MO ACCESS
AdminT s
Adminlstrators s
Analyst1 s
Analysts .
IMalware_Analysts =
Operator] .
Cperators s
50C_Managers .

Cancel Save

This figure shows the Rules Permissions dialog when multiple rules are selected.
Rules Permissions

Multiple objects selected

Roles ~ Read & Write Read Only Mo Access

Administrators®

Analyst1*

Analysts O

Event Stream A.. &
Malware_Analysts .

Managers .

Operators .

Security®

Users* b

“**" indicates other permissions on the object. Select the required cbject only to medify

the permissicn
Cancel Save

The dialog has a different appearance for rule groups versus rules. To access the dialog:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Inthe Rules list panel, select one or more rules or a rule group.
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3. Click - > Permissions in the toolbar.

The Rules Permissions dialog is displayed.

N

Roles column Lists the NetWitness Platform user roles, both built-in and custom roles. Each
user who is logged in to NetWitness Platform has user roles assigned.

When multiple rules are selected, the asterisk beside the role name, for
example, Security*, indicates there are other permissions available on that
user role. To change the other permissions, you must select the user role and
change the access permission.

Read & Write When the checkbox in this column is selected, the corresponding user role has
column permission to view, edit, delete, import, and export rules in the Rules view. The
user can also change the permission on the rule.

Read Only column When the checkbox in this column is selected, the corresponding user role has
permission to view the rules in the rule group.

No Access column  When the checkbox in this column is selected, the corresponding user role
cannot view or edit the rules in the rule group.

Before applying rule permissions, this is the default permission set for all the
user roles though the checkbox is unchecked.

Apply these When checked, NetWitness Platform applies permissions to sub-groups and
permissions to sub-  rules in the group.

groups and Rules in

this group checkbox

Cancel option Clicking Cancel closes the dialog without saving any changes made.
Save option Clicking Save closes the dialog and updates the rule group permissions for user
roles.

If specified, the access permissions are applied to subgroups and child objects
of this group.

When multiple rules are selected, the access permission is applied to all the
selected rules.
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Rule View

The Rule view is the user interface for managing rules.

Workflow

This workflow shows the procedure to define rule or rule groups.

You are here

Configure Reporting Create and Schedule a

Report > View a Report

\
What do you want to do?

Engine

Manage Lists, Rules or

Reports

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure

Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide

Administrator / Create a List or List Configure a Rule

Analyst Group/Create or Deploy a

Rule/Test a Rule*

Administrator / Create and Schedule a Report Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports

*Y ou can complete these tasks here.
Related Topics
o Rule Permissions Dialog

o Build Rule View

Quick View
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MONITOR @admn® @)

REPORTS

m Reports harts Alerts Lists ‘Warehouse Analytics Search Report Details &
Groups Rules
+ O lme
Groups ~ [ Name ~ Type Group Date Modified Actions
2 [ 135 ] [ Accounts Created NetWit Identity Management FYE
- 0 O Accounts Deleted Net Identity Management 2017-08-0710:15 | £ @
© [ Accounts Disabled NetWitness .. Identity Management 2017-080710:15 | 2§
@ [m Modified Identity Management
© [ All Risk Suspicious By Session Size
[ Identity Managemeant (=]
[ 5ecuring Anclyeics o [ AllRisk Warning By Destination IP NetWimess ..
» ST 1032 o [ AllRisk Warning By Se:
» CISIT10.4.0.2 =0 [ AllRisk Warning By So
[ Situational Awareness B [ Behaviors of Compromise .. Hunting
[ Threa: 2] [ Behaviors of Compromise Detail Hunting
[bserhy © o Authentications by Senice o
| Page 1 | ofs | } B | C PageSize 30 v Displaying 1 - 30 of 135

To access the Rules view:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Rules.
The Rules view is displayed.

The Rule view includes the following panels.

Rule Groups

Rules List
Rule Toolbar
Rule Groups Panel

The Rule Groups panel allows you to organize rules into groups using the options in the toolbar. You can
create groups and sub-groups and add rules to them. You can also group and move rules between
different groups.

The following figure shows the groups in the Rule Groups panel:
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Groups
+ (ORI - 2=

Groups ~

3

All

b [ Ageregate Function
» [ All-Rules_Final
[ Coemmand and Contral
[ cCampliance
[ Data Exfiltraticn
[CJFiltering Candidate
[JFiltering Candidates
¥ [Jldentity Management
L&A Rules
b [ Metwork Activity
|
3

000000 Booobob

L |

The following table describes the features in the Rule Groups Panel.

o o

-+ This option allows you to add a new rule group to the Reporting module.

This option allows you to delete one or more rule groups.

Fo This option refreshes the rule group list.
- The actions menu has the following options: Import, Export and Permissions.
All Displays a list of all the rule groups.

Rule Toolbar

The Rule toolbar allows you to add, delete, edit, and duplicate a rule. The following figure shows the
toolbar.

+ | L N

The following table describes the features in the Rule Toolbar

Fowrs JDsscipton

== This option allows you to add a new rule to the Reporting module.
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Description
= This option allows you to delete one or more selected rules.
= This option allows you to edit a rule.
= This option allows you to duplicate a rule.
E o T The actions menu has the following options: Use, Import, Export
and Permissions.
P This option allows you to select the rule type.

Rule List Panel
The following figure shows the list of rules in the Rule List panel.

[ Name ~ Type Group Date Modified Actions

[ Accounts Crested NetWitness.. Identity Management 2017-08-0710:15 | = -
[ Accounts Deleted NetWitness...  Identity Management 201708071045 |§ =

[0 Accounts Disabled NetWitness... Identity Management 2017-08-07 10:13 -

[ Accounts Modified NetWitness.. Identity Management 2017080710415 | =

[} All Risk Suspicious By Session Size NetWitness... 2017-08-07 08:44 | £ =

[0 Al Risk Warning By Destination IP NetWitness... 2017-08-07 10:10 -

[ All Risk Warning By Session Size NetWitness... 201708071010 |

[ All Risk Warning By Source IP NetWitness... 2017-08-0710:10 | =

[l Behaviors of Compromise NetWitness.. Hunting 20170807 06:08 | £ =

[0 Behaviors of Compromise Detail NetWitness.. Hunting 2017-08-07 06:02 -

[ Clesrtext Authentications by Service NetWitness..  User Activity 2017-08-0708:53 | - -

| Page 1 ofS | } » | C Pegesize 30 ~ Displaying 1 - 30 of 135

The following table describes the features in the Rule List Panel.

Description

Name Displays the name of the rule that you are created or edited.

Note: For the Name field, the icon to extend the column size is not displayed at the end
of the column field. You have to hover the mouse a little to the left side to see the icon
for extending the column.

Type Displays the supported database type for the rule you created.
Group Displays the values which are grouped.

Date Displays the date when the rule was last modified.
Modified

Actions  Displays the actions menu has the following options: Create Alert, Create Chart, Create
Report, Delete, Edit, Export, and Dependents.
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Select a Logo Dialog

In the Select a Logo dialog, you can upload a new logo that is not available in Reporting Engine Services
Config view or choose an existing logo from the Reporting Engine Services Config view.

Workflow

This workflow shows the procedure to manage reports or report groups.

Configure Reporting Create and Schedule a .
Engine Report — View a Report

\

~

You are here |

: | Investigate a Report
Manage Lists, Rules or |

| Reports |

|

|

What do you want to do?

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports*

*You can complete these tasks here.

Related Topics

o Configure and Generate a Report

o Scheduled Reports View
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o Report View

Quick View

Change Logo

Upload new logo

or select from existing logos...

| RSy
e g o

Cancel

To access this dialog:
1. Goto MONITOR > Reports.

The Manage tab is displayed.
2. Click Reports.
The Reports view is displayed.
3. Inthe Report List panel, select a report.

4. Click # % > View Scheduled Reports.
The View scheduled reports view tab is displayed.

5. Select a scheduled report and click ¥ " > Edit Schedule.
The Schedule a Report view tab is displayed.

6. Click the Logo panel.
The Change a Logo dialog box is displayed.

The following table lists the fields in the Select a Logo dialog.

I

Upload new logo Click the icon to upload a new logo from the local directory.
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o owmen

Select Select a logo from the existing list to be used as a logo in the scheduled report.
Cancel Cancels the logo selection and returns to the Schedule a Report panel.
Set Default Select a logo to set it as the default logo.
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Schedule a Chart View

In the Schedule a Chart View, you can enable or disable a chart.

Workflow

You are here

\
Schedule a Chart _r.‘
| \
| [
- -
Test a Chart Investigate a Chart

Configure Reporting Engine

Manage Chart Groups
and Charts

What do you want to do?

Administrator/ Configure Reporting Engine For more information, see "Configure Reporting

Analyst Engine" in the Reporting Engine Configuration
Guide.

Administrator/ Configure a chart Configure a Chart

Analyst

Administrator/ Schedule a chart* Schedule a Chart

Analyst

Administrator/ View a chart View a Chart

Analyst

Administrator/ Test a chart Test a Chart

Analyst

Administrator/ Investigate a chart Investigate a Chart

Analyst

Administrator/ Manage a chart group and Manage a Chart Group and Chart

Analyst chart

*Y ou can complete these tasks here.

Related Topics

o Configure and Generate a Chart

Quick View

The following figure shows the Schedule a Chart view.
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MONITOR @ (@ admin

Reports

Manage
Rules Reports Alerts Lists Warehouse Analytics Search Report Details k<]
Groups Charts ,/n !
+ T + | | # o | [@viewAllCharts ™ Auto Refresh ‘
Groups ~ [T Enabled Name ~ Group State Duration(H:M:5) Avg(H:M:5) Max(H:M:S) View Chart Actios
A (2] 0o © Cleartext Authentications by Servi User Acti.. Inactive o5
By stuational wareness @0 m] Cleartext Passwords by Service User Acti...  Inactive oy
e e (m} Email Senders User Acti... Inactive o
[ user Activity (]
= Firewall Denied Connections Siuation...  Inactive oo
m] Firewall Destination IP Addresses Siwation... Inactive o
0 C Firewall Events Situation...  Inactive &
0 C Firewall Systems Inactive e
0 C Firewall Users nactive &
O C IDS Signatures Situation...  Inactive (-8
0O C Log Destination Ports Situation...  Inactive oL
0 C Log Event Categories Situation... Inactive e .
| Page 1 | of1 | | C' Pagesize 30 v Displaying 1 - 28 of 28

RS /\ NETWITNESS' PLATFORM

The Schedule a Chart view includes the following panels:

Chart Groups panel
Chart toolbar
Chart View panel

Chart Toolbar

The Charts toolbar allows you to add, modify, delete, duplicate, enable, disable, import and export a
chart. You can also set access permissions for charts in a group.

= | | # © | [@viewallCharts & Auto Refresh

The Chart toolbar includes the following options:

N

+ Adds a new chart to the Reporting module.
- Deletes one or more selected charts.

“ Edit charts.

® Enables the selected charts.

Disables the selected charts.
IS Creates a duplicate copy of the selected chart.
& Provides the following options: Import, Export, Export as Text and Permissions.

View All Charts Displays all the executed charts.
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o

Auto Refresh Automatically refreshes the charts list.

Chart View Panel

The Chart View Panel presents all the charts in a tabular or grid format.

[0 | Enabled = Name ~ Group State Duration({H:M-S) AvgH:M:5) Max{H:M:5) View Chart Actions

o o Cleartext Authentications by Servi... User Acti...  Inactive 5 - =

[mie] Cleartext Passwords by Service User Acti.. Inactive f. 30

oo Email Senders User Acti...  Inactive f- 38

o o Firewall Denied Connections Situation... Inactive o JO

oo Firewall Destination IP Addresses Situation...  Inactive -

[mie] Firewall Events Situation... Inactive f 30

oo Firewall Systems Situation... Inactive & -

oo Firewall Users Situation...  Inactive -

[mie] IDS Signatures Situation... Inactive fo 38

[mie] Log Destination Ports Situation... Inactive f 30

oo Log Event Categories Situation... Inactive . 2O -
| Page |1 | of1 | | ¢ Pagesize 30 ~ Displaying 1-28 of 28

The following table lists the columns in the Chart View panel and their description.

R R

Enabled

Name
Group

State

Duration (H:M:S)

® - The chart is enabled.
© - The chart is disabled.

The name of the chart.
The Chart Group to which the chart belongs.

The state of the chart:
e Queued

o Completed

o Failed

The time taken to execute the latest chart.

Avg(H:M:S) The average time taken to run the chart.
Max(H:M:S) The maximum time taken to run the chart.
View Chart A hyperlink that redirects to the View a Chart panel.
L XE The actions menu has the following options: Enable, Disable,
View, Delete, Edit, and Export.
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Schedule Report Panel

The Schedule Report panel allows you to schedule a customized report. Prior to scheduling a report, you

can create a dynamic list (with the overwrite option selected) with services added. For more information,
see "Generate a List from the Scheduled Report" section in Create and Schedule a Report. Then use the

list to generate a report with details in the report like services and host names.

Workflow

This workflow shows the procedure to create and schedule a report.

You are here

Configure Reporting

| |
! |

Configure a Rule ‘l_’_ Create and Schedule a . View a Report
I

——
What do you want to do?

Engine

Manage Lists, Rules or
Reports

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report*  Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports

*You can complete these tasks here.

Related Topics
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o Configure and Generate a Report

o Report View
o Build Report View

o Scheduled Reports View

Quick View

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN @:}admln~ @

Overview Reports

Manage View [REPT] New Schedule &
Schedule Report
bl ™ + n

Report Name  FeedsT

Schedule Nam

NetWitness .

Suite DB

Time Zone UTC (GMT+00:01 - Def

Run o v

o t v < v|Ou
D —
e

COUPEN  Reset | Configure
RS /\ NETWITNESS' PLATFORM 11.2.0.0

To access this view:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Reports.
The Reports view is displayed.

3. Inthe Report List panel, click ¥ " > Schedule Report.
Features

The Schedule Report view consists of the following panels:

Schedule Report View
Output Actions Panel
Dynamic List Panel

Logo Panel
Schedule Report View

The Schedule Report view allows you to schedule reports.
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Schedule Report

Enatle £

MetWitness DB | SA - Broker

Report Mame  Dynamic Report With List for Service

Schedule Mame Dynamic Report With List for Service

Run Mo -~
On Fast | 24 2 |Hours ~ [ Userelative time calculation
Variablez |terative
~
Report
Iterste On List |S[/Per User Report/List of Services] o
Apply To war ~
Variable ~ Value terative
B Rule: IP-SRC
war £[/Per User Report/List of Services) R

w

The following table lists the fields in the Schedule Report panel.

Fad oeepten

Enable

Report Name
Schedule Name
NetWitness DB

Warehouse
Resource Pool

Run

Enables the report schedules and runs the report.
The name of the report.
The name of the scheduled report configuration.

The database can be NWDB and Warehouse DB depending on the type of database
that you selected in the rule definition. If the report has rules of NWDB and
Warehouse DB types, all the database types or rule types are displayed.

If the report has rules of Warehouse DB, the Warehouse Resource Pool drop-down
is displayed to select the pools or queues available in the cluster. If no pools or
queues are entered for the Reporting engine, this field is disabled. For more
information, see "Step 5: Configure Task Scheduler for a Reporting Engine" topic in
the Host and Services Configuration Guide.

Provides the type of schedule for the run configuration:

o Ad-hoc execution

Hourly execution

Daily execution

o Weekly execution

o Monthly execution

The data range on which the query is run.
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o owan

Use relative Uses the relative time duration to schedule a report.
time calculation

Iterative Report Select the checkbox to schedule a report for the selected list value.

Iterate on List  Click this button to navigate to the List Selection panel and select a list. The
o) following figure displays this panel:

List Selection Window

¥ Refresh
List Mame =~
=25 -
@[ compliance
& [ Filtering Candidate
= Local_Country

[ Logs

& [ network Activity
@[ Per User Report
=M All_FInal

| Lists_Final
< | | »

Close Select

The List Selection panel is a collection of Lists. The Reporting Engine maintains an
active list of the available list names by continuously synchronizing with the
collection to which it is connected.

Apply To Apply list values on the selected variable.

Variables Displays the rule variables along with their associated values and the iterative
properties included in the report.

Note: Depending on the rule chosen while creating a report, you can view
dynamic variables defined for the rule in the Variables field of the Schedule
Report panel. For example, Test-Country is the rule having the dynamic variable

var.

Schedule Schedules the report.

Reset Resets the scheduled report.

Configure Allows you to alter the Reporting Engine configuration details on the "Reporting

Engine General Tab" topic in the Host and Services Configuration Guide.

Note: This button is visible on the Schedule Report panel only when you have the
'Manage Device' access permissions on the Reporting module.

Output Actions Panel
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The Output Actions panel specifies output actions to notify the email recipient when the report execution
completes and also sends reports in PDF and CSV formats as attachments in the email, based on your

selection.

(®) Output Actions

(®) Other Options

() Email
To Use , To Separate The Email IDs
Subject
Body f
f
1
|
Artach: OporF OOV CSY Delimiter |, ¥ Multivalue Delimiter | | |

+

0| 1ype Motification Servers ~ send As PDF send As CSV
[1 MNETWORK_S... ’ Windows Mount v W &4

[] URL ’ Tomcat URL v ™ 4

[] SFTP ’ CentQ5 ¥ ™ 5

The following table lists the fields in the Output Actions panel.

e Jowewien

To A comma-separated list of email addresses to receive the output.
Subject The subject entered in the mail.
Body The body of the email. By default, the body field is populated with pre-

defined text that has certain variables that will add meta appropriate to the
generated report.
In the Reporting Engine, these variables are replaced with actual values.

${RanAtStartTime} : The Start time of the report.
${DataRangeStartTime} : The Start time of the data time range.
${DataRangeEndTime} : The End time of the data time range.

${LinkToSA} : The link to the NetWitness PlatformHost from the
email which in turn opens the report in NetWitness Platform interface.

${ReportName} : The name of the report.

${DataSource} : The name of the data source.

Attach: The output format in which the report is attached to the email, such as
PDF or CSV as configured in the Schedule Report dialog.
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I

CSV Delimiter

Multivalue Delimiter

Other Options

+ @

SFTP
URL
Network Share

Type
Output Actions

Send as PDF / Send as
CSvV

Dynamic List Panel

The default CSV delimiter is comma (,). If the CSV content contains a
comma, you must identify a unique separator so the content is stored in its
original form. For example, if msg is a column in the report to be saved as

CSV and the msg content is as follows: ASA-SSM-CSC-20 Module in
slot 1," application reloading ""CSC SSM"""," version
""6.2.1599.0"" CSC SSM scan services are reloading
because of a pattern file or configuration update

The above content will be included in three columns due to the commas
(). To avoid this, you must specify a different delimiter such as a pipe
line character “|”.

Note: To import the CSV file into Microsoft Excel, use the Data >
From Text option in the Excel application. When you import the CSV
file you must specify the file type of the file being imported as
Delimited and use the same delimiter that you specify to generate the
CSV file.

The data in multivalued fields are separated by the multivalue delimiter.
The default Multivalue delimiter is two pipe line characters (]|).

You can select an SFTP, URL, or Network Share location configured in
((RE}} and then send the report either in PDF or CSV format based on
the requirement.

Select this option to send the report to the SFTP, URL or Network Share
location configured in the Reporting Engine Services Config view.

The type of output action chosen. For example, SFTP, URL or Network
Share.

Select the SFTP, URL or Network Share name configured in the
Reporting Engine Services Config view.

Select these options to send the report either in PDF or CSV format, or
both to the configured Notification Server (SFTP, URL or Network
Share).

The Dynamic List panel populates the lists created and you can add, edit or delete the list. The list is
generated based on the scheduled report which can be viewed in the Lists view.
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-:J};u Dynamic List

+ -
List Name ~
$[/Per User Report/List of Alias Host] _

« | ’

The following table lists the operations in the Generate List panel.

+ Adds a new list to the report.
= Deletes all the lists added to the report.
4 Displays the Generate List dialog.

List Name  The name of the list chosen from the List Selection panel. For more information on the
List Selection panel topic, see Generate List Panel.

Logo Panel

The Logo panel populates the default logo from the Select a Logo panel. For more information on
choosing a logo from this panel, see "Manage and Select a Report Logo" section in the Manage Lists,
Rules or Reports.

You can set the default logo for a Reporting Engine. This is the logo that is used in the generated
reports. For more information on choosing a logo, see Select a Logo Dialog.

Note: If you have not selected any logo then the default RSA logo is used on the report. The option
Save as PDF for the previously executed reports does not support a new customer logo. It displays the
default RSA Logo, if the customer logo must be displayed in the Schedule a Report view.

)
™) Logo

Change Logo NETWITNESS
PLATFORM
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Scheduled Reports View

The Scheduled Reports view allows you to create, view and manage scheduled reports.

Workflow

This workflow shows the procedure to create and schedule a report.

You are here

Configure Reporting

| |
! |

Configure a Rule 'l_’_ Create and Schedule a . View a Report
I

Engine

Investigate a Report
Manage Lists, Rules or

Reports

What do you want to do?

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report*  Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports*

*Y ou can complete these tasks here.

Related Topics

o Build Report View

o Report View
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o Schedule Report Panel

« Reports Permissions Dialog

Quick View

[REPT] Malware Activity Re... @

Report Schedule i
| + | | o % | MAutorefresh Filter Schedule By Name
O Name ~ Schedule Last Run Duration(H:M:S) Avg(H:M:S) State View Report. Actions
O Malware Activity Hourly 2017-08-0909:15  00:00:03 00:00:02 Complered € & &
| Page 1 | of1 | | G PageSize 30 v Displaying 1 -1 of 1
[R'S /\ NETWITNESS PLATFORM 11.2.00

To access this view:
1. Goto MONITOR > Reports.

The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.
3. Inthe Report List panel, do one of the following:

« Click . > View Scheduled Reports.
o Click the #Schedules column.
Features

The View Scheduled Reports has the following features:

Report ScheduleToolbar
Report Schedule List panel

Report ScheduleToolbar

The Scheduled Reports has options to add, modify and delete the scheduled report as well as options to
enable or disable the selected run configuration.

‘ - & | Q|7 o | ™ Auto Refresh
The following table lists the operations in the Scheduled Reports toolbar.
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+ Create a new report schedule.

Delete the selected report schedule.

& Edit the selected report schedule.

Note: Double-click on a desired
report schedule to edit it.

e Enables the selected report schedule.

Disables the selected report schedule.

9 View the history of the scheduled
report.
¥ Filter schedules based on the type of

schedule. (For example, AdHoc)

o Allows you to set permissions for the
selected scheduled report.

™ Auto Refresh Automatically refreshes the scheduled
reports list.

Filter Schedule By Name Searches schedules based on the
schedule name.

Report Schedule List Panel

The Scheduled Reports List panel lists the scheduled reports in a tabular format.
The following table lists the columns in the Scheduled Reports List panel:

Name The name of the scheduled report.
Schedule The type of schedule for the run configuration:
o Ad-hoc execution
o Hourly execution
« Daily execution
o Weekly execution

o Monthly execution

Last Run Displays the last time the report was run.
Duration(H:M:S) Displays the time taken for last execution of the report
Avg(H:M:S) Displays the average time taken to run the report.
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State Indicates the state of the scheduled report.

o Scheduled: If a report is scheduled to run on an hourly, daily, weekly,
monthly, or later time, the state of the report is displayed as scheduled, for
the first run.

o Queued: If a report is still waiting to get executed, the state of the report is
displayed as queued.

o Running: If the report schedule is in progress, the state of the report is
displayed as running.

« Partial: If in a report with several rules, a single rule execution failed or an
output action failed or creation of PDF/CSV failed, the state of the report is
displayed as partial. For example, consider a report with five rules and four
rules are executed successfully and one fails, then the state is displayed as
Partial.

o Failed: If in a report with several rules, all the rule schedule executions
failed, the state of the report is displayed as failed.

o Completed: If a report schedule is successfully executed, the state of the
report is displayed as completed.

o Canceled: When cancel request is completed, the state of the report is
displayed as canceled.

Note: Cancel option may not work for Warehouse Analytics jobs. You must
kill the job manually. Following are the steps to kill the job:
For MapR:

1. Get the Jobid from job logs.

2. Login to jobtracker UI and search for Jobid to kill under "Running Jobs".
Sample URL: http://<job-tracker-host>:50030/jobtracker.jsp

3. Kill the Jobid:

* Select Jobid under "Running Jobs" and click Kill Selected Jobs.

(or)

* Click on Jobid link, scroll down and click Kill this job link.

o Inactive: If a report schedule is disabled, the state of the report is displayed
as Inactive.

o Not available: If the report schedule executed information is not available,
the state of the report is displayed as not available.
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o Click to view the rule execution information and output action information.
Rule Execution Info  This pop-up notifies the status of multiple rules in a report and the time taken
AT-09863 TC040 for its execution.

Status: COMPLETED
Executed in 0.329 sec

Note: You can view the rule execution and output action information for a
:;f'“‘_’?;hﬁg-’fﬂm scheduled report having the state Completed, Running, Partial or Failed.
208 e By default, the Output Actions for Completed Report on Reporting Engine

Config page is set to enable, to receive an email when the report status is

Test-Allases . 0 q .
Sratus: COMEBLETED completed. To receive an email for Failed or Partial reports, you must
Executed in 0.251 sec disable this option.

Test-Con-Broker
Status: COMPLETED
Executed in 3.261 sec

Output Action Info

LIST
Status: COMPLETED
Executed in 0.008 sec

View Report Click to view the rule execution information on the View a Report Panel. You
can view the rule execution information for a scheduled report having the state
'running' as well.
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Test a Chart View

In the Test a Chart view, you can view and test the charts.

Workflow

Schedule a Chart —
-

| You are here |

—> —
| Test a Chart | Investigate a Chart
\ |
‘ |

Configure Reporting Engine JiIN Configure a Chart

Manage Chart Groups
and Charts

What do you want to do?

Administrator/ Configure Reporting Engine For more information, see "Configure Reporting

Analyst Engine" in the Reporting Engine Configuration
Guide.

Administrator/ Configure a chart Configure a Chart

Analyst

Administrator/ Schedule a chart Schedule a Chart

Analyst

Administrator/ View a chart View a Chart

Analyst

Administrator/ Test a chart™* Test a Chart

Analyst

Administrator/ Investigate a chart Investigate a Chart

Analyst

Administrator/ Manage a chart group and Manage a Chart Group and Chart

Analyst chart

*You can complete these tasks here.
Related Topics

o Configure and Generate a Chart

Quick View

The following figure is an example with the important features labeled.
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[ oo a

- Display [ X Axis ¥ Axis ¥ Legends

Chart Options

Time Range Chart Type

Last 3 Hours

The Test a Chart view consists of the following panels:

Chart toolbar

Chart Output panel
Chart Options panel
Chart Toolbar

The Charts toolbar allows you to investigate on a particular chart and change the screen to full screen.

‘i" Investigate & Full screen

o oo

Investigate Investigates further on the selected chart.

Full Displays the chart in full screen.
Screen
Chart Output Panel

The Chart Output panel displays the information in a chart format for the selected time chart options.

The following table lists the features in the Test a Chart View and their descriptions.

o o~

Display  Allows you select the values that needs to be displayed and have the following options:
X Axis, Y Axis and Legends.

X Axis Displays the session count.
Y Axis Displays the actual output.

Legends  Displays the list of variables appearing in the chart.
Chart Options Panel

The following figure shows the Chart Options panel, which displays the time range, series, and chart
type fields to configure the chart display.
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Chart Options
Time Range From To Series Itemns To Plot Chart Type
Custom v | 2017-06-01 08:55:24 2017-06-02 08:55:28 @ Chart Values over Time |5 s Line 4

() Chart with Totals

The following table lists the fields in the Charts Options panel and the descriptions.

o o

Time
Range
From
To

Series

Items to
Plot

Chart
Type

The default time range is Last 3 Hours. However, you can select a different value from the
drop-down list, for example, Last Hour, or Last 6 Hours which are the preset values. Or
you can customize by selecting Last N Days or the Custom option.

The start date and time. (only for custom options).

The end date and time. (only for custom options).

The series field provides you with two options:
* Chart Values over Time: Renders the chart for the entire time range selected.
* Chart with Totals: Renders the summary of data for the selected date range.

The maximum number of events the user wants to view on the chart.

The type of chart to be rendered either area, bar, column, line, step line, step area,
spline area or spline.
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View a Chart Panel

In the View a Chart panel, you can view and manage charts. There are options for filtering and sorting
the information in the chart, as well as options for the type of chart, the number of items to chart, and
charting values or totals. When viewing a chart, you can open the charted sessions in the Investigation
module and save the chart as a PDF.

Workflow

You are here

|

| |

Schedule a Chart _I..
- |
| |
I |

-

Investigate a Chart

Configure Reporting Engine Configure a Chart

—
l Test a Chart
Manage Chart Groups
and Charts

What do you want to do?

Administrator/ Configure Reporting Engine For more information, see "Configure Reporting

Analyst Engine" in the Reporting Engine Configuration
Guide.

Administrator/ Configure a chart Configure a Chart

Analyst

Administrator/ Schedule a chart Schedule a Chart

Analyst

Administrator/ View a chart* View a Chart

Analyst

Administrator/ Test a chart Test a Chart

Analyst

Administrator/ Investigate a chart Investigate a Chart

Analyst

Administrator/ Manage a chart group and Manage a Chart Group and Chart

Analyst chart

*Y ou can complete these tasks here.
Related Topics

o Configure and Generate a Chart
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Quick View

The following figure is an example with the important features labeled.

Manage View [CHRT] Cleartext Password... &

‘ P Investigate I3 Full Screen H ‘fn

Behaviors of Compromise

Friday
September 29, 2017

< September 2017 -~ >
s M T W T F s

1 2

3 4 5 3 7 8 9

10 1 12 13 14 15 16
17 18 19 20 21 22 23

24 25 26 27 28 ﬂ

Charts

0500 0510 = l

SESSION COUNT

+ EMPTY

Behaviors of Compramise

Chart Options

Time Range Series Items To Plot Chart Type
Last 2 Hours

The View a Chart panel includes the following panels:

Chart toolbar

Chart Output panel
Chart Calendar panel
Chart Options panel
Chart Executed list

Chart Toolbar

The Chart toolbar has options that allow you to investigate, and view the chart on another screen.

“i} Investigate & Full Screen

The following table lists the options in the Chart toolbar.

Investigate Investigates the chart details.
Full Screen Displays the chart on a full screen.
Chart Output Panel

The Chart Output panel displays the chart with sortBy on the Y-axis, time on the X-axis and legends.

Note: You can save the chart as PDF using the icon on the Chart Output panel.

Chart Calendar Panel

The Chart Calendar panel is the default calendar with which you can filter the list of charts depending on
the date you select from the Calendar, as shown in the following figure.
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Friday
September 29, 2017

< September 2017 -~ ’

5 M T W T F 5

1 2
3 - 5 b 7 8 9
0 N 1213 14 15 16
17 18 19 20 21 22 23

24 25 26 27 28 E

Charts
Chart Options Panel

The Chart Options panel displays the time range, series, and chart type fields to configure the chart
is displayed.

Chart Options

Time Range From To Series Items To Plot Chart Type

~ | |2017-06-01 08:55:24 2017-06-02 08:55:28 @® Chart Values over Time

() Chart with Totals

The following table lists the fields in the Chart Options panel.

oo

Time

Custom 5 ] Line ~

The default time range is Last 3 Hours. However, you can select a different value from the
Range drop-down list, for example, Last Hour, or Last 6 Hours which are the preset values. Or you
can customize by selecting Last N Days or the Custom option.

Note: The time range selected by you for a chart will be saved. When you open the same

chart the next time, the time range that is saved will be displayed. This behavior is not
applicable for the custom option.

From The start date and time. (only for custom options)

To The end date and time. (only for custom options)
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o lowen

Series The series field provides the user with two options:

o Chart Values over Time: Renders the chart for the entire time range selected.

o Chart with Totals: Renders the summary of data for the selected date range.

Items The maximum number of events the user wants to view on the chart.
to Plot

Chart The type of chart to be rendered. Either area, bar, column, line, step line, step area, spline
Type area or spline.

Chart Executed List Panel

The Chart Executed List panel displays all the executions for a particular chart for the selected date.
Double-clicking on any chart execution loads the chart on the Chart Output panel. By default, the
last executed chart is displayed in the Chart Output panel.
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View All Charts View

In the View All Charts view, you can display, print, save and email charts.

Workflow

You are here

|
| |
Schedule a Chart _I..
- |
|

Configure Reporting Engine Configure a Chart | |
[

-
l Test a Chart Investigate a Chart
Manage Chart Groups
and Charts

What do you want to do?

Administrator/ Configure Reporting Engine For more information, see "Configure Reporting

Analyst Engine" in the Reporting Engine Configuration
Guide.

Administrator/ Configure a chart Configure a Chart

Analyst

Administrator/ Schedule a chart Schedule a Chart

Analyst

Administrator/ View a chart* View a Chart

Analyst

Administrator/ Test a chart Test a Chart

Analyst

Administrator/ Investigate a chart Investigate a Chart

Analyst

Administrator/ Manage a chart group and Manage a Chart Group and Chart

Analyst chart

*Y ou can complete these tasks here.

Related Topics

o Configure and Generate a Chart

Quick View
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

N @admine (@

Overview Reports

Manage View

5
Report Alert  Warehouse Analytics ‘/n 3

Charts / Thursday
pr——— / September 28, 2017
Filter Chart By Name

Chart ~

< September 2017 -~ >

Compromise

Indicators of Compromise

tion Context

| Page 1 of3 | ) | C PageSize 30 ~

Displaying 1 - 30 of 72
[R'S/\ NETWITNESS  PLATFORM 11.200

The View All Charts panel includes the following panels.

Charts Toolbar

Charts Output panel
Charts Calendar panel
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Charts Toolbar
The following table lists the options in the View All Charts toolbar:

Filter Chart Bv Name Searches schedules
y based on the chart
name for a selected
calendar day.

Charts Output Panel

The Charts Output panel displays the chart with the chart schedule name.

Chart ~

Behaviors of Compromise
Chart Max_Threshold

Chart lookup and add

Cleartext Passwords by Service
Erablers of Compromise
Firewall Denied Connections
Firewall Destination IP Addresses
Firewall Systems

HTTP Headers Mon Standard
HTTP User Agents Non Standard
HTTP Webshells

1DS Signatures

Indicators of Compramise

Investigation Context

Lnm Diassinating Nases

Feature Description

Chart This field displays all the successfully executed charts.
Charts Calendar Panel

The Charts Calendar panel is used to select a date from the Calendar. Based on the date you select, the
list of successfully run charts for the date is displayed.
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2 Thursday
September 28, 2017

< September 2017 - >
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View a Report Panel

The View a Report panel is used to review the reports.

Workflow

This workflow shows the procedure view a report or list of all reports.

You are here

| :

|
Configure Reporting Create and Schedule a X |

View a Report
Engine Report Jl-, - |
|
| \ .
Investigate a Report
Manage Lists, Rules or

Reports

What do you want to do?

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Rep()rt Create and Schedule a Repoﬂ
Analyst

Administrator / View a report or list of all View a Report

Analyst reports*

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports

*Y ou can complete these tasks here.
Related Topics

o Configure and Generate a Report

o Build Report View

o Import Report Dialog
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o Scheduled Reports View

« Reports Permissions Dialog

o View All Reports View

o Report View

Quick View

MONITOR

REPORTS

Manage View [REPT]

.= —H

[REPT] Report-RuleToTests... @

Report-RuleToTestSpecialChars-1
Generated on - 2017-08-09 08-03 (+00:00)

2016 gg 08:03:00 (+00:00) Time Range

RuleToTestSpecialChars-1/ nw-conc1 - Concentrator

User Account

NETWITNESS
PLATFORM

2017 55 08:02:59 (+00:00)

0 Wednesday

August9, 2017

< August 2017 - >
s M T w T F s

1 2 3
AR

To access this view:
I. Goto MONITOR > Reports.
The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.
3. Inthe Report List panel, do one of the following:

« Click #2 >View Scheduled Reports.
o Click the #Schedules column.
The Report Schedule view is displayed.

4. Click View.

Features
The View a Report panel has the following sections.

Reports Toolbar

Reports Output panel
Reports Calendar panel

Reports Time panel
Reports Toolbar
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The Reports toolbar allows you to print, save, email, and view reports on full screen.

Note: The Reporting Engine is responsible for generating PDF and CSV output of the reports based on
the report definition. The size of the PDF files for a report must not exceed 50,000 cells.

=850

The following table lists the options in the Reports toolbar.

- Prints the generated report.

(] Saves the report as a PDF and a CSV file.

Note: The Save As PDF option is not available for a large report. If you are
generating a PDF for a report and it takes a longer time than expected, you get a
warning message stating PDF generation is in progress, please try after some
time.

When you click download as a CSV file, the Select Rule to download dialog is
displayed. You must select a rule from this dialog to download the rule result in a CSV
file.

If the file generation takes a while, you can click on the Notify me option to be notified
once the PDF or CSV is generated. Once the PDF or CSV is generated, you can view
the Notifications for the status.

= Emails the report with the PDF or CSV attachment.
= Opens the generated report on a new window.
Reports Output View

The Reports Output panel view the report with the report schedule name, report generated time and the
actual report with the selected rule variables.

Report-RuleToTestSpecialChars-1 NETWITNESS:
Generated on - 2017-08-09 08:03 (+00-:00) R S A PLATFORM
2016 55  08:03:00 (+00:00) Time Range 2017 3% 08:02:59 (+00:00)

-

RuleToTestSpecialChars-1/ nw-conc1 - Concentrator

User Account

L L - T L B S B N e

375 Reporting References



Reporting User Guide

Feature Description

Name This field displays the name of the scheduled report.
Time This field displays the time when the report is generated.

Report  This field displays the details report with the selected rule variables.

Reports Calendar View

The Reports Calendar view is used to select a date from the Calendar. Based on the date you select, the
list of successfully run reports for the date is displayed.

1 Thursday

August 10, 2017

< August 2017 - >
5 M T w T F 5

..-l

2 3 4
SRR

Reports Time View

The Reports Time view displays the time when the report was actually run.

Reports
Time

03:13

When you click View on the scheduled report having Iterative selected, the Sub Reports panel is
displayed. For each value in the configured list a report is generated.
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Values
poseidonmasterbbirwin.com.br
10.153.5201

* goog e-anaytics.oom
ns1.dnspoint.net
adopteursdick com
ns.gwuedu
Lednturner.com
101530228

poell lb-revsoinet
izapiblwibug com
iron3-istserv tops gwoedu
stb.msn.com
miscwesther.com
101535210

Cp.Us musicyahsocom

State
Completed @
Completed @

Completed @

Completed M

Completed @
Completed @
Completed @
Completed @
Completed @
Completed @
Completed @
Completed @
Completed @
Completed @

Completed @

Thiz report has been genersted for each value in the configured list. Select the
report that you Want o view.

Wiew Report
Wigw
Wigw
Wigw
View
Wigw
Wigw
Wigw
Wigw
Wigw
Wiew
Wigw
Wigw
Wigw
Wigw

Wigw

<

| »

| Page 1 of34 | » I C

Displaying 1 - 30 of 1000

The following table lists the columns in the Sub Reports panel.

Column | Description

Values

State

View

The List values chosen for a dynamic variable from the List Selection panel.
Indicates the state of the scheduled report for each of the list values.

o Partial: If in a report with several rules, a single rule execution failed or an output
action failed or creation of PDF/CSV failed, the state of the report is displayed as
partial. For example, consider a report with five rules and four rules are executed
successfully and one fails, then the state is displayed as Partial.

o Failed: If in a report with several rules, all the rule executions failed, the state of the
report is displayed as failed.

o Completed: If a report is successfully executed, the state of the report is displayed as
completed.

Clicking on any of the report schedules or sub reports listed and then View displays the
desired report.

Note: You can view the completed rules on the View a Report page even when the
report is 'running’'.
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View All Reports View

In the View All Reports view, you can display, print, save and email reports.

Workflow

This workflow shows the procedure view a report or list of all reports.

You are here

| :

|
Configure Reportin Create and Schedule a i |
9 Enginep 9 Report | View a Report |
|
| \ .

Investigate a Report
What do you want to do?

Manage Lists, Rules or

Reports

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure

Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide

Administrator / Create a List or List Configure a Rule

Analyst Group/Create or Deploy a

Rule/Test a Rule

Administrator / Create and Schedule a Report Create and Schedule a RGDOI"[
Analyst

Administrator / View a report or list of all View a Report

Analyst reports*

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports

*Y ou can complete these tasks here.
Related Topics

o Configure and Generate a Report

o Build Report View

o Import Report Dialog
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Scheduled Reports View

Reports Permissions Dialog

View a Report Panel

Report View

Quick View

MONITOR @ admin® (@)

Manage View

Chart  Alert  Warehouse Analytics

0 Wednesday

August9, 2017

Filter Schedule Name
B All Risk Warning (9 lt=ms) s M T w T F s
2017-08-09 00:10 1 2 3 4 5
2017-08-0901:10 6 7 8 n

2017-08-09 00:15 -

Vialvwar
[R'S/\ NETWITNESS' PLATFORM 11.200

To access this view:

1. Goto MONITOR > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. Inthe Report panel, click View All Reports.
The Reports panel is displayed, clicking on any of the reports listed allows you to view the report.

Features
The View All Reports panel has the following features.

Reports Toolbar

Reports Output panel
Reports Calendar panel

Reports Toolbar
The following table lists the options in the View All Reports toolbar:
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Filter By Report Or Schedule Name Searches schedules based on the
report name or schedule name for
a selected calendar day.

Reports Output Panel

The Reports Output panel displays the report with the report schedule name and report generated time.

Reports Time

B All Risk Warning (3 ltems)
2017-08-10 00:10

Risk Warning

Risk Warning 2017-08-1001:10
Risk Warning 2017-08-10 02:10
Risk Warning 2017-08-10 03:10
Risk Warning 2017-08-10 04:10

B Hunting Summary (5 lzems)

Hunting Summary 2017-08-10 00:15

Hunting Summary 2017-08-1001:15

Hunting Summary 2017-08-10 02:15

Hunting Summary 2017-08-10 03:15

Hunting Summary 2017-08-10 04:15

Identity Management (5 ltems)

Malware Activity Report (5 ltems)

E Report-Alerts by severity (1 ltem)

Feature Description

Reports  This field displays the detailed report with the selected rule variables.

Time This field displays the time when the report is generated.

Reports Calendar View

The Reports Calendar view is used to select a date from the Calendar. Based on the date you select, the
list of successfully run reports for the date is displayed.
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August 10, 2017

< August 2017 - >
s M T W T F s

1

2 3 4
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Alerting References

The Reporting module user interface provides access to NetWitness alerts. This topic contains
descriptions of the user interface as well as other reference information to help users manage Alerts.
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Alert List View

The Alert List view allows you to import, export, manage, and add alerts.

Workflow

Schedule an Alert

Configure Reporting Engine Configure an Alert

2

Qau are hey
: : Investigate an Alert
fll Manage Alerts and Alert
Templates :
I

What do you want to do?

Administrator/ Configure Reporting Engine Configure Reporting Engine
Analyst

Administrator/ Configure an alert Configure an Alert

Analyst

Administrator/ Schedule an alert Schedule an Alert

Analyst

Administrator/ View an alert View an Alert

Analyst

Administrator/ Investigate an alert Investigate an Alert
Analyst

Administrator/ Manage an alert and alert template* Manage an Alert and Alert Template
Analyst

*Y ou can complete these tasks here.

Related Topics

Alerting Overview

Quick View

The following figure is an example with the important features labeled.
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Overview Reports

Manage View

Rules  Reports  Charts @; Warehouse Analytics Search Report Details &

Alert

+ = 4 | ®ctnable Disable | O 4 © | EETemplate E View Schedule <& View Alerts ~ ﬂ ‘/n

Enabled  Pushed?  Name Description Actions

No Record
No Record

No Record

Yes Record

RS /\ NETWITNESS PLATFORM

Click Monitor> Reports to view the Manage tab.
Click Alerts to open the Alert view.

gl The Alert toolbar allows you to add, modify, delete, enable, disable, refresh, import, and export
an alert. Using this toolbar, you can also set access permissions for the selected alert.

The Alert List panel lists all the alerts in a tabular format.
The Alerts List view has the following panels:

o Alert Toolbar

o Alert List

Alert Toolbar
The Alert toolbar panel has the following features:

Fowrs Josectpton

-+ Adds a new alert to the Reporting module.
- Deletes one or more selected alerts.
1 Edits an alert.
Enable Enables the selected alerts.
Disable Disables the selected alerts.
o Refreshes the view.
& - Enables the following options: Import, Export and Permissions.
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Alert List

The Alert List panel lists all the alerts in a tabular format. The following table lists the columns in the
Alert List panel and their descriptions.

Feature |Description

Enabled Displays the state of the alert:
o Enabled - the alert is active and fires based on the rule assigned to it.
o Disabled - the alert is not active.
Pushed? Indicates whether the alert is sent to Decoders or Log Decoders:
e Yes - Alert is pushed to Decoders or Log Decoders.
o No - Alert is not pushed to Decoders or Log Decoders.

Name Identifies the name of the alert. Clicking the alert name displays the rule on which this
alert is based in the Define Rules panel.

Description Indicates the alert description.

Actions Indicates the action the system takes when the alert fires. The different available action
types are as follows:

e Record
o SMTP
e SNMP

o Syslog
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Alert Permissions Dialog

In the Alert Permissions dialog, the users with 'Read & Write' access permission can set access
permissions for an alert to configure permissions in the Alert Permissions dialog.

Workflow

Configure Reporting Engine Configure an Alert Schedule an Alert m

Qnu are heV Z
: Investigate an Alert
i Manage Alerts and Alert
Templates
\

What do you want to do?

Administrator/ Configure Reporting Engine Configure Reporting Engine
Analyst

Administrator/ Configure an alert Configure an Alert

Analyst

Administrator/ Schedule an alert Schedule an Alert

Analyst

Administrator/ View an alert View an Alert

Analyst

Administrator/ Investigate an alert Investigate an Alert
Analyst

Administrator/ Manage an alert and alert template* ~ Manage an Alert and Alert Template
Analyst

*Y ou can complete these tasks here.

Related Topics

Alerting Overview

Quick View

The Alert permissions dialog allows you to set alert permissions depending on the user role.

The following figure is an example with the important features labeled.

Alerting References 386



Reporting User Guide

MONITOR

®@admin® (3

Manage ,
Rules Reports Charts Lists Warehouse Analytics Search Report Detai e
Alert
+ = 4 | ®cnable Disable | O % v | EWTemplate B viewSchedule <@ View Alerts
Enabled  Pushed? Name import Description Actions
o No ipsre ‘ Export ‘ Record

Ver . Export as Text 3 Record
oo |

Alert Permissions

ST Communication to Blacklisted Hosts

Roles ~ Read & Write Read only Mo ACCess
Administrators ® O O
Analysts O O O]
Data_Privacy_Officers O O (O
Malware_Analysts O O ®
Operators O O O]
SOC_Managers @ O ®

[ Apply Read-only permission to Rules in the Alerts

Cancel Save

Click Monitor> Reports to view the Manage tab.

Click Alerts to open the Alert view.

Click % ~ > Permissions. The Alert Permissions dialog box is displayed.
Based on the user role, select the appropriate options.

Rl (Optional) Select the checkbox if you want to automatically provide read access permission to
dependent rules.

I Click Save.

Note: If a User (other than a super user) creates an alert, super users will not be able to access the
alert.

The following table lists the columns in the Alert Permissions dialog.

Column Description
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Roles

Read & Write

Read Only

No Access

D Apply Read-only permission to Rules in the

Alerts

Cancel

Save

Displays all the user roles in the NetWitness
user interface.

Allows you to apply 'Read&Write' access to the
alert.

Allows you to apply only 'Read' access to the
alert.

By selecting this permission, you cannot access
or view the alert.

Allows you to automatically apply permissions
to the rules in the alerts.
Cancels all the changes made to the

permissions.

Saves the selection and provides access to the
role based on the selection.
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Alert Schedules View

In the Alert Schedules view, you can view all the alerts scheduled. Alternately, you can also disable the
scheduled alerts.

Workflow

The following workflow shows the tasks involved in creating or modifying an alert.

You are here

Schedule an Alert View an Alert

|
|
Configure Reporting Engine > Configure an Alert
|
I

/ Investigate an Alert
Manage Alerts and Alert
Templates

What do you want to do?

Administrator/ Configure Reporting Engine Configure Reporting Engine
Analyst

Administrator/ Configure an alert*® Configure an Alert

Analyst

Administrator/ Schedule an alert Schedule an Alert

Analyst

Administrator/ View an alert View an Alert

Analyst

Administrator/ Investigate an alert Investigate an Alert
Analyst

Administrator/ Manage an alert and alert template ~ Manage an Alert and Alert Template
Analyst

*Y ou can complete these tasks here.

Related Topics

Alerting Overview

Quick View

The following example shows you how to access the Alert Schedules view dialog.
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Reports

Manage View

Rules

Alert 3
4 = [Z | ®Enable O Dissble | O & - | EWTemplate |E View Schedule | «@ View Alerts

]| enavled | pushed? | name Description

nnnnnn

Ooe N Recard

oe N Record

oe N Record

oe ¥ Record
Manage View [ALRT] Alert Schedules @ 4

Completed 2017/0315 6:59:20 355610 o 00:00:00 00:00:00 00:00:00

Completed 2017/03/15 6:59:31 365719 0 00:00:00 00:00:00 00:00:01

0
o
] Completed 2017/03/15 6:59:17 355610 o 00:00:00 00:00:00 00:00:01
o
O

Completed 2017/03/15 6:58:49 355609 321202 00:00:02 00:00:00 00:00:05

Click Monitor> Reports to view the Manage tab.

Click Alerts to open the Alert view.

Click View Schedule to open the View Alerts Schedule view.

The Alerts Schedule toolbar allows you to modify the state of the scheduled alert.
The Alerts Schedule List panel lists only the Enabled alerts in a tabular format.

Features
The different panels on the Alert Schedules View dialog are:

o Alerts schedule toolbar panel

o Alerts schedule list panel

Alerts Schedule Toolbar Panel

In the Alerts Schedule Toolbar panel, the Disable icon disables the selected alert. When schedule alerts
are no longer needed or are determined to be ineffective, you can disable them so that they are no longer
executed. You can select one of more alerts to disable. When an alert is disabled, it is removed from the
scheduled alerts list so that you cannot view it here, and it will not execute again unless you manually
execute the alert or set up a new schedule for it.

Alerts Schedule List Panel

The following table lists the columns in the Alerts Schedule List panel and their description.

State The state of the scheduled alert:
o Completed

o Failed
Name The name of the scheduled alert.
Last Run {#time} The last time the scheduled alert was run.
Last Session Id The Session Id of the last scheduled alert.
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Total Alerts The total number of event occurrences.

Duration The time taken to run the scheduled alert.

Avg (s) The average time taken to run the scheduled alert.
Max (s) The maximum time taken to run the scheduled alert.
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Create or Modify Alert Panel

The Create or Modify alert panel is a panel in the Alert List view. This panel allows you to create or
modify an alert as per the requirement.

Workflow

You are here

|
| .
Configure Reporting Engine » Configure an Alert Schedule an Alert View an Alert
|
I

Manage Alerts and Alert
Templates

What do you want to do?
mm

Administrator/ Configure Reporting Engine Configure Reporting Engine

Analyst

Administrator/ Configure an alert* Configure an Alert

Analyst

Administrator/ Schedule an alert Schedule an Alert

Analyst

Administrator/ View an alert View an Alert

Analyst

Administrator/ Investigate an alert Investigate an Alert

Analyst

Administrator/ Manage an alert and alert template ~ Manage an Alert and Alert Template

Analyst

*Y ou can complete these tasks here.

Related Topics

Alerting Overview

Quick View

The following figure is an example with the important features labeled.
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MONITOR

Overview Reports 1

View 2

Alert
-

[+]= @ | ®enable ODisable | T 8- | ETemplote T View Schedule & View Alers

Manage

3 Warehouse Analytics earch Report De )

Enabled  Pushed 7 Name Description Actions.
No munication to Black L Record
No wall Denie e s Record
No rewall Destination IP Addresse Record

Yes T estination IP Addre Record

RS/\ NETWITNESS' PLATFORM 11.2.00
Manage View [ALRT] New Alert &

Create/Modify Alert

Enable 54

Rule Basis: Browse ‘__n
Data Sources: v [] Push to decoders /H

Description

Severity: Choose ... v
Notification: ¥ Record [ smTP []1SNMP (] Syslog
Record SMTP SNMP syslog

Execute Once v

Body

Body Template v

Click Monitor> Reports to view the Manage tab.
Click Alerts to open the Alert view.

Click ¥ to navigate to the Create or Modify Alert panel.
Enable the alert, navigate the rule, and select a data source to alert.
Enter a brief description of an alert.

Define the alert notification methods(RECORD, SMTP, SNMP, Syslog) to alert, when an alert
condition is matched.

The Create or Modify Alert panel has the following sections:
o Alert Definition
o Alert Description

o Alert Notification

Alert Definition
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The following table describes the fields in the Alert Definition:

P pecrbton

Enable o Enable activates the alert. The alert executes and sends output actions every minute (by
default) when the alert conditions are met.

o Disable deactivates the alert. The alert does not execute and does not send any output

actions.
Rule Click Browse to display the Rules Library panel from which you select the rule that is the
Basis basis of this alert.

You must select a rule that has a unique 'where' clause for an alert.

Data Specifies the data source for the alert.
Sources

Pushto  Pushes the ‘where’ clause of the alert rule to Decoders connected to the selected NWDB
decoders data source.

This is the recommended option used to create RE alerts, as the alert conditions are
checked on the Decoder itself and the alert queries will be comparatively faster in NWDB.

If you deselect this option, the alert rule “‘where’ clause will be queried against the selected
NWDB data source. Based on the complexity and metas in the ‘where’ clause of the rule,
the alert queries might take more time to process in NWDB.

Note: RSA NetWitness does not send rules to the Decoder automatically.

Alert Description

The following table describes the fields in the Alert Description:

Fad Jowerpen

Description Describes the alert.
Create Creates the alert. (This option is displayed when you create an alert.)

Save Saves the changes made to the alert. (This option is displayed when you modify an alert.)

Alert Notification

The Alert Notification allows you to define the notification action NetWitness takes when an alert is
generated, for example, recording or sending the alert using one of the defined output actions. The output
actions are Simple Mail Transfer Protocol (SMTP), Simple Network Management Protocol (SNMP), or
Syslog message.

The Notification contains the default Record tab, which you use to create an alert. The icon beside the
Record tab allows you to select the notification type from the drop-down list for the output to specify for
the alert: SMTP, SNMP, or Syslog.

Depending on the selected notification type, the Notification section is populated with predefined text
that contains variables that add Meta that is appropriate for the alert. In the Reporting Engine, these
variables are replaced with actual values. The following table lists the variables and their descriptions.
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${meta.<metakey>}  The meta key value.

Note: If the <metakey> did not fetch any value, an empty string("") is
printed.

By default, Reporting Engine displays all the repeated values for a meta
key. If you do not want the meta values to repeat in the Alert output,
enable the "removeRepeatedMetaValue" option by navigating to
Configuration > Alert Configuration available for the Reporting Engine
in the Services - Configuration > Explore view.

For example, in an HTTP Session the value for the action is displayed as
get, get, put, put, post, get. When this option is enabled, the value is
displayed as get, put, post.

${meta.time} / ${meta.time} - The session time is printed in "yyyy-MMM-dd
S{meta.time:<time HH:mm:ss" format.
format>}

${meta.time:<time format>} - The session time is printed in the user-
defined custom time format. For example, ${meta.time:dd-MM-yyyy
HH:mm:ss}.

For more information on the supported time formats, see
http://docs.oracle.com/javase/7/docs/api/java/text/Simple Date Format.html

Note: If the time format provided by the user is invalid, the default time
format will be used. The default time format is "yyyy-MMM-dd

HH:mm:ss".
§{name} The alert name defined in Reporting Engine.
§{count} The number of times an alert is detected in a given time frame. (By default,
it is one minute)
${nw.host} The NetWitness host name as configured in Reporting Engine.
${device.id} The NetWitness device ID of the data source.

The Alert Notification has four tabs:
o Record Tab

« SMTP Tab

o« SNMP Tab

o Syslog Tab
Record Tab

Use the Record tab to define the frequency for recording an alert and the message to generate when an
alert is generated.

395 Alerting References


http://docs.oracle.com/javase/7/docs/api/java/text/SimpleDateFormat.html

Reporting User Guide

Notification: [ Record [] sMTP []5NMP [ Syslog.
Record SMTP SNMP Syslog

Execute

Body.

Body Template v

The following table lists the fields in the Record tab and their description.

e

Execute  The frequency for recording an alert.

o Once - Record the alert only once based on the alert interval no matter how often the
alert is generated. NetWitness records the number of times the alert has actually
generated during that interval in the log file so that analysts know how many times the
alert registered a match over a given day.

o Each Event - Record the alert each time as it generates. If an alert generates unlimited
number of times during a day, that alert is often treated as noise and can be ignored,
except in case of alerts that require continuous monitoring such as network configuration
changes and DDOS attacks.

Note: Select Each Event setting from the Execute drop-down list for SNMP and Syslog
output actions.

Body The body of the message.

Body (Optional) If templates have been defined, select a template for the alert message.
Template

SMTP Tab
The SMTP tab allows you to define the SMTP (email) output for this alert.

Notification: ~ [_] Record [ smTp ] SNMP [ Syslog.

Record SMTP SuMP Syslog

Execute Once v

To Use, To Separate The Email IDs

Subject

Body P: .host] i e, DETAILS/${met: ionid}

Body Template v

The following table lists the fields in the SMTP tab and their description.
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s Jowmen

Execute The frequency to send an email message for the alert.

¢ Once - Sends only one email for an interval, if an alert generates in that interval,
irrespective of how many alerts generated.

« Each Event - Send an email with the alert for every event in which the rule criteria

are met.
To The email addresses to which to send this alert.
Subject The subject of the email message.
Body The body of the message.
Body (Optional) If templates have been defined, select a template for the SMTP message that
Template  you can use as is or modify.
SNMP Tab
The SNMP tab allows you to define the SNMP output for the alert.
Notification: [ Record []sMTP ¥ SNMP [) Sysleg.
Body o host}finvestigati e. i DETAILS/${met:

Body Template

The following table lists the various fields in the SNMP tab and their description.

Fad Joserpn

Execute  The frequency to send an SNMP output for an alert.

¢ Once - Sends an SNMP message along with an email for an interval, if an alert
generates in that interval, irrespective of how many alerts generated.

o Each Event - Sends an SNMP message with the alert for every event in which the rule
criteria are met.

Body The body of the message.

Body (Optional) If templates have been defined, select a template for the SNMP message to use
Template as is or modify.

Syslog Tab

The Syslog tab allows you to define the Syslog message output for this alert.
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Notification: [ Record [ sMTP 1 SNMP ¥ syslog.
Record SMTP SNMP Syslog

+

[ sysogname~ | Exean ite severity Facllity

No syslog config created

Click F to add Syslog configuration to an alert. The New Syslog Configuration dialog box is displayed:

~

New Syslog Configuration

Syslog Configs  Choose... b
Execute Once w
Facility Local? (23) v
Severity Warning ™
Body https://${sa.host}/investigation/

${device.idp/navigate/event/DETAILS/S
${meta.sessionid}

Body Template Choose.. b

Cancel ave

The following table describes the fields in the New Syslog Configuration dialog:

oo

Syslog The Syslog configuration of the Device Config view located at the Syslog Configuration
Configs  panel.

Execute  The number of times that you want to send a Syslog output for the alert.

o Once - Sends a Syslog output along with an email for an interval, an alert generates in
that interval, irrespective of how many alerts generated.

« Each Event - Sends a Syslog output with the alert for every event in which the rule
criteria are met.

Facility =~ The type of program logging the message. Examples for the type of programs are Syslog,
Daemon, Mail, and Kernel.
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o o

Severity ~ The severity level of the alert that generated.

o Emergency
o Alert

o Critical

o Error

o Warning

« Notice

o Informational

o Debug

Body The body of the message.

Body (Optional) If templates have been defined, select a template for the Syslog message to use
Template as is or modify.
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Investigate an Alert View

In the Investigate an Alert view, you can view and investigate alert details. When investigating an alert,

you can open the sessions in the Investigation module for further investigation.
Configure Reporting Engine Configure an Alert - Schedule an Alert
You are herez

k‘ / | |

| Investigate an Alert [l

Manage Alerts and Alert | |
Templates |
I

Workflow

What do you want to do?

Administrator/ Configure Reporting Engine Configure Reporting Engine
Analyst

Administrator/ Configure an alert Configure an Alert

Analyst

Administrator/ Schedule an alert Schedule an Alert

Analyst

Administrator/ View an alert View an Alert

Analyst

Administrator/ Investigate an alert*® Investigate an Alert
Analyst

Administrator/ Manage an alert and alert template ~ Manage an Alert and Alert Template
Analyst

*Y ou can complete these tasks here.

Related Topics

Alerting Overview

Quick View

The following figure is an example with the important features labeled.
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Manage View

Report Chart Warehouse Analytics

Alert View

All Day ~ | Max No Of Alerts | 100 C

Investigate Name Number of hits Detected Message
T Top 10 Destination IP Addresses 1 2017/03/13 3:16:49
‘? Top 10 Destination IP Addresses 1 20717/03/13 3:15:49
‘? Top 10 Destination IP Addresses 1 2017/03/13 3:14:49
‘? Top 10 Destination IP Addresses 1 2017/03/13 3:13:49
g Top 10 Destination IP Addresses 1 2017/03/13 3:12:49
g Top 10 Destination IP Addresses 1 2017/03/13 3:11:49
T Top 10 Destination IP Addresses 1 2017/03/13 3:10:49
T Top 10 Destination IP Addresses 1 2017/03/13 3:09:49
‘? Top 10 Destination IP Addresses 1 2017/03/13 3:08:49
‘? Top 10 Destination IP Addresses 1 2077/03/13 3:07:49
h g Top 10 Destination IP Addresses 1 2017/03/13 3:06:49
g Top 10 Destination IP Addresses 1 2017/03/13 3:05:49
g Top 10 Destination IP Addresses 1 2017/03/13 3:04:49
T Top 10 Destination IP Addresses 1 2017/03/13 3:03:49
‘? Top 10 Destination IP Addresses 1 2017/03/13 3:02:49
‘? Top 10 Destination IP Addresses 1 20717/03/13 3:01:49

The View an Alert view has the following panels:
o View Alerts Toolbar
o View Alerts List

View Alerts List

The following table lists the columns in the View Alerts List panel.

Column | Description

T The icon that opens the Investigation module, where the details of the first session that
registered the match for the given alert is displayed for immediate analysis.

Note: You are not redirected to the Investigation module when:

-Y ou reconfigure a data source for an existing alert and run an alert on the new
data source.

-You enter a host name instead of an IP address in the data source field.

Name The name of the alert that registered the match. The hyperlink on the name opens the
Investigation module to view all matches for that particular alert for the hour surrounding
the registered alert.

Number  The number of times the alert is generated.
of hits

Detected The date and time at which the alert generates.

Message The alert message.
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Import Alert Dialog

The Import Alert dialog allows you to import an alerts archive and specify whether to overwrite existing
rules, lists, and alerts.

Workflow

Configure Reporting Engine Configure an Alert Schedule an Alert m

Qnu are heV Z
: Investigate an Alert
il Manage Alerts and Alert
Templates
\

What do you want to do?

Administrator/ Configure Reporting Engine Configure Reporting Engine
Analyst

Administrator/ Configure an alert Configure an Alert

Analyst

Administrator/ Schedule an alert Schedule an Alert

Analyst

Administrator/ View an alert View an Alert

Analyst

Administrator/ Investigate an alert Investigate an Alert
Analyst

Administrator/ Manage an alert and alert template* Manage an Alert and Alert Template
Analyst

*Y ou can complete these tasks here.

Related Topics

Alerting Overview

Quick View

The following figure is an example with the important features labeled.
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RSA RESFOND INVESTIGATE MONITOR  CONFIGURE ADMIN

Reports

Rules Reports Charts Lists Warehouse Analytics Search Report Details d

Import Alert

% Erowse... Delete

File Name w  Overwrite ?

oo | impon

Click Monitor> Reports to view the Manage tab.

Click Alerts to open the Alert view.

In the Alert panel, select a folder to import the file.

In the Alert toolbar, click # ~ > Import to import an alert.

The following table lists the actions in the Import Alert dialog and their description.

Actions |Description

= Browse... Displays a view of the local zip file system so that you can select the alert to be
imported.

- Deletes the selected alert from the Import Alert dialog.

File Name Name of the imported binary file.

Overwrite? Selects the option to overwrite an existing version of the alert you are importing. If you do
not select the Overwrite option, a duplicate file is imported and no error message is

displayed.
Close Closes the Import Alert dialog.
Import Imports the alert with a confirmation message.
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Alert Template References

The Reporting module user interface provides access to NetWitness alerts and alert templates as well.

This topic contains descriptions of the user interface as well as other reference information to help users
manage alert templates.

Topics:
o Create or Modify Template View

o Template View
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Alert Template View

In the Template view, you can add, modify, view, and delete alert templates.

Workflow

Schedule an Alert

Configure Reporting Engine Configure an Alert

2

Qnu are heV
: : Investigate an Alert
il Manage Alerts and Alert
Templates |
|
I

What do you want to do?

Administrator/ Configure Reporting Engine Configure Reporting Engine
Analyst

Administrator/ Configure an alert Configure an Alert

Analyst

Administrator/ Schedule an alert Schedule an Alert

Analyst

Administrator/ View an alert View an Alert

Analyst

Administrator/ Investigate an alert Investigate an Alert
Analyst

Administrator/ Manage an alert and alert template*  Manage an Alert and Alert Template
Analyst

*You can complete these tasks here.

Related Topics

Alerting Overview

Quick View

The following figure is an example with the important features labeled.
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RSA REsPOND INVESTIGATE MONITOR CONFIGURE ADMIN G admin

Overview Reports

Manage

Rules Reports Charts Lists Warehouse Analytics Search Report Details &

Alert
+ = F | ®Enable
[ enabled  Pushed?

= @ No
o e No
o e No
o e Yes

+ -z

Name Message

alert template template message

Click Monitor> Reports to view the Manage tab.
Click Alerts to open the Alert view.
Click EW Template to open the Template view.

The Template toolbar allows you to add, modify, and delete alert templates.
The Template List panel allows you to view a list of all the templates in a tabular format.

The Alert Template view has the following panels:
o Template Toolbar

o Template List

Template Toolbar

Once the templates are defined, you can select a template to simplify defining and modifying alert
messages.

The following table lists the various actions in the Template view and their description.

T

+ Creates a new alert template.

- Deletes the selected alert template.
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G =

i Edits an existing alert template.

Template List

The following table describes the columns in the Templates List panel.

Name Name of the template.

Message  Alert message defined for the template.
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Create or Modify Template View

In the Create/Modify Template view, you can customize alert templates to use when creating alerts.

Workflow

Schedule an Alert

Configure Reporting Engine Configure an Alert

2

Qnu are hey
: : Investigate an Alert
il Manage Alerts and Alert
Templates |
|
I

What do you want to do?

Administrator/ Configure Reporting Engine Configure Reporting Engine
Analyst

Administrator/ Configure an alert Configure an Alert

Analyst

Administrator/ Schedule an alert Schedule an Alert

Analyst

Administrator/ View an alert View an Alert

Analyst

Administrator/ Investigate an alert Investigate an Alert
Analyst

Administrator/ Manage an alert and alert template* Manage an Alert and Alert Template
Analyst

*You can complete these tasks here.

Related Topics

Alerting Overview

Quick View

You can create or modify an alert template name and message on this view.

The following figure is an example of the Create or Modify alert template.
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Create/Modify Template

Mame

Message

The following table describes the fields in the Create/Modify template.

e e

Name Indicates the name of the template for Reporting alerts. For example, source IP.
Message Specifies the message that will be sent when an alert is triggered.

Create Creates the template with a confirmation message and becomes available for use in
Reporting immediately.

Save Saves the template with the edited details or when a new template is created. This button
is visible only in the edit mode.

Cancel Closes the dialog without saving the template or any changes made to the template.
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View Alerts Schedule View

In the View Alerts Schedule view, you can view the following information about each of your scheduled
alerts.

o Completion status, name, last run time, last session ID, total alerts triggered.

« Statistics about the time taken to run the scheduled alert: duration, average duration, maximum
duration.

Note: You can also disable the scheduled alerts.

Workflow

You are here

View an Alert

2

Templates
What do you want to do?
o oo Jommrtn

Configure Reporting Engine

Administrator/ Configure Reporting Engine Configure Reporting Engine
Analyst

Administrator/ Configure an alert Configure an Alert

Analyst

Administrator/ Schedule an alert* Schedule an Alert

Analyst

Administrator/ View an alert View an Alert

Analyst

Administrator/ Investigate an alert Investigate an Alert
Analyst

Administrator/ Manage an alert and alert template ~ Manage an Alert and Alert Template
Analyst

*You can complete these tasks here.

Related Topics

Alerting Overview
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Quick View

The following figure is an example with the important features labeled.

Overview

Reports

Manage view

Rules Reports Charts Lists Warehouse Analytics Search Report Details o

Alert 3
4+ = [Z | ®Enable O Disable | & & - | ETemplate | View Schedule | <@ View Alerts

[ enabled Pushed? | Name Description

Ooe

olo|o
o0 e
<

i 8EE
pomomom
38 8 8 &
i ddd

[ALRT] Alert Schedules @

Completed 2017/03A15 6:59:20 355610 [ 00:00:00 00:00:00 00:00:00

Completed 2017/03A15 6:59:31 365719 [ 00:00:00 00:00:00 00:00:01

B

()

[ Completed 2017/03/15 €:58:17 355610 o 00:00:00 00:00:00 00:00:01
o

o

Completed 2017/03A15 6:58:49 355609 321202 00:00:02 00:00:00 00:00:05

Click Monitor> Reports to view the Manage tab.
Click Alerts to open the Alert view.
Click View Scheduleto view all the alerts scheduled.

The Alerts schedule toolbar allows you to disable the scheduled alert.
The Alerts schedule list allows you to view the scheduled alert details.

The View Alerts Schedule view includes the following panels:
1. Alerts Schedule toolbar

2. Alerts Schedule list

Alert Schedule Toolbar

The Alerts Schedule Toolbar panel allows you to modify the state of the scheduled alert.

Fews fpwerpien

Disable Clicking Disable disables the selected alert.
When schedule alerts are no longer needed or are determined to be ineffective, you
can disable them so that they are no longer executed. You can select one of more
alerts to disable. When an alert is disabled, it is removed from the scheduled alerts
list so that you can't view it here, and it will not execute again unless you manually
execute the alert or set up a new schedule for it.

Alert Schedule List Panel

The Alerts Schedule List panel lists only the Enabled alerts in a tabular format. The following table lists
the columns in the Alerts Schedule List panel and their description.

Feature Description

The state of the scheduled alert:
o Completed
° Falled
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Feature Description

Name The name of the scheduled alert.
Last Run {#time} The last time the scheduled alert was run.

Last Session Id The Session Id of the last scheduled alert.

Total Alerts The total number of event occurrences.

Duration The time taken to run the scheduled alert.

Avg (s) The average time taken to run the scheduled alert.
Max (s) The maximum time taken to run the scheduled alert.
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View Alerts View

In the View Alerts view, you can view all the alerts. Also, you can also customize the view to show
alerts for a specific period of time, and set the maximum number of alerts displayed in a single page.

Workflow

You are here

Configure Reporting Engine |

Investigate an Alert
Manage Alerts and Alert
Templates

What do you want to do?

Administrator/ Configure Reporting Engine Configure Reporting Engine
Analyst

Administrator/ Configure an alert Configure an Alert

Analyst

Administrator/ Schedule an alert Schedule an Alert

Analyst

Administrator/ View an alert* View an Alert

Analyst

Administrator/ Investigate an alert Investigate an Alert
Analyst

Administrator/ Manage an alert and alert template ~ Manage an Alert and Alert Template
Analyst

*Y ou can complete these tasks here.

Related Topics

Alerting Overview

Quick View

The following figure is an example with the important features labeled.
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RSA RESPOND INVESTIGATE CONFIGURE

1

Overview Reports

Manage View

Rules Reports Charts Alerts (IR Warehouse Analytics Search Report Detal E-3

Alert 3
+ -@= | Enable Disable | O ## - | W Template [ View Schedule

Enabled  Pushed 7 Name. oescription Actions.

No Communication to Blacklisted Hosts Record

Record

Record

Yes Top 10 Destination IP Addresses Record

Report Chart Warehouse Analytics

Alert View

All Day v Max No Of Alerts 100 z

Investigate Name Number of hits Detected Message
>
I 1 2017703713 3:16:49
P
I 1 2017703713 3:15:49
<>
I 1 2017703713 3:14:49
<>
I 1 2017/03/13 3:13:49
P
I 1 2017/03/13 3:12:49
o
I 1 2017/03/13 3:11:49
o
I 1 2017703713 3:10:49
o
I 1 2017/03/13 3:09:49
<>
I 1 2017/03/13 3:08:49
<>
I 1 2017703413 3:07:49
P
I 1 2017/03/13 3:06:49
o
I Top 10 Destination IP Addresses 1 2017/03/13 3:05:49
o
1 P Addresses 1 2017/03/13 3:04:49
s
I 1 2017/03/13 3:03:49
o
I 1 2017/03/13 3:02:49
<>
I P Addresses 1 2017/03/13 3:01:49

Click Monitor> Reports to view the Manage tab.
Click Alerts to open the Alert view.
Click View Alerts to view the different panels on View Alerts.

The View Alerts toolbar allows you to filter alerts based on a count, or the start and end date of
the alerts.

The View Alerts List lists all the filtered alerts in a tabular format.

The View Alerts view has the following panels:
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e View Alerts Toolbar

e View Alerts List

View Alerts Toolbar

The following table lists the operations in View Alerts toolbar panel.

opten[Descrlon

Last Hour(s) The data fetched from the previous execution.

data
Max No Of  The maximum number of alerts that you want to fetch from the Reporting Engine
Alerts service for a specific time-range.

View Alerts List

The following table lists the columns in the View Alerts List panel.

< The icon that opens the Investigation module, where the details of the first session that
registered the match for the given alert is displayed for immediate analysis.

Note: You are not redirected to the Investigation module when:
-You reconfigure a data source for an existing alert and run an alert on the new

data source.
-You enter a host name instead of an IP address in the data source field.

Name The name of the alert that registered the match. The hyperlink on the name opens the
Investigation module to view all matches for that particular alert for the hour surrounding

the registered alert.

Number  The number of times the alert is generated.
of hits

Detected The date and time at which the alert generates.

Message  The alert message.
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